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Note

The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration.
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's
path protection feature, which may be used in any topological network configuration. Cisco does not
recommend using its path protection feature in any particular topological network configuration.
This section explains the objectives, intended audience, and organization of this publication and
describes the conventions that convey instructions and other information.
This section provides the following information:
•

Revision History

•

Document Objectives

•

Audience

•

Document Organization

•

Related Documentation

•

Document Conventions

•

Obtaining Optical Networking Information

•

Obtaining Documentation and Submitting a Service Request
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Revision History
Date

Notes

October 2007

Updated “PROTNA” alarm on page 2-187. Modified Step 1 of
“2.5.10 APC-OUT-OF-RANGE” section on page 30 to: To determine the correct root
cause, complete the network-level troubleshooting procedures and node level problems
located in 1.13 Node Level (Intranode) Problems.

February 2008

•

Added new troubleshooting procedure “Counter-Propagating Light Affecting
Operation of 32DMX-C and 32DMX-L Cards” in Chapter 1, General
Troubleshooting.

•

Added note on counter-propagating light affecting operation of 32DMX-C and
32DMX-L cards in the “LOS-P (AOTS, OMS, OTS)” section in Chapter 2, Alarm
Troubleshooting.

•

Added WXC card information for OPWR-LFAIL and OPWR-HDEG alarms in
Chapter 2, Alarm Troubleshooting.

•

Added EID-6147 and EID-6148 in Chapter 4, Error Messages.

•

Updated PROV-MISMATCH section in Chapter 2, Alarm Troubleshooting.

•

Added “SPAN-NOT-MEASURED” transient condition to Chapter 3, Transient
Conditions.

•

Updated PROV-MISMATCH section in Chapter 2, Alarm Troubleshooting.

•

Updated the severity of UNQUAL-PPM alarm in Chapter 2, Alarm
Troubleshooting.

•

Updated the terminal and facility loopback behavior of DWDM cards in Chapter
1, General Troubleshooting.

•

Added mode details for APC-CORR-SKIPPED and APC-DISABLED alarms in
Chaper 2, Alarm Troubleshooting.

•

Added amplifier cards, demultiplexer cards, and add/drop multiplexer cards to
Node Level (Intranode) Problems section in Chapter 1, General Troubleshooting.

•

Updated Alarm Severity for SYNCPRI in Chapter 2, Alarm Troubleshooting.

•

Added ADM-10G card alarms and updated Tables 2-1 through 2-6 and Table 2-8
in Chapter 2, Alarm Troubleshooting.

March 2009

•

Deleted references to the ADD-OPWR-HDEG, ADD-OPWR-LDEG,
ADD-OPWR-HFAIL, and ADD-OPWR-LFAIL alarms in Chapter 2, Alarm
Troubleshooting.

May 2009

•

Updated PWR-FAIL-A, PWR-FAIL-B, PWR-FAIL-RET-A, and
PWR-FAIL-RET-B alarm details in Chapter 2, Alarm Troubleshooting.

June 2009

•

Updated client and trunk port details for ADM-10G card in Table 1-1 and
Table 1-2 of Chapter 1, General Troubleshooting.

July 2009

•

Adde a note under the “OPWR-LDEG” alarm in Chapter 2, “Alarm
Troubleshooting”.

August 2009

•

Added the description and the procedure to clear the “APC-WRONG-GAIN”
condition in Chapter 2, “Alarm Troubleshooting”.

•

Updated MEM-GONE alarm description in Chapter 2, Alarm Troubleshooting.

April 2008

May 2008

August 2008

November
2008
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Date

Notes

November
2009

•

Updated the section “Isolate the Cause of Power Supply Problems” in the chapter,
“General Troubleshooting”.

January 2010

•

Updated the “Alarm Troubleshooting” chapter with four new alarms: SD-L
(TRUNK), SF-L (TRUNK), MEA (SHELF), and
UNREACHABLE-TARGET-POWER.

February 2010

•

Changed the BIEC parameter to BIT-EC in Chapter 1, “General Troubleshooting”.

June 2010

•

Updated the table “Alarm Logical Object Type Definitions” in the chapter “Alarm
Troubleshooting”.

•

Updated the description of the PWR-FAIL-A and PWR-FAIL-B alarms in the
chapter, Alarm Troubleshooting.

July 2010

•

Updated the “Error Messages” table in the chapter “Error Messages”.

September
2011

•

Updated the “Facility Loopbacks” section in the chapter, “General
Troubleshooting”.

November
2011

Updated the section “PROV-MISMATCH” in the chapter “Alarm Troubleshooting”.

January 2012

Updated the section “SPANLENGTH-OUT-OF-RANGE” in the chapter, “Alarm
Troubleshooting”.

February 2012 Updated the section “IMPROPRMVL” in the chapter “Alarm Troubleshooting”.
May 2012

Updated the section “Clear the UNC-WORD Condition” in the chapter “Alarm
Troubleshooting”.

June 2012

Document Part Number revisioned to 78-18342-02 and a full length book-PDF was
generated.

Document Objectives
This guide gives troubleshooting information and troubleshooting-related parameters for the Cisco ONS
15454 (ANSI) and Cisco ONS 15454 SDH (ETSI) platforms, specifically the dense wavelength division
multiplexing (DWDM) application that can operate on either platform. Use this guide in conjunction
with the appropriate publications listed in the Related Documentation section.

Audience
To use this publication, you should be familiar with Cisco or equivalent optical transmission hardware
and cabling, telecommunications hardware and cabling, electronic circuitry and wiring practices, and
preferably have experience as a telecomunications technician.
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Document Organization
Table 1

Cisco ONS 15454 Procedure Guide Chapters

Title

Summary

Chapter 1, “General Troubleshooting”

Provides procedures for troubleshooting the most
common problems encountered when operating a
Cisco ONS 15454 DWDM shelf in ANSI or ETSI
platforms.

Chapter 2, “Alarm Troubleshooting”

Gives a description, severity, and troubleshooting
procedure for each commonly encountered
Cisco DWDM alarm and condition.

Chapter 4, “Error Messages”

Lists the error messages for the Cisco ONS 15454
Multi-Service Transport Platform (MSTP).

Chapter 3, “Transient Conditions”

Gives a description, entity, Simple Network
Management Protocol (SNMP) number, and trap
for each commonly encountered Cisco ONS 15454
transient condition.

Related Documentation
Use the Cisco ONS 15454 DWDM Troubleshooting Guide in conjunction with the following
publications:
•

Cisco ONS 15454 DWDM Procedure Guide
Provides procedures to install, turn up, test, and maintain an ONS 15454 DWDM node and network.

•

Cisco ONS 15454 DWDM Reference Manual
Provides card, node, and network reference information, including performance monitoring
parameters and network element defaults.

•

Cisco ONS SONET TL1 Command Guide
Provides a full TL1 command and autonomous message set including parameters, AIDs, conditions
and modifiers for the Cisco ONS 15454, ONS 15600, ONS 15310-CL, and ONS 15310-MA
systems.

•

Cisco ONS SONET TL1 Reference Guide
Provides general information, procedures, and errors for TL1 in the Cisco ONS 15454, ONS 15327,
ONS 15600, ONS 15310-CL, and ONS 15310-MA systems.

•

Cisco ONS 15454 SDH and Cisco ONS 15600 SDH TL1 Command Guide
Provides a full TL1 command and autonomous message set including parameters, AIDs, conditions
and modifiers for the Cisco ONS 15454 SDH and Cisco ONS 15600 SDH.

•

Cisco ONS 15454 SDH and Cisco ONS 15600 SDH TL1 Reference Guide
Provides general information, procedures, and errors for TL1 in the Cisco ONS 15454 SDH and
Cisco ONS 15600 SDH.

•

Release Notes for the Cisco ONS 15454 Release 8.5
Provides caveats, closed issues, and new feature and functionality information.

•

Release Notes for the Cisco ONS 15454 SDH Release 8.5
Provides caveats, closed issues, and new feature and functionality information.
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Refer to the following standards documentation referenced in this publication:
•

Telcordia GR-253 CORE

Document Conventions
This publication uses the following conventions:

Note

Caution

Convention

Application

boldface

Commands and keywords in body text.

italic

Command input that is supplied by the user.

[

Keywords or arguments that appear within square brackets are optional.

]

{x|x|x}

A choice of keywords (represented by x) appears in braces separated by
vertical bars. The user must select one.

Ctrl

The control key. For example, where Ctrl + D is written, hold down the
Control key while pressing the D key.

screen font

Examples of information displayed on the screen.

boldface screen font

Examples of information that the user must enter.

<

Command parameters that must be replaced by module-specific codes.

>

Means reader take note. Notes contain helpful suggestions or references to material not covered in the
document.

Means reader be careful. In this situation, the user might do something that could result in equipment
damage or loss of data.
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Warning

IMPORTANT SAFETY INSTRUCTIONS
This warning symbol means danger. You are in a situation that could cause bodily injury. Before you
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar
with standard practices for preventing accidents. Use the statement number provided at the end of
each warning to locate its translation in the translated safety warnings that accompanied this
device. Statement 1071
SAVE THESE INSTRUCTIONS

Waarschuwing

BELANGRIJKE VEILIGHEIDSINSTRUCTIES
Dit waarschuwingssymbool betekent gevaar. U verkeert in een situatie die lichamelijk letsel kan
veroorzaken. Voordat u aan enige apparatuur gaat werken, dient u zich bewust te zijn van de bij
elektrische schakelingen betrokken risico's en dient u op de hoogte te zijn van de standaard
praktijken om ongelukken te voorkomen. Gebruik het nummer van de verklaring onderaan de
waarschuwing als u een vertaling van de waarschuwing die bij het apparaat wordt geleverd, wilt
raadplegen.
BEWAAR DEZE INSTRUCTIES

Varoitus

TÄRKEITÄ TURVALLISUUSOHJEITA
Tämä varoitusmerkki merkitsee vaaraa. Tilanne voi aiheuttaa ruumiillisia vammoja. Ennen kuin
käsittelet laitteistoa, huomioi sähköpiirien käsittelemiseen liittyvät riskit ja tutustu
onnettomuuksien yleisiin ehkäisytapoihin. Turvallisuusvaroitusten käännökset löytyvät laitteen
mukana toimitettujen käännettyjen turvallisuusvaroitusten joukosta varoitusten lopussa näkyvien
lausuntonumeroiden avulla.
SÄILYTÄ NÄMÄ OHJEET

Attention

IMPORTANTES INFORMATIONS DE SÉCURITÉ
Ce symbole d'avertissement indique un danger. Vous vous trouvez dans une situation pouvant
entraîner des blessures ou des dommages corporels. Avant de travailler sur un équipement, soyez
conscient des dangers liés aux circuits électriques et familiarisez-vous avec les procédures
couramment utilisées pour éviter les accidents. Pour prendre connaissance des traductions des
avertissements figurant dans les consignes de sécurité traduites qui accompagnent cet appareil,
référez-vous au numéro de l'instruction situé à la fin de chaque avertissement.
CONSERVEZ CES INFORMATIONS

Warnung

WICHTIGE SICHERHEITSHINWEISE
Dieses Warnsymbol bedeutet Gefahr. Sie befinden sich in einer Situation, die zu Verletzungen führen
kann. Machen Sie sich vor der Arbeit mit Geräten mit den Gefahren elektrischer Schaltungen und
den üblichen Verfahren zur Vorbeugung vor Unfällen vertraut. Suchen Sie mit der am Ende jeder
Warnung angegebenen Anweisungsnummer nach der jeweiligen Übersetzung in den übersetzten
Sicherheitshinweisen, die zusammen mit diesem Gerät ausgeliefert wurden.
BEWAHREN SIE DIESE HINWEISE GUT AUF.
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Avvertenza

IMPORTANTI ISTRUZIONI SULLA SICUREZZA
Questo simbolo di avvertenza indica un pericolo. La situazione potrebbe causare infortuni alle
persone. Prima di intervenire su qualsiasi apparecchiatura, occorre essere al corrente dei pericoli
relativi ai circuiti elettrici e conoscere le procedure standard per la prevenzione di incidenti.
Utilizzare il numero di istruzione presente alla fine di ciascuna avvertenza per individuare le
traduzioni delle avvertenze riportate in questo documento.
CONSERVARE QUESTE ISTRUZIONI

Advarsel

VIKTIGE SIKKERHETSINSTRUKSJONER
Dette advarselssymbolet betyr fare. Du er i en situasjon som kan føre til skade på person. Før du
begynner å arbeide med noe av utstyret, må du være oppmerksom på farene forbundet med
elektriske kretser, og kjenne til standardprosedyrer for å forhindre ulykker. Bruk nummeret i slutten
av hver advarsel for å finne oversettelsen i de oversatte sikkerhetsadvarslene som fulgte med denne
enheten.
TA VARE PÅ DISSE INSTRUKSJONENE

Aviso

INSTRUÇÕES IMPORTANTES DE SEGURANÇA
Este símbolo de aviso significa perigo. Você está em uma situação que poderá ser causadora de
lesões corporais. Antes de iniciar a utilização de qualquer equipamento, tenha conhecimento dos
perigos envolvidos no manuseio de circuitos elétricos e familiarize-se com as práticas habituais de
prevenção de acidentes. Utilize o número da instrução fornecido ao final de cada aviso para
localizar sua tradução nos avisos de segurança traduzidos que acompanham este dispositivo.
GUARDE ESTAS INSTRUÇÕES

¡Advertencia!

INSTRUCCIONES IMPORTANTES DE SEGURIDAD
Este símbolo de aviso indica peligro. Existe riesgo para su integridad física. Antes de manipular
cualquier equipo, considere los riesgos de la corriente eléctrica y familiarícese con los
procedimientos estándar de prevención de accidentes. Al final de cada advertencia encontrará el
número que le ayudará a encontrar el texto traducido en el apartado de traducciones que acompaña
a este dispositivo.
GUARDE ESTAS INSTRUCCIONES

Varning!

VIKTIGA SÄKERHETSANVISNINGAR
Denna varningssignal signalerar fara. Du befinner dig i en situation som kan leda till personskada.
Innan du utför arbete på någon utrustning måste du vara medveten om farorna med elkretsar och
känna till vanliga förfaranden för att förebygga olyckor. Använd det nummer som finns i slutet av
varje varning för att hitta dess översättning i de översatta säkerhetsvarningar som medföljer denna
anordning.
SPARA DESSA ANVISNINGAR
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Aviso

INSTRUÇÕES IMPORTANTES DE SEGURANÇA
Este símbolo de aviso significa perigo. Você se encontra em uma situação em que há risco de lesões
corporais. Antes de trabalhar com qualquer equipamento, esteja ciente dos riscos que envolvem os
circuitos elétricos e familiarize-se com as práticas padrão de prevenção de acidentes. Use o
número da declaração fornecido ao final de cada aviso para localizar sua tradução nos avisos de
segurança traduzidos que acompanham o dispositivo.
GUARDE ESTAS INSTRUÇÕES

Advarsel

VIGTIGE SIKKERHEDSANVISNINGER
Dette advarselssymbol betyder fare. Du befinder dig i en situation med risiko for
legemesbeskadigelse. Før du begynder arbejde på udstyr, skal du være opmærksom på de
involverede risici, der er ved elektriske kredsløb, og du skal sætte dig ind i standardprocedurer til
undgåelse af ulykker. Brug erklæringsnummeret efter hver advarsel for at finde oversættelsen i de
oversatte advarsler, der fulgte med denne enhed.
GEM DISSE ANVISNINGER
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Obtaining Optical Networking Information
This section contains information that is specific to optical networking products. For information that
pertains to all of Cisco, refer to the Obtaining Documentation and Submitting a Service Request section.

Where to Find Safety and Warning Information
For safety and warning information, refer to the Cisco Optical Transport Products Safety and
Compliance Information document that accompanied the product. This publication describes the
international agency compliance and safety information for the Cisco ONS 15454 system. It also
includes translations of the safety warnings that appear in the ONS 15454 system documentation.

Cisco Optical Networking Product Documentation CD-ROM
Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is
available in a CD-ROM package that ships with your product. The Optical Networking Product
Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and
revised Cisco technical documentation, at:
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS)
feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds
are a free service and Cisco currently supports RSS version 2.0.
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CH A P T E R

1

General Troubleshooting
This chapter provides procedures for troubleshooting the most common problems encountered when
operating a Cisco ONS 15454 DWDM shelf in ANSI or ETSI platforms. To troubleshoot specific alarms,
see Chapter 2, “Alarm Troubleshooting.” If you cannot find what you are looking for, contact Cisco
Technical Support (1-800-553-2447).

Note

In this chapter, “ONS 15454” refers to both ANSI and ETSI versions of the platform unless otherwise
noted.
This chapter includes the following sections on network problems:

Note

For dense wavelength division multiplexing (DWDM) network acceptance tests, refer to the
Cisco ONS 15454 DWDM Procedure Guide.
•

1.1 Loopback Description, page 1-2—Explains in general terms the types of loopback tests (facility
and terminal) that can be run along with general loopback behavior and card loopback behavior.

•

1.2 Troubleshooting MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks,
page 1-7—Explains how to use loopbacks tests described in “1.1 Loopback Description” section on
page 1-2 to isolate trouble on muxponder (MXP) and transponder (TXP) circuits.

•

1.3 Troubleshooting DWDM Circuit Paths With ITU-T G.709 Monitoring, page 1-24—Explains
how to utilize performance monitoring (PM) and threshold crossing alerts (TCA) to locate signal
degrades on DWDM circuit paths.

The remaining sections describe symptoms, problems, and solutions that are categorized according to
the following topics:
•

1.4 Using CTC Diagnostics, page 1-32—Explains how to perform card LED tests and download a
diagnostic file for Cisco Technical Support.

•

1.5 Restoring the Database and Default Settings, page 1-35—Provides procedures for restoring
software data and restoring the node to the default setup.

•

1.6 PC Connectivity Troubleshooting, page 1-36—Provides troubleshooting procedures for PC and
network connectivity to the ONS 15454.

•

1.7 CTC Operation Troubleshooting, page 1-41—Provides troubleshooting procedures for
Cisco Transport Controller (CTC) login or operation problems.

•

1.8 Timing, page 1-51—Provides troubleshooting procedures for circuit creation and error
reporting as well as timing reference errors and alarms.
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•

1.9 Fiber and Cabling, page 1-54—Provides troubleshooting procedures for fiber and cabling
connectivity errors.

•

1.10 Power Supply Problems, page 1-57—Provides troubleshooting procedures for rack power
supply problems.

•

1.11 Power Up Problems for Node and Cards, page 1-59—Provides troubleshooting procedures for
shelf and card power supply problems.

•

1.12 Network Level (Internode) Problems, page 1-59—Provides troubleshooting procedures for
problems between nodes, such as fiber cuts and optical channel network connection (OCHNC)
circuit creation failure.

•

1.13 Node Level (Intranode) Problems, page 1-83—Provides troubleshooting procedures for
variable optical attenuator (VOA) startup problems as well as internal VOA control loop problems
in the 32DMX-C and 32DMX-L cards that occur due to counter-propagating light.

1.1 Loopback Description
Use loopbacks and hairpin circuits to test newly created circuits before running live traffic or to logically
locate the source of a network failure. All ONS 15454 and ONS 15454 SDH TXP and MXP cards allow
loopbacks and hairpin test circuits. The ADM-10G allows loopbacks, but does not support hairpin
circuits. Other cards do not allow loopbacks, including OPT-AMP-C, OPT-AMP-17C to OPT-BST,
OPT-PRE, OPT-BST, OPT-PRE, OSC-CSM, AD-xB-xx.x, and AD-xC-xx.x cards.
To create a loopback on an ANSI or SONET port, the port must be in the Out-of-Service and
Management, Maintenance (OOS-MA,MT) service state. After you create the loopback, the service state
becomes Out-of-Service and Management, Loopback and Maintenance (OOS-MA,LPBK & MT).
To create a loopback on an SDH or ETSI port, the port must be in the Locked, maintenance
administrative state and the Locked-Enabled, loopback & maintenance administrative state.

Caution

Facility or terminal loopbacks can be service-affecting. To protect traffic, apply a lockout or Force
switch to the target loopback port. Basic directions for these procedures exist in Chapter 2, “Alarm
Troubleshooting.” For more information about these operations, refer to the “Maintain the Node” chapter
in the Cisco ONS 15454 DWDM Procedure Guide.

Note

In CTC, a facility loopback is sometimes called “facility (line)” loopback, and a terminal loopback is
sometimes called a “terminal (inward)” loopback. This is done to indicate the terminating direction of
the signal: a facility loopback is sent outward toward the span, whereas a terminal loopback is redirected
inward toward its originating port.

1.1.1 Facility Loopbacks
The following sections give general information about facility loopback operations and specific
information about ONS 15454 or ONS 15454 SDH card loopback activity.
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1.1.1.1 General Behavior
A facility loopback tests the line interface unit (LIU) of a card, the electrical interface assembly (EIA),
and related cabling. After applying a facility loopback on a port, use a test set to run traffic over the
loopback. A successful facility loopback isolates the LIU, the EIA, or the cabling plant as the potential
cause of a network problem.
To test a card LIU, connect an optical test set to a trunk or client port and perform a facility loopback.
Alternately, use a loopback or hairpin circuit on a card that is farther along the circuit path. For example,
Figure 1-1 shows a facility loopback at a trunk port and at a client port on a TXP card.
Figure 1-1

Facility Loopback Path on a Near-End Transponder Card

Client port Facility loopback at trunk port
TXP

Test Set
Trunk port
Client port Facility loopback at client port
TXP

Trunk port

145758

Test Set

Caution

Before performing a facility loopback on a TXP card, be sure that the card contains at least two data
communications channel (DCC) paths to the node where the card is installed. A second DCC provides
a nonlooped path to log into the node after the loopback is applied, enabling you to remove the facility
loopback. Ensuring a second DCC is not necessary if you are directly connected to the node containing
the loopback card.

Caution

Ensure that the facility being loopbacked is not being used by the node for line timing. If it is, a timing
loop will be created.

1.1.1.2 Card Behavior
Port loopbacks either terminate or bridge the loopback signal. All MXP and TXP facility loopbacks are
terminated as shown in Table 1-1.
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When a port terminates a facility loopback signal, the signal only loops back to the originating port and
is not transmitted downstream. When a port bridges a loopback signal, the signal loops back to the
originating port and is also transmitted downstream.

Note

In Table 1-1, no alarm indication signal (AIS) is injected if the signal is bridged. If the signal is
terminated, an applicable AIS is injected downstream.
Table 1-1

DWDM Card Facility Loopback Behavior

Card/Port

Facility Loopback Signal

TXP_MR_10E/TXP_MR_10E_C/TXP_MR_10E_L client ports

Bridged

TXP_MR_10E/TXP_MR_10E_C/TXP_MR_10E_L trunk ports

Terminated

TXP_MR_2.5G/TXPP_MR_2.5G client ports

Terminated

TXP_MR_2.5G/TXPP_MR_2.5G trunk ports

Terminated

MXP_2.5G_10E_C/MXP_2.5G_10E_L client ports

Bridged

MXP_2.5G_10E_C/MXP_2.5G_10E_L trunk ports

Terminated

MXP_MR_10DME client ports

Bridged

MXP_MR_10DME trunk ports

Terminated

MXP_MR_2.5G/MXPP_MR_2.5G client ports

Terminated

MXP_MR_2.5G/MXPP_MR_2.5G trunk ports

Terminated

GE_XP/10GE_XP client ports

Bridged

GE_XP/10GE_XP trunk ports

Terminated

ADM-10G client ports

Bridged

ADM-10G trunk ports

Terminated

The loopback itself is listed in the Conditions window. For example, the window would list the
LPBKFACILITY condition for a tested port. (The Alarms window would show the AS-MT condition
which means that alarms are suppressed on the facility during loopback unless the default is set to alarm
for loopback while in AS-MT.)
With a client-side SONET or ANSI facility loopback, the client port service state is OOS-MA,LPBK &
MT. However, any remaining client and trunk ports can be in any other service state. For SONET or
ANSI cards in a trunk-side facility loopback, the trunk port service state is OOS-MA,LPBK & MT and
the remaining client and trunk ports can be in any other service state.
With a client-side SDH or ESTI facility loopback, the client port is in the Locked-enabled,maintenance
& loopback service state. However, the remaining client and trunk ports can be in any other service state.
For MXP and TXP cards in a SDH or ETSI trunk-side facility loopback, the trunk port is in the
Locked-enabled,maintenance & loopback service state and the remaining client and trunk ports can be
in any other service state.
When you apply a facility loopback on the GE_XP and 10GE_XP cards, the ifInDiscard counters
increment continuously.
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1.1.2 Terminal Loopbacks
The following sections give general information about terminal loopback operations and specific
information about ONS 15454 card loopback activity.

1.1.2.1 General Behavior
A terminal loopback tests a circuit path as it passes through a TXP, MXP, or ADM-10G card and loops
back. For example, as shown in Figure 1-2, there are two types of terminal loopbacks shown for a TXP
card.
The first is a terminal loopback at the client port. In this situation, the test set traffic comes in through
the TXP trunk port, travels through the card, and turns around because of the terminal loopback in effect
on the card just before it reaches the LIU of the client port. The signal is then sent back through the card
to the trunk port and back to the test set.
The second is a terminal loopback at the trunk port. In this situation, the test set traffic comes in through
the TXP client port, travels through the card, and turns around because of the terminal loopback in effect
on the card just before it reaches the LIU of the trunk port. The signal is then sent back through the card
to the client port and back to the test set.
This test verifies that the terminal circuit paths are valid, but does not test the LIU on the TXP card.
Figure 1-2

Terminal Loopback on a TXP Card

Client port Terminal loopback at client port
TXP

Test Set

Trunk port
Client port Terminal loopback at trunk port
TXP

Trunk port

145760

Test Set
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1.1.2.2 Card Behavior
ONS 15454 and ONS 15454 SDH terminal port loopbacks can either terminate or bridge the signal. TXP
terminal loopbacks are terminated as shown in Table 1-2. During terminal loopbacks, if a port terminates
a terminal loopback signal, the signal only loops back to the originating port and is not transmitted
downstream. If the port bridges a loopback signal, the signal loops back to the originating port and is
also transmitted downstream. Client card terminal loopback bridging and terminating behaviors are
listed in Table 1-2.

Note

In Table 1-2, no AIS signal is injected if the signal is bridged. If the signal is terminated, an applicable
AIS is injected downstream.
Table 1-2

DWDM Card Terminal Loopback Behavior

Card/Port

Terminal Loopback Signal

TXP_MR_10E/TXP_MR_10E_C/TXP_MR_10E_L client ports

Bridged

TXP_MR_10E/TXP_MR_10E_C/TXP_MR_10E_L trunk ports

Bridged

TXP_MR_2.5G/TXPP_MR_2.5G client ports

Bridged

TXP_MR_2.5G/TXPP_MR_2.5G trunk ports

Bridged

MXP_2.5G_10E_C/MXP_2.5G_10E_L client ports

Bridged

MXP_2.5G_10E_C/MXP_2.5G_10E_L trunk ports

Bridged

MXP_MR_10DME client ports

Bridged

MXP_MR_10DME trunk ports

Bridged

MXP_MR_2.5G/MXPP_MR_2.5G client ports

Bridged

MXP_MR_2.5G/MXPP_MR_2.5G trunk ports

Bridged

GE_XP/10GE_XP client ports

Bridged

GE_XP/10GE_XP trunk ports

Bridged

ADM-10G client ports

Bridged

ADM-10G trunk ports

Bridged

The MXP and TXP trunk and client ports can simultaneously maintain different service states:
•

For SONET or ANSI TXP and TXPP cards with a client-side terminal loopback, the client port is in
the OOS-MA,LPBK & MT service state and trunk port must be in IS-NR service state.

•

For SONET or ANSI MXP and MXPP cards with a client-side terminal loopback, the client port is
in the OOS-MA,LPBK & MT service state and the remaining client and trunk ports can be in any
service state.

•

For ADM-10G cards with Client Terminal Loopback on a SONET Client port, AIS-P is sent
forward on client for the circuits on that port.

•

For ADM-10G cards with a Terminal Loopback on a GE Client port, the client port is squelched.

•

In SONET or ANSI MXP or TXP trunk-side terminal loopbacks, the trunk port is in the
OOS-MA,LPBK & MT service state and the client ports must be in IS-NR service state for complete
loopback functionality. A terminal loopback affects all client ports because it is performed on the
aggregate signal.
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•

For ADM-10G cards with a Facility Loopback on the Trunk port, AIS-P is sent forward on all the
SONET client ports.

•

For ADM-10G cards with a Facility Loopback on the Trunk port, all the GE client ports is squelched

•

For ADM-10G Terminal Loopback on the Trunk port, the signal is anyway sent downstream (drop
and continue).

•

For SDH or ETSI TXP and TXPP client-side facility loopbacks, the client port is in the
Locked-enabled,maintenance & loopback service state and the trunk port must be in
Unlocked-enabled service state.

•

For SDH or ETSI MXP and MXPP cards with a client-side terminal loopback, the client port is in
the Locked-enabled,maintenance & loopback service state and remaining client and trunk ports can
be in any service state.

•

In SDH and ETSI MXP or TXP trunk-side terminal loopbacks, the trunk port is in the
Locked-enabled,maintenance & loopback service state and the client ports must be in
Unlocked-enabled service state for complete loopback functionality. A facility loopback affects all
client ports because it is performed on the aggregate signal.

The loopback itself is listed in the Conditions window. For example, the window would list the
LPBKTERMINAL condition or LPBKFACILITY condition for a tested port. (The Alarms window
would show the AS-MT condition, which indicates that all alarms are suppressed on the port during
loopback testing unless the default is set to alarm for loopback while in AS-MT.)

1.2 Troubleshooting MXP, TXP, XP, or ADM-10G Circuit Paths
With Loopbacks
Facility loopbacks and terminal loopbacks are often used together to test the circuit path through the
network or to logically isolate a fault. Performing a loopback test at each point along the circuit path
systematically isolates possible points of failure. MXP, TXP, XP, or ADM-10G card loopback tests differ
from other testing in that loopback testing does not require circuit creation. MXP, TXP, and XP client
ports are statically mapped to the trunk ports so no signal needs to traverse the cross-connect card (in a
circuit) to test the loopback.
You can use these procedures on transponder cards (TXP, TXPP, ADM-10G), muxponder, or xponder
cards (MXP, MXPP, XP, ADM-10G) cards. The example in this section tests an MXP or TXP circuit on
a three-node bidirectional line switched ring (BLSR) or multiplex section-shared protection ring
(MS-SPRing). Using a series of facility loopbacks and terminal loopbacks, the example scenario traces
the circuit path, tests the possible failure points, and eliminates them. The logical progression contains
six network test procedures:

Note

MXP, TXP, XP, or ADM-10G card client ports do not appear when you click the Maintenance >
Loopback tab unless they have been provisioned. Do this in the card view by clicking the Provisioning
> Pluggable Port Modules tab. For information about provisioning client ports, refer to the
Cisco ONS 15454 DWDM Procedure Guide.

Note

The test sequence for your circuits will differ according to the type of circuit and network topology.
1.

A facility loopback on the source-node MXP, TXP, XP, or ADM-10G port
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Note

2.

A terminal loopback on the source-node MXP, TXP, XP, or ADM-10G port

3.

A facility loopback on the intermediate-node MXP, TXP, XP, or ADM-10G port

4.

A terminal loopback on the intermediate-node MXP, TXP, XP, or ADM-10G port

5.

A facility loopback on the destination-node MXP, TXP, XP, or ADM-10G port

6.

A terminal loopback on the destination-node MXP, TXP, XP, or ADM-10G port

Facility and terminal loopback tests require on-site personnel.

1.2.1 Perform a Facility Loopback on a Source-Node MXP, TXP, XP, or
ADM-10G Port
This facility loopback test is performed on the node source port in the network circuit. In the testing
situation used in this example, the source muxponder, transponder, xponder, or ADM-10G port under
test is located in the source node. Facility loopback can be performed at the trunk port or at a client port.
Completing a successful facility loopback on this port isolates the source MXP, TXP, XP, or ADM-10G
port as a possible failure point. Figure 1-3 shows the facility loopback examples on source ONS node
TXP ports (client and trunk).
Figure 1-3

Client port

Facility Loopback on a Circuit Source MXP or TXP Port
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Caution

Note

Performing a loopback on an in-service circuit is service-affecting.

Facility loopbacks require on-site personnel.
Complete the “Create the Facility Loopback on the Source-Node MXP, TXP, XP or ADM-10G Port”
procedure on page 1-9.

Create the Facility Loopback on the Source-Node MXP, TXP, XP or ADM-10G Port
Step 1

Connect an optical test set to the port you are testing.

Note

For specific procedures to connect, set up, and use the test set equipment, consult the
manufacturer.

Use appropriate cabling to attach the transmit (Tx) and receive (Rx) terminals of the optical test set to
the port you are testing. The Tx and Rx terminals connect to the same port.
Step 2

Adjust the test set accordingly. (Refer to manufacturer instructions for test set use.)

Step 3

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to display the card
view.

Step 4

Click the Maintenance > Loopback tabs.

Step 5

Choose OOS,MT (or locked,maintenance) from the Admin State column for the port being tested. If
this is a multiport card, select the appropriate row for the desired port.

Step 6

Choose Facility (Line) from the Loopback Type column for the port being tested. If this is a multiport
card, select the appropriate row for the desired port.

Step 7

Click Apply.

Step 8

Click Yes in the confirmation dialog box.

Note

Step 9

It is normal for the “LPBKFACILITY (ESCON)” condition on page 2-147, “LPBKFACILITY
(FC)” condition on page 2-147, “LPBKFACILITY (GE)” condition on page 2-148,
“LPBKFACILITY (ISC)” condition on page 2-148or the “LPBKFACILITY (TRUNK)”
condition on page 2-149 to appear during loopback setup. The condition clears when you remove
the loopback.

Complete the “Test and Clear the MXP, TXP, XP or ADM-10G Facility Loopback Circuit” procedure on
page 1-9.

Test and Clear the MXP, TXP, XP or ADM-10G Facility Loopback Circuit
Step 1

If the test set is not already sending traffic, send test traffic on the loopback circuit.
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Step 2

Examine the traffic received by the test set. Look for errors or any other signal information that the test
set is capable of indicating.

Step 3

If the test set indicates no errors, no further testing is necessary with the facility loopback. Clear the
facility loopback:

Step 4

a.

Click the Maintenance > Loopback tabs.

b.

Choose None from the Loopback Type column for the port being tested.

c.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

d.

Click Apply.

e.

Click Yes in the confirmation dialog box.

f.

Complete the “1.2.2 Perform a Terminal Loopback on a Source-Node MXP, TXP, XP or ADM-10G
Port” procedure on page 1-11.

If the test set indicates errors, complete the “Test the MXP, TXP, XP or ADM-10G Card” procedure on
page 1-10.

Test the MXP, TXP, XP or ADM-10G Card
Step 1

Warning

Caution

Complete the “Physically Replace a Card” procedure on page 2-240 for the suspected bad card and
replace it with a known-good one.

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this,
perform an external switch if a switch has not already occurred. Refer to the procedures in the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233. For more
information, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

Resend test traffic on the loopback circuit with a known-good card installed.

Step 3

If the test set indicates no errors, the problem was probably the defective card. Return the defective card
to Cisco through the Return Materials Authorization (RMA) process. Contact Cisco Technical Support
(1-800-553-2447).

Step 4

Clear the facility loopback:
a.

Click the Maintenance > Loopback tabs.

b.

Choose None from the Loopback Type column for the port being tested.

c.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

d.

Click Apply.

e.

Click Yes in the confirmation dialog box.
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Step 5

Complete the “1.2.2 Perform a Terminal Loopback on a Source-Node MXP, TXP, XP or ADM-10G
Port” procedure on page 1-11.

1.2.2 Perform a Terminal Loopback on a Source-Node MXP, TXP, XP or
ADM-10G Port
The terminal loopback test is performed on the node source MXP, TXP, XP, or ADM-10G port. For the
circuit in this example, it is the source TXP trunk port or a client port in the source node. Completing a
successful terminal loopback to a node source port verifies that the circuit is through the source port.
Figure 1-4 shows an example of a terminal loopback on a source TXP port and a client TXP port.
Figure 1-4

Terminal Loopback on a Source-Node MXP or TXP Port
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Performing a loopback on an in-service circuit is service-affecting.

Terminal loopbacks require on-site personnel.
Complete the “Create the Terminal Loopback on a Source-Node MXP, TXP, XP or ADM-10G Port”
procedure on page 1-12.
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Create the Terminal Loopback on a Source-Node MXP, TXP, XP or ADM-10G Port
Step 1

Connect an optical test set to the port you are testing:

Note

For specific procedures to connect, set up, and use the test set equipment, consult the
manufacturer.

a.

If you just completed the “1.2.1 Perform a Facility Loopback on a Source-Node MXP, TXP, XP, or
ADM-10G Port” procedure on page 1-8, leave the optical test set hooked up to the MXP, TXP, XP
or ADM-10G port in the source node.

b.

If you are starting the current procedure without the optical test set hooked up to the source port,
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are
testing. Both Tx and Rx connect to the same port.

Step 2

Adjust the test set accordingly. (Refer to manufacturer instructions for test set use.)

Step 3

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card that requires the
loopback.

Step 4

Click the Maintenance > Loopback tabs.

Step 5

Select OOS,MT (or locked,maintenance) from the Admin State column. If this is a multiport card,
select the row appropriate for the desired port.

Step 6

Select Terminal (Inward) from the Loopback Type column. If this is a multiport card, select the row
appropriate for the desired port.

Step 7

Click Apply.

Step 8

Click Yes in the confirmation dialog box.

Step 9

Complete the “Test and Clear the MXP, TXP, XP or ADM-10G Port Terminal Loopback Circuit”
procedure on page 1-12.

Test and Clear the MXP, TXP, XP or ADM-10G Port Terminal Loopback Circuit
Step 1

If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2

Examine the test traffic being received by the test set. Look for errors or any other signal information
that the test set is capable of indicating.

Step 3

If the test set indicates no errors, no further testing is necessary on the loopback circuit. Clear the
terminal loopback state on the port:
a.

Double-click the card in the source node with the terminal loopback.

b.

Click the Maintenance > Loopback tabs.

c.

Select None from the Loopback Type column for the port being tested.

d.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

e.

Click Apply.

f.

Click Yes in the confirmation dialog box.
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g.
Step 4

Complete the “1.2.3 Create a Facility Loopback on an Intermediate-Node MXP or TXP Port”
procedure on page 1-13.

If the test set indicates errors, complete the “Test the MXP, TXP, XP or ADM-10G Card” procedure on
page 1-13.

Test the MXP, TXP, XP or ADM-10G Card
Step 1

Warning

Caution

Complete the “Physically Replace a Card” procedure on page 2-240 for the suspected bad card and
replace it with a known-good one.

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this,
perform an external switch if a switch has not already occurred. Refer to the procedures in the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233. For more
information, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

Resend test traffic on the loopback circuit with a known-good card.

Step 3

If the test set indicates no errors, the problem was probably the defective card. Return the defective card
to Cisco through the RMA process. Contact Cisco Technical Support (1-800-553-2447).

Step 4

Clear the terminal loopback on the port before testing the next segment of the network circuit path:

Step 5

a.

Double-click the card in the source node with the terminal loopback.

b.

Click the Maintenance > Loopback tabs.

c.

Select None from the Loopback Type column for the port being tested.

d.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

e.

Click Apply.

f.

Click Yes in the confirmation dialog box.

Complete the “1.2.3 Create a Facility Loopback on an Intermediate-Node MXP or TXP Port” procedure
on page 1-13.

1.2.3 Create a Facility Loopback on an Intermediate-Node MXP or TXP Port
Performing the facility loopback test on an intermediate port isolates whether this node is causing circuit
failure. In the situation shown in Figure 1-5, the test is being performed on an intermediate MXP or TXP
port.
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Figure 1-5

Facility Loopback on an Intermediate-Node MXP or TXP Port
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Performing a loopback on an in-service circuit is service-affecting.

Facility loopbacks require on-site personnel.
Complete the “Create a Facility Loopback on an Intermediate-Node MXP or TXP Port” procedure on
page 1-14.

Create a Facility Loopback on an Intermediate-Node MXP or TXP Port
Step 1

Connect an optical test set to the port you are testing:

Note

For specific procedures to connect, set up, and use the test set equipment, consult the
manufacturer.

a.

If you just completed the “1.2.2 Perform a Terminal Loopback on a Source-Node MXP, TXP, XP
or ADM-10G Port” procedure on page 1-11, leave the optical test set hooked up to the source-node
port.

b.

If you are starting the current procedure without the optical test set hooked up to the source port
port, use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you
are testing. Both Tx and Rx connect to the same port.

Step 2

Adjust the test set accordingly. (Refer to manufacturer instructions for test set use.)

Step 3

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the intermediate-node card
that requires the loopback.

Step 4

Click the Maintenance > Loopback tabs.

Step 5

Select OOS,MT (or locked,maintenance) from the Admin State column. If this is a multiport card,
select the row appropriate for the desired port.

Step 6

Select Facility (Line) from the Loopback Type column. If this is a multiport card, select the row
appropriate for the desired port.

Step 7

Click Apply.
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Step 8

Click Yes in the confirmation dialog box.

Step 9

Complete the “Test and Clear the MXP or TXP Port Facility Loopback Circuit” procedure on page 1-15.

Test and Clear the MXP or TXP Port Facility Loopback Circuit
Step 1

If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2

Examine the traffic received by the test set. Look for errors or any other signal information that the test
set is capable of indicating.

Step 3

If the test set indicates no errors, no further testing is necessary with the facility loopback. Clear the
facility loopback from the port:

Step 4

a.

Click the Maintenance > Loopback tabs.

b.

Choose None from the Loopback Type column for the port being tested.

c.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

d.

Click Apply.

e.

Click Yes in the confirmation dialog box.

f.

Complete the “1.2.4 Create a Terminal Loopback on Intermediate-Node MXP or TXP Ports”
procedure on page 1-16.

If the test set indicates errors, complete the “Test the MXP or TXP Card” procedure on page 1-15.

Test the MXP or TXP Card
Step 1

Warning

Caution

Complete the “Physically Replace a Card” procedure on page 2-240 for the suspected bad card and
replace it with a known-good one.

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this,
perform an external switch if a switch has not already occurred. Refer to the procedures in the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233. For more
information, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

Resend test traffic on the loopback circuit with a known-good card installed.

Step 3

If the test set indicates no errors, the problem was probably the defective card. Return the defective card
to Cisco through the RMA process. Contact Cisco Technical Support (1-800-553-2447).

Step 4

Clear the facility loopback from the port:
a.

Click the Maintenance > Loopback tabs.
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Step 5

b.

Choose None from the Loopback Type column for the port being tested.

c.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

d.

Click Apply.

e.

Click Yes in the confirmation dialog box.

Complete the “1.2.4 Create a Terminal Loopback on Intermediate-Node MXP or TXP Ports” procedure
on page 1-16.

1.2.4 Create a Terminal Loopback on Intermediate-Node MXP or TXP Ports
In the next troubleshooting test, you perform a terminal loopback on the intermediate-node port to isolate
whether the intermediate client or trunk port is causing circuit trouble. In the example situation in
Figure 1-6, the terminal loopback is performed on an intermediate MXP or TXP port in the circuit. If
you successfully complete a terminal loopback on the node, this node is excluded from possible sources
of circuit trouble.
Figure 1-6

Terminal Loopback on an Intermediate-Node MXP or TXP Port
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Caution

Note

Performing a loopback on an in-service circuit is service-affecting.

Terminal loopbacks require on-site personnel.
Complete the “Create a Terminal Loopback on Intermediate-Node MXP or TXP Ports” procedure on
page 1-16.

Create a Terminal Loopback on Intermediate-Node MXP or TXP Ports
Step 1

Connect an optical test set to the port you are testing:
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For specific procedures to connect, set up, and use the test set equipment, consult the
manufacturer.

Note

a.

If you just completed the “1.2.3 Create a Facility Loopback on an Intermediate-Node MXP or TXP
Port” section on page 1-13, leave the optical test set hooked up to the source-node port.

b.

If you are starting the current procedure without the optical test set hooked up to the source port,
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are
testing. Both Tx and Rx connect to the same port.

Step 2

Adjust the test set accordingly. (Refer to manufacturer instructions for test set use.)

Step 3

Create the terminal loopback on the destination port being tested:
a.

Step 4

Go to node view (single-shelf mode) or shelf view (multishelf mode) of the intermediate node:
•

Choose View > Go To Other Node from the menu bar.

•

Choose the node (or shelf) from the drop-down list in the Select Node dialog box and click OK.

b.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card that requires
the loopback.

c.

Click the Maintenance > Loopback tabs.

d.

Select OOS,MT (or locked,maintenance) from the Admin State column. If this is a multiport card,
select the row appropriate for the desired port.

e.

Select Terminal (Inward) from the Loopback Type column. If this is a multiport card, select the
row appropriate for the desired port.

f.

Click Apply.

g.

Click Yes in the confirmation dialog box.

Complete the “Test and Clear the MXP or TXP Terminal Loopback Circuit” procedure on page 1-17.

Test and Clear the MXP or TXP Terminal Loopback Circuit
Step 1

If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2

Examine the test traffic being received by the test set. Look for errors or any other signal information
that the test set is capable of indicating.

Step 3

If the test set indicates no errors, no further testing is necessary on the loopback circuit. Clear the
terminal loopback from the port:
a.

Double-click the intermediate-node card with the terminal loopback to display the card view.

b.

Click the Maintenance > Loopback tabs.

c.

Select None from the Loopback Type column for the port being tested.

d.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

e.

Click Apply.

f.

Click Yes in the confirmation dialog box.
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g.
Step 4

Complete the “1.2.5 Perform a Facility Loopback on a Destination-Node MXP, TXP, XP or
ADM-10G Port” procedure on page 1-18.

If the test set indicates errors, complete the “Test the MXP or TXP Card” procedure on page 1-18.

Test the MXP or TXP Card
Step 1

Warning

Caution

Complete the “Physically Replace a Card” procedure on page 2-240 for the suspected bad card and
replace it with a known-good one.

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this,
perform an external switch if a switch has not already occurred. Refer to the procedures in the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233. For more
information, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

Resend test traffic on the loopback circuit with a known-good card.

Step 3

If the test set indicates no errors, the problem was probably the defective card. Return the defective card
to Cisco through the RMA process. Contact Cisco Technical Support (1-800-553-2447).

Step 4

Clear the terminal loopback on the port:

Step 5

a.

Double-click the source-node card with the terminal loopback.

b.

Click the Maintenance > Loopback tabs.

c.

Select None from the Loopback Type column for the port being tested.

d.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

e.

Click Apply.

f.

Click Yes in the confirmation dialog box.

Complete the “1.2.5 Perform a Facility Loopback on a Destination-Node MXP, TXP, XP or ADM-10G
Port” procedure on page 1-18.

1.2.5 Perform a Facility Loopback on a Destination-Node MXP, TXP, XP or
ADM-10G Port
You perform a facility loopback test at the destination port to determine whether this local port is the
source of circuit trouble. The example in Figure 1-7 shows a facility loopback being performed on a TXP
client or trunk port at a destination node.
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Figure 1-7

Facility Loopback on a Destination-Node MXP or TXP Port
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Caution

Note

Performing a loopback on an in-service circuit is service-affecting.

Facility loopbacks require on-site personnel.
Complete the “Create the Facility Loopback on a Destination-Node MXP, TXP, XP or ADM-10G Port”
procedure on page 1-19.

Create the Facility Loopback on a Destination-Node MXP, TXP, XP or ADM-10G Port
Step 1

Connect an optical test set to the port you are testing:

For specific procedures to connect, set up, and use the test set equipment, consult the
manufacturer.

Note

a.

If you just completed the “1.2.4 Create a Terminal Loopback on Intermediate-Node MXP or TXP
Ports” procedure on page 1-16, leave the optical test set hooked up to the source-node port.

b.

If you are starting the current procedure without the optical test set hooked up to the source port,
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are
testing. Both Tx and Rx connect to the same port.

Step 2

Adjust the test set accordingly. (Refer to manufacturer instructions for test set use.)

Step 3

Create the facility loopback on the destination port being tested:
a.

Go to the node view (single-shelf mode) or shelf view (multishelf mode) of the destination node:
•

Choose View > Go To Other Node from the menu bar.

•

Choose the node (or shelf) from the drop-down list in the Select Node dialog box and click OK.

b.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card that requires
the loopback.

c.

Click the Maintenance > Loopback tabs.

d.

Select OOS,MT (or locked,maintenance) from the Admin State column. If this is a multiport card,
select the row appropriate for the desired port.
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Step 4

e.

Select Facility (Line) from the Loopback Type column. If this is a multiport card, select the row
appropriate for the desired port.

f.

Click Apply.

g.

Click Yes in the confirmation dialog box.

Complete the “Test and Clear the MXP, TXP, XP or ADM-10G Facility Loopback Circuit” procedure on
page 1-20.

Test and Clear the MXP, TXP, XP or ADM-10G Facility Loopback Circuit
Step 1

If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2

Examine the traffic received by the test set. Look for errors or any other signal information that the test
set is capable of indicating.

Step 3

If the test set indicates no errors, no further testing is necessary with the facility loopback. Clear the
facility loopback from the port:

Step 4

a.

Click the Maintenance > Loopback tabs.

b.

Choose None from the Loopback Type column for the port being tested.

c.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

d.

Click Apply.

e.

Click Yes in the confirmation dialog box.

f.

Complete the “1.2.6 Perform a Terminal Loopback on a Destination-Node MXP, TXP, XP or
ADM-10G Port” procedure on page 1-21.

If the test set indicates errors, complete the “Test the MXP, TXP, XP or ADM-10G Card” procedure on
page 1-20.

Test the MXP, TXP, XP or ADM-10G Card
Step 1

Warning

Caution

Complete the “Physically Replace a Card” procedure on page 2-240 for the suspected bad card and
replace it with a known-good one.

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this,
perform an external switch if a switch has not already occurred. Refer to the procedures in the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233. For more
information, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.
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Step 2

Resend test traffic on the loopback circuit with a known-good card installed.

Step 3

If the test set indicates no errors, the problem was probably the defective card. Return the defective card
to Cisco through the RMA process. Contact Cisco Technical Support (1-800-553-2447).

Step 4

Clear the facility loopback on the port:

Step 5

a.

Click the Maintenance > Loopback tabs.

b.

Choose None from the Loopback Type column for the port being tested.

c.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

d.

Click Apply.

e.

Click Yes in the confirmation dialog box.

Complete the “1.2.6 Perform a Terminal Loopback on a Destination-Node MXP, TXP, XP or ADM-10G
Port” procedure on page 1-21.

1.2.6 Perform a Terminal Loopback on a Destination-Node MXP, TXP, XP or
ADM-10G Port
The terminal loopback at the destination-node port is the final local hardware error elimination in the
circuit troubleshooting process. If this test is completed successfully, you have verified that the circuit
is good up to the destination port. The example in Figure 1-8 shows a terminal loopback on an
destination node TXP port.
Figure 1-8

Terminal Loopback on a Destination-Node MXP or TXP Port
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Caution

Note

Performing a loopback on an in-service circuit is service-affecting.

Terminal loopbacks require on-site personnel.
Complete the “Create the Terminal Loopback on a Destination-Node MXP, TXP, XP or ADM-10G Port”
procedure on page 1-22.
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Create the Terminal Loopback on a Destination-Node MXP, TXP, XP or ADM-10G Port
Step 1

Connect an optical test set to the port you are testing:

For specific procedures to connect, set up, and use the test set equipment, consult the
manufacturer.

Note

Step 2

a.

If you just completed the “1.2.5 Perform a Facility Loopback on a Destination-Node MXP, TXP,
XP or ADM-10G Port” procedure on page 1-18, leave the optical test set hooked up to the source
port.

b.

If you are starting the current procedure without the optical test set hooked up to the source port,
use appropriate cabling to attach the Tx and Rx terminals of the optical test set to the port you are
testing. Both Tx and Rx connect to the same port.

Adjust the test set accordingly. (Refer to manufacturer instructions for test set use.)

It is normal for the “LPBKTERMINAL (ESCON)” condition on page 2-150,
“LPBKTERMINAL (FC)” condition on page 2-150, “LPBKTERMINAL (GE)” condition on
page 2-151, “LPBKTERMINAL (ISC)” condition on page 2-151 or the “LPBKTERMINAL
(TRUNK)” condition on page 2-152 to appear during loopback setup. The condition clears when
you remove the loopback.

Note

Step 3

Create the terminal loopback on the destination port being tested:
a.

Step 4

Go to the node view (single-shelf mode) or shelf view (multishelf mode) of the destination node:
•

Choose View > Go To Other Node from the menu bar.

•

Choose the node (or shelf) from the drop-down list in the Select Node dialog box and click OK.

b.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card that requires
the loopback.

c.

Click the Maintenance > Loopback tabs.

d.

Select OOS,MT (or locked,maintenance) from the Admin State column. If this is a multiport card,
select the row appropriate for the desired port.

e.

Select Terminal (Inward) from the Loopback Type column. If this is a multiport card, select the
row appropriate for the desired port.

f.

Click Apply.

g.

Click Yes in the confirmation dialog box.

Complete the “Test and Clear the MXP, TXP, XP or ADM-10G Terminal Loopback Circuit” procedure
on page 1-22.

Test and Clear the MXP, TXP, XP or ADM-10G Terminal Loopback Circuit
Step 1

If the test set is not already sending traffic, send test traffic on the loopback circuit.

Step 2

Examine the test traffic being received by the test set. Look for errors or any other signal information
that the test set is capable of indicating.
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Step 3

If the test set indicates no errors, no further testing is necessary on the loopback circuit. Clear the
terminal loopback from the port:
a.

Double-click the intermediate-node card with the terminal loopback.

b.

Click the Maintenance > Loopback tabs.

c.

Select None from the Loopback Type column for the port being tested.

d.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

e.

Click Apply.

f.

Click Yes in the confirmation dialog box.

Step 4

If the test set indicates errors, the problem might be a faulty card.

Step 5

If the test set indicates errors, complete the “Test the MXP, TXP, XP or ADM-10G Card” procedure on
page 1-23.

Test the MXP, TXP, XP or ADM-10G Card
Step 1

Warning

Caution

Complete the “Physically Replace a Card” procedure on page 2-240 for the suspected bad card and
replace it with a known-good one.

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this,
perform an external switch if a switch has not already occurred. Refer to the procedures in the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233. For more
information, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

Resend test traffic on the loopback circuit with a known-good card.

Step 3

If the test set indicates no errors the problem was probably the defective card. Return the defective card
to Cisco through the RMA process. Contact Cisco Technical Support (1-800-553-2447).

Step 4

Clear the terminal loopback on the port:
a.

Double-click the source-node card with the terminal loopback.

b.

Click the Maintenance > Loopback tabs.

c.

Select None from the Loopback Type column for the port being tested.

d.

Choose the appropriate state to place the port in service, out of service and disabled, out of service
for maintenance, or automatically in service from the Admin State column for the port being tested.

e.

Click Apply.

f.

Click Yes in the confirmation dialog box.
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The entire circuit path has now passed its comprehensive series of loopback tests. This circuit qualifies
to carry live traffic.

1.3 Troubleshooting DWDM Circuit Paths With ITU-T G.709
Monitoring
This section provides an overview of the optical transport network (OTN) specified in ITU-T G.709,
Network Node Interface for the Optical Transport Network, and provides troubleshooting procedures for
DWDM circuit paths in the ITU-T G.709 OTN using PM and TCAs.

1.3.1 ITU-T G.709 Monitoring in Optical Transport Networks
ITU-T Recommendation G.709 is part of a suite of recommendations covering the full functionality of
an OTN. ITU-T G.709 enables single-wavelength SONET transparent optical wavelength-based
networks. ITU-T G.709 adds the Operation, Administration, Maintenance, and Provisioning (OAM&P)
functionality of SONET/SDH to DWDM optical networks. It adds extra overhead to existing SONET,
Ethernet, or asynchronous transfer mode (ATM) bit streams for performance management and
improvement.
Like traditional SONET networks, ITU-T G.709 optical networks have a layered design (Figure 1-9).
This structure enables localized monitoring that helps you isolate and troubleshoot network problems.
Figure 1-9
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1.3.2 Optical Channel Layer
The optical channel (OCH) layer is the outermost part of the OTN and spans from client to client. The
optical channel is built as follows:
1.

A client signal such as SONET, Gigabit Ethernet, IP, ATM, Fibre Channel, or enterprise system
connection (ESCON) is mapped to a client payload area and combined with an overhead to create
the optical channel payload unit (OPUk).
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2.

A second overhead is added to the OPUk unit to create the optical channel data unit (ODUk).

3.

A third overhead including forward error correction (FEC) is added to the ODUk to create the
optical channel transport unit (OTUk).

4.

A fourth overhead is added to the OTUk to create the entire OCH layer.

1.3.3 Optical Multiplex Section Layer
The optical multiplex section (OMS) of the OTN allows carriers to identify errors occurring within
DWDM network sections. The OMS layer consists of a payload and an overhead (OMS-OH). It supports
the ability to monitor multiplexed sections of the network, for example, the span between an optical
multiplexer such as the 32MUX-O card and an optical demultiplexer such as the 32DMX-O card.

1.3.4 Optical Transmission Section Layer
The optical transmission section (OTS) layer supports monitoring partial spans of a network’s
multiplexed sections. This layer consists of a payload and an overhead (OTS-OH). It is a transmission
span between two elements in an optical network, such as between:
•

A multiplexer such as the 32MUX-O card and an amplifier such as the OPT-PRE card

•

An amplifier and another amplifier, such as the OPT-BST card and the OPT-PRE card

•

An amplifier such as the OPT-BST card and a demultiplexer such as the 32DMX card

1.3.5 Performance Monitoring Counters and Threshold Crossing Alerts
PM counters and TCAs can be used for identifying trouble and troubleshooting problems in
ITU-T G.709 optical transport networks. ITU-T Recommendation M.2401 recommends that the
following PM parameters be monitored at the ODUk layer:
•

SES (severely errored seconds)—A one-second period that contains greater than or equal to
30 percent errored blocks or at least one defect. SES is a subset of the errored second (ES)
parameter, which is a one-second period with one or more errored blocks or at least one defect.

•

BBE (background block error counter)—An errored block not occurring as part of an SES. BBE is
a subset of the errored block (EB) parameter, which is a block in which one or more bits are in error.

Different PM count parameters are associated with different read points in a network. Figure 1-10
illustrates the PM read points that are useful in identifying DWDM circuit points of failure. The
“Performance Monitoring” chapter in the Cisco ONS 15454 DWDM Reference Manual lists all PM
parameters and provides block diagrams of signal entry points, exit points, and interconnections between
the individual circuit cards. Consult these specifications to determine which PM parameters are
associated with the system points you want to monitor or provision with CTC or TL1. The monitoring
points might vary according to your configuration.

Note

When LOS, LOS-P, or LOF alarms occur on TXP and MXP trunks, G709/SONET/SDH TCAs are
suppressed. For details, see the “Alarm and TCA Monitoring and Management” chapter in the
Cisco ONS 15454 DWDM Reference Manual.
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Figure 1-10

Performance Monitoring Points on ONS DWDM

TCAs are used to monitor performance through the management interface by indicating whether preset
thresholds have been crossed, or whether a transmission (such as a laser transmission) is degraded. TCAs
are not associated with severity levels. They are usually associated with rate, counter, and percentage
parameters that are available at transponder monitoring points. The “Performance Monitoring” chapter
in the Cisco ONS 15454 DWDM Reference Manual contains more information about these alerts.
Select and complete the following procedures according to your network parameters.

Set Node Default BBE or SES Card Thresholds
Complete the following procedure to provision default node ODUk BBE and SES PM thresholds for
TXP cards.
Step 1

In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > Defaults
tabs (Figure 1-11).
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Figure 1-11

Step 2

Set Default BBE/SES Card Thresholds

In the Defaults Selector field, click the card you wish to provision, then click opticalthresholds > trunk
> warning > 15min in the drop-down list.

Provision Individual Card BBE or SES Thresholds in CTC
Complete the following procedure to provision BBE or SES PM thresholds in CTC for an individual
TXP card.
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the applicable card (TXP,
MXP, or XP.)

Step 2

Click the Provisioning > OTN > G.709 Thresholds tabs (Figure 1-12).
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Figure 1-12

Provision Card BBE/SES Thresholds

Step 3

In the Directions area, click the Near End radio button.

Step 4

In the Intervals area, click the 15 Min radio button.

Step 5

In the Types area, click the PM (ODUk) radio button.

Step 6

In the SES and BBE fields, enter threshold numbers, for example 500 and 10000.

Provision Card PM Thresholds Using TL1
Complete the following procedure if you wish to provision PM thresholds in TL1 rather than in CTC.
Step 1

Open a TL1 command line (click Tools > Open TL1 Connection).

Step 2

In the TL1 command line, enter a command using the following syntax:
SET-TH-OCH:[<TID>]:<AID>:<CTAG>::<MONTYPE>,<THLEV>,[<LOCN>],,[<TMPER>];
where:
•

Access Identifier (AID) identifies the NE to which the command pertains. All the OCH, STS, VT1,
facility, and DS1 AIDs are supported.

•

The parameter MONTYPE is the monitored type.

•

The parameter THLEV is optional and indicates a threshold count value (the number of errors that
must be exceeded before the threshold is crossed).

•

The parameter LOCN specifies the location associated with the particular command.

•

The parameter TMPER is optional and is an accumulation time period for performance counters,
with possible values of 1-DAY, 1-HR, 1-MIN, 15-MIN, and RAW-DATA.
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Note

For a more information about this command and a list of TL1 commands, refer to the
Cisco SONET TL1 Command Guide at the following link:
http://www.cisco.com/en/US/products/hw/optical/ps2006/products_command_reference_book
09186a0080483b9b.html

Provision Optical TCA Thresholds
Complete the following procedure to provision TCA thresholds in CTC.
Step 1

In card view, click the Provisioning > Optics Thresholds tabs (Figure 1-13).
Figure 1-13

Provision Optical TCA Thresholds

Step 2

In the Types area, click TCA.

Step 3

In the Intervals area, click 15 Min.

Step 4

In the Laser Bias High (%) field, enter the threshold value, for example, 81.0 percent.

1.3.6 Forward Error Correction
In DWDM spans, FEC reduces the quantities of retiming, reshaping, and regeneration (3R) needed to
maintain signal quality. The following two PM parameters are associated with FEC:
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•

BIT-EC—Bit errors corrected (BIT-EC) indicates the number of bit errors corrected in the DWDM
trunk line during the PM time interval.

•

UNC-WORDS—The number of uncorrectable words detected in the DWDM trunk line during the
PM time interval.

Complete the following procedure to provision BIT-EC and UNC-WORDS PM parameters for FEC.

Provision Card FEC Thresholds
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), double-click a transponder, muxponder,
or xponder card to open the card view.

Step 2

Click the Provisioning > OTN > FEC Thresholds tabs (Figure 1-14).
Figure 1-14

Provision Card FEC Thresholds

Step 3

In the Bit Errors Corrected field, enter a threshold number, for example 225837.

Step 4

In the Uncorrectable Words field, enter a threshold number, for example, 2.

Step 5

In the Intervals area, click 15 Min.

1.3.7 Sample Trouble Resolutions
The following sample trouble resolutions use PM and TCAs to isolate degrade points.
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Symptom There is a BBE TCA on a single transponder pair.
Possible Cause The transponder input power is out of range.
Recommended Action Check the input power on the transponder. It should be within the

specified/supported range.
Possible Cause There are dirty trunk connectors on the transponder.
Recommended Action Check the connector on the trunk port.
Possible Cause There is a degraded trunk patchcord between the transponder and the DWDM port.
Recommended Action Check the patchcord on the transponder DWDM port.
Possible Cause There are dirty client connectors on the ADxC-xx.x card transmit port or the

demultiplexer (DMX) has crossed the near-end TCA.
Recommended Action Check the connector on the OCH port of the ADxC-xx.x card.
Possible Cause There are dirty client connectors on the ADxC-xx.x card receive port or the

multiplexer (MUX) has crossed the far-end TCA point.
Recommended Action If an optical channel bypass exists along the line, check the connectors.

Symptom There is a BBE TCA on all transponders connected to an ADxB-xx.x card.
Possible Cause The transponder input power is out of range.
Recommended Action Check the input power on the transponder. It should be within the

specified/supported range.
Possible Cause There is a dirty connector on the 4MD-xx.x card port.
Recommended Action Check the connector on the drop port of the 4MD-xx.x card.
Possible Cause There is a dirty connector on the ADxB-xx.x card drop port, and it has crossed the

near-end TCA point.
Recommended Action Check the connector on the drop port of the ADxB-xx.x card.
Possible Cause There is a dirty connector on the ADxB-xx.x card add port and it has crossed the

far-end TCA.
Recommended Action Check the patchcord on the 4MD-xx.x or AD1B-xx.x card.
Possible Cause There is a degraded patchcord between the ADxB-xx.x and 4MD-xx.x cards.
Recommended Action If an optical band bypass exists along the line, check the band connectors.
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Symptom There is a BBE TCA on all transponders that the OCH passes through a single OTS section.
Possible Cause This is not a transponder or channel-related issue.
Recommended Action The problem is in the intercabinet signal path preceding the transponder. Refer

to the Cisco ONS 15454 DWDM Procedure Guide for more information about configurations and
acceptance tests for this area.

Symptom You have a laser bias current (LBC) TCA on a single transponder.
Possible Cause The laser of the transponder is degrading.
Recommended Action The problem is within the laser circuitry. Check the OPT-PRE, OPT-BST,

OPT-AMP-C and OPT-AMP-17C after OTP-BST optical amplifier cards. Refer to the
Cisco ONS 15454 DWDM Procedure Guide for more information about setting up these cards.

1.4 Using CTC Diagnostics
In Software Release 8.5, CTC provides diagnostics for the following functions:
•

Verifying proper card application-specific integrated circuit (ASIC) functionality

•

Verifying standby card operation

•

Verifying proper card LED operation

•

Diagnostic circuit creation

•

Customer problem notifications detected by alarms

•

Provision of a downloadable, machine-readable diagnostic information file to be used by Cisco
Technical Support

Some of these functions, such as ASIC verification and standby card operation, are invisibly monitored
in background functions. Change or problem notifications are provided in the Alarms and Conditions
windows. Other diagnostic functions—verifying card LED function, creating bidirectional diagnostic
circuits, and also downloading diagnostic files for technical support—are available to the user in the
node view (single-shelf mode) or shelf view (multishelf mode) Maintenance > Diagnostic tab. The
user-operated diagnostic features are described in the following paragraphs.

1.4.1 Card LED Lamp Tests
A card LED lamp test determines whether card-level indication LEDs are operational. This diagnostic
test is run as part of the initial ONS 15454 turn-up, during maintenance routines, or any time you
question whether an LED is in working order. Maintenance or higher-level users can complete the
following tasks to verify LED operation.

Verify Card LED Operation
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Diagnostic tabs
(Figure 1-15).
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Figure 1-15

ONS 15454 Node View Diagnostic Window

Step 2

Click Lamp Test.

Step 3

Watch to make sure all the port LEDs illuminate simultaneously for several seconds, with the following
durations:

Step 4

•

For tri-color LEDs: three 5-second cycles

•

For dual-color LEDs: one 5-second cycle and one 10-second cycle

•

For the AIC or AIC-I: one 15-second cycle

Click OK in the Lamp Test Run dialog box.

1.4.2 Retrieve Diagnostics File Button
When you click the Retrieve Diagnostics File button in the Maintenance window, CTC retrieves system
data that can be off-loaded by a Maintenance or higher-level user to a local directory and sent to
Technical Support for troubleshooting purposes. The diagnostics file is in machine language and is not
human-readable, but can be used by Cisco Technical Support for problem analysis. Complete the
following task to off-load the diagnostics file.

Note

In addition to the machine-readable diagnostics file, the ONS 15454 also stores an audit trail of all
system events such as user logins, remote logins, configuration, and changes. This audit trail is
considered a record-keeping feature rather than a troubleshooting feature. Information about the feature
is located in the “Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.
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Off-Load the Diagnostics File
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Diagnostic tabs
(Figure 1-15).

Step 2

Click Retrieve Tech Support Log.

Step 3

In the Saving Diagnostic File dialog box, navigate to the directory (local or network) where you want to
save the file.

Step 4

Enter a name in the File Name field.
You do not have to give the archive file a particular extension. It is a compressed file (gzip) that can be
unzipped and read by Cisco Technical Support.

Step 5

Click Save.
The Get Diagnostics status window shows a progress bar indicating the percentage of the file being
saved, then shows “Get Diagnostics Complete.”

Step 6

Click OK.

1.4.3 Data Communications Network Tool
CTC contains a data communications network (DCN) tool that assists with network troubleshooting for
Open Shortest Path First (OSPF) networks. This tool, located in network view, is shown in Figure 1-16.
It executes an internal dump command to retrieve information about all nodes accessible from the entry
point.
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Figure 1-16

DCN Tools OSPF Dump

The dump, which provides the same information as a dump executed by special networking commands,
is available at the network view in the Maintenance > Diagnostic tab. You can select the access point
node in the Select Node drop-down list. To create the dump, click Retrieve. (To clear the dump, click
Clear.)
The contents of the dump file can be saved or printed and furnished to Cisco Technical Support for use
in OSPF network support.

1.5 Restoring the Database and Default Settings
This section contains troubleshooting for node operation errors that require restoration of software data
or the default node setup.

1.5.1 Restore the Node Database
Symptom One or more nodes do not function properly or have incorrect data.
Possible Cause Incorrect or corrupted node database.
Recommended Action Complete the procedures in the “Maintain the Node” chapter of the

Cisco ONS 15454 DWDM Procedure Guide.
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1.6 PC Connectivity Troubleshooting
This section contains information about system minimum requirements, supported platforms, browsers,
and Java Runtime Environments (JREs) for Software R8.5, and troubleshooting procedures for PC and
network connectivity to the ONS 15454.

1.6.1 PC System Minimum Requirements
Workstations running CTC Software R8.5 for the Optical Networking System (ONS) products on
Windows platforms need to have the following minimum requirements:
•

Pentium III or higher processor

•

Processor speed of at least 700 MHz

•

256 MB or more of RAM

•

50 MB or more of available hard disk space

•

20 GB or larger hard drive

1.6.2 Sun System Minimum Requirements
Workstations running Software R8.5 for the ONS products on Sun workstations need to have the
following minimum requirements:
•

UltraSPARC or faster processor

•

256 MB or more of RAM

•

50 MB or more of available hard disk space

1.6.3 Supported Platforms, Browsers, and JREs
Software R8.5 supports the following platforms:
•

Windows NT

•

Windows 98

•

Windows XP

•

Windows 2000

•

Solaris 8

•

Solaris 9

•

Solaris 10

Software R8.5 supports the following browsers and JREs:
•

Netscape 7 browser (PC or Solaris 8 or 9 with Java plug-in 1.4.2 or 5.0, or Solaris 10 with JRE 5.0)

•

PC platforms with Java plug-in 5.0

•

Internet Explorer 6.0 browser (on PC platforms with Java plug-in 5.0)

•

Mozilla 1.7 (Solaris only)
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Note

Note

You can obtain browsers at the following URLs:
•

Netscape: http://channels.netscape.com/ns/browsers/default.jsp

•

Internet Explorer: http://www.microsoft.com

•

Mozilla: http://mozilla.org

JRE 5.0 is required to run Software R8.5. JRE 5.0 is provided on the software CD.

1.6.4 Unsupported Platforms and Browsers
Software R8.5 does not support the following platforms:
•

Windows 95

•

Solaris 2.5

•

Solaris 2.6

Software R8.5 does not support the following browsers and JREs:
•

Netscape 4.73 for Windows.

•

Netscape 4.76 on Solaris.

•

Netscape 7 on Solaris 8 or 9 is only supported with JRE 1.4.2 and above.

1.6.5 Unable to Verify the IP Configuration of Your PC
Symptom When connecting your PC to the ONS 15454, you are unable to successfully ping the IP

address of your PC to verify the IP configuration.
Possible Cause The IP address was entered incorrectly.
Recommended Action Verify that the IP address used to ping the PC matches the IP address displayed

when in the Windows IP Configuration information retrieved from the system. See the “Verify the
IP Configuration of Your PC” procedure on page 1-37.
Possible Cause The IP configuration of your PC is not properly set.
Recommended Action Verify the IP configuration of your PC. Complete the “Verify the IP

Configuration of Your PC” procedure on page 1-37. If this procedure is unsuccessful, contact your
network administrator for instructions to correct the IP configuration of your PC.

Verify the IP Configuration of Your PC
Step 1

Open a DOS command window by selecting Start > Run from the Start menu.

Step 2

In the Open field, type command and then click OK. The DOS command window appears.
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Step 3

At the prompt in the DOS window, type ipconfig and press the Enter key.
The Windows IP configuration information appears, including the IP address, the subnet mask, and the
default gateway.

Note

The winipcfg command only returns the information above if you are on a network.

Step 4

At the prompt in the DOS window, type ping followed by the IP address shown in the Windows IP
configuration information previously displayed.

Step 5

Press the Enter key to execute the command.
If the DOS window returns multiple (usually four) replies, the IP configuration is working properly.
If you do not receive a reply, your IP configuration might not be properly set. Contact your network
administrator for instructions to correct the IP configuration of your PC.

1.6.6 Browser Login Does Not Launch Java
Symptom The message “Loading Java Applet” does not appear and the JRE does not launch during the

initial login.
Possible Cause The PC operating system and browser are not properly configured.
Recommended Action Reconfigure the PC operating system Java Plug-in Control Panel and the

browser settings. Complete the “Reconfigure the PC Operating System Java Plug-in Control Panel”
procedure on page 1-38 and the “Reconfigure the Browser” procedure on page 1-39.

Reconfigure the PC Operating System Java Plug-in Control Panel
Step 1

From the Windows start menu, click Settings > Control Panel.

Step 2

If Java Plug-in does not appear, the JRE might not be installed on your PC:
a.

Run the Cisco ONS 15454 software CD.

b.

Open the CD-drive:\Windows\JRE folder.

c.

Double-click the j2re-5_0-win icon to run the JRE installation wizard.

d.

Follow the JRE installation wizard steps.

Step 3

From the Windows start menu, click Settings > Control Panel.

Step 4

In the Java Plug-in Control Panel window, double-click the Java Plug-in 5.0 icon.

Step 5

Click the Advanced tab on the Java Plug-in Control Panel.

Step 6

Navigate to C:\ProgramFiles\JavaSoft\JRE\5.0.

Step 7

Select JRE 5.0.

Step 8

Click Apply.
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Step 9

Close the Java Plug-in Control Panel window.

Reconfigure the Browser
Step 1

From the Start Menu, launch your browser application.

Step 2

If you are using Netscape Navigator:

Step 3

a.

From the Netscape Navigator menu bar, click the Edit > Preferences menus.

b.

In the Preferences window, click the Advanced > Proxies categories.

c.

In the Proxies window, click the Direct connection to the Internet check box and click OK.

d.

From the Netscape Navigator menu bar, click the Edit > Preferences menus.

e.

In the Preferences window, click the Advanced > Cache categories.

f.

Confirm that the Disk Cache Folder field shows one of the following paths:
•

For Windows 98/ME: C:\ProgramFiles\Netscape\Communicator\cache

•

For Windows NT/2000/XP: C:\ProgramFiles\Netscape\username\Communicator\cache

g.

If the Disk Cache Folder field is not correct, click Choose Folder.

h.

Navigate to the file listed in Step f, and click OK.

i.

Click OK in the Preferences window and exit the browser.

If you are using Internet Explorer:
a.

From the Internet Explorer menu bar, click the Tools > Internet Options menus.

b.

In the Internet Options window, click the Advanced tab.

c.

In the Settings menu, scroll down to Java (Sun) and click the Use Java 2 v1.4.2 for applet (requires
restart) check box.

d.

Click OK in the Internet Options window and exit the browser.

Step 4

Temporarily disable any virus-scanning software on the computer. See the “1.7.4 Browser Stalls When
Downloading CTC JAR Files From TCC2/TCC2P Card” section on page 1-44.

Step 5

Verify that the computer does not have two network interface cards (NICs) installed. If the computer
does have two NICs, remove one.

Step 6

Restart the browser and log onto the ONS 15454.

1.6.7 Unable to Verify the NIC Connection on Your PC
Symptom When connecting your PC to the ONS 15454, you are unable to verify that the NIC connection

is working properly because the link LED is not illuminated or flashing.
Possible Cause The CAT-5 cable is not plugged in properly.
Recommended Action Confirm that both ends of the cable are properly inserted. If the cable is not

fully inserted due to a broken locking clip, the cable should be replaced.
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Possible Cause The CAT-5 cable is damaged.
Recommended Action Ensure that the cable is in good condition. If in doubt, use a known-good cable.
Often, cabling is damaged due to pulling or bending. (For information about installing cable, refer
to the “Install Cards and Fiber-Optic Cable” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.)
Possible Cause Incorrect type of CAT-5 cable is being used.
Recommended Action If connecting an ONS 15454 directly to your laptop, a PC, or a router, use a

straight-through CAT-5 cable. When connecting the ONS 15454 to a hub or a LAN switch, use a
crossover CAT-5 cable. For details on the types of CAT-5 cables, see the “1.9.2.1 Crimp
Replacement LAN Cables” section on page 1-55.
Possible Cause The NIC is improperly inserted or installed.
Recommended Action If you are using a Personal Computer Memory Card International Association
(PCMCIA)-based NIC, remove and reinsert the NIC to make sure the NIC is fully inserted. (If the
NIC is built into the laptop or PC, verify that the NIC is not faulty.)
Possible Cause The NIC is faulty.
Recommended Action Confirm that the NIC is working properly. If you have no issues connecting to
the network (or any other node), then the NIC should be working correctly. If you have difficulty
connecting a to the network (or any other node), then the NIC might be faulty and needs to be
replaced.

1.6.8 Verify PC Connection to the ONS 15454 (ping)
Symptom The TCP/IP connection was established and then lost.
Possible Cause A lost connection between the PC and the ONS 15454.
Recommended Action Use a standard ping command to verify the TCP/IP connection between the PC

and the ONS 15454 TCC2/TCC2P card. A ping command should work if the PC connects directly
to the TCC2/TCC2P card or uses a LAN to access the TCC2/TCC2P card. Complete the “Ping the
ONS 15454” procedure on page 1-40.

Ping the ONS 15454
Step 1

Step 2

Display the command prompt:
a.

If you are using a Microsoft Windows operating system, from the Start Menu choose Run, enter
command in the Open field of the Run dialog box, and click OK.

b.

If you are using a Sun Solaris operating system, from the Common Desktop Environment (CDE)
click the Personal Application tab and click Terminal.

For both the Sun and Microsoft operating systems, at the prompt enter:
ping ONS-15454-IP-address
For example:
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ping 198.168.10.10
Step 3

If the workstation has connectivity to the ONS 15454, the ping is successful and displays a reply from
the IP address. If the workstation does not have connectivity, a “Request timed out” message appears.

Step 4

If the ping is successful, it demonstrates that an active TCP/IP connection exists. Restart CTC.

Step 5

If the ping is not successful, and the workstation connects to the ONS 15454 through a LAN, check that
the workstation’s IP address is on the same subnet as the ONS node.

Step 6

If the ping is not successful and the workstation connects directly to the ONS 15454, check that the link
light on the workstation’s NIC is illuminated.

1.6.9 The IP Address of the Node is Unknown
Symptom The IP address of the node is unknown and you are unable to login.
Possible Cause The node is not set to the default IP address.
Recommended Action Leave one TCC2/TCC2P card in the shelf. Connect a PC directly to the

remaining TCC2/TCC2P card and perform a hardware reset of the card. The TCC2/TCC2P card
transmits the IP address after the reset to enable you to capture the IP address for login. Complete
the “Retrieve Unknown Node IP Address” procedure on page 1-41.

Retrieve Unknown Node IP Address
Step 1

Connect your PC directly to the active TCC2/TCC2P card Ethernet port on the faceplate.

Step 2

Start the Sniffer application on your PC.

Step 3

Perform a hardware reset by pulling and reseating the active TCC2/TCC2P card.

Step 4

After the TCC2/TCC2P card completes resetting, it broadcasts its IP address. The Sniffer software on
your PC will capture the IP address being broadcast.

1.7 CTC Operation Troubleshooting
This section contains troubleshooting procedures for CTC login or operation problems.
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1.7.1 CTC Colors Do Not Appear Correctly on a UNIX Workstation
Symptom When running CTC on a UNIX workstation, the colors do not appear correctly. For example,

both major and minor alarms appear in the same color.
Possible Cause When running in 256-color mode on a UNIX workstation, color-intensive

applications such as Netscape might use all of the colors.
Recommended Action CTC requires a full 24-color palette to run properly. When logging into CTC

on a UNIX workstation, run as many colors as your adapter will support. In addition, you can use
the -install or the -ncols 32 command line options to limit the number of colors that Netscape uses.
Complete the “Limit Netscape Colors” procedure on page 1-42. If the problem persists after limiting
Netscape colors, exit any other color-intensive applications in use.

Limit Netscape Colors
Step 1

Close the current session of Netscape.

Step 2

Launch Netscape from the command line by entering one of the following commands:
•

netscape -install (installs Netscape colors for Netscape use)

•

netscape -ncols 32 (limits Netscape to 32 colors so that if the requested color is not available,
Netscape chooses the closest color option)

1.7.2 Unable to Launch CTC Help After Removing Netscape
Symptom After removing Netscape and running CTC using Internet Explorer, you are unable to launch

CTC Help and receive an “MSIE is not the default browser” error message.
Possible Cause Loss of association between browser and Help files.
Recommended Action When the CTC software and Netscape are installed, the Help files are
associated with Netscape by default. When you remove Netscape, the Help files are not
automatically associated with Internet Explorer as the default browser. Reset Internet Explorer as
the default browser so that CTC associates the Help files to the correct browser. Complete the “Reset
Internet Explorer as the Default Browser for CTC” procedure on page 1-42 to associate the CTC
Help files to the correct browser.

Reset Internet Explorer as the Default Browser for CTC
Step 1

Open the Internet Explorer browser.

Step 2

From the menu bar, click Tools > Internet Options. The Internet Options window appears.

Step 3

In the Internet Options window, click the Programs tab.

Step 4

Click the Internet Explorer should check to see whether it is the default browser check box.
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Step 5

Click OK.

Step 6

Exit any and all open and running CTC and Internet Explorer applications.

Step 7

Launch Internet Explorer and open a new CTC session. You should now be able to access the CTC Help.

1.7.3 Unable to Change Node View to Network View
Symptom When activating a large, multinode BLSR from Software R3.2 to Software R3.3, some of the

nodes appear grayed out. Logging into the new CTC, the user is unable to change node view (single-shelf
mode) or shelf view (multishelf mode) to network view on any nodes, from any workstation. This is
accompanied by an “Exception occurred during event dispatching: java.lang.OutOfMemoryError” in the
java window.
Possible Cause The large, multinode BLSR requires more memory for the graphical user interface

(GUI) environment variables.
Recommended Action Set the system or user CTC_HEAP environment variable to increase the

memory limits. Complete the “Set the CTC_HEAP and CTC_MAX_PERM_SIZE_HEAP
Environment Variables for Windows” procedure on page 1-43 or the “Set the CTC_HEAP and
CTC_MAX_PERM_SIZE_HEAP Environment Variables for Solaris” procedure on page 1-44 to
enable the CTC_HEAP variable change.

Note

This problem typically affects large networks where additional memory is required to manage
large numbers of nodes and circuits.

Set the CTC_HEAP and CTC_MAX_PERM_SIZE_HEAP Environment Variables for Windows
Note

Before proceeding with the following steps, ensure that your system has a minimum of 1 GB of RAM.
If your system does not have a minimum of 1 GB of RAM, contact the Cisco Technical Assistance Center
(TAC).

Step 1

Close all open CTC sessions and browser windows.

Step 2

From the Windows Start menu, choose Control Panel > System.

Step 3

In the System Properties window, click the Advanced tab.

Step 4

Click the Environment Variables button to open the Environment Variables window.

Step 5

Click the New button under the System variables field.

Step 6

Type

CTC_HEAP

Step 7

Type

512

Step 8

Again, click the New button under the System variables field.

Step 9

Type

CTC_MAX_PERM_SIZE_HEAP

Step 10

Type

128

in the Variable Name field.

in the Variable Value field, and then click the OK button to create the variable.
in the Variable Name field.

in the Variable Value field, and then click the OK button to create the variable.
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Step 11

Click the OK button in the Environment Variables window to accept the changes.

Step 12

Click the OK button in the System Properties window to accept the changes.

Set the CTC_HEAP and CTC_MAX_PERM_SIZE_HEAP Environment Variables for Solaris
Step 1

From the user shell window, kill any CTC sessions and browser applications.

Step 2

In the user shell window, set the environment variables to increase the heap size.
Example

The following example shows how to set the environment variables in the C shell:
% setenv CTC_HEAP 512
% setenv CTC_MAX_PERM_SIZE_HEAP 128

1.7.4 Browser Stalls When Downloading CTC JAR Files From TCC2/TCC2P Card
Symptom The browser stalls or hangs when downloading a CTC Java archive (JAR) file from the

TCC2/TCC2P card.
Possible Cause McAfee VirusScan software might be interfering with the operation. The problem

occurs when the VirusScan Download Scan is enabled on McAfee VirusScan 4.5 or later.
Recommended Action Disable the VirusScan Download Scan feature. Complete the “Disable the

VirusScan Download Scan” procedure on page 1-44.

Disable the VirusScan Download Scan
Step 1

From the Windows Start menu, choose Programs > Network Associates > VirusScan Console.

Step 2

Double-click the VShield icon listed in the VirusScan Console dialog box.

Step 3

Click Configure on the lower part of the Task Properties window.

Step 4

Click the Download Scan icon on the left of the System Scan Properties dialog box.

Step 5

Uncheck the Enable Internet download scanning check box.

Step 6

Click Yes when the warning message appears.

Step 7

Click OK in the System Scan Properties dialog box.

Step 8

Click OK in the Task Properties window.

Step 9

Close the McAfee VirusScan window.
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1.7.5 CTC Does Not Launch
Symptom CTC does not launch; usually an error message appears before the login window appears.
Possible Cause The Netscape browser cache might point to an invalid directory.
Recommended Action Redirect the Netscape cache to a valid directory. Complete the “Redirect the
Netscape Cache to a Valid Directory” procedure on page 1-45.

Redirect the Netscape Cache to a Valid Directory
Step 1

Launch Netscape.

Step 2

Open the Edit menu.

Step 3

Choose Preferences.

Step 4

In the Category column on the left side, expand the Advanced category and choose the Cache tab.

Step 5

Change your disk cache folder to point to the cache file location.
The cache file location is usually C:\ProgramFiles\Netscape\Users\yourname\cache. The yourname
segment of the file location is often the same as the user name.

1.7.6 Slow CTC Operation or Login Problems
Symptom You experience slow CTC operation or have problems logging into CTC.

Table 1-3 describes the potential cause of the symptom and the solution.
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Table 1-3

Slow CTC Operation or Login Problems

Possible Problem

Solution

The CTC cache file
might be corrupted or
might need to be
replaced.

Search for and delete cache files. This operation forces the ONS 15454 to
download a new set of Java archive (JAR) files to your computer hard drive.
Complete the “Delete the CTC Cache File Automatically” procedure on
page 1-46 or the “Delete the CTC Cache File Manually” procedure on
page 1-47.

Insufficient heap
memory allocation.

Increase the heap size if you are using CTC to manage more than 50 nodes
concurrently. See the “Set the CTC_HEAP and
CTC_MAX_PERM_SIZE_HEAP Environment Variables for Windows”
procedure on page 1-43 or the “Set the CTC_HEAP and
CTC_MAX_PERM_SIZE_HEAP Environment Variables for Solaris”
procedure on page 1-44.
Note

To avoid network performance issues, Cisco recommends managing
a maximum of 50 nodes concurrently with CTC. To manage more
than 50 nodes, Cisco recommends using Cisco Transport Manager
(CTM). Cisco does not recommend running multiple CTC sessions
when managing two or more large networks.

Delete the CTC Cache File Automatically
Caution

All running sessions of CTC must be halted before deleting the CTC cache. Deleting the CTC cache
might cause any CTC running on this system to behave in an unexpected manner.

Step 1

Enter an ONS 15454 IP address into the browser URL field. The initial browser window shows a
Delete CTC Cache button.

Step 2

Close all open CTC sessions and browser windows. The PC operating system does not allow you to
delete files that are in use.

Step 3

Click Delete CTC Cache in the initial browser window to clear the CTC cache. Figure 1-17 shows the
Delete CTC Cache window.
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Figure 1-17

Deleting the CTC Cache

Delete the CTC Cache File Manually
Caution

All running sessions of CTC must be halted before deleting the CTC cache. Deleting the CTC cache
might cause any CTC running on this system to behave in an unexpected manner.

Step 1

To delete the JAR files manually, from the Windows Start menu choose Search > For Files or Folders.

Step 2

In the Search Results dialog box, enter ctc*.jar or cms*.jar in the Search for Files or Folders Named
field and click Search Now.

Step 3

Click the Modified column in the Search Results dialog box to find the JAR files that match the date
when you downloaded the files from the TCC2/TCC2P.

Step 4

Highlight the files and press the keyboard Delete key.

Step 5

Click Yes in the Confirm dialog box.
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1.7.7 Node Icon is Gray on CTC Network View
Symptom The CTC network view shows one or more node icons as gray in color and without a node

name.
Possible Cause Different CTC releases do not recognize each other.
Recommended Action Correct the core version build as described in the “1.7.9 Different CTC
Releases Do Not Recognize Each Other” section on page 1-49.
Possible Cause Username and password do not match.
Recommended Action Correct the username and password as described in the “1.7.10 Username or

Password Do Not Match” section on page 1-50.
Possible Cause A lost DCC connection.
Recommended Action Usually accompanied by an embedded operations channel (EOC) alarm. Clear
the EOC alarm and verify the DCC connection as described in the “EOC” alarm.

1.7.8 Java Runtime Environment Incompatible
Symptom The CTC application does not run properly.
Possible Cause The compatible Java 2 JRE is not installed.
Recommended Action The JRE contains the Java virtual machine, runtime class libraries, and Java

application launcher that are necessary to run programs written in the Java programming language.
The ONS 15454 CTC is a Java application. A Java application, unlike an applet, cannot rely
completely on a web browser for installation and runtime services. When you run an application
written in the Java programming language, you need the correct JRE installed. The correct JRE for
each CTC software release is included on the Cisco ONS 15454 software CD. Complete the
“Launch CTC to Correct the Core Version Build” procedure on page 1-49. If you are running
multiple CTC software releases on a network, the JRE installed on the computer must be compatible
with the different software releases. Table 1-4 shows JRE compatibility with ONS 15454 software
releases.
Table 1-4

JRE Compatibility

JRE 1.2.2
Compatible

JRE 1.3
Compatible

JRE 1.4
Compatible1

JRE 5.0
Compatible

ONS 15454 R2.2.1 and
earlier

Yes

No

No

No

ONS 15454 R2.2.2

Yes

Yes

No

No

ONS 15454 R3.0

Yes

Yes

No

No

ONS 15454 R3.1

Yes

Yes

No

No

ONS 15454 R3.2

Yes

Yes

No

No

ONS 15454 R3.3

Yes

Yes

No

No

Software Release
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Table 1-4

JRE Compatibility (continued)

Software Release

JRE 1.2.2
Compatible

JRE 1.3
Compatible

JRE 1.4
Compatible1

JRE 5.0
Compatible

ONS 15454 R3.4

No

Yes

No

No

No

Yes

No

No

ONS 15454 R4.1

No

Yes

No

No

ONS 15454 R4.5

No

Yes

No

No

ONS 15454 R4.6

No

Yes

Yes

No

ONS 15454 R4.7

No

Yes

Yes

No

ONS 15454 R5.0

No

Yes

Yes

No

ONS 15454 R6.0

No

No

Yes

No

ONS 15454 R7.0

No

No

No

Yes

ONS 15454 R8.5

No

No

No

Yes

ONS 15454 R4.0

2

1. JRE 1.4.2 is the recommended version and is provided on the software CD.
2. Software Release 4.0 notifies you if an earlier JRE version is running on your PC or UNIX workstation.

Launch CTC to Correct the Core Version Build
Step 1

Exit the current CTC session and completely close the browser.

Step 2

Start the browser.

Step 3

Enter the ONS 15454 IP address of the node that reported the alarm. This can be the original IP address
you logged in with or an IP address other than the original.

Step 4

Log into CTC. The browser downloads the JAR file from CTC.

1.7.9 Different CTC Releases Do Not Recognize Each Other
Symptom Different CTC releases do not recognize each other. This situation is often accompanied by the

INCOMPATIBLE-SW alarm.
Possible Cause The software loaded on the connecting workstation and the software on the

TCC2/TCC2P card are incompatible.
Recommended Action This occurs when the TCC2/TCC2P software is upgraded but the PC has not
yet upgraded the compatible CTC JAR file. It also occurs on login nodes with compatible software
that encounter other nodes in the network that have a newer software version. Complete the “Launch
CTC to Correct the Core Version Build” procedure on page 1-50.
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Remember to always log into the ONS node with the latest CTC core version first. If you initially
log into an ONS node running a CTC core version of 2.2 or lower and then attempt to log into
another ONS node in the network running a higher CTC core version, the lower version node
does not recognize the new node.

Note

Launch CTC to Correct the Core Version Build
Step 1

Exit the current CTC session and completely close the browser.

Step 2

Start the browser.

Step 3

Enter the ONS 15454 IP address of the node that reported the alarm. This can be the original IP address
you logged on with or an IP address other than the original.

Step 4

Log into CTC. The browser downloads the JAR file from CTC.

1.7.10 Username or Password Do Not Match
Symptom A username/password mismatch often occurs concurrently with a NOT-AUTHENTICATED

alarm .
Possible Cause The username or password entered does not match the information stored in the

TCC2/TCC2P card.
Recommended Action All ONS nodes must have the same username and password created to display
every ONS node in the network. You can also be locked out of certain ONS nodes on a network if
your username and password were not created on those specific ONS nodes. For initial login to the
ONS 15454, enter the CISCO15 user name in capital letters, click Login, and use the password
otbu+1, which is case-sensitive.

Complete the “Verify Correct Username and Password” procedure on page 1-50. If the node has
been configured for Remote Authentication Dial In User Service (RADIUS) authentication, the
username and password are verified against the RADIUS server database rather than the security
information in the local node database. For more information about RADIUS security, refer to the
“Security Reference” chapter in the Cisco ONS 15454 DWDM Reference Manual.

Verify Correct Username and Password
Step 1

Ensure that your keyboard Caps Lock key is not turned on and affecting the case-sensitive entry of the
username and password.

Step 2

Contact your system administrator to verify the username and password.

Step 3

Call Cisco Technical Support (1-800-553-2447) to have them enter your system and create a new user
name and password.
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1.7.11 DCC Connection Lost
Symptom DCC connection is lost. The node usually has alarms and the nodes in the network view have

a gray icon. This symptom is usually accompanied by an EOC alarm.
Possible Cause A lost DCC connection.
Recommended Action Usually accompanied by an EOC alarm. Clear the EOC alarm and verify the

DCC connection as described in the “EOC” alarm.

1.7.12 “Path in Use” Error When Creating a Circuit
Symptom While creating a circuit, you get a “Path in Use” error that prevents you from completing the

circuit creation.
Possible Cause Another user has already selected the same source port to create another circuit.
Recommended Action CTC does not remove a card or port from the available list until a circuit is

completely provisioned. If two users simultaneously select the same source port to create a circuit,
the first user to complete circuit provisioning gets use of the port. The other user gets the “Path in
Use” error. Cancel the circuit creation and start over, or click Back until you return to the initial
circuit creation window. The source port that was previously selected no longer appears in the
available list because it is now part of a provisioned circuit. Select a different available port and
begin the circuit creation process again.

1.7.13 Calculate and Design IP Subnets
Symptom You cannot calculate or design IP subnets on the ONS 15454.
Possible Cause The IP capabilities of the ONS 15454 require specific calculations to properly design

IP subnets.
Recommended Action Cisco provides a free online tool to calculate and design IP subnets. Go to

http://www.cisco.com/techtools/ip_addr.html. For information about ONS 15454 IP capability,
refer to the “Management Network Connectivity” chapter in the Cisco ONS 15454 DWDM
Reference Manual.

1.8 Timing
This section provides solutions to common timing reference errors and alarms.
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1.8.1 ONS 15454 Switches Timing Reference
Symptom Timing references switch when one or more problems occur.
Possible Cause The optical or building integrated timing supply (BITS) input is receiving loss of

signal (LOS), loss of frame (LOF), or AIS alarms from its timing source.
Possible Cause The optical or BITS input is not functioning.
Possible Cause The synchronization status messaging (SSM) message is set to do not use for

synchronization (DUS).
Possible Cause SSM indicates a Stratum 3 or lower clock quality.
Possible Cause The input frequency is off by more than 15 ppm.
Possible Cause The input clock wanders and has more than three slips in 30 seconds.
Possible Cause A bad timing reference existed for at least two minutes.
Recommended Action The ONS 15454 internal clock operates at a Stratum 3E level of accuracy. This

gives the ONS 15454 a free-running synchronization accuracy of +/– 4.6 ppm and a holdover
stability of less than 255 slips in the first 24 hours or 3.7 x 10–7/day, including temperature.
ONS 15454 free-running synchronization relies on the Stratum 3 internal clock. Over an extended
time period, using a higher quality Stratum 1 or Stratum 2 timing source results in fewer timing slips
than a lower quality Stratum 3 timing source.

1.8.2 Holdover Synchronization Alarm
Symptom The clock is running at a different frequency than normal and the “HLDOVRSYNC” alarm

appears.
Possible Cause The last reference input has failed.
Recommended Action The clock is running at the frequency of the last known-good reference input.

This alarm is raised when the last reference input fails. See the “HLDOVRSYNC” alarm on
page 2-101 for a detailed description.

Note

The ONS 15454 supports holdover timing per Telcordia GR-436 when provisioned for external
(BITS) timing.
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1.8.3 Free-Running Synchronization Mode
Symptom The clock is running at a different frequency than normal and the “FRNGSYNC” alarm

appears.
Possible Cause No reliable reference input is available.
Recommended Action The clock is using the internal oscillator as its only frequency reference. This

occurs when no reliable, prior timing reference is available. See the “FRNGSYNC” alarm on
page 2-87 for a detailed description.

1.8.4 Daisy-Chained BITS Not Functioning
Symptom You are unable to daisy chain the BITS sources.
Possible Cause Daisy-chained BITS sources are not supported on the ONS 15454.
Recommended Action Daisy-chained BITS sources cause additional wander buildup in the network

and are therefore not supported. Instead, use a timing signal generator to create multiple copies of
the BITS clock and separately link them to each ONS 15454.

1.8.5 Blinking STAT LED after Installing a Card
Symptom After installing a card, the STAT LED blinks continuously for more than 60 seconds.
Possible Cause The card cannot boot because it failed the Power On Shelf Test (POST) diagnostics.
Recommended Action The blinking STAT LED indicates that POST diagnostics are being performed.

If the LED continues to blink for more than 60 seconds, the card has failed the POST diagnostics
test and has failed to boot. If the card has truly failed, an “EQPT” alarm is raised against the slot
number with an “Equipment Failure” description. Check the alarm tab for this alarm to appear for
the slot where the card was installed. To attempt recovery, remove and reinstall the card and observe
the card boot process. If the card fails to boot, replace the card. Complete the “Physically Replace
a Card” procedure on page 2-240.

Warning

Caution

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this,
perform an external switch if a switch has not already occurred. Refer to the procedures in the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233. For more
information, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.
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1.9 Fiber and Cabling
This section explains problems typically caused by cabling connectivity errors. It also includes
instructions for crimping CAT-5 cable and lists the optical fiber connectivity levels.

1.9.1 Bit Errors Appear for a Traffic Card
Symptom A traffic card has multiple bit errors.
Possible Cause Faulty cabling or low optical-line levels.
Recommended Action Bit errors on line (traffic) cards usually originate from cabling problems or low
optical-line levels. The errors can be caused by synchronization problems, especially if pointer
justification (PJ) errors are reported. Moving cards into different error-free slots will isolate the
cause. Use a test set whenever possible because the cause of the errors could be external cabling,
fiber, or external equipment connecting to the ONS 15454. Troubleshoot low optical levels using the
“1.9.2 Faulty Fiber-Optic Connections” section on page 1-54.

1.9.2 Faulty Fiber-Optic Connections
Symptom A card has multiple alarms and/or signal errors.
Possible Cause Faulty fiber-optic connections. Fiber connection problems usually occur in

conjunction with alarms.
Recommended Action Refer to the appropriate trouble-clearing procedure in Chapter 2, “Alarm

Troubleshooting.”
Possible Cause Faulty CAT-5 cables.
Recommended Action Faulty CAT-5 cables can be the source of alarms and signal errors. Complete
the “1.9.2.1 Crimp Replacement LAN Cables” section on page 1-55.
Possible Cause Faulty Gigabit Interface Converters (GBICs).
Recommended Action Faulty GBICs can be the source of alarms and signal errors. See the

“1.9.2.2 Replace Faulty SFP or XFP Connectors” section on page 1-56.

Warning

Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into
beams or view directly with optical instruments. Statement 272

Warning

Laser radiation presents an invisible hazard, so personnel should avoid exposure to the laser beam.
Personnel must be qualified in laser safety procedures and must use proper eye protection before
working on this equipment. Statement 300
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1.9.2.1 Crimp Replacement LAN Cables
You can crimp your own LAN cables for use with the ONS 15454. Use a cross-over cable when
connecting an ONS 15454 to a hub, LAN modem, or switch, and use a LAN cable when connecting an
ONS 15454 to a router or workstation. Use CAT-5 cable RJ-45 T-568B, Color Code (100 Mbps), and a
crimping tool. Figure 1-18 shows the wiring of an RJ-45 connector. Figure 1-19 shows a LAN cable
layout, and Table 1-5 shows the cable pinouts. Figure 1-20 shows a cross-over cable layout, and
Table 1-6 shows the cross-over pinouts.
Figure 1-18

RJ-45 Pin Numbers

1 2 3 4 5 6 7 8

End view of RJ-45 plug

Looking into an RJ-45 jack

55048

8 7 6 5 4 3 2 1

Table 1-5

LAN Cable Layout

1
2
3
4

1
2
3
4

5
6

5
6

7
8

7
8

55415

Figure 1-19

LAN Cable Pinout

Pin

Color

Pair

Name

Pin

1

white/orange

2

Transmit Data +

1

2

orange

2

Transmit Data –

2

3

white/green

3

Receive Data +

3

4

blue

1

—

4

5

white/blue

1

—

5

6

green

3

Receive Data –

6

7

white/brown

4

—

7

8

brown

4

—

8
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Table 1-6

Note

Cross-Over Cable Layout

1
2

1
2

3
4
5

3
4
5

6
7
8

6
7
8

55416

Figure 1-20

Cross-Over Cable Pinout

Pin

Color

Pair

Name

Pin

1

white/orange

2

Transmit Data +

3

2

orange

2

Transmit Data –

6

3

white/green

3

Receive Data +

1

4

blue

1

—

4

5

white/blue

1

—

5

6

green

3

Receive Data –

2

7

white/brown

4

—

7

8

brown

4

—

8

Odd-numbered pins always connect to a white wire with a colored stripe.

1.9.2.2 Replace Faulty SFP or XFP Connectors
Small Form-factor Pluggables (SFPs) and 10-Gbps SFPs (called XFPs) are input/output devices that
plug into some DWDM cards to link the port with the fiber-optic network. The type of SFP or XFP
determines the maximum distance that traffic can travel from the card to the next network device. For a
description of SFPs and XFPs and their capabilities, refer to the Cisco ONS 15454 DWDM Reference
Manual. SFPs and XFPs are hot-swappable and can be installed or removed while the card or shelf
assembly is powered and running.

Warning

Class 1 laser product. Statement 1008

Warning

Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into
beams or view directly with optical instruments. Statement 272

Note

SFPs and XFPs must be matched on both ends by type: SX to SX, LX to LX, or ZX to ZX.
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Remove SFP or XFP Connectors
Warning

Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into
beams or view directly with optical instruments. Statement 272

Step 1

Disconnect the network fiber cable from the SFP or XFP LC duplex connector.

Step 2

Release the SFP or XFP from the slot by simultaneously squeezing the two plastic tabs on each side.

Step 3

Slide the SFP out of the card slot. A flap closes over the SFP slot to protect the connector on the card.

Install an SFP or XFP Connector

Warning

Class 1 laser product. Statement 1008

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Step 1

Remove the SFP or XFP from its protective packaging.

Step 2

Check the label to verify that you are using a compatible SFP or XFP for the card where you want to
install the connector. For a list of the SFPs and XFPs that are compatible with each card, refer to the
“Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Reference Manual.

Step 3

Plug the LC duplex connector of the fiber into a Cisco-supported SFP or XFP.

Step 4

If the new SFP or XFP has a latch, close the latch over the cable to secure it.

Step 5

Plug the cabled SFP or XFP into the card port until it clicks.
To change the payload type of an SFP or XFP (called pluggable port modules [PPMs] in CTC), refer to
the “Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

1.10 Power Supply Problems
This section explains problems related to loss of power or power supply low voltage.
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Symptom Loss of power or low voltage, resulting in a loss of traffic and causing the LCD clock to reset

to the default date and time.
Possible Cause Loss of power or low voltage.
Possible Cause Improperly connected power supply.
Recommended Action The ONS 15454 requires a constant source of DC power to properly function.
Input power is –48 VDC. Power requirements range from –42 VDC to –57 VDC. A newly installed
ONS 15454 that is not properly connected to its power supply does not operate. Power problems can
be confined to a specific ONS 15454 or affect several pieces of equipment on the site. A loss of
power or low voltage can result in a loss of traffic and causes the LCD clock on the ONS 15454 to
default to January 1, 1970, 00:04:15. To reset the clock, in node view (single-shelf mode) or shelf view
(multishelf mode) click the Provisioning > General > General tab and change the Date and Time
fields. Complete the “Isolate the Cause of Power Supply Problems” procedure on page 1-58.

Warning

Only trained and qualified personnel should be allowed to install, replace, or service this equipment.
Statement 1030

Warning

During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly
touch the backplane with your hand or any metal tool, or you could shock yourself. Statement 94

Caution

Operations that interrupt power supply or short the power connections to the ONS 15454 are
service-affecting.

Isolate the Cause of Power Supply Problems
Step 1

If a single ONS 15454 show signs of fluctuating power or power loss:
a.

Verify that the –48 VDC #8 power terminals are properly connected to a fuse panel. These power
terminals are located on the lower section of the backplane EIA under the clear plastic cover.

b.

Verify that the power cable is #10 AWG and in good condition.

c.

Verify that the power cable connections are properly crimped. Stranded #10 AWG does not always
crimp properly with Staycon type connectors.

d.

Verify that 20-A fuses are used in the fuse panel.

e.

Verify that the fuses are not blown.

f.

Verify that a rack-ground cable attaches to the frame-ground terminal (FGND) on the right side of
the ONS 15454 EIA. Connect this cable to the ground terminal according to local site practice.

g.

Verify that the DC power source has enough capacity to carry the power load.

h.

If the DC power source is battery-based:
•

Check that the output power is high enough. Power requirements range from –40.5 VDC to
–57 VDC.

•

Check the age of the batteries. Battery performance decreases with age.

•

Check for opens and shorts in batteries, which might affect power output.
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•
Step 2

If brownouts occur, the power load and fuses might be too high for the battery plant.

If multiple pieces of site equipment show signs of fluctuating power or power loss:
a.

Check the uninterruptible power supply (UPS) or rectifiers that supply the equipment. Refer to the
UPS manufacturer’s documentation for specific instructions.

b.

Check for excessive power drains caused by other equipment, such as generators.

c.

Check for excessive power demand on backup power systems or batteries when alternate power
sources are used.

1.11 Power Up Problems for Node and Cards
This section explains power up problems in a node or cards typically caused an improper power supply.

Symptom You are unable to power up a node or the cards in a node.
Possible Cause Improper power supply.
Recommended Action Refer to the power information in the “Hardware Specifications” appendix of

the Cisco ONS 15454 DWDM Reference Manual.

1.12 Network Level (Internode) Problems
The following network-level troubleshooting is discussed in this section:
•

Fiber cut detection

•

System restart after a fiber cut

•

OCHNC circuit creation failure

1.12.1 Fiber Cut Detection
A fiber cut is one of the most disruptive faults for a DWDM system because more than one channel is
potentially affected. Fault isolation must, therefore, be quick and effective.
In the Multi-Service Transport Platform (MSTP), a dedicated alarm is unambiguously associated with
the detection of a fiber cut. The alarm is LOS (OTS or AOTS) and can be raised only by the cards
(OPT-BST, OPT-AMP-C, OPT-AMP-17C, and OSC-CSM) that directly interface to the span fiber. The
LOS (OTS or AOTS) alarm is associated with the physical LINE-RX port of the pre-amp (OPT-BST,
OPT-AMP-C, OPT-AMP-17C) and OSC-CSM cards (in CTC, identified by Port 5 on the pre-amp and
Port 4 on the OSC-CSM). LOS (OTS or AOTS) is the combination of the two alarms LOS-P (OTS or
AOTS) (applies to channel payload) and LOS-O (applies to the OC-3 overhead OSC signal).
The simultaneous failure of both the active channel (C band) and the service channel (1510 nm) coming
into the node is evidence of a fiber span issue, whereas either the LOS-P (OTS or AOTS) alarm alone or
the LOS-O alarm alone can only be derived from different root causes.
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Note

When a fiber cut occurs, the actual conditions on the affected span (for example, alarms raised on both
line directions) are strictly dependent on the network automatic laser shutdown (ALS) setting. The
network ALS setting is a function of the ALS mode configured on the appropriate cards in the system
(OPT-BST, OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-C, OPT-AMP-17C, OSC-CSM, and
OSCM).
Different symptoms and scenarios can occur, depending on the network ALS settings. Consider the
linear network (four nodes) in Figure 1-21 as a reference. The scenarios are presented after the figure.
Figure 1-21

Linear Network, With No Fiber Cut

1.12.1.1 Scenario A
Scenario A has the following conditions:
•

ALS Mode = Auto Restart on OPT-BST (+ OSCM) and OSC-CSM

•

Fiber cut on the fiber between the OLA-TX node and the ROADM-RX node

The ALS protocol (refer to the “Network Optical Safety—Automatic Laser Shutdown” section in the
“Network Reference” chapter of the Cisco ONS 15454 DWDM Reference Manual) is activated in the
event of a fiber cut, resulting in the shutdown of optical power on both of the fibers belonging to the
affected span, even if only one of the two fibers is cut.
The final fault condition of the network is shown in Figure 1-22.
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Figure 1-22

Fiber Cut with ALS MODE = Auto Restart

In network view, both of the lines representing the span were formerly green and have now changed to
gray. Notice also that the status of all the OCHNC circuits on the broken span have changed from
Discovered to Partial.
In node view (single-shelf mode) or shelf view (multishelf mode), the alarm panel of the two nodes
(reconfigurable optical add/drop multiplexing [ROADM] and optical line amplification [OLA] in the
example) show the LOS (AOTS) alarm on Port 4 of the OSC-CSM (see Figure 1-23) and the LOS (OTS)
on Port 5 of the OPT-BST (see Figure 1-24).
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Figure 1-23

LOS Indication on the ROADM Node OSC-CSM
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Figure 1-24

LOS Indication on the OLA Node OPT-BST

Note

An EOC condition is always present on both nodes, because the optical service channel (OSC) link (to
which the communication channel applies) is down.

Note

For the OSCM card, only an LOS (OC-3) alarm is present at the SONET layer (Port 1).

1.12.1.2 Scenario B
Scenario B has the following conditions:
•

ALS Mode = DISABLE on OPT-BST (+ OSCM) and OSC-CSM

•

Fiber cut on the fiber between the OLA-TX node and the ROADM-RX node

Because the ALS protocol is disabled, the signal is lost on only the affected fiber (power is not shut down
on both fibers).
The LOS (OTS or AOTS) alarm is raised by the ROADM-RX node that was receiving the signal coming
from the broken fiber. The final fault condition of the network is shown in Figure 1-25.
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Figure 1-25

Network View Fault Condition for Fiber Cut with ALS Mode Disabled

In network view (Figure 1-25), only the actual affected fiber becomes gray, whereas the traffic (and OSC
signal as well) on the good fiber is active and fault identification is immediate.
In node view (single-shelf mode) or shelf view (multishelf mode) (Figure 1-26 and Figure 1-27), the alarm
panel of the receiving node (ROADM in this example) reports the LOS (OTS), while the transmitting
node (OLA) reports only an EOC alarm.
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Figure 1-26

ONS 15454 SDH ROADM Node View with Fault Condition for ALS MODE Disabled
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Figure 1-27

ONS 15454 SDH OLA Node View with Fault Condition for ALS MODE Disabled

In order to troubleshoot and eventually fix a fiber cut, follow the “Fix a Fiber Cut” procedure on
page 1-66. The basic assumption is that the MSTP system was already installed and working correctly
before the alarm condition occurred. For first installation or restart from a fiber cut, refer to
1.12.2 System Restart after a Fiber Cut, page 1-68.

Fix a Fiber Cut
Caution

Step 1

Step 2

When the network ALS setting is DISABLE, optical power is still present at the damaged fiber. Before
fixing the span, it is highly recommended that you shut down the amplifier and the OSC laser upstream
of the fiber cut.
Isolate the span affected by the fiber cut.
a.

Go to CTC network view.

b.

Identify the span connection that is gray.

Verify the alarm is valid, then perform the following steps for both DWDM nodes connected to the span
identified in Step 1.
a.

Double-click the card directly connected to the span (either the OPT-BST or the OSC-CSM).
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b.

Click the Alarms tab and verify that a LOS condition is present on the LINE-RX port. If the alarm
is correctly reported, move to Step 3. If not, close the CTC application, delete the CTC cache and
reopen the CTC connection.

c.

Click the Synchronize button on the bottom left of the window.

If the “gray” condition of the span persists, log into the Technical Support website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447) to
report a service-affecting problem.

Note

Step 3

If the network ALS setting on the DWDM nodes that you are troubleshooting is Auto Restart, continue
with Step 4; if the network ALS setting is DISABLE, go to Step 5.

Note

The network ALS setting is a function of the ALS mode configured on the appropriate cards in the
system (OPT-BST, OPT-BST-E, OPT-BST-L, OPT-AMP-L, OPT-AMP-C, OPT-AMP-17C, OSC-CSM,
and OSCM).

Step 4

Step 5

Warning

Isolate the fiber affected by the fiber cut. For the two fibers belonging to the span, identify the fiber
belonging to the west-to-east (W–E) line direction:
a.

Go into the upstream node and identify the OSCM or OSC-CSM card managing the OSC
termination referring to the faulty span.

b.

Double-click the card, then click the Maintenance Panel tab.

c.

Force the OSC-TX laser to be active by setting the ALS Mode to DISABLE.

d.

Go into the downstream node and verify if OSC power is being received.
•

If a pair of OPT-BST + OSCM cards terminate the OSC connection, click the Provisioning >
Optical Line > Parameters tabs, then verify that there is power for OSC-TX (Port 4).

•

If an OSC-CSM terminates the OSC connection, click the Provisioning > Optical Line >
Parameters tabs, then verify that there is power for OSC-RX (Port 6).

e.

If no power is detected and the LOS (OC-3) alarm persists, go to Step 5; otherwise, the fiber under
test is good. In this case, go to Step f to check the other fiber.

f.

Repeat Steps a to d for the other fiber to verify that it is at fault.

Repair the identified broken fiber to restore the internode link.

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Note

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.
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1.12.2 System Restart after a Fiber Cut
When the network ALS setting is Auto Restart, the system automatically restarts after a fiber cut occurs.
MSTP system restart after a fiber cut is a fully automatic process regulated by a chronological sequence
of steps including the OSC link built-in amplifiers restart and amplifier power control (APC) regulation.
The successful completion of system restart is strictly related to possible changes of the insertion loss
value of the repaired span. A change in insertion loss is dependent on many factors, including the process
of physically repairing the fiber, a change in fiber length after repair, and so on.
Four different scenarios related to span loss are presented in this section:
1.

2.

Note

Span loss increased:
•

Span loss change > 5 dBm

•

OSC power value on the receiver < –42 dBm

Span loss increased:
•

Span loss change > 5 dBm

•

OSC power value on the receiver > –42 dBm

3.

Span loss increased: 3 dBm < span loss change < 5 dBm

4.

Span loss increased: span loss change < 3 dBm

It is also possible that span loss decreased, but this is unlikely. This condition does not prevent the MSTP
system automatic restart process, but can lead (potentially) to issues downstream of the repaired span,
for example, a Power Overload condition on the OSC receiver or on the Trunk-RX port of a TXP or MXP
card.
These conditions are identified by specific alarms (see the “HI-RX-POWER” section of Chapter 2,
“Alarm Troubleshooting” of the DWDM Alarm and Troubleshooting Guide).
The symptoms of the possible span loss scenarios (except for span loss decrease) are described in the
following paragraphs. Refer to the linear network in Figure 1-21 on page 1-60 during the discussion of
the scenarios.
The basic assumption is that the network ALS feature (for feature details, refer to the “Network Optical
Safety––Automatic Laser Shutdown” section in the Cisco ONS 15454 DWDM Reference Manual) is
active (ALS Mode = Auto Restart on the OPT-BST, OPT-AMP-x-C [+ OSCM] and OSC-CSM). Given
this assumption, the starting condition is as shown in Figure 1-22 on page 1-61.
The system behavior when the network ALS Mode is DISABLE is a subcase that requires a manual
restart after repairing a single fiber in only one line direction.

Note

The network ALS feature is a function of the ALS Mode settings of the OPT-BST, OPT-BST-E,
OPT-BST-L, OPT-AMP-L, OPT-AMP-x-C, OSCM, and OSC-CSM cards. For the network ALS Mode
to be disabled, each of these cards must have its ALS Mode set to DISABLE.

1.12.2.1 Scenario 1: Span Loss Change > 5 dBm and OSC Power Value on the Receiver < –42 dBm
In network view, both of the lines representing the span remain gray as long as the status of the OCHNC
circuits relating to the repaired span remain in Partial state.
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In node view (single-shelf mode) or shelf view (multishelf mode), the alarm panels of the two nodes
(ROADM and OLA in this example) show the LOS (OTS or AOTS) condition on the LINE-RX port of
the OPT-BST and OPT-AMP-x-C (when configured as booster) or OSC-CSM.
An EOC condition is always present on both nodes because the OSC optical link is down due to an
incoming power level lower than the optical sensitivity limit (–42 dBm). The system condition remains
unchanged as illustrated in Figure 1-22.
Every 100 seconds, the ALS protocol turns up the OSC TX laser in a pulse mode (pulse duration =
2 seconds), but the excessive loss on the span prevents the OSC link from synchronizing, and the MSTP
system remains unoperational.

Note

During the attempt to restart, a valid power value is reported by the OSC transmit card (in the example,
the OSC-CSM in the OLA node), but on the OSC receive card (the OSCM in the ROADM node), the
alarm condition persists.

Corrective Action for Scenario 1
Step 1

Follow these steps to verify the alarms for both DWDM nodes that are connected to the repaired span:
a.

Double-click the card directly connected to the span (either the OPT-BST/OPT-AMP-x-C or the
OSC-CSM).

b.

Click the Alarms tab.

c.

Verify that a LOS condition is present on the LINE-RX port.

d.

Click the Synchronize button on the bottom left of the window.

e.

If the alarm is correctly reported, move to Step 2. If not, close the CTC application and delete the
CTC cache. Then reopen the CTC connection, and repeat Step 1.

If the gray color persists on the span, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447) in
order to report a service-affecting problem.

Note

Step 2

Isolate the fiber affected by the excessive insertion loss. For the two fibers belonging to the span, identify
the one for the W–E line direction.
a.

Go into the upstream node and identify the OSCM or OSC-CSM card that manages the OSC
termination for the faulty span.

b.

Double-click the card, then click the Maintenance tab.

c.

Force the OSC-TX laser active by setting ALS Mode to DISABLE.

d.

Go into the downstream node and verify the OSC Power level received.
•

If a pair of OPT-BST/OPT-AMP-x-C + OSCM cards terminate the OSC connection, click the
Provisioning > Optical Line > Parameters tabs, then verify that there is power for OSC-TX
(Port 4).

•

If an OSC-CSM terminates the OSC connection, click the Provisioning > Optical Line >
Parameters tabs, then verify that there is power for OSC-RX (Port 6).

•

If no power is detected and the LOS (OC-3) alarm persists, the faulty fiber has been identified,
so go to Step 3.

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5
78-18342-02

1-69

Chapter 1

General Troubleshooting

Network Level (Internode) Problems

e.

If a power value greater than –42 dBm is detected, the fiber under test has been properly repaired.
However, it is recommended that you check the new fiber Insertion Loss value.
•

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance >
DWDM > WDM Span Check tabs.

•

Retrieve the new value of fiber Insertion Loss of the repaired span.

Note

The new value of the fiber Insertion Loss of this fiber after restoration must be less than 5
dB higher than the previous Insertion Loss value. If possible, try to recover the original value
by making a better fiber splice. If this is not possible, use the new value (must be less than
5 dB higher than the previous value) and rerun Cisco TransportPlanner to revalidate the new
condition.

Step 3

For the two fibers belonging to the repaired span, identify one for the east to west (E–W) line direction.

Step 4

Repeat the procedure starting at Step 2 for the E–W direction.

Step 5

Clean the LINE-RX and LINE-TX connectors for the failing fiber that was identified in the previous
steps.

Step 6

If the problem persists, continue with Step 7. Otherwise, the corrective action is finished.

Step 7

Repair the failing fiber again until the expected OSC link is reestablished.

Warning

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Note

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

Note

If the OSC link cannot be reestablished (either by splicing or replacing the fiber), and the new
value of Span Loss cannot be modified, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem.

1.12.2.2 Scenario 2: Span Loss Change > 5 dBm and OSC Power Value on the Receiver > –42 dBm
In network view, both of the lines representing the span change to green; however, the status of the
OCHNC circuits relating to the repaired span remains Partial, instead of Complete (due to the fiber cut).
This change is due to the fact the physical optical power value received by the OSC transceiver is above
the sensitivity limit (–42 dBm) and consequently, the OSC optical link can be rebuilt, allowing the
restoration of the Section DCC (SDCC) or multiplex section DCC (MS-DCC). The network view for this
condition is shown in Figure 1-28.
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Figure 1-28

Network View for Span Loss Change > 5 dBm and OSC Power Value at Receiver >
–42 dBm

In node view (single-shelf mode) or shelf view (multishelf mode), the EOC condition is cleared, but the
alarm panels of the two nodes (ROADM and OLA in the example) continue to show LOS (OTS or AOTS)
on the LINE-RX port of the OPT-BST/OPT-AMP-x-C or OSC-CSM.
The network ALS protocol keeps the OCHNC traffic down along the span because the new losses of the
restored span can potentially affect the optical validation of the network design done by
Cisco TransportPlanner.

Corrective Action for Scenario 2
Step 1

Verify the validity of the alarm.

Step 2

For both DWDM nodes connected to the repaired span:
a.

Double-click the card directly connected with the span (either the OPT-BST/OPT-AMP-x-C or the
OSC-CSM).

b.

Click Alarms.

c.

Click the Synchronize button on the bottom left of the window.

d.

Verify that a LOS condition is present on the LINE-RX port.

e.

If the alarm is correctly reported, move to Step 3. If not, close the CTC application, delete the CTC
cache, and open the CTC connection again. Then, go back to Step 1.
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Note

Step 3

If the “gray condition” of the span persists, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in order to
report a service-affecting problem.
Measure the new Span Loss value after fixing the fiber.
a.

In the node view (single-shelf mode) or shelf view (multishelf mode) of both nodes for the span, click
the Maintenance > DWDM > WDM Span Check tabs.

b.

Click Retrieve Span Loss Values to retrieve the latest loss data.

The two values retrieved at each node level (west side and east side) refer to the two fibers
coming into the node from the adjacent nodes, so they apply to different spans. To complete the
measurement in Step 3, the appropriate values must be taken into account.

Note

Step 4

Compare the span measurements of Step 3 with the span losses values used during the network design
with Cisco TransportPlanner.

Step 5

For the two fibers belonging to the repaired span, identify the fiber for the W–E line direction and
calculate the insertion loss variation. If the span loss change is greater than 3 dBm, continue with Step 6.
If not, go to Step 9.

Step 6

Clean the LINE-RX and LINE-TX connectors on the DWDM cards managing the fiber of the repaired
span. If the problem persists, continue with Step 7.

Step 7

If the alarm condition is still reported, it is recommended that the fiber be repaired again to reestablish
the expected span loss value. If this is not possible and the new value of span loss cannot be modified,
go to Step 8 to fix the system faulty condition.

Warning

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

Note

Step 8

Follow the signal flow into the network starting from the repaired fiber:
a.

In the downstream node, identify the OPT-BST/OPT-AMP-x-C or OSC-CSM card that manages
OSC and CHS detection.

b.

In card view, click the Provisioning > Optical Line > Optic Thresholds tabs.

c.

Click the Alarms radio button, then click Refresh.

d.

Decrease the current OSC and CHS Fail Low thresholds by the same amount of the span loss change
calculated in Step 5.
If an OPT-BST/OPT-AMP-x-C is present:
•

CHS Fail Low threshold refers to Port 2.

•

OSC Fail Low threshold refers to Port 4.
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If an OSC-CSM is present:
•

CHS Fail Low threshold refers to Port 3.

•

OSC Fail Low threshold refers to Port 6.

Step 9

For the two fibers belonging to the repaired span, identify the fiber for the east to west (E–W) line
direction.

Step 10

Repeat the procedure from Step 5 to Step 8 for the E–W direction.

Step 11

If the LOS alarm has cleared, the system has restarted properly. However, because a significantly
different span loss value is now present, we highly recommended that you complete the following steps:
a.

Go back to the Cisco TransportPlanner tool and open the network design configuration file.

b.

Select Installation Mode to freeze the node layout and amplifier positioning.

c.

Change the span value, inserting the new insertion loss that was measured in Step 3.

d.

Run the Cisco TransportPlanner algorithm to validate the new design.

e.

If the optical result indications (power, optical signal-to-noise ratio [OSNR], chromatic dispersion
[CD], and so on) are all green, the repair procedure is complete. If not, log into the Technical
Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1 800 553-2447) and report a service-affecting problem.

If the LOS alarm is still present, continue with Step 12.
Step 12

Go back to the card where the LOS alarm is active, and set the optic thresholds (see Step 8b) to the lowest
value allowed.
If an OPT-BST/OPT-AMP-x-C is present:
•

CHS Fail Low threshold must to be set to –30 dBm.

•

OSC Fail Low threshold must to be set to –42 dBm.

If an OSC-CSM is present:
•

CHS Fail Low threshold must to be set to –30 dBm.

•

OSC Fail Low threshold must to be set to –40 dBm.

Note

If the LOS alarm is still present, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in order to
report a service-affecting problem.

Step 13

If the LOS alarm is has cleared, the system has restarted properly, but because a Span Loss value
significantly different from the design is now present, we highly recommend that you repeat the steps
described in Step 11.

1.12.2.3 Scenario 3: 3 dBm < Span Loss Change < 5 dBm
In network view, both of the lines representing the span change to green after the rebuild of the OSC
optical link and consequent restoration of the SDCC or MS-DCC. The EOC condition and the LOS
alarms are cleared.
The network ALS protocol successfully restarts the amplifiers, which enables the OCHNC traffic
restoration along the span.
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The reactivation of the OCHNC circuits relating to the repaired span (the status changes from Partial to
Complete) can lead to several final conditions that depend on the network topology and node layout.
The rebuilding of circuits automatically triggers the APC check mechanism (for details, refer to the
“Network Reference” chapter of the Cisco ONS 15454 DWDM Reference Manual). The APC check
mechanism impacts the optical gain of the amplifiers (primarily the OPT-PRE card) and the VOA express
attenuation for the optical add/drop multiplexing (OADM) cards. The APC application acts on the
appropriate cards downstream of the repaired span (for each line direction), and attempts to compensate
for the introduction of excess loss.
Because the loss increase exceeds the maximum variation (+/–3 dBm) for which APC is allowed to
compensate, an APC-CORRECTIO N-SKIPPED condition is raised by the first node along the flow
detecting the event. The condition panel of the impacted node (the ROADM, in this example) reports the
APC-CORRECTION-SKIPPED condition and indicates the port or card to which it applies.
To correct Scenario 3:
Step 1

Verify the alarm validity.

Step 2

For both DWDM nodes connected to the repaired span:
a.

Double-click the card reporting the issue.

b.

Click Conditions.

c.

Click Retrieve and verify that an APC-CORRECTION-SKIPPED condition is present on an
aggregate port.

d.

If the alarm is correctly reported, go to Step 3. If not, close the CTC application, delete the CTC
cache, and open the CTC connection again. Then, go to Step 1.

Note

Step 3

If the discrepancy persists, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem.

Measure the new Span Loss value after the fiber has been repaired.
a.

In the node view (single-shelf mode) or shelf view (multishelf mode) of both nodes of the span, click
the Maintenance > DWDM > WDM Span Check tabs.

b.

Click Retrieve Span Loss Values to retrieve the latest loss data.

Note

The two values retrieved at each node level (west side and east side) refer to the two fibers
coming into the node from the adjacent nodes, so they apply to different spans. To complete the
measurement in Step 4, the appropriate values must be taken into account.

Step 4

Compare the Span Measurements of the previous step with the Span Losses values used during the
network design with Cisco TransportPlanner.

Step 5

For the two fibers belonging to the repaired span, identify the one for the W–E line direction. If the Span
Loss Change is greater than 3 dB, continue with Step 6. If not, go to Step 9.

Step 6

Clean the LINE-RX and LINE-TX connectors of the DWDM cards that manage the fiber of the repaired
span. If the problem persists, continue with Step 7. Otherwise, you are finished with the corrective
action.
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Step 7

If the alarm condition is still reported, we recommend that you again repair the fiber to reestablish the
expected span loss value. If this is not possible and the new value of Span Loss cannot be modified, move
to Step 8 to fix the system faulty condition.

Warning

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

Note

Step 8

Follow the signal flow into the network starting from the repaired fiber.
a.

In the first downstream node of the restored span (W–E), check whether a DWDM card reports the
APC-CORRECTION-SKIPPED condition on a port applying to the W–E direction (see Step 2 for
how to do this).

b.

If the answer is yes, retrieve the following values according to the card type.
•

For pre- or booster-amp cards, click the Provisioning > Optical Ampli. Line > Gain Setpoint
tabs.

•

For AD-xC-xx.x or AD-xB-xx.x cards, click the Provisioning > Optical Line >
VOA Attenuation Reference tabs.

•

Go to Step 8f.

c.

If the answer is no, go to Step 8d.

d.

Move along the downstream nodes until a card with the APC-CORRECTION-SKIPPED condition
for a W–E port is detected.

e.

From that card, retrieve parameters according to Step 8b.

f.

In the first downstream node of the restored span, go to the Circuits tab and identify all the OCHNC
circuits passing through the repaired span.

g.

Edit all the OCHNC circuits identified in Step 8f:
•

Click the Tools > Circuits > Set Circuit State tabs.

•

Change the Target Circuit Admin. State to OOS,DSBLD (or Locked, disabled) and click
Apply.

h.

Go to the DWDM card for which the Gain or VOA Attenuation values were retrieved (the card can
be either the one in substep Step 8b or Step 8e) and verify that the administrative state of the alarmed
port is now OOS (locked).

i.

If the alarmed port is not OOS (locked), go to the card view, click Circuits, and identify the
remaining OCHNC circuits that are still active. Put the circuits in OOS,DSBLD (or Locked,
disabled) state in order to reach the OOS (locked) administrative state on the alarmed port.

j.

Wait for three minutes, then switch the administrative state of only one of the circuits selected in
Step 8f and Step 8i back to IS (Unlocked).

k.

After the network completes the restart phase, go to the formerly alarmed card and verify that the
APC-CORRECTION-SKIPPED condition has cleared and a new Gain Setpoint or VOA Attenuation
Reference (compare with Step 8a) has been provisioned.
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Note

l.

Note

The total variation of the above parameter setpoint must be within approximately +/– 1 dBm
of the Span Loss Change measured in Step 3.

If the APC-CORRECTION-SKIPPED condition has cleared and the system has restarted properly,
we highly recommend that you complete the following procedure due to the fact that a Span Loss
value that is significantly different than the design is now present.
•

Go back to the Cisco TransportPlanner tool and open the network design configuration file.

•

Select Installation Mode to freeze the node layout and amplifier positioning.

•

Change the span value, inserting the new Insertion Loss measured in Step 3.

•

Run the Cisco TransportPlanner algorithm to validate the new design.

•

If the optical result indications (power, OSNR, CD, and so on) are all green, the repair procedure
is complete. If not, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a service-affecting
problem.

If the APC condition persists, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem.

Step 9

For the two fibers belonging to the repaired span, identify the fiber for to the east to west (E–W) line
direction.

Step 10

Repeat the procedures from Step 6 to Step 8 for the E–W direction.

1.12.2.4 Scenario 4: Span Loss Change < 3 dB
In network view, both the lines that represent the span turn green after the rebuilding of the OSC optical
link and consequent restoration of the SDCC or MS-DCC. The EOC condition and LOS alarms are
cleared.
The network ALS protocol successfully completes the amplifier restart to enable OCHNC traffic
restoration along the span.
The rebuilding of circuits automatically triggers the APC check mechanism (for details, refer to the
“Network Reference” chapter of the Cisco ONS 15454 DWDM Reference Manual). The APC check
mechanism affects the optical gain of the amplifiers (primarily the OPT-PRE) and the VOA express
attenuation for the OADM cards. The APC application acts on the “suitable” cards downstream of the
repaired span (for each line direction), and attempts to compensate for the introduction of excess loss.
The APC operation is successfully completed if enough margin during the Cisco TransportPlanner
network design phase has been taken into account. If not, the adjustment done by the APC application
overcomes the range setting for a specific optical parameter in the first appropriate card along the flow
and an APC-OUT-OF-RANGE condition is raised. The condition panel of the impacted node (the
ROADM in the example) reports the APC-OUT-OF-RANGE condition and indicates the port or card to
which it applies.
To correct Scenario 4:
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Step 1

Verify the alarm validity.

Step 2

For both DWDM nodes on the repaired span:
a.

Double-click the card reporting the issue.

b.

Click Conditions.

c.

Click Retrieve and verify that an APC-OUT-OF-RANGE condition is present on an aggregate port.

d.

If the alarm is correctly reported, go to Step 3. If not, close the CTC application, delete the CTC
cache, and open the CTC connection again. Then, go to Step 1.

Note

Step 3

If the discrepancy persists, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem.

Measure the new Span Loss value after the fiber is repaired.
a.

In the node view (single-shelf mode) or shelf view (multishelf mode) of both nodes for to the span,
click the Maintenance > DWDM > WDM Span Check tabs.

b.

Click Retrieve Span Loss Values to retrieve the latest loss data.

Note

The two values retrieved at each node level (west side and east side) refer to the two fibers
coming into the node from the adjacent nodes, so they apply to different spans. To complete the
measurement in Step 4, the appropriate values must be taken into account.

Step 4

Compare the Span Measurements done in Step 3 with the Span Losses values used during the network
design with Cisco TransportPlanner.

Step 5

For the two fibers belonging to the repaired span, identify the one for the W–E line direction.
•

If the Span Loss Change is greater than 1 dBm, continue with Step 6.

•

If the Span Loss Change is 1 dBm or less, move to Step 9.

Step 6

Clean the LINE-RX and LINE-TX connectors of the DWDM cards that manage the fiber of the repaired
span.

Step 7

If the problem persists, continue with the next step. If not, you have finished the corrective action.

Step 8

If the Span Loss Change is greater than 1 dBm and the APC-OUT-OF-RANGE condition still exists, it
is mandatory to again repair the fibers to reestablish the expected span loss value.

Warning

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Note

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.
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Note

If this is not possible and the new value of Span Loss cannot be modified, log into the Technical
Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1 800 553-2447) in order to report a service-affecting problem

Step 9

For the two fibers belonging to the repaired span, identify the fiber for the east to west (E–W) line
direction.

Step 10

Repeat the procedure from Step 6 to Step 8 for the E–W direction.

1.12.3 OCHNC Circuits Creation Failure
OCHNC circuit creation is managed by the Cisco Wavelength Path Provisioning (WPP) network
application. The WPP application helps prevent errors during new circuit activation (if the wavelength
is already allocated in the path between source and destination) and also guarantees an appropriate time
interval between one circuit activation and the next to enable proper amplifier gain regulation by APC.
WPP uses the network topology information carried by the OSC link among different nodes to identify
the routing path of the optical wavelength (OCHNC circuits) from the source node to the destination
node. WPP also enables the card ports of the OCHNC circuits by changing the administrative state from
the default (OOS or Locked) state to the final (IS or Unlocked) state.

1.12.3.1 Prerequisites for Successful OCHNC Circuit Creation
The prerequisite conditions for successfully completed circuit creation are:
1.

Internode: OSC link active among all DWDM nodes involved

2.

Internode: APC enabled (or alternatively manually disabled by the user)

3.

Intranode: Logical connections among cards created and provisioned on every node of the network
(ANS completed)

Note

For more information about these operations, refer to the “NTP-G183 Diagnose and Fix OCHNC
and OCH Trail Circuits” section in “Create Optical Channel Circuits and Provisionable
Patchcords” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

OCHNC circuit creation is successfully completed when the CTC circuit table reports the situation
shown in Figure 1-29.
•

The Circuit Status has turned to DISCOVERED.

•

The # of spans field shows the correct number of hops among different nodes that the OCHNC
circuit passes through to reach the final destination.

•

Circuit State reports IS (or unlocked).
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Figure 1-29

OCHNC Circuit Successfully Completed

1.12.3.2 Conditions for OCHNC Circuit Creation Failure
If the OCHNC circuit creation fails, you will see one of the following conditions:
•

If the WPP wizard cannot complete the circuit creation procedure, CTC displays the error message
shown in Figure 1-30. In the message, click Details to see the partial connections that WPP can set
up. Start troubleshooting the problem in the first node that is unreachable along the path.
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Figure 1-30

•

Partial Circuit

The circuit is successfully created and reported under the Circuits tab, the Status field turns to
DISCOVERED, but the Circuit State is OOS (locked). The condition is shown in Figure 1-31.
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Figure 1-31

•

Circuit Discovered, State OSS

The OCHNC circuit is shown under the Circuits tab, but the Status field reports PARTIAL. This
applies to a circuit successfully built-up when the network falls into scenarios a. or b (OSC link fail
or APC disabled), described below.

The root cause identification for the preceding conditions are found in the prerequisite conditions
described in 1.12.3.1 Prerequisites for Successful OCHNC Circuit Creation.

1.12.3.3 Scenarios for OCHNC Circuit Creation Failure
The most common scenarios for failure to create an OCHNC circuit are:
1.

One (or more) of the Span OSC links involving the OCHNC circuit has not been properly
established. The WPP application prevents the creation of any circuit passing through the failing
span. Prerequisite condition 1. of 1.12.3.1 Prerequisites for Successful OCHNC Circuit Creation
has not been met.
a. The APC application is internally disabled due to the presence of a Critical alarm somewhere

in the network. As a consequence, no reliable information about the number of active channels
can be shared among the nodes and the creation of any further OCHNC circuit is prevented until
the faulty condition is fixed. Prerequisite condition 2. of 1.12.3.1 Prerequisites for Successful
OCHNC Circuit Creation has not been met.
b. One (or more) of the intranode connections between two DWDM cards associated with the

circuit have not been properly created. Prerequisite condition 3. of 1.12.3.1 Prerequisites for
Successful OCHNC Circuit Creation has not been met.
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c. One (or more) of the intranode connections between two DWDM cards associated with the

circuit have not been properly provisioned. This happens when ANS application has not run in
one of the involved nodes or at least one port status after the ANS run has not been successfully
configured (Fail-Out of Range alarm on the ANS panel). Prerequisite condition 3. of
1.12.3.1 Prerequisites for Successful OCHNC Circuit Creation has not been met.
To troubleshoot and eventually fix issues related to the faulty OCHNC circuit creation shown in
Figure 1-30 on page 1-80, the following procedure must be performed.
Step 1

Verify OSC connectivity:
a.

Go to network view and identify the MSTP nodes to which the OCHNC circuit applies.

b.

Verify that all the OSC links connecting the MSTP nodes along the circuit path, from the source
node to the destination node, are active (green line).

Note

Bidirectional circuits have two possible nodes, depending on the line direction being
considered.

Complete one of the following actions depending on OSC connectivity:
•

If the OSC link is down, focus on the affected span and troubleshoot the issue (see 1.12.2 System
Restart after a Fiber Cut, page 1-68).

Note

•
Step 2

If necessary, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a
service-affecting problem.

If the OSC link is not down, continue with Step 2.

Verify APC status:
a.

Go to node view (single-shelf mode) or shelf view (multishelf mode) on the MSTP node that is the
source node for the circuit.

b.

In the General Info box on the left, check the APC state (last row).
•

If the APC state is DISABLE - INTERNAL, complete the appropriate troubleshooting
procedure from Chapter 2, “Alarm Troubleshooting”.

Note

•
Step 3

Step 4

If necessary, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC
(1 800 553-2447) in order to report a service-affecting problem.

If the APC state is not DISABLE - INTERNAL, continue with Step 3.

Verify that the intranode connections have been built in:
a.

Go to the node view (single-shelf mode) or multishelf view (multishelf mode) on the MSTP node that
is the source node for the circuit.

b.

Click the Provisioning > WDM-ANS > Connections tabs.

Verify that all node connections have been created and that their state is Connected.
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Tip

To quickly verify the connections, click the Calculate Connection button and check to see if
any new connections come up.

If some connections are missing, perform the proper procedure according to “Turn Up a Node” in the
Cisco ONS 15454 DWDM Procedure Guide.
Step 5

If necessary, log into the Technical Support Website at http://www.cisco.com/techsupport for more
information or call Cisco TAC (1 800 553-2447) in order to report a service-affecting problem.

1.13 Node Level (Intranode) Problems
Troubleshooting for node-level optical channel (OCH) VOA start-up failure as well as internal VOA
control loop problems in the amplifier cards (OPT-BST , OPT-BST-L, OPT-PRE, OPT-AMP-17-C,
OPT-AMP-C, OPT-AMP-L, and OPT-BST-E); demultiplexer cards (32-DMX, 32-DMX-L, 40-DMX-C,
and 40-DMX-CE) having a single variable optical attenuator (VOA); and optical add/drop multiplexer
cards (AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, and AD-4B-xx.x) that occur due to
counter-propagating light are discussed in this section.
A dedicated VOA regulates the optical power for every single channel (single wavelength) inserted in
the MSTP system through a WSS, 32MUX-O, or AD-xC-xx.x card.
The final state for the VOAs is the power control working mode. In this mode, the attenuation that the
VOA introduces is automatically set based on the feedback provided from a dedicated photodiode, so
that a specific power setpoint value is reached and maintained.

1.13.1 VOA Startup Phases
The final VOA condition is achieved through a startup procedure divided into the four sequential phases
shown in Figure 1-32.
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Figure 1-32

VOA Startup Procedure
OCH-NC Circuit not created
(ADD Port is IS-AINS)

Starting Condition
VOA is DISABLE
(VOA Attenuation > 40 dB)
OCH-NC circuit successfully built-in
Incoming Signal Validation
(ADD Port becomes IS)
Phase 1
VOA is ACTIVE
(VOA Attenuation = VOA Attenuation Ref.)

TXP/MXP card activated
(Valid signal detected)
Phase 2
POWER ADD > Pstart
(VOA starts an internal procedure
to adjust the attenuation

Channel Power Setpoint Locking
(ADD Port shows a Degr. Low Alarm)
Phase 3
VOA attenuation adjustment (Safe Mode)
(VOA completes locking procedure)

Channel Power Control Mode fully activated
(ADD Port IS and green)
VOA switch in Power CTRL.
(Channel POWER = VOA Power Ref.)
(VOA ATT. VOA Attenuation Ref.)

145264

Phase 4

Until the VOA has completed all the phases shown in Figure 1-32, the power control mode is not fully
activated.

1.13.1.1 Phase 1: Incoming Signal Validation
The Incoming Signal Validation phase checks to see that the optical interface connection is valid and that
the optical power level is appropriate.
Cisco TransportPlanner calculates the VOA Attenuation Reference value to allow only supported MSTP
interfaces to overcome the power start-up (Pstart-up) acceptance level. (Refer to the “Network
Reference” chapter of the Cisco ONS 15454 DWDM Reference Manual.)
If the interface that is connected has a power value outside the allowed range, the Phase 1 check prevents
OCHNC turn-up.

1.13.1.2 Phase 2: Valid Signal Detected
If Phase 1 indicates that the signal is valid, an automatic iterative attenuation adjustment on the VOA
takes place to reach a power target on the photodiode downstream of the VOA.
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Note

The power setpoint is generated by Cisco TransportPlanner on a case-by-case basis. During the ANS run,
the power target is provisioned on the VOA.

1.13.1.3 Phase 3: Channel Power Setpoint Locking
In Phase 3, the VOA is kept in a transient standby condition when a steady power value close enough to
the final power setpoint has been reached (nominally 3 dBm lower).
The duration of the transient standby condition is three seconds (by default) and allows safe management
of optical interfaces that have different signal rise time values or are undergoing a pulse startup
procedure compliant with the ITU-T G664 recommendation.

1.13.1.4 Phase 4: Channel Power Control Mode Fully Activated
The VOA reaches the final attenuation condition that leads the power value that is read on the photodiode
to the expected target value (VOA Power Reference). Simultaneously, the VOA operating mode switches
to power control mode.
From this point on, any further adjustment of the VOA attenuation is triggered by a variation of the value
read on the photodiode. The aim of these adjustments is to always keep the power value equal to the
power setpoint, with +/– 0.5 dBm as the minimum adjustment increment.

1.13.2 VOA Failure Scenarios
Several conditions can stop the startup procedure at an intermediate step, blocking the VOA (and the
circuit activation, as a consequence) from completing activation of the power control mode. The
scenarios in this section portray those conditions.
Root-cause identification can be performed based on the alarm raised and the power reading on the
photodiode associated with the VOA.

1.13.2.1 Scenario A: Optical Power Level of the Incoming Signal Lower Than Minimum Allowed by
MSTP Supported Optical Interfaces
This scenario is for a condition where a TXP or MXP card is directly connected to a 32MUX-O, 40MUX,
32WSS, or 40WSS-C card where power in is expressed as Pin < –4.5 dBm.
If the incoming power level is lower than the minimum allowed, the startup procedure always stops at
Phase 1 (see Figure 1-33). This is the case even if the final VOA Power Reference reported in CTC is
reachable.
The final conditions that CTC reports are:
•

A LOS-P (OCH layer) alarm on the port associated with the VOA (see Figure 1-33)

•

A valid optical power value (different from the end of scale value of – 50 dBm) in the Power field,
but the value for Power is less than –33 dBm. (To view the Power field, in card view, click the
Provisioning > Parameters tabs.)
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Figure 1-33

LOS-P Indication on the VOA Port

Use the following procedure to troubleshoot and eventually fix issues related to the VOA start-up when
the optical power level of the incoming signal is lower than the minimum allowed by the MSTP
supported optical interfaces.
Step 1

Verify the alarm validity:
a.

Identify the DWDM nodes where the alarmed card is seated.

b.

Double-click the card.

c.

Click Alarms.

d.

Verify that a LOS-P alarm is present on the ADD-RX port.

e.

Click the Synchronize button in the bottom left of the window.

f.

If the alarm is correctly reported, move to Step 2. If not, close the CTC application, delete the CTC
cache, and open the CTC connection again.

Note

If the alarm inconsistency persists, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem.
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Step 2

If the alarmed card is a 32WSS or 40WSS-C, verify the incoming power level from the connected TXP,
MXP, or line card. If the alarmed card is a 32MUX-O or 40MUX, go to Step 5.
a.

Double-click the WSS card.

b.

Click the Provisioning > Optical Chn: Optical Connector X > Parameters tabs to display the
optical power physically coming into the WSS ADD-RX port.

Note

c.

Identify the proper channel (wavelength) and read the Power ADD field.

d.

If the Power ADD value is less than –4.5 dBm, go to Step 3. If not, click the Provisioning >
Optical Chn: Optical Connector X > Parameters tabs.

Note

Warning

Step 3

X is the number (1 to 45) of the appropriate multifiber MPO connector that manages the
alarmed channel (wavelength).

X is the number (1 to 4) of the appropriate multifiber MPO connector that manages the
alarmed channel (wavelength).

e.

Identify the correct row based on the Type field (the row must indicate Add in the type field).

f.

Decrease the attenuation on the VOA to the minimum (0 dB) to enable channel startup. To perform
this adjustment:
•

Read the VOA Attenuation Ref value for the channel (wavelength).

•

Enter into the VOA Attenuation Calib field the same value as that of the VOA Attenuation Ref
field, but with the opposite sign (the algebraic sum of the two contributions must be equal to
zero).

•

Click Apply. If the LOS-P alarm persists, continue with this procedure. Otherwise, the problem
has been corrected.

g.

In card view, click Circuits.

h.

Delete the OCHNC circuit that relates to the faulty channel.

i.

Ensure that the corresponding ADD-RX service state port changes to IS-AINS (or
Unlocked,automaticInService) and that the color changes to grey (the LOS-P alarm should clear).

j.

Recreate the OCHNC circuit and verify that the Status field reports DISCOVERED and that the state
is IS (Unlocked).

k.

If the LOS-P alarm has not cleared, replace the 32WSS card (refer to the “Add and Remove Cards
and Nodes” chapter of the Cisco ONS 15454 DWDM Procedure Guide). Before you replace the card,
log into the Technical Support Website at http://www.cisco.com/techsupport for more information
or call Cisco TAC (1 800 553-2447) in order to report a service-affecting problem.

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

Because the actual power received by the WSS card is lower than expected, verify the correct behavior
of the TXP, MXP, or line card connected to the WSS:
•

The TX laser must be active (trunk port is in IS [or Unlocked] state).

•

The wavelength provisioned must be the proper one.
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•

The output power value must be within the expected range (refer to the “Hardware Specifications”
appendix in the Cisco ONS 15454 DWDM Reference Manual). If the trunk port PM is not available
through CTC, perform a manual measurement using a standard power meter.

If the TX laser is active, the wavelength is provisioned properly, and the output power value is in the
correct range, go to Step 4. Otherwise, take the appropriate corrective action, including card replacement
if the output power value is outside of the expected range (refer to the “Add and Remove Cards and
Nodes” chapter of the Cisco ONS 15454 DWDM Procedure Guide. Replacing the card should correct the
problem.)

Warning

Step 4

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

If the TXP or MXP card behaves as expected, the only remaining root cause is the fiber connection
between the two cards:
a.

Verify that the ADD_RX port of the alarmed WSS is connected to the TRUNK_TX port of the TXP
or MXP card using an MPO-LC multifiber cable.

Note

b.

Check and clean the LC fiber fan-out according to site practice. The fiber numbers (1 to 8) must
correspond to the wavelength managed.

c.

If a patch panel is used, check and, if necessary, clean the LC-LC adapter. If necessary, replace any
bad devices (maximum tolerance is 1 dB).

d.

Pull out the LC connector from the TRUNK_TX port of the TXP or MXP card and clean the fiber
according to site practice.

Note

Note

Step 5

A patch-panel tray is normally used to manage fiber connections (for patch-panel cabling
details, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide).

If no site practice exists for cleaning fibers, complete the procedure in the “Maintain the
Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

If the alarm condition has not cleared, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem.

When the alarmed card is a 32MUX-O or 40MUX, the troubleshooting procedure should start from the
TXP, MXP, or line card. Verify the correct behavior of the TXP, MXP, or line card connected to the
32MUX-O or 40MUX:
•

The TX laser must be active (trunk port is in IS [or Unlocked] state).

•

The wavelength provisioned must be the proper one.

•

The output power value must be within the expected range (refer to the “Hardware Specifications”
appendix in the Cisco ONS 15454 DWDM Reference Manual). If the trunk port PM is not available
through CTC, perform a manual measurement using a standard power meter.
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If the TX laser is active, the wavelength is provisioned properly, and the output power value is in the
correct range, go to Step 6. Otherwise, take the appropriate corrective action, including card replacement
if the output power value is outside of the expected range (refer to the “Add and Remove Cards and
Nodes” chapter of the Cisco ONS 15454 DWDM Procedure Guide. Replacing the card should correct the
problem.)

Warning

Step 6

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

If the TXP or MXP card behaves as expected, check the fiber connection between the two cards:
a.

The ADD_RX port of the alarmed 32MUX-O or 40MUX must be connected to the TRUNK_TX port
of a TXP or MXP card using an MPO-LC multifiber cable.

Note

b.

Check and clean the LC fiber fan-out according to site practice. The fiber numbers (1 to 8) must
correspond to the wavelength managed.

c.

If a patch panel is used, check and, if necessary, clean the LC-LC adapter.

d.

If necessary, replace any bad devices (maximum tolerance is 1 dB).

e.

Pull out the LC connector from the TRUNK_TX port of the TXP or MXP card and clean the fiber
according to site practice.

Note

f.
Step 7

A patch-panel tray is normally used to manage fiber connections (for patch-panel cabling
details, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide).

If no site practice exists for cleaning fibers, complete the procedure in the “Maintain the
Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

If the alarm condition persists, move to Step 7. Otherwise, the problem has been corrected.

Verify the correct behavior of the VOA inside the 32MUX-O or 40MUX card:
a.

Double-click the card.

b.

Click Circuits.
•

Delete the OCHNC circuit relating to the faulty channel.

•

Ensure that the service state of the corresponding ADD-RX port changes to IS-AINS (or
Unlocked,automaticInService), and that the color turns grey (the LOS-P alarm should clear).

c.

In card view, click the Provisioning > Optical Chn > Parameters tabs and identify the proper
channel (wavelength).

d.

Decrease the attenuation on the VOA to the minimum (0 dB) to enable channel startup. To perform
this in field adjustment:
•

Read the VOA Attenuation Ref value for the channel (wavelength).

•

Enter the same value into the VOA Attenuation Calib field as that of the VOA Attenuation Ref
field, but with the opposite sign (the algebraic sum of the two contributions must be equal to
zero).
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•

Warning

Click Apply. If the LOS-P alarm persists, continue with this procedure. Otherwise, the problem
has been corrected.

e.

Click Circuits.

f.

Recreate the OCHNC circuit and verify that Circuit Status field reports DISCOVERED and the state
is IS (Unlocked).

g.

If the LOS-P alarm has not cleared, replace the 32MUX-O or 40MUX card (refer to the “Add and
Remove Cards and Nodes” chapter of the Cisco ONS 15454 DWDM Procedure Guide). Before you
replace the card, log into the Technical Support Website at http://www.cisco.com/techsupport for
more information or call Cisco TAC (1 800 553-2447) in order to report a service-affecting
problem).

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

1.13.2.2 Scenario B: Optical Power Level of the Incoming Signal Lower Than Expected
In some cases, the pass-through channels on the WSS card or the optical bypass channels on the
32MUX-O or 40MUX card are at a power level that is lower than expected. The incoming power level
can be lower than expected for several reasons. A few examples are:
•

Dirty connections

•

Excessive span loss

•

Wrong amplifier gain setting

When the power is lower than expected, the start-up procedure can stop at Phase 1, Phase 2, or Phase 3
(see Figure 1-32). The point at which the start-up procedure stops depends on the amount of power
missing.
Given that Delta Power is the amount of optical power missing compared to the expected value, two final
conditions for Scenario B can be identified, Conditions B1 and B2.

1.13.2.2.1 Condition B1—Delta Power > 6 dB (LOS-P Alarm)
When the optical power is more than 6 dB lower than the expected value, the final VOA Power Reference
setpoint value is definitively not reachable and even Phase 1 of the start-up procedure cannot be properly
completed. As a consequence, the final condition reported in CTC is the same as that of Scenario A:
•

A LOS-P (OCH layer) alarm is present on the port associated with the VOA.

•

A valid optical power value (different from the end of scale value of – 50 dBm) can be read in the
Power field, but the value for Power is less than –33 dBm (see Figure 1-34). (To access this value,
in card view, click the Provisioning > Parameters tabs.)
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Figure 1-34

Power Level of Incoming Signal Less than –33 dBm

1.13.2.2.2 Condition B2—Delta Power < 6 dB (OPWR-LowDEGrade Alarm)
When the optical power is less than 6 dB lower than the expected value, even if a valid incoming signal
is present, the final VOA Power Reference setpoint value that is reported in the CTC is not reachable and
the VOA startup procedure is stopped at Phase 3.
The final conditions that CTC reports are:
•

An OPWR-LowDEGrade (OCH layer) alarm is present on the port associated with the VOA.

•

A valid optical power value (different from the end of scale value of –50 dBm) can be read in the
Power field, but the value is (VOA Power Ref – 6 dBm) < Power < VOA Power Ref (see
Figure 1-35). To access this value, in card view, click the Provisioning > Parameters tabs.
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Figure 1-35

Optical Power Less than 6 dB Lower than Expected

Corrective Actions for Scenario B (Optical Power Level of Incoming Signal Lower than Expected)
When the optical power level of the incoming signal is lower than expected for the pass-through channels
on the WSS or the optical bypass channels on the 32MUX-O ro 40MUX card, use the following
procedures to troubleshoot and eventually fix issues related to VOA start-up. According to the final
conditions reported by the card (either LOS-P alarm for condition B1 or OPWR-LowDEGrade for
condition B2), two troubleshooting procedures are suggested. These procedures are given in the
following sections.

Condition B1—LOS-P Alarm
Step 1

Verify the alarm validity:
a.

Identify the DWDM nodes where the alarmed card is located.

b.

Double-click the card (either the 32MUX-O or 40MUX or the WSS card).

c.

Click Alarms.

d.

Verify that a LOS-P alarm is present on the ADD-RX port.

e.

Click the Synchronize button at the bottom left of the window.

f.

If the alarm is correctly reported, move to Step 2. If not, close the CTC application, delete the CTC
cache, and open the CTC connection again.
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If the alarm inconsistency persists, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem.

Note

Step 2

In card view, click Circuits and retrieve the node, card, and port information for the alarmed channel
from the Source field of the OCHNC circuit. Then follow the procedures of Step 3 (32MUX-O, 32WSS,
40MUX, 40WSS-C, or AD-xC-xx.x card) or Step 4 (TXP, MXP, or line card) as appropriate.

Step 3

Verify the correct behavior of the far-end DWDM card (32MUX-O, 32WSS, 40MUX, 40WSS-C, or
AD-xC-xx.x) that manages the channel (wavelength):
a.

Verify that the power value coming in on the ADD_RX port is correct.
•

In card view, click the Provisioning > Optical Chn: Optical Connector X > Parameters tabs.

Note

X is number (1 to 45) of the proper multifiber MPO connector that manages the alarmed
channel (wavelength).

•
Step 4

The Power field value must be the same as that in the VOA Power Ref field. If not, take the
appropriate corrective actions according to the alarm raised at the RX-ADD port.

Verify the correct behavior of the TXP, MXP, or line card that is the signal source of the channel
(wavelength) that is alarmed:
a.

The TX laser must be active (trunk port is in IS [Unlocked] state).

b.

The wavelength provisioned must be the proper one.

c.

The output power value must be within the expected range (refer to the “Hardware Specifications”
appendix in the Cisco ONS 15454 DWDM Reference Manual). If the trunk port PM is not available
through CTC (for example, TXP_MR_2.5G), perform a manual measurement using a standard
power meter.

Step 5

If the cards referenced in Step 3 and Step 4 are operating properly, go to Step 6. If not, take the
appropriate corrective actions according to the alarm raised on the card.

Step 6

If the alarmed card is a 32MUX-O or 40MUX, go to Step 9.

Step 7

If the alarmed card is a 32WSS or 40WSS-C, continue with the following steps:
a.

Double-click the card.

b.

Click the Provisioning > Optical Chn: Optical Connector X > Parameters tabs.

Note

X is number (1 to 45) of the proper multifiber MPO connector that manages the alarmed
channel (wavelength).

c.

Identify the correct row based in the Type field (the row must indicate Passthrough in the type field).

d.

Decrease the attenuation on the VOA to the minimum (0 dB) to enable channel startup. To perform
this in field adjustment:
•

Read the VOA Attenuation Ref value for the channel (wavelength).

•

Enter the same value into the VOA Attenuation Calib field as that of the VOA Attenuation Ref
field, but with the opposite sign (the algebraic sum of the two contributions must be equal to
zero).
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•

Step 8

e.

Click Circuits.

f.

Delete the OCHNC circuit for the faulty channel.

g.

Ensure that the service state of the corresponding ADD-RX port changes to IS-AINS (or
Unlocked,automaticInService) and that the color changes to grey (LOS-P alarm should clear).

h.

Recreate the OCHNC circuit and verify that Circuit Status field reports DISCOVERED and the state
is IS (Unlocked).

i.

If the LOS-P alarm has not cleared, continue with Step 8. Otherwise, the problem has been
corrected.

To unambiguously pinpoint the root cause of the alarm, verify the proper cabling of the EXP_RX port
(which is the common input port for all the pass-through channels) on the 32WSS or 40WSS-C card:
a.

The EXP_RX port of the alarmed 32WSS card must be connected to the EXP_TX port of the
coupled WSS card on the opposite side of the node.

b.

Pull out the LC connector from the EXP_RX port of the WSS card and clean the fiber according to
site practice.

c.

Pull out the LC connector from the EXP_TX port of the coupled WSS card and clean that connector
also.

d.

Verify that the fiber attenuation is within the specifications (maximum tolerance is 1 dB).

e.

If necessary, replace any bad fibers.

f.

Warning

Step 9

Click Apply. If the LOS-P alarm persists, continue with this procedure. Otherwise, the problem
has been corrected.

Note

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the
optical amplifier card is unplugged.

Note

If no site practice exists for cleaning fibers, complete the procedure in the “Maintain the
Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

If the alarm condition persists even after the checking and fixing the fibers, replace the 32WSS card
(refer to the “Add and Remove Cards and Nodes” chapter of the Cisco ONS 15454 DWDM
Procedure Guide). Before replacing the card, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem).

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

Verify the correct behavior of the VOA inside the 32MUX-O or 40MUX card:
a.

Double-click the 32MUX-O or 40MUX card.

b.

Click Circuits.

c.

Delete the OCHNC circuit for the faulty channel.

d.

Ensure that the service state of the corresponding ADD-RX port changes to IS-AINS (or
Unlocked,automaticInService) and that the color changes to grey (LOS-P alarm should clear).
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Step 10

e.

Click the Provisioning > Optical Chn: > Parameters tabs and identify the proper channel
(wavelength).

f.

Decrease the attenuation on the VOA to the minimum (0 dB) to enable channel startup. To perform
this in field adjustment:
Read the VOA Attenuation Ref value for the channel (wavelength).

•

Enter the same value into the VOA Attenuation Calib field as that of the VOA Attenuation Ref
field, but with the opposite sign (the algebraic sum of the two contributions must be equal to
zero).

•

Click the Apply button. If the LOS-P alarm persists, continue with this procedure. Otherwise,
the problem has been corrected.

g.

Click Circuits.

h.

Recreate the OCHNC circuit and verify that Circuit Status field reports DISCOVERED and the state
is IS (Unlocked).

i.

If the LOS-P alarm has not cleared, continue with Step 10. Otherwise, the problem has been
corrected.

To unambiguously pinpoint the root cause of the alarm, verify the proper cabling of the alarmed
ADD_RX port on the 32MUX-O or 40MUX card:
a.

Note

•

The ADD_RX port of the alarmed 32MUX-O or 40MUX must be connected to the DROP_TX port
of the coupled 32DMX-O or 40DMX card on the opposite side of the node using two MPO-LC
multifiber cables.

A patch-panel tray is normally used to manage fiber connections (for patch-panel cabling details, refer
to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide).
b.

Verify that the power value coming out of DROP_TX port of the coupled 32DMX-O or 40DMX card
is correct:
•

In card view, click the Provisioning > Optical Chn: > Parameters tabs.

•

The Power field value must be the same as that in the VOA Power Ref field. If it is not, take the
appropriate corrective action for the alarm according to Chapter 2, “Alarm Troubleshooting.”

c.

Check and clean the LC fiber fan-out according to site practice. The fiber numbers (1 to 8) must
correspond to the wavelength managed.

d.

Repeat Step c for the MPO-LC multifiber cable coming out of the DROP_TX port of the coupled
32DMX-O or 40DMX card.

e.

Check and, if necessary, clean the LC-LC adapter.

f.

If necessary, replace and bad devices (maximum tolerance is 1 dB).

Note

g.

If no site practice exists for cleaning fibers, complete the procedure in the “Maintain the
Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

If the alarm condition persists even after the cabling is checked or fixed, replace the 32MUX-O or
40MUX card (refer to the “Add and Remove Cards and Nodes” chapter of the Cisco ONS 15454
DWDM Procedure Guide. Before replacing the card, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem).
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Warning

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

Condition B2—OPWR-LowDEGrade Alarm
Step 1

Verify the alarm validity:
a.

Identify the DWDM node where the alarmed card is located.

b.

Double-click the card (either the 32MUX-O, 32WSS, 40MUX, or 40WSS-C card).

c.

Click Alarms.

d.

Verify that an Optical Power Degrade Low (OPWR-LDEG) alarm is present on the ADD-RX port.

e.

Click the Synchronize button at the bottom left of the window.

f.

If the alarm is correctly reported, go to Step 2. If not, close the CTC application, delete the CTC
cache, and open the CTC connection again.

Note

If the alarm inconsistency persists, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem.

Step 2

In card view, click Circuits and retrieve the node, card, and port information for the alarmed channel
from the Source field of the OCHNC circuit. Then, follow the procedures in Step 3 (for 32MUX-O,
32WSS, 40MUX, 40WSS-C, or AD-xC-xx.x cards) or Step 4 (for TXP, MXP, or line cards) as
appropriate.

Step 3

Verify the correct behavior of the far-end DWDM card (32MUX-O, 32WSS, 40MUX, 40WSS-C, or
AD-xC-xx.x) that manages the channel (wavelength). To do this, verify that the power value coming in
on the ADD_RX port is correct:
a.

In card view, click the Provisioning > Optical Chn: Optical Connector X > Parameters tabs.

Note

b.
Step 4

X is number (1 to 45) of the proper multi-fibers MPO connector that manages the alarmed
channel (wavelength).

The Power field value must be the same as the VOA Power Ref field. If it is not, take the appropriate
corrective action for the alarm according to Chapter 2, “Alarm Troubleshooting.”

Verify the correct behavior of the TXP, MXP, or line card that is the signal source of the channel
(wavelength) that is alarmed:
a.

The TX laser must be active (trunk port is in IS [unlocked] state).

b.

The wavelength provisioned must be the proper one.

c.

The output power value must be within the expected range (refer to the “Hardware Specifications”
appendix in the Cisco ONS 15454 DWDM Reference Manual). If the trunk port PM is not available
through CTC, perform a manual measurement using a standard power meter.
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Step 5

If the cards referenced in Step 3 and Step 4 are operating properly, go to Step 6. If not, take the
appropriate corrective actions according to the alarm raised on the card (see Chapter 2, “Alarm
Troubleshooting”).

Step 6

If the alarmed card is a 32MUX-O or 40MUX card, go to Step 8.

Step 7

If the alarmed card is a 32WSS or 40WSS-C card, verify the proper cabling of the EXP_RX port
(common input port for all pass-through channels) on the WSS card:
a.

Verify that the EXP_RX port of the alarmed WSS card is connected to the EXP_TX port of the
coupled WSS card on the opposite side of the node.

b.

Pull out the LC connector from the EXP_RX port of the WSS card and clean the fiber according to
site practice.

c.

Pull out the LC connector from the EXP_TX port of the coupled WSS card and clean its connector
also.

d.

Verify that the fiber attenuation is within the specifications (maximum tolerance is 1 dB).

e.

If necessary, replace any bad fibers.

Note

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the
optical amplifier card is unplugged.

Note

If no site practice exists for cleaning fibers, complete the procedure in the “Maintain the
Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

If the alarm condition persists even after the cabling check/fixing, the root cause could be related
to a network issue and a more accurate analysis of the signal flow is needed according to the
actual system topology. If necessary, call Cisco TAC (1 800 553-2447) for help.

Note

Step 8

Verify the proper cabling of the alarmed ADD_RX port on the 32MUX-O or 40MUX card:
a.

Note

Verify that the ADD_RX port of the alarmed 32MUX-O or 40MUX is connected to the DROP_TX
port of the coupled 32DMX-O or 40DMX card on the opposite side of the node, using two MPO-LC
multifiber cables.

A patch-panel tray is normally used to manage fiber connections (for patch-panel cabling details, refer
to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide).
b.

Verify that the power value coming out of the DROP_TX port of the coupled 32DMX-O card is
correct:
•

In card view, click the Provisioning > Optical Chn: > Parameters tabs.

•

The Power field value must be the same as that in the VOA Power Ref field. If it is not, take the
appropriate corrective action for the alarm according to Chapter 2, “Alarm Troubleshooting.”

c.

Check (the number [1 to 8] must correspond with the wavelength managed) and clean the LC fan-out
according to site practice.

d.

Repeat Step c for the MPO-LC multifiber cable coming out of the DROP_TX port of the coupled
32DMX-O or 40DMX card.
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e.

Check and, if necessary, clean the LC-LC adapter used.

f.

If necessary, replace any bad devices (maximum tolerance is 1 dB).

Note

Note

If no site practice exists for cleaning fibers, complete the procedure in the “Maintain the
Node.” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

If the alarm condition persists even after the cable check and repair procedures, the root cause
could be related to a network issue and a more accurate analysis of the signal flow is needed
according with the actual system topology. If necessary, call Cisco TAC (1 800 553-2447) for
help.

1.13.2.3 Scenario C: Optical Drop Power Level Lower Than Expected
This scenario describes the condition in which the optical power at the 32DMX-O or 40DMX drop
channels is lower than expected. The 32DMX-O or 40DMX card is equipped with a VOA for each
wavelength, and each VOA manages the power for one dropped wavelength.
The failing scenarios during the OCHNC turn-up and consequent VOA startup are the same as those
described in the “1.13.2.2 Scenario B: Optical Power Level of the Incoming Signal Lower Than
Expected” section on page 1-90. The only difference is the type of alarm that is raised when the
condition exists in which Delta Power is greater than 6 dB.

1.13.2.3.1 Condition C1—Delta Power > 6 dB Lower than Expected
When the optical power on the dropped channel is more than 6 dB lower that the value expected, the final
VOA Power Reference setpoint value is definitively not reachable. As a consequence, the final
conditions reported in CTC are as follows:
•

An OPWR-LFAIL (OCH layer) alarm is present on the port associated with the VOA (see
Figure 1-36).

•

A valid optical power value (different from the end of scale value of –50 dBm) can be read in the
CTC Power field, but the Power value is less than –33 dBm. (To view this value in card view, click
the Provisioning > Parameters tabs.)
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Figure 1-36

Optical Drop Power More than 6 dB Lower than Expected

1.13.2.3.2 Condition C2—Delta Power < 6 dB Lower than Expected
If the delta power is less than 6 dB lower than expected, the final conditions reported in CTC are the
same as those reported for Condition B2 (see the “1.13.2.2.2 Condition B2—Delta Power < 6 dB
(OPWR-LowDEGrade Alarm)” section on page 1-91):
•

Αn OPWR-LowDEGrade (OCH layer) alarm is present on the port associated with the VOA.

•

A valid optical power value (different from the end of scale value of –50 dBm) can be read in the
CTC Power field, but the value is (VOA Power Ref – 6 dBm) < Power < VOA Power Ref
(Figure 1-35). To view this value in card view, click the Provisioning > Parameters tabs.

A dirty connection or excessive loss of the incoming span are among the possible reasons that can lead
to a fault condition. They are the most common and affect all wavelengths, whereas an excessive
amplifier gain tilt or a wavelength misconfiguration on the far-end TXP or MXP card can lead to
condition where only a single wavelength fails, such as the one (Channel 25) shown in Figure 1-37.
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Figure 1-37

Optical Drop Power Less than 6 dB Lower than Expected

Corrective Action for Scenario C (Optical Power Level of Incoming Signal Lower than Expected)
Scenario C1 - LOS-P Alarm
Step 1

Verify the alarm validity:
a.

Identify the DWDM nodes where the alarmed card is located.

b.

Double-click the 32DMX-O or 40DMX card.

c.

Click Alarms.

d.

Verify that a LOS-P alarm is present on the CHAN-TX port.

e.

Click the Synchronize button at the bottom left of the window.

f.

If the alarm is correctly reported, move to Step 2. If not, close the CTC application, delete the CTC
cache, and open the CTC connection again.

Note

If the alarm inconsistency persists, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem.
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Step 2

Verify the correct behavior of the far-end DWDM card (32MUX-O, 32WSS, 40MUX, 40WSS-C,
AD-xC-xx.x) that manages the channel (wavelength), and the TXP, MXP, or line card that is the signal
source of the channel (wavelength) alarmed:
a.

Click Circuits and retrieve the node, card, and port information for the alarmed channel from the
Source field of the OCHNC circuit.

b.

For the far-end DWDM card, verify that the power value coming in the ADD_RX port is correct:
•

In card view, click the Provisioning > Optical Chn: Optical Connector X > Parameters tabs.

Note

•
c.

Step 3

X is number (1 to 45) of the proper multifiber MPO connector that manages the alarmed
channel (wavelength).

The Power field value must be the same of VOA Power Ref field. If not, take the appropriate
corrective actions according to Chapter 2, “Alarm Troubleshooting.”

For the corresponding TXP, MXP, or line card connected, verify the following:
•

The TX laser is active (the trunk port is in IS [Unlocked] state).

•

The wavelength provisioned is the proper one.

d.

The output power value must be within the expected range (refer to the “Hardware Specifications”
appendix in the Cisco ONS 15454 DWDM Reference Manual). If the trunk port PM is not available
through CTC (for example, TXP_MR_2.5G), perform a manual measurement using a standard
power meter.

e.

If everything in Step 2 is correct, go to Step 3. If not, take the appropriate corrective actions
according to Chapter 2, “Alarm Troubleshooting.”

Verify the correct behavior of the VOA inside the 32DMX-O or 40DMX card:
a.

Double-click the 32DMX-O or 40DMX card.

b.

Click Circuits.

c.

Delete the OCHNC circuit for the faulty channel.

d.

Ensure that the service state of the corresponding CHAN-TX port changes to IS-AINS (or
Unlocked,automaticInService) and the color changes to grey (LOS-P alarm should clear).

e.

Click the Provisioning > Optical Chn: > Parameters tabs and identify the proper channel
(wavelength).

f.

Decrease the attenuation on the VOA to the minimum (0 dB) to enable channel startup. To perform
this in field adjustment:
•

Read the VOA Attenuation Ref value for the channel (wavelength).

•

Enter the same value into the VOA Attenuation Calib field as that in the VOA Attenuation Ref
field, but with the opposite sign (the algebraic sum of the two contributions must be equal to
zero).

•

Click Apply.

g.

Click Circuits.

h.

Recreate the OCHNC circuit and verify that Circuit Status field reports DISCOVERED and the state
is IS (Unlocked).

i.

If the LOS-P alarm has not cleared, continue with Step 4. If it has cleared, you are finished.
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Step 4

Warning

To unambiguously pinpoint the root cause of the alarm, verify the proper cabling of the COM-RX port
(common input port for all the drop channels) of the alarmed 32DMX-O or 40DMX card:
a.

Verify that the COM_RX port of the alarmed 32DMX-O or 40DMX is connected either to the
DROP_TX port of a 32WSS or 40WSS-C card or to the COM_TX port of an OPT-PRE,
OPT-BST/OPT-AMP-x-C, or OSC-CSM card, depending on the actual node layout.

b.

Pull out the LC connector from the COM_RX port of the 32DMX-O or 40DMX card and clean the
fiber according to site practice.

c.

Pull out the LC connector from the COM_TX or DROP_TX port of the connected DWDM card and
clean the fiber according to site practice.

d.

Verify that the fiber attenuation is within the specifications (maximum tolerance is 1 dB).

e.

If necessary, replace any bad fibers.

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

f.

Warning

Note

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the
optical amplifier card is unplugged.

Note

If no site practice exists for cleaning fibers, complete the procedure in the “Maintain the
Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

If the alarm condition persists even after the cabling has been checked and fixed, replace the
32DMX-O card (refer to the “Add and Remove Cards and Nodes” chapter of the Cisco ONS 15454
DWDM Procedure Guide. Before replacing the card, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem).

High-performance devices on this card can get hot during operation. To remove the card, hold it by
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before
placing it in an antistatic bag. Statement 201

Scenario C2 - OPWR-LowDEGrade Alarm
Step 1

Verify the alarm validity:
a.

Identify the DWDM nodes where the alarmed card is seated.

b.

Double-click the 32DMX-O or 40DMX card.

c.

Click Alarms.

d.

Verify that an Optical Power Degrade Low Loss of incoming Payload (OPWR-LDEG) alarm is
present on the CHAN-TX port.
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e.

Click the Synchronize button at the bottom left of the window.

f.

If the alarm is correctly reported, move to Step 2. If not, close the CTC application, delete the CTC
cache, and open the CTC connection again.

If the alarm inconsistency persists, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in
order to report a service-affecting problem.

Note

Step 2

Verify the correct behavior of the far-end DWDM card (32MUX-O, 32WSS, 40MUX, 40WSS-C, or
AD-xC-xx.x) that manages the channel (wavelength) and the TXP, MXP, or line card that is the signal
source of the channel (wavelength) alarmed.
a.

Click Circuits and retrieve the node, card, and port information for to the alarmed channel from the
Source field of the OCHNC circuit.

b.

For the far-end DWDM card, verify that the power value coming in on the ADD_RX port is correct:
•

In card view, click the Provisioning > Optical Chn: Optical Connector X > Parameters tabs.

Note

•
c.

Step 3

X is number (1 to 45) of the proper multifiber MPO connector that manages the alarmed
channel (wavelength).

The Power field value must be the same of VOA Power Ref field. If not, take the appropriate
corrective actions according to Chapter 2, “Alarm Troubleshooting.”

For the corresponding TXP, MXP, or line card connected, verify the following:
•

The TX laser is active (the trunk port is in IS [Unlocked] state).

•

The wavelength provisioned is the proper one.

d.

The output power value must be within the expected range (refer to the “Hardware Specifications”
appendix in the Cisco ONS 15454 DWDM Reference Manual). If the trunk port PM is not available
through CTC, perform a manual measurement using a standard power meter.

e.

If everything in Step 2 is correct, move to Step 3. If not, take the appropriate corrective actions
according to Chapter 2, “Alarm Troubleshooting.”

Verify the proper cabling of the COM-RX port (the common input port for all of the drop channels) of
the alarmed 32DMX-O or 40DMX:
a.

Verify that the COM_RX port of the alarmed 32DMX-O or 40DMX is connected either to the
DROP_TX port of a 32WSS or 40WSS-C card or to the COM_TX port of an OPT-PRE,
OPT-BST/OPT-AMP-x-C, or OSC-CSM, depending on the actual node layout.

b.

Pull out the LC connector from the COM_RX port of the 32DMX-O or 40DMX card and clean the
fiber according to site practice.

c.

Pull out the LC connector from the COM_TX or DROP_TX port of the connected DWDM card and
clean the fiber according to site practice.

d.

Verify that the fiber attenuation is within the specifications (maximum tolerance is 1 dB).

e.

If necessary, replace any bad fibers.
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Warning

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

f.

Note

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the
optical amplifier card is unplugged.

Note

If no site practice exists for cleaning fibers, complete the procedure in the “Maintain the
Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

If the alarm condition persists even after the cabling has been checked and fixed, the root cause
could be related to a network issue and a more accurate analysis of the signal flow is needed
according to the actual system topology. If necessary, call Cisco TAC (1 800 553-2447) in order to
report a service-affecting problem.

1.13.3 Counter-Propagating Light Affecting Operation of 32DMX-C and
32DMX-L Cards
Symptom The in-service operation of the 32DMX-C and 32DMX-L cards (with vendor ID 2049 and

2050) can be seriously affected by the counter-propagating light travelling from the drop ports of the
card towards the COM RX port. This counter-propagating light affects the internal VOA control loop of
the vendor-specific optical module of the 32DMX-C and 32DMX-L cards, leading to an increased
optical path attenuation. This is traffic affecting for all in-service channels.
Possible Cause The counter-propagating light can be inserted into the 32DMX-C or 32DMX-L card
as a result of incorrect cabling of transponder or line cards to the fiber patch-panel (in particular,
swapping RX with TX patchcords).
Recommended Action For software releases higher than or equal to 8.5.1, the vendor-specific optical
module on all the cards is automatically upgraded to a newer version. The vendor ID of the new
version of the card is 2051 and can be viewed at CTC > Card View > Inventory tab. This new
version of the optical module makes the VOA control robust to counter-propagating light, thus,
minimizing the effects of incorrect cabling during installation and/or maintenance.

For software releases lower than 8.5.1, for new 32DMX-C and 32DMX-L cards that are not already
installed, the vendor-specific optical module on all these new cards is automatically upgraded to a
newer version at the Cisco Spare depots. Once the new card is installed in field, a downgrade of the
optical module will be prevented and the latest optical module version is preserved on the software
package. If the 32DMX-C or 32DMX-L card is already installed, complete the “Corrective
Action—Software Releases Lower than 8.5.1” procedure on page 1-105 to manually fix the
problem.
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Corrective Action—Software Releases Lower than 8.5.1
Step 1

If the TXP card is preprovisioned in CTC, but not installed:
a.

Log into CTC.

b.

Display card view for the TXP card.

c.

Click the Provisioning > Line tab and choose OOS,DSBLD (ANSI) or Locked,disabled (ETSI)
from the Admin State drop-down list for the Trunk-TX port.

d.

Continue with Step 2

Step 2

Install the TXP card into the receptacle at the back of the designated slot.

Step 3

Wait for the TXP card to boot completely.

Step 4

Verify that the Trunk-TX port of the TXP card is in OOS,DSBLD (ANSI) or Locked,disabled (ETSI)
state.

Step 5

Wire the Trunk-TX/RX port of the TXP card to the fiber patch-panel.

Step 6

Turn up the TXP card and display card view for the TXP card in CTC.

Step 7

Click the Provisioning > Line tab and choose IS,AINS (ANSI) or Unlocked,automaticInService
(ETSI) from the Admin State drop-down list for the Trunk-TX port.

Step 8

Display card view for the 32WSS card.

Step 9

Click the Performance > Optical Chn tab and verify the Power ADD field on the CHAN-RX port of the
32WSS card connected to the TXP card.
a.

If a valid power level exists, the cabling of the TXP card is correct. Change the admin state of the
Trunk-TX port of the TXP card back to the original state.

b.

If no power level exists, the cabling of the TXP card is incorrect. Change the admin state of the
Trunk-TX port of the TXP card to OOS,DSBLD (ANSI) or Locked,disabled (ETSI) state and reverse
the cabling.

Note

It is important that you perform Steps 7 to 9 in the shortest time possible. That is, you must check
the presence of a valid RX power on WSS card (Step 9) immediately after you turn up the TXP
Trunk-TX port (Step 7), and in case of a bad connection, you must shut off the TXP Trunk-TX
port (Step 9b) as soon as possible. This is to minimize possible impairments on other channels
that are already in service.
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2

Alarm Troubleshooting
This chapter gives a description, severity, and troubleshooting procedure for each commonly
encountered Cisco DWDM alarm and condition. Tables 2-1 through 2-5 provide lists of DWDM alarms
organized by severity. Table 2-6 on page 2-8 provides a list of alarms organized alphabetically. Table 2-7
gives definitions of all DWDM alarm logical objects, which are the basis of the alarm profile list in
Table 2-8 on page 2-16. For a comprehensive list of all conditions and instructions for using TL1
commands, refer to the Cisco ONS SONET TL1 Command Guide.
An alarm’s troubleshooting procedure applies to both the Cisco Transport Controller (CTC) and TL1
version of that alarm. If the troubleshooting procedure does not clear the alarm, log into the Technical
Support Website at http://www.cisco.com/techsupport for more information or call the Cisco Technical
Assistance Center (1-800-553-2447).
For more information about alarm profiles, refer to the “Manage Alarms” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

Note

Unless otherwise noted, ONS 15454 refers to the ANSI and ETSI versions of the platform.

2.1 Alarm Indexes
The following tables group alarms and conditions by their default severities in the ONS DWDM system.
These severities are the same whether they are reported in the CTC Alarms window severity (SEV)
column or in TL1.

Note

The CTC default alarm profile contains some alarms or conditions that are not currently implemented
but are reserved for future use.

Note

The CTC default alarm profile in some cases contains two severities for one alarm (for example,
MJ/MN). The platform default severity comes first (in this example, MJ), but the alarm can be demoted
to the second severity in the presence of a higher-ranking alarm. This is in accordance with
Telcordia GR-474.
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2.1.1 Critical Alarms (CR)
Table 2-1 alphabetically lists Critical (CR) DWDM alarms.
Table 2-1

Critical DWDM Alarm List

—

HP-TIM (VCMON-HP)

MFGMEM (PPM)

—

HP-UNEQ (VCMON-HP)

OPWR-HFAIL (AOTS)

AU-LOP (VCMON-HP)

HP-UNEQ (VCTRM-HP)

OPWR-HFAIL (OCH)

AU-LOP (VCTRM-HP)

I-HITEMP (NE)

OPWR-HFAIL (OMS)

AUTOLSROFF (OCN)

ILK-FAIL (TRUNK)

OPWR-HFAIL (OTS)

AWG-FAIL (OTS)

IMPROPRMVL (EQPT)

OPWR-LFAIL (AOTS)

AWG-OVERTEMP (OTS)

IMPROPRMVL (PPM)

OPWR-LFAIL (OCH-TERM)

BKUPMEMP (EQPT)

LOF (TRUNK)

OPWR-LFAIL (OCH)

CONTBUS-DISABLED (EQPT)

LOM (TRUNK)

OPWR-LFAIL (OMS)

ENCAP-MISMATCH-P (POS)

LOP-P (STSMON)

OPWR-LFAIL (OTS)

ENCAP-MISMATCH-P (STSTRM)

LOP-P (STSTRM)

OTUK-LOF (TRUNK)

EQPT (AICI-AEP)

LOS (2R)

OTUK-TIM (TRUNK)

EQPT (AICI-AIE)

LOS (ESCON)

PORT-FAIL (OCH)

EQPT-DIAG (EQPT)

LOS (ISC)

RS-TIM (STMN)

EQPT (EQPT)

LOS (OTS)

TIM (TRUNK)

EQPT (PPM)

LOS (TRUNK)

TIM-P (STSTRM)

EQPT-MISS (FAN)

LOS-P (OCH)

TIM-S (OCN)

FAN (FAN)

LOS-P (OMS)

UNEQ-P (STSMON)

GAIN-HFAIL (AOTS)

LOS-P (OTS)

UNEQ-P (STSTRM)

GAIN-LFAIL (AOTS)

LOS-P (TRUNK)

VOA-HFAIL (AOTS)

GE-OOSYNC (FC)

MEA (AIP)

VOA-HFAIL (OCH)

GE-OOSYNC (GE)

MEA (EQPT)

VOA-HFAIL (OMS)

GE-OOSYNC (ISC)

MEA (FAN)

VOA-HFAIL (OTS)

GE-OOSYNC (TRUNK)

MEA (PPM)

VOA-LFAIL (AOTS)

HITEMP (NE)

MFGMEM (AICI-AEP)

VOA-LFAIL (OCH)

HP-ENCAP-MISMATCH (VCTRM-HP) MFGMEM (AICI-AIE)

VOA-LFAIL (OMS)

HP-PLM (VCMON-HP)

MFGMEM (BPLANE)

VOA-LFAIL (OTS)

HP-PLM (VCTRM-HP)

MFGMEM (FAN)

—

2.1.2 Major Alarms (MJ)
Table 2-2 alphabetically lists Major (MJ) DWDM alarms.
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Table 2-2

Major DWDM Alarm List

APSCNMIS (OCN)

GFP-LFD (CE100T)

ODUK-TIM-PM (TRUNK)

BAT-FAIL (PWR)

GFP-LFD (CE1000)

OUT-OF-SYNC (FC)

CARLOSS (EQPT)

GFP-LFD (CEMR)

OUT-OF-SYNC (GE)

CARLOSS (FC)

GFP-LFD (FCMR)

OUT-OF-SYNC (TRUNK)

CARLOSS (GE)

GFP-LFD (GFP-FAC)

PEER-NORESPONSE (EQPT)

CARLOSS (ISC)

GFP-LFD (ML100T)

PROV-MISMATCH (TRUNK)

CARLOSS (TRUNK)

GFP-LFD (ML1000)

PTIM (TRUNK)

DBOSYNC (NE)

GFP-LFD (MLMR)

RING-ID-MIS (OSC-RING)

DSP-COMM-FAIL (TRUNK)

GFP-LFD (POS)

SHELF-COMM-FAIL (SHELF)

DSP-FAIL (TRUNK)

GFP-UP-MISMATCH (CE100T)

SIGLOSS (ESCON)

DUP-SHELF-ID (SHELF)

GFP-UP-MISMATCH (CE1000)

SIGLOSS (FC)

EHIBATVG (PWR)

GFP-UP-MISMATCH (CEMR)

SIGLOSS (GE)

ELWBATVG (PWR)

GFP-UP-MISMATCH (FCMR)

SIGLOSS (ISC)

FC-NO-CREDITS (FC)

GFP-UP-MISMATCH (GFP-FAC)

SIGLOSS (TRUNK)

FC-NO-CREDITS (TRUNK)

GFP-UP-MISMATCH (ML100T)

SYNCLOSS (FC)

FEC-MISM (TRUNK)

GFP-UP-MISMATCH (ML1000)

SYNCLOSS (GE)

GFP-CSF (CE100T)

GFP-UP-MISMATCH (MLMR)

SYNCLOSS (ISC)

GFP-CSF (CE1000)

GFP-UP-MISMATCH (POS)

SYNCLOSS (TRUNK)

GFP-CSF (CEMR)

HIBATVG (PWR)

SYNCPRI (NE-SREF)

GFP-CSF (FCMR)

INVMACADR (AIP)

SYSBOOT (NE)

GFP-CSF (GFP-FAC)

LASERBIAS-FAIL (AOTS)

UT-COMM-FAIL (TRUNK)

GFP-CSF (ML100T)

LWBATVG (PWR)

UT-FAIL (TRUNK)

GFP-CSF (ML1000)

MEA (SHELF)

WVL-MISMATCH (TRUNK)

GFP-CSF (MLMR)

MEM-GONE (EQPT)

—

2.1.3 Minor Alarms (MN)
Table 2-3 alphabetically lists Minor (MN) DWDM alarms.
Table 2-3

Minor DWDM Alarm List

—

HI-LASERBIAS (OCN)

LO-TXPOWER (ESCON)

—

HI-LASERBIAS (PPM)

LO-TXPOWER (FC)

AMPLI-INIT (AOTS)

HI-LASERBIAS (TRUNK)

LO-TXPOWER (GE)

APC-CORR-SKIPPED (AOTS)

HI-LASERTEMP (EQPT)

LO-TXPOWER (ISC)

APC-CORR-SKIPPED (OCH)

HI-LASERTEMP (OCN)

LO-TXPOWER (OCN)

APC-CORR-SKIPPED (OMS)

HI-LASERTEMP (PPM)

LO-TXPOWER (PPM)

APC-CORR-SKIPPED (OTS)

HI-RXPOWER (2R)

LO-TXPOWER (TRUNK)
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Table 2-3

Minor DWDM Alarm List (continued)

APC-OUT-OF-RANGE (AOTS)

HI-RXPOWER (ESCON)

MEM-LOW (EQPT)

APC-OUT-OF-RANGE (OCH)

HI-RXPOWER (FC)

MS-EOC (STMN)

APC-OUT-OF-RANGE (OMS)

HI-RXPOWER (GE)

NON-CISCO-PPM (PPM)

APC-OUT-OF-RANGE (OTS)

HI-RXPOWER (ISC)

OPWR-HDEG (AOTS)

APS-INV-PRIM (OCN)

HI-RXPOWER (OCN)

OPWR-HDEG (OCH-TERM)

APS-PRIM-FAC (OCN)

HI-RXPOWER (TRUNK)

OPWR-HDEG (OCH)

APS-PRIM-SEC-MISM (OCN)

HITEMP (EQPT)

OPWR-HDEG (OMS)

APSB (OCN)

HI-TXPOWER (2R)

OPWR-HDEG (OTS)

APSC-IMP (OCN)

HI-TXPOWER (EQPT)

OPWR-LDEG (AOTS)

APSCDFLTK (OCN)

HI-TXPOWER (ESCON)

OPWR-LDEG (OCH-TERM)

APSCINCON (OCN)

HI-TXPOWER (FC)

OPWR-LDEG (OCH)

APSCM (OCN)

HI-TXPOWER (GE)

OPWR-LDEG (OMS)

APSIMP (OCN)

HI-TXPOWER (ISC)

OPWR-LDEG (OTS)

APSMM (OCN)

HI-TXPOWER (OCN)

OTUK-IAE (TRUNK)

AUTORESET (EQPT)

HI-TXPOWER (PPM)

PROTNA (EQPT)

AWG-DEG (OTS)

HI-TXPOWER (TRUNK)

PROV-MISMATCH (PPM)

BPV (BITS)

HP-TIM (VCMON-HP)

PWR-FAIL-A (EQPT)

CASETEMP-DEG (AOTS)

IS-ADJ-FAIL (OCN)

PWR-FAIL-B (EQPT)

CONTBUS-IO-A (CONTBUS-A)
(EQPT)

IS-ADJ-FAIL (TRUNK)

PWR-FAIL-RET-A (EQPT)

CONTBUS-IO-B (CONTBUS-B)
(EQPT)

LASERBIAS-DEG (AOTS)

PWR-FAIL-RET-B (EQPT)

DATAFLT (NE)

LASERBIAS-DEG (OTS)

RS-EOC (STMN)

DCU-LOSS-FAIL (OTS)

LASERTEMP-DEG (AOTS)

SFTWDOWN (EQPT)

DUP-IPADDR (NE)

LMP-FAIL (GE)

SH-IL-VAR-DEG-HIGH (OTS)

DUP-NODENAME (NE)

LMP-SD (GE)

SH-IL-VAR-DEG-LOW (OTS)

EOC (OCN)

LMP-SF (GE)

SNTP-HOST (NE)

EOC (TRUNK)

LOF (BITS)

SPANLEN-OUT-OF-RANGE (OTS)

EOC-L (OCN)

LO-LASERBIAS (EQPT)

SSM-FAIL (BITS)

EOC-L (TRUNK)

LO-LASERBIAS (OCN)

SSM-FAIL (TRUNK)

EXCCOL (EQPT)

LO-LASERBIAS (PPM)

SYNCPRI (EXT-SREF)

EXT (ENVALRM)

LO-LASERTEMP (EQPT)

SYNCSEC (EXT-SREF)

FAPS-CONFIG-MISMATCH (EQPT)

LO-LASERTEMP (OCN)

SYNCSEC (NE-SREF)

FEPRLF (OCN)

LO-LASERTEMP (PPM)

SYNCTHIRD (EXT-SREF)

FIBERTEMP-DEG (AOTS)

LO-RXPOWER (2R)

SYNCTHIRD (NE-SREF)

FP-LINK-LOSS (EQPT)

LO-RXPOWER (ESCON)

TIM-MON (TRUNK)

GAIN-HDEG (AOTS)

LO-RXPOWER (FC)

TIM-P (STSMON)

GAIN-LDEG (AOTS)

LO-RXPOWER (GE)

VOA-HDEG (AOTS)
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Table 2-3

Minor DWDM Alarm List (continued)

GCC-EOC (TRUNK)

LO-RXPOWER (ISC)

VOA-HDEG (OCH)

HELLO (OCN)

LO-RXPOWER (OCN)

VOA-HDEG (OMS)

HELLO (TRUNK)

LO-RXPOWER (TRUNK)

VOA-HDEG (OTS)

HI-LASERBIAS (2R)

LOS (BITS)

VOA-LDEG (AOTS)

HI-LASERBIAS (EQPT)

LOS-O (OCH)

VOA-LDEG (OCH)

HI-LASERBIAS (ESCON)

LOS-O (OMS)

VOA-LDEG (OMS)

HI-LASERBIAS (FC)

LOS-O (OTS)

VOA-LDEG (OTS)

HI-LASERBIAS (GE)

LO-TXPOWER (2R)

—

HI-LASERBIAS (ISC)

LO-TXPOWER (EQPT)

2.1.4 NA Conditions
Table 2-4 alphabetically lists Not Alarmed (NA) DWDM conditions.
Table 2-4

NA DWDM Conditions List

APC-DISABLED (OCH)

FORCED-REQ-SPAN (FC)

SD-L (OCN)

APC-DISABLED (OMS)

FORCED-REQ-SPAN (GE)

SD-L (TRUNK)

APC-DISABLED (OTS)

FORCED-REQ-SPAN (ISC)

SD-P (STSMON)

APC-DISABLED (SHELF)

FORCED-REQ-SPAN (OCN)

SD-P (STSTRM)

APC-END (NE)

FORCED-REQ-SPAN (TRUNK)

SF (TRUNK)

APC-WRONG-GAIN (AOTS)

FRCDSWTOINT (NE-SREF)

SFBER-EXCEED-HO
(VCMON-HP)

ALS (2R)

FRNGSYNC (NE-SREF)

SFBER-EXCEED-HO
(VCTRM-HP)

ALS (AOTS)

FRCDSWTOPRI (EXT-SREF)

SFBER-EXCEED-HO
(VCTRM-LP)

ALS (ESCON)

FRCDSWTOPRI (NE-SREF)

SF-L (TRUNK)

ALS (FC)

FRCDSWTOSEC (EXT-SREF)

SF-P (STSMON)

ALS (GE)

FRCDSWTOSEC (NE-SREF)

SF-P (STSTRM)

ALS (ISC)

FRCDSWTOTHIRD (EXT-SREF)

SHUTTER-OPEN (OTS)

ALS (OCN)

FRCDSWTOTHIRD (NE-SREF)

SPAN-NOT-MEASURED (OTS)

ALS (TRUNK)

FSTSYNC (NE-SREF)

SQUELCHED (2R)

ALS-DISABLED (EQPT)

FTA-MISMATCH (EQPT)

SQUELCHED (ESCON)

APC-DISABLED (AOTS)

HI-CCVOLT (BITS)

SQUELCHED (FC)

APC-DISABLED (EQPT)

HLDOVRSYNC (NE-SREF)

WKSWPR (FC)

APC-DISABLED (NE)

HP-DEG (VCMON-HP)

WKSWPR (GE)

APS-PRIM-FAC (OCN)

HP-DEG (VCTRM-HP)

WKSWPR (ISC)

AS-CMD (2R)

HP-EXC (VCMON-HP)

WTR (2R)
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Table 2-4

NA DWDM Conditions List (continued)

AS-CMD (AOTS)

HP-EXC (VCTRM-HP)

WTR (EQPT)

AS-CMD (BPLANE)

INHSWPR (EQPT)

WTR (ESCON)

AS-CMD (EQPT)

INHSWWKG (EQPT)

WTR (FC)

AS-CMD (ESCON)

INTRUSION-PSWD (NE)

WTR (GE)

AS-CMD (FC)

LAN-POL-REV (NE)

WTR (ISC)

AS-CMD (GE)

LASER-APR (AOTS)

WTR (TRUNK)

AS-CMD (ISC)

LMP-UNALLOC (GE)

SSM-LNC (BITS)

AS-CMD (NE)

LOCKOUT-REQ (2R)

SSM-LNC (NE-SREF)

AS-CMD (OCH)

LOCKOUT-REQ (EQPT)

SSM-LNC (TRUNK)

AS-CMD (OCN)

LOCKOUT-REQ (ESCON)

SSM-OFF (BITS)

AS-CMD (OMS)

LOCKOUT-REQ (FC)

SSM-OFF (TRUNK)

AS-CMD (OTS)

LOCKOUT-REQ (GE)

SSM-PRC (BITS)

AS-CMD (PPM)

LOCKOUT-REQ (ISC)

SQUELCHED (GE)

AS-CMD (PWR)

LOCKOUT-REQ (OCN)

SQUELCHED (ISC)

AS-CMD (SHELF)

LOCKOUT-REQ (OTS)

SQUELCHED (OCN)

AS-CMD (TRUNK)

LOCKOUT-REQ (STSMON)

SQUELCHED (TRUNK)

AS-MT (2R)

LOCKOUT-REQ (TRUNK)

SSM-DUS (BITS)

AS-MT (AOTS)

LPBKCRS (STSMON)

SSM-DUS (TRUNK)

AS-MT (EQPT)

LPBKFACILITY (ESCON)

SSM-PRC (NE-SREF)

AS-MT (ESCON)

LPBKFACILITY (FC)

SSM-PRC (TRUNK)

AS-MT (FC)

LPBKFACILITY (GE)

SSM-PRS (BITS)

AS-MT (GE)

LPBKFACILITY (ISC)

SSM-PRS (NE-SREF)

AS-MT (ISC)

LPBKFACILITY (TRUNK)

SSM-PRS (TRUNK)

AS-MT (OCH)

LPBKTERMINAL (ESCON)

SSM-RES (BITS)

AS-MT (OCN)

LPBKTERMINAL (FC)

SSM-RES (NE-SREF)

AS-MT (OMS)

LPBKTERMINAL (GE)

SSM-RES (TRUNK)

AS-MT (OTS)

LPBKTERMINAL (ISC)

SSM-SDH-TN (BITS)

AS-MT (PPM)

LPBKTERMINAL (TRUNK)

SSM-SDH-TN (NE-SREF)

AS-MT (SHELF)

MAN-REQ (EQPT)

SSM-SDH-TN (TRUNK)

AS-MT (TRUNK)

MANRESET (EQPT)

SSM-SETS (BITS)

AS-MT-OOG (STSTRM)

MANSWTOINT (NE-SREF)

SSM-SETS (NE-SREF)

AUD-LOG-LOSS (NE)

MANSWTOPRI (EXT-SREF)

SSM-SETS (TRUNK)

AUD-LOG-LOW (NE)

MANSWTOPRI (NE-SREF)

SSM-SMC (BITS)

AUTOSW-LOP (STSMON)

MANSWTOSEC (EXT-SREF)

SSM-SMC (NE-SREF)

AUTOSW-LOP-SNCP (VCMON-HP)

MANSWTOSEC (NE-SREF)

SSM-SMC (TRUNK)

AUTOSW-LOP-SNCP (VCMON-LP)

MANSWTOTHIRD (EXT-SREF)

SSM-ST2 (BITS)

AUTOSW-PDI-SNCP (VCMON-HP)

MANSWTOTHIRD (NE-SREF)

SSM-ST2 (NE-SREF)
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Table 2-4

NA DWDM Conditions List (continued)

AUTOSW-PDI (STSMON)

MANUAL-REQ-SPAN (2R)

SSM-ST2 (TRUNK)

AUTOSW-SDBER (STSMON)

MANUAL-REQ-SPAN (ESCON)

SSM-ST3 (BITS)

AUTOSW-SFBER (STSMON)

MANUAL-REQ-SPAN (FC)

SSM-ST3 (NE-SREF)

AUTOSW-SDBER-SNCP (VCMON-HP) MANUAL-REQ-SPAN (GE)

SSM-ST3 (TRUNK)

AUTOSW-SFBER-SNCP (STSMON)

MANUAL-REQ-SPAN (ISC)

SSM-ST3E (BITS)

AUTOSW-UNEQ (STSMON)

MANUAL-REQ-SPAN (OCN)

SSM-ST3E (NE-SREF)

AUTOSW-UNEQ-SNCP (VCMON-HP)

MANUAL-REQ-SPAN (TRUNK)

SSM-ST3E (TRUNK)

AUTOSW-UNEQ-SNCP (VCMON-LP)

MS-DEG (STM1E)

SSM-ST4 (BITS)

AWG-WARM-UP (OTS)

MS-DEG (STMN)

SSM-ST4 (NE-SREF)

CHANLOSS (OCN)

MS-EOC (STMN)

SSM-ST4 (TRUNK)

CLDRESTART (EQPT)

MS-EXC (STM1E)

SSM-STU (BITS)

CTNEQPT-MISMATCH (EQPT)

MS-EXC (STMN)

SSM-STU (NE-SREF)

ETH-LINKLOSS (NE)

MT-OCHNC (OTS)

SSM-STU (TRUNK)

FAILTOSW (2R)

OCHNC-INC (OCHNC-CONN)

SSM-TNC (BITS)

FAILTOSW (EQPT)

OCHTERM-INC (OCH-TERM)

SSM-TNC (NE-SREF)

FAILTOSW (ESCON)

ODUK-SD-PM (TRUNK)

SSM-TNC (TRUNK)

FAILTOSW (GE)

ODUK-SF-PM (TRUNK)

SW-MISMATCH (EQPT)

FAILTOSW (FC)

OPEN-SLOT (EQPT)

SWTOPRI (EXT-SREF)

FAILTOSW (ISC)

OSRION (AOTS)

SWTOPRI (NE-SREF)

FAILTOSW (OCN)

OSRION (OTS)

SWTOSEC (EXT-SREF)

FAILTOSW (TRUNK)

OTUK-SD (TRUNK)

SWTOSEC (NE-SREF)

FAILTOSW-HO (VCMON-HP)

OTUK-SF (TRUNK)

SWTOTHIRD (EXT-SREF)

FAILTOSW-PATH (STSMON)

OUT-OF-SYNC (ISC)

TRAIL-SIGNAL-FAIL (OCH)

FAPS (TRUNK)

PARAM-MISM (AOTS)

SWTOTHIRD (NE-SREF)

FDI (OCH-TERM)

PARAM-MISM (OCH)

SYNC-FREQ (BITS)

FDI (OCH)

PARAM-MISM (OCH-TERM)

SYNC-FREQ (TRUNK)

FE-FRCDWKSWBK-SPAN (OCN)

PARAM-MISM (OMS)

TEMP-MISM (NE)

FORCED-REQ (STSMON)

PARAM-MISM (OTS)

TRAIL-SIGNAL-FAIL (TRUNK)

FE-FRCDWKSWPR-SPAN (OCN)

PDI-P (STSMON)

UNC-WORD (TRUNK)

FE-MANWKSWBK-SPAN (OCN)

PDI-P (STSTRM)

VOLT-MISM (PWR)

FE-MANWKSWPR-SPAN (OCN)

PMI (OMS)

WKSWPR (2R)

FORCED-REQ (EQPT)

PMI (OTS)

WKSWPR (EQPT)

FORCED-REQ (POS)

RUNCFG-SAVENEED (EQPT)

WKSWPR (ESCON)

FORCED-REQ-SPAN (2R)

SD (TRUNK)

—

FORCED-REQ-SPAN (ESCON)

SD-L (OCN)

—
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2.1.5 NR Conditions
Table 2-5 alphabetically lists Not Reported (NR) DWDM conditions.
Table 2-5

NR DWDM Conditions List

AIS (BITS)

ERFI-P-CONN (STSTRM)

ODUK-AIS-PM (TRUNK)

AIS (TRUNK)

ERFI-P-SRVR (STSMON)

ODUK-BDI-PM (TRUNK)

AIS-L (OCN)

ERFI-P-SRVR (STSTRM)

ODUK-LCK-PM (TRUNK)

AIS-L (TRUNK)

HP-RFI (VCMON-HP)

ODUK-OCI-PM (TRUNK)

AIS-P (STSMON)

MS-AIS (STMN)

OTUK-AIS (TRUNK)

AIS-P (STSTRM)

MS-AIS (STM1E)

OTUK-BDI (TRUNK)

AU-AIS (VCTRM-HP)

MS-RFI (STMN)

RFI (TRUNK)

AU-AIS (VCMON-HP)

MS-RFI (STM1E)

RFI-L (OCN)

AUTOSW-AIS (STSMON)

ODUK-1-AIS-PM (TRUNK)

RFI-L (TRUNK)

AUTOSW-AIS-SNCP (VCMON-HP)

ODUK-2-AIS-PM (TRUNK)

RFI-P (STSMON)

AUTOSW-AIS-SNCP (VCMON-LP)

ODUK-3-AIS-PM (TRUNK)

RFI-P (STSTRM)

ERFI-P-CONN (STSMON)

ODUK-4-AIS-PM (TRUNK)

UNQUAL-PPM

2.1.6 Alarms and Conditions Listed By Alphabetical Entry
Table 2-6 alphabetically lists all DWDM alarms and conditions.
Table 2-6

Alphabetical DWDM Alarm and Condition List

—

GFP-CSF (CE100T)

ODUK-TIM-PM (TRUNK)

—

GFP-CSF (CE1000)

OPEN-SLOT (EQPT)

—

GFP-CSF (CEMR)

OPWR-HDEG (AOTS)

—

GFP-CSF (FCMR)

OPWR-HDEG (OCH)

AIS (BITS)

GFP-CSF (GFP-FAC)

OPWR-HDEG (OCH-TERM)

AIS (TRUNK)

GFP-CSF (ML100T)

OPWR-HDEG (OMS)

AIS-L (OCN)

GFP-CSF (ML1000)

OPWR-HDEG (OTS)

AIS-L (TRUNK)

GFP-CSF (MLMR)

OPWR-HFAIL (AOTS)

AIS-P (STSMON)

GFP-LFD (CE100T)

OPWR-HFAIL (OCH)

AIS-P (STSTRM)

GFP-LFD (CE1000)

OPWR-HFAIL (OMS)

ALS (2R)

GFP-LFD (CEMR)

OPWR-HFAIL (OTS)

ALS (AOTS)

GFP-LFD (FCMR)

OPWR-LDEG (AOTS)

ALS (ESCON)

GFP-LFD (GFP-FAC)

OPWR-LDEG (OCH)

ALS (FC)

GFP-LFD (ML100T)

OPWR-LDEG (OCH-TERM)

ALS (GE)

GFP-LFD (ML1000)

OPWR-LDEG (OMS)

ALS (ISC)

GFP-LFD (MLMR)

OPWR-LDEG (OTS)
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Table 2-6

Alphabetical DWDM Alarm and Condition List (continued)

ALS (OCN)

GFP-LFD (POS)

OPWR-LFAIL (AOTS)

ALS (TRUNK)

GFP-UP-MISMATCH (CE100T)

OPWR-LFAIL (OCH)

ALS-DISABLED (EQPT)

GFP-UP-MISMATCH (CE1000)

OPWR-LFAIL (OCH-TERM)

AMPLI-INIT (AOTS)

GFP-UP-MISMATCH (CEMR)

OPWR-LFAIL (OMS)

APC-CORR-SKIPPED (AOTS)

GFP-UP-MISMATCH (FCMR)

OPWR-LFAIL (OTS)

APC-CORR-SKIPPED (OCH)

GFP-UP-MISMATCH (GFP-FAC)

OSRION (AOTS)

APC-CORR-SKIPPED (OMS)

GFP-UP-MISMATCH (ML100T)

OSRION (OTS)

APC-CORR-SKIPPED (OTS)

GFP-UP-MISMATCH (ML1000)

OTUK-AIS (TRUNK)

APC-DISABLED (AOTS)

GFP-UP-MISMATCH (MLMR)

OTUK-BDI (TRUNK)

APC-DISABLED (EQPT)

GFP-UP-MISMATCH (POS)

OTUK-IAE (TRUNK)

APC-DISABLED (NE)

HELLO (TRUNK)

OTUK-LOF (TRUNK)

APC-DISABLED (OCH)

HIBATVG (PWR)

OTUK-SD (TRUNK)

APC-DISABLED (OMS)

HI-CCVOLT (BITS)

OTUK-SF (TRUNK)

APC-DISABLED (OTS)

HI-LASERBIAS (2R)

OTUK-TIM (TRUNK)

APC-DISABLED (SHELF)

HI-LASERBIAS (EQPT)

OUT-OF-SYNC (FC)

APC-END (NE)

HI-LASERBIAS (ESCON)

OUT-OF-SYNC (GE)

APC-OUT-OF-RANGE (AOTS)

HI-LASERBIAS (FC)

OUT-OF-SYNC (ISC)

APC-OUT-OF-RANGE (OCH)

HI-LASERBIAS (GE)

OUT-OF-SYNC (TRUNK)

APC-OUT-OF-RANGE (OMS)

HI-LASERBIAS (ISC)

PARAM-MISM (AOTS)

APC-OUT-OF-RANGE (OTS)

HI-LASERBIAS (OCN)

PARAM-MISM (OCH)

APC-WRONG-GAIN (AOTS)

HI-LASERBIAS (PPM)

PARAM-MISM (OCH-TERM)

APS-INV-PRIM (OCN)

HI-LASERBIAS (TRUNK)

PARAM-MISM (OMS)

APS-PRIM-FAC (OCN)

HI-LASERTEMP (EQPT)

PARAM-MISM (OTS)

APS-PRIM-SEC-MISM (OCN)

HI-LASERTEMP (OCN)

PDI-P (STSMON)

APSB (OCN)

HI-LASERTEMP (PPM)

PDI-P (STSTRM)

APSC-IMP (OCN)

HI-RXPOWER (2R)

PEER-NORESPONSE (EQPT)

APSCDFLTK (OCN)

HI-RXPOWER (ESCON)

PM-TCA

APSCINCON (OCN)

HI-RXPOWER (FC)

PMI (OMS)

APSCM (OCN)

HI-RXPOWER (GE)

PMI (OTS)

APSCNMIS (OCN)

HI-RXPOWER (ISC)

PORT-FAIL (OCH)

APSIMP (OCN)

HI-RXPOWER (OCN)

PROTNA (EQPT)

APSMM (OCN)

HI-RXPOWER (TRUNK)

PROV-MISMATCH (PPM)

AS-CMD (2R)

HITEMP (EQPT)

PROV-MISMATCH (TRUNK)

AS-CMD (AOTS)

HITEMP (NE)

PTIM (TRUNK)

AS-CMD (BPLANE)

HI-TXPOWER (2R)

PWR-FAIL-A (EQPT)

AS-CMD (EQPT)

HI-TXPOWER (EQPT)

PWR-FAIL-B (EQPT)

AS-CMD (ESCON)

HI-TXPOWER (ESCON)

PWR-FAIL-RET-A (EQPT)
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Table 2-6

Alphabetical DWDM Alarm and Condition List (continued)

AS-CMD (FC)

HI-TXPOWER (FC)

PWR-FAIL-RET-B (EQPT)

AS-CMD (GE)

HI-TXPOWER (GE)

RFI (TRUNK)

AS-CMD (ISC)

HI-TXPOWER (ISC)

RFI-L (OCN)

AS-CMD (NE)

HI-TXPOWER (OCN)

RFI-P (STSMON)

AS-CMD (OCH)

HI-TXPOWER (PPM)

RFI-P (STSTRM)

AS-CMD (OCN)

HI-TXPOWER (TRUNK)

RING-ID-MIS (OSC-RING)

AS-CMD (OMS)

HLDOVRSYNC (NE-SREF)

RMON-ALARM

AS-CMD (OTS)

HP-DEG (VCMON-HP)

RMON-RESET

AS-CMD (PPM)

HP-DEG (VCTRM-HP)

RS-EOC (STMN)

AS-CMD (PWR)

HP-ENCAP-MISMATCH (VCTRM-HP) RS-TIM (STMN)

AS-CMD (SHELF)

HP-EXC (VCMON-HP)

RUNCFG-SAVENEED (EQPT)

AS-CMD (TRUNK)

HP-EXC (VCTRM-HP)

SD (TRUNK)

AS-MT-OOG (STSTRM)

HP-PLM (VCMON-HP)

SD-L (OCN)

AS-MT (2R)

HP-PLM (VCTRM-HP)

SD-P (STSMON)

AS-MT (AOTS)

HP-RFI (VCMON-HP)

SD-P (STSTRM)

AS-MT (EQPT)

HP-TIM (VCMON-HP)

SF (TRUNK)

AS-MT (ESCON)

HP-UNEQ (VCMON-HP)

SF-L (TRUNK)

AS-MT (FC)

HP-UNEQ (VCTRM-HP)

SF-P (STSMON)

AS-MT (GE)

I-HITEMP (NE)

SF-P (STSTRM)

AS-MT (ISC)

ILK-FAIL (TRUNK)

SFBER-EXCEED-HO (VCMON-HP)

AS-MT (OCH)

IMPROPRMVL (EQPT)

SFBER-EXCEED-HO (VCTRM-HP)

AS-MT (OCN)

IMPROPRMVL (PPM)

SFBER-EXCEED-HO (VCTRM-LP)

AS-MT (OMS)

INTRUSION-PSWD (NE)

SFTWDOWN (EQPT)

AS-MT (OTS)

INVMACADR (AIP)

SHELF-COMM-FAIL (SHELF)

AS-MT (PPM)

INHSWPR (EQPT)

SH-IL-VAR-DEG-HIGH (OTS)

AS-MT (SHELF)

INHSWWKG (EQPT)

SH-IL-VAR-DEG-LOW (OTS)

AS-MT (TRUNK)

ISIS-ADJ-FAIL (OCN)

SHUTTER-OPEN (OTS)

AU-AIS (VCTRM-HP)

ISIS-ADJ-FAIL (TRUNK)

SIGLOSS (ESCON)

AU-AIS (VCMON-HP)

LAN-POL-REV (NE)

SIGLOSS (FC)

AU-LOP (VCTRM-HP)

LASEREOL (OCN)

SIGLOSS (GE)

AU-LOP (VCMON-HP)

LASER-APR (AOTS)

SIGLOSS (ISC)

AUD-LOG-LOSS (NE)

LASERBIAS-DEG (AOTS)

SIGLOSS (TRUNK)

AUD-LOG-LOW (NE)

LASERBIAS-DEG (OTS)

SNTP-HOST (NE)

AUTORESET (EQPT)

LASERBIAS-FAIL (AOTS)

SPANLEN-OUT-OF-RANGE (OTS)

AUTOLSROFF (OCN)

LASERTEMP-DEG (AOTS)

SPAN-NOT-MEASURED (OTS)

AUTOSW-AIS (STSMON)

LMP-FAIL (GE)

SQUELCHED (2R)

AUTOSW-AIS-SNCP (VCMON-HP)

LMP-SD (GE)

SQUELCHED (ESCON)
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Table 2-6

Alphabetical DWDM Alarm and Condition List (continued)

AUTOSW-AIS-SNCP (VCMON-LP)

LMP-SF (GE)

SQUELCHED (FC)

AUTOSW-LOP (STSMON)

LMP-UNALLOC (GE)

SQUELCHED (GE)

AUTOSW-LOP-SNCP (VCMON-HP)

LOCKOUT-REQ (2R)

SQUELCHED (ISC)

AUTOSW-LOP-SNCP (VCMON-LP)

LOCKOUT-REQ (EQPT)

SQUELCHED (OCN)

AUTOSW-PDI (STSMON)

LOCKOUT-REQ (ESCON)

SQUELCHED (TRUNK)

AUTOSW-PDI-SNCP (VCMON-HP)

LOCKOUT-REQ (FC)

SSM-DUS (BITS)

AUTOSW-SDBER (STSMON)

LOCKOUT-REQ (GE)

SSM-DUS (TRUNK)

AUTOSW-SDBER-SNCP (VCMON-HP) LOCKOUT-REQ (ISC)

SSM-FAIL (BITS)

AUTOSW-SFBER (STSMON)

LOCKOUT-REQ (TRUNK)

SSM-FAIL (TRUNK)

AUTOSW-SFBER-SNCP (STSMON)

LOF (BITS)

SSM-LNC (BITS)

AUTOSW-UNEQ (STSMON)

LOF (TRUNK)

SSM-LNC (NE-SREF)

AUTOSW-UNEQ-SNCP (VCMON-HP)

LO-LASERBIAS (EQPT)

SSM-LNC (TRUNK)

AUTOSW-UNEQ-SNCP (VCMON-LP)

LO-LASERBIAS (OCN)

SSM-OFF (BITS)

AWG-DEG (OTS)

LO-LASERBIAS (PPM)

SSM-OFF (TRUNK)

AWG-FAIL (OTS)

LO-LASERTEMP (EQPT)

SSM-PRC (BITS)

AWG-OVERTEMP (OTS)

LO-LASERTEMP (OCN)

SSM-PRC (NE-SREF)

AWG-WARM-UP (OTS)

LO-LASERTEMP (PPM)

SSM-PRC (TRUNK)

BAT-FAIL (PWR)

LOM (TRUNK)

SSM-PRS (BITS)

BKUPMEMP (EQPT)

LOP-P (TRUNK)

SSM-PRS (NE-SREF)

BPV (BITS)

LOP-P (OCH)

SSM-PRS (TRUNK)

CARLOSS (EQPT)

LOP-P (OMS)

SSM-RES (BITS)

CARLOSS (FC)

LOP-P (OTS)

SSM-RES (NE-SREF)

CARLOSS (GE)

LO-RXPOWER (2R)

SSM-RES (TRUNK)

CARLOSS (ISC)

LO-RXPOWER (ESCON)

SSM-SDH-TN (BITS)

CARLOSS (TRUNK)

LO-RXPOWER (FC)

SSM-SDH-TN (NE-SREF)

CASETEMP-DEG (AOTS)

LO-RXPOWER (GE)

SSM-SDH-TN (TRUNK)

CHANLOSS (OCN)

LO-RXPOWER (ISC)

SSM-SETS (BITS)

CLDRESTART (EQPT)

LO-RXPOWER (OCN)

SSM-SETS (NE-SREF)

CONTBUS-DISABLED (EQPT)

LO-RXPOWER (TRUNK)

SSM-SETS (TRUNK)

CONTBUS-IO-A (CONTBUS-A)
(EQPT)

LOS (2R)

SSM-SMC (BITS)

CONTBUS-IO-B (CONTBUS-B)
(EQPT)

LOS (BITS)

SSM-SMC (NE-SREF)

CTNEQPT-MISMATCH (EQPT)

LOS (ESCON)

SSM-SMC (TRUNK)

DATAFLT (NE)

LOS (ISC)

SSM-ST2 (BITS)

DBOSYNC (NE)

LOS (OTS)

SSM-ST2 (NE-SREF)

DCU-LOSS-FAIL (OTS)

LOS (TRUNK)

SSM-ST2 (TRUNK)

DSP-COMM-FAIL (TRUNK)

LOS-O (OCH)

SSM-ST3 (BITS)
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Alphabetical DWDM Alarm and Condition List (continued)

DSP-FAIL (TRUNK)

LOS-O (OMS)

SSM-ST3 (NE-SREF)

DUP-IPADDR (NE)

LOS-O (OTS)

SSM-ST3 (TRUNK)

DUP-NODENAME (NE)

LOS-P (OCH)

SSM-ST3E (BITS)

DUP-SHELF-ID (SHELF)

LOS-P (OMS)

SSM-ST3E (NE-SREF)

EHIBATVG (PWR)

LOS-P (OTS)

SSM-ST3E (TRUNK)

ELWBATVG (PWR)

LOS-P (TRUNK)

SSM-ST4 (BITS)

ENCAP-MISMATCH-P (STSTRM)

LO-TXPOWER (2R)

SSM-ST4 (NE-SREF)

ENCAP-MISMATCH-P (POS)

LO-TXPOWER (EQPT)

SSM-ST4 (TRUNK)

EOC (OCN)

LO-TXPOWER (ESCON)

SSM-STU (BITS)

EOC (TRUNK)

LO-TXPOWER (FC)

SSM-STU (NE-SREF)

EOC-L (OCN)

LO-TXPOWER (GE)

SSM-STU (TRUNK)

EOC-L (TRUNK)

LO-TXPOWER (ISC)

SSM-TNC (BITS)

ERFI-P-CONN (STSMON)

LO-TXPOWER (OCN)

SSM-TNC (NE-SREF)

ERFI-P-CONN (STSTRM)

LO-TXPOWER (PPM)

SSM-TNC (TRUNK)

ERFI-P-SRVR (STSMON)

LO-TXPOWER (TRUNK)

SW-MISMATCH (EQPT)

ERFI-P-SRVR (STSTRM)

LPBKCRS (STSMON)

SWTOPRI (EXT-SREF)

EQPT (AICI-AEP)

LPBKFACILITY (ESCON)

SWTOPRI (NE-SREF)

EQPT (AICI-AIE)

LPBKFACILITY (FC)

SWTOSEC (EXT-SREF)

EQPT (EQPT)

LPBKFACILITY (GE)

SWTOSEC (NE-SREF)

EQPT (PPM)

LPBKFACILITY (ISC)

SWTOTHIRD (EXT-SREF)

EQPT-DIAG (EQPT)

LPBKFACILITY (TRUNK)

SWTOTHIRD (NE-SREF)

EQPT-MISS (FAN)

LPBKTERMINAL (ESCON)

SYNC-FREQ (BITS)

ETH-LINKLOSS (NE)

LPBKTERMINAL (FC)

SYNC-FREQ (TRUNK)

EXCCOL (EQPT)

LPBKTERMINAL (GE)

SYNCLOSS (FC)

EXT (ENVALRM)

LPBKTERMINAL (ISC)

SYNCLOSS (GE)

FAILTOSW (2R)

LPBKTERMINAL (TRUNK)

SYNCLOSS (ISC)

FAILTOSW (EQPT)

LWBATVG (PWR)

SYNCLOSS (TRUNK)

FAILTOSW (ESCON)

MAN-REQ (EQPT)

SYNCPRI (EXT-SREF)

FAILTOSW (FC)

MANRESET (EQPT)

SYNCPRI (NE-SREF)

FAILTOSW (GE)

MANSWTOINT (NE-SREF)

SYNCSEC (EXT-SREF)

FAILTOSW (ISC)

MANSWTOPRI (EXT-SREF)

SYNCSEC (NE-SREF)

FAILTOSW (OCN)

MANSWTOPRI (NE-SREF)

SYNCTHIRD (EXT-SREF)

FAILTOSW (TRUNK)

MANSWTOSEC (EXT-SREF)

SYNCTHIRD (NE-SREF)

FAILTOSW-HO (STSMON)

MANSWTOSEC (NE-SREF)

SYSBOOT (NE)

FAILTOSW-PATH (STSMON)

MANSWTOTHIRD (EXT-SREF)

TEMP-MISM (NE)

FAN (FAN)

MANSWTOTHIRD (NE-SREF)

TIM (TRUNK)

FAPS (TRUNK)

MANUAL-REQ-SPAN (2R)

TIM-MON (TRUNK)
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Table 2-6

Alphabetical DWDM Alarm and Condition List (continued)

FAPS-CONFIG-MISMATCH (EQPT)

MANUAL-REQ-SPAN (ESCON)

TIM-P (TRUNK)

FC-NO-CREDITS (FC)

MANUAL-REQ-SPAN (FC)

TIM-S (TRUNK)

FC-NO-CREDITS (TRUNK)

MANUAL-REQ-SPAN (GE)

TRAIL-SIGNAL-FAIL (OCH)

FDI (OCH)

MANUAL-REQ-SPAN (ISC)

TRAIL-SIGNAL-FAIL (TRUNK)

FDI (OCH-TERM)

MANUAL-REQ-SPAN (OCN)

UNC-WORD (TRUNK)

FE-FRCDWKSWBK-SPAN (OCN)

MANUAL-REQ-SPAN (TRUNK)

UNEQ-P (STSMON, STSTRM)

FE-FRCDWKSWPR-SPAN (OCN)

MANWKSWBK-NO-TRFSW (OCN)

UNQUAL-PPM (PPM)

FE-MANWKSWBK-SPAN (OCN)

MANWKSWPR-NO-TRFSW (OCN)

UT-COMM-FAIL (TRUNK)

FE-MANWKSWPR-SPAN (OCN)

MEA (AIP)

UT-FAIL (TRUNK)

FEC-MISM (TRUNK)

MEA (EQPT)

VOA-HDEG (AOTS)

FEPRLF (OCN)

MEA (FAN)

VOA-HDEG (OCH)

FIBERTEMP-DEG (AOTS)

MEA (PPM)

VOA-HDEG (OMS)

FORCED-REQ (EQPT)

MEA (SHELF)

VOA-HDEG (OTS)

FORCED-REQ (STSMON)

MEM-GONE (EQPT)

VOA-HFAIL (AOTS)

FORCED-REQ (POS)

MEM-LOW (EQPT)

VOA-HFAIL (OCH)

FORCED-REQ-SPAN (2R)

MFGMEM (AICI-AEP)

VOA-HFAIL (OMS)

FORCED-REQ-SPAN (ESCON)

MFGMEM (AICI-AIE)

VOA-HFAIL (OTS)

FORCED-REQ-SPAN (FC)

MFGMEM (AIP)

VOA-LDEG (AOTS)

FORCED-REQ-SPAN (GE)

MFGMEM (BPLANE)

VOA-LDEG (OCH)

FORCED-REQ-SPAN (ISC)

MFGMEM (FAN)

VOA-LDEG (OMS)

FORCED-REQ-SPAN (OCN)

MFGMEM (PPM)

VOA-LDEG (OTS)

FORCED-REQ-SPAN (TRUNK)

MS-AIS (STMN)

VOA-LFAIL (AOTS)

FP-LINK-LOSS (EQPT)

MS-AIS (STM1E)

VOA-LFAIL (OCH)

FRCDSWTOINT (NE-SREF)

MS-DEG (STMN)

VOA-LFAIL (OMS)

FRCDSWTOPRI (EXT-SREF)

MS-DEG (STM1E)

VOA-LFAIL (OTS)

FRCDSWTOPRI (NE-SREF)

MS-EOC (STMN)

VOLT-MISM (PWR)

FRCDSWTOSEC (EXT-SREF)

MS-EXC (STMN)

WKSWBK (EQPT)

FRCDSWTOSEC (NE-SREF)

MS-EXC (STM1E)

WKSWBK (OCN)

FRCDSWTOTHIRD (EXT-SREF)

MS-RFI (STMN)

WKSWBK (OTS)

FRCDSWTOTHIRD (NE-SREF)

MS-RFI (STM1E)

WKSWPR (2R)

FRCDWKSWBK-NO-TRFSW (OCN)

MT-OCHNC (OTS)

WKSWPR (EQPT)

FRCDWKSWPR-NO-TRFSW (OCN)

NON-CISCO-PPM (PPM)

WKSWPR (ESCON)

FRNGSYNC (NE-SREF)

OCHNC-INC (OCHNC-CONN)

WKSWPR (FC)

FSTSYNC (NE-SREF)

OCHTERM-INC (OCH-TERM)

WKSWPR (GE)

FTA-MISMATCH (EQPT)

ODUK-1-AIS-PM (TRUNK)

WKSWPR (ISC)

GAIN-HDEG (AOTS)

ODUK-2-AIS-PM (TRUNK)

WORK-QUEUE-FULL (EQPT)

GAIN-HFAIL (AOTS)

ODUK-3-AIS-PM (TRUNK)

WTR (2R)
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Alphabetical DWDM Alarm and Condition List (continued)

GAIN-LDEG (AOTS)

ODUK-4-AIS-PM (TRUNK)

WTR (EQPT)

GAIN-LFAIL (AOTS)

ODUK-AIS-PM (TRUNK)

WTR (ESCON)

GCC-EOC (TRUNK)

ODUK-BDI-PM (TRUNK)

WTR (FC)

GE-OOSYNC (FC)

ODUK-LCK-PM (TRUNK)

WTR (GE)

GE-OOSYNC (GE)

ODUK-OCI-PM (TRUNK)

WTR (ISC)

GE-OOSYNC (ISC)

ODUK-SD-PM (TRUNK)

WTR (TRUNK)

GE-OOSYNC (TRUNK)

ODUK-SF-PM (TRUNK)

—

2.2 Logical Objects
The CTC alarm profile list organizes all alarms and conditions according to the logical objects they are
raised against. These logical objects represent physical objects such as cards, logical objects such as
circuits, or transport and signal monitoring entities such as the SONET or ITU-T G.709 optical overhead
bits. One alarm can appear in multiple entries. It can be raised against multiple objects. For example, the
loss of signal (LOS) alarm can be raised against the optical signal (OC-N) or the optical transport layer
overhead (OTN) as well as other objects. Therefore, both OCN: LOS and OTN: LOS appear in the list
(as well as the other objects).
Alarm profile list objects are defined in Table 2-7.

Note

Alarm logical object names can appear as abbreviated versions of standard terms used in the system and
the documentation. For example, the “OCN” logical object refers to the OC-N signal. Logical object
names or industry-standard terms are used within the entries as appropriate.

2.2.1 Alarm Logical Objects
Table 2-7 lists all logical alarm objects used in this chapter.
Table 2-7

Alarm Logical Object Type Definitions

Logical Object

Definition

2R

Reshape and retransmit (used for transponder [TXP] cards).

AICI-AEP

Alarm Interface Controller–International/alarm expansion panel. A combination
term that refers to this platform’s AIC-I card.

AICI-AIE

Alarm Interface Controller-International/Alarm Interface Extension. A
combination term that refers to this platform's AIC-I card.

AIP

Alarm Interface Panel.

AOTS

Amplified optical transport section.

BITS

Building integrated timing supply incoming references (BITS-1, BITS-2).

BPLANE

The backplane.

ENVALRM

An environmental alarm port.
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Table 2-7

Alarm Logical Object Type Definitions (continued)

Logical Object

Definition

EQPT

A card, its physical objects, and its logical objects as they are located in any of the
eight noncommon card slots. The EQPT object is used for alarms that refer to the
card itself and all other objects on the card including ports, lines, synchronous
transport signals (STS), and virtual tributaries (VT).

ESCON

Enterprise System Connection fiber optic technology, referring to the following
TXP cards: TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G,
MXPP_MR_2.5G.

EXT-SREF

BITS outgoing references (SYNC-BITS1, SYNC-BITS2).

FAN

Fan-tray assembly.

FC

Fibre channel data transfer architecture, referring to the following muxponder
(MXP) or TXP cards: MXP_MR_2.5G, MXPP_MR_2.5G, MXP_MR_10DME_C,
MXP_MR_10DME_L, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L

GE

Gigabit Ethernet, referring to the following MXP or TXP cards: MXP_MR_2.5G,
MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10G,
TXP_MR_10E,TXP_MR_10E_C, TXP_MR_10E_L, MXP_MR_10DME_C,
MXP_MR_10DME_L, GE-XP, 10GE-XP, ADM-10G.

ISC

Inter-service channel, referring to TXPP_MR_2.5G or TXP_MR_2.5G cards.

NE

The entire network element.

NE-SREF

The timing status of the NE.

OCH

The optical channel, referring to dense wavelength division multiplexing (DWDM)
cards.

OCH-TERM

The optical channel termination node, referring to DWDM cards.
The network element reports alarms or conditions on ingress ports of the card.
Alarms detected at the internal ports (TERM side) will be ingress mapped to the
MON side. The alarm profile entities of OCH-TERM, if available, should be
changed to the same severity as the customized severity for a specific OCH-TERM
alarm.

OCHNC-CONN

The optical channel network connection, referring to DWDM cards.

OMS

Optical multiplex section.

OSC-RING

Optical service channel ring.

OTS

Optical transport section.

PPM

Pluggable port module (PPM, also called SFP), referring to MXP and TXP cards.

PWR

Power equipment.

SHELF

The shelf assembly.

STSMON

STS alarm detection at the monitor point (upstream from the cross-connect).
Note

The network element reports alarms or conditions on ingress ports of the
card. Alarms detected at the internal ports (TERM side) will be ingress
mapped to the MON side. The alarm profile entities of STSMON, if
available, should be changed to the same severity as the customized severity
for a specific STS alarm.
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Table 2-7

Alarm Logical Object Type Definitions (continued)

Logical Object

Definition

STSTRM

STS alarm detection at termination (downstream from the cross-connect).
Note

The network element reports alarms or conditions on ingress ports of the
card. Alarms detected at the internal ports (TERM side) will be ingress
mapped to the MON side. The alarm profile entities of STSTRM, if
available, should be changed to the same severity as the customized severity
for a specific STS alarm.

TRUNK

The optical or DWDM card carrying the high-speed signal; referring to MXP or
TXP cards.

VT-MON

VT1 alarm detection at the monitor point (upstream from the cross-connect).
Note

The network element reports alarms or conditions on ingress ports of the
card. Alarms detected at the internal ports (TERM side) will be ingress
mapped to the MON side. The alarm profile entities of VT-MON, if
available, should be changed to the same severity as the customized severity
for a specific VT alarm.

2.2.2 Alarm List by Logical Object Type
Table 2-8 lists all Release 8.5 DWDM alarms and logical objects as they are given in the system alarm
profile. The list entries are organized by logical object name and then by alarm or condition name. Where
appropriate, the alarm entries also contain troubleshooting procedures.

Note

In a mixed network containing different types of nodes (for example, ONS 15310-CL, ONS 15454, and
ONS 15600), the initially displayed alarm list in the node view (single-shelf mode) or shelf view
(multishelf mode) Provisioning > Alarm Profiles tabs > Alarm Profile Editor tab lists all conditions that
are applicable to all nodes in the network. However, when you load the default severity profile from a
node, only applicable alarms will display severity levels. Nonapplicable alarms can display “use default”
or “unset.”

Note

In some cases this list does not follow alphabetical order, but it does reflect the order shown in CTC.

Table 2-8

Alarm List by Logical Object in Alarm Profile

2R: ALS (NA)

GE: MANUAL-REQ-SPAN (NA)

POS: GFP-CSF (MJ)

2R: AS-CMD (NA)

GE: OUT-OF-SYNC (MJ)

POS: GFP-LFD (MJ)

2R: AS-MT (NA)

GE: SIGLOSS (MJ)

PPM: AS-CMD (NA)

2R: FAILTOSW (NA)

GE: SQUELCHED (NA)

PPM: AS-MT (NA)

2R: FORCED-REQ-SPAN (NA)

GE: SYNCLOSS (MJ)

PPM: EQPT (CR)

2R: HI-LASERBIAS (MN)

GE: WKSWPR (NA)

PPM: HI-LASERBIAS (MN)

2R: HI-RXPOWER (MN)

GE: WTR (NA)

PPM: HI-LASERTEMP (MN)

2R: HI-TXPOWER (MN)

GFP-FAC: GFP-CSF (MJ)

PPM: HI-TXPOWER (MN)
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Table 2-8

Alarm List by Logical Object in Alarm Profile (continued)

2R: LO-RXPOWER (MN)

GFP-FAC: GFP-LFD (MJ)

PPM: IMPROPRMVL (CR)

2R: LO-TXPOWER (MN)

GFP-FAC: GFP-UP-MISMATCH (MJ)

PPM: LO-LASERBIAS (MN)

2R: LOCKOUT-REQ (NA)

ISC: ALS (NA)

PPM: LO-LASERTEMP (MN)

2R: LOS (CR)

ISC: AS-CMD (NA)

PPM: LO-TXPOWER (MN)

2R: MANUAL-REQ-SPAN (NA)

ISC: AS-MT (NA)

PPM: MEA (CR)

2R: SQUELCHED (NA)

ISC: CARLOSS (MJ)

PPM: MFGMEM (CR)

2R: WKSWPR (NA)

ISC: FAILTOSW (NA)

PPM: NON-CISCO-PPM (MN)

2R: WTR (NA)

ISC: FORCED-REQ-SPAN (NA)

PPM: PROV-MISMATCH (MN)

AICI-AEP: EQPT (CR)

ISC: GE-OOSYNC (CR)

PPM: UNQUAL-PPM (NR)

AICI-AEP: MFGMEM (CR)

ISC: HI-LASERBIAS (MN)

PWR: AS-CMD (NA)

AICI-AIE: EQPT (CR)

ISC: HI-RXPOWER (MN)

PWR: BAT-FAIL (MJ)

AICI-AIE: MFGMEM (CR)

ISC: HI-TXPOWER (MN)

PWR: EHIBATVG (MJ)

AIP: INVMACADR (MJ)

ISC: LO-RXPOWER (MN)

PWR: ELWBATVG (MJ)

AIP: MEA (CR)

ISC: LO-TXPOWER (MN)

PWR: HIBATVG (MJ)

AIP: MFGMEM (CR)

ISC: LOCKOUT-REQ (NA)

PWR: LWBATVG (MJ)

AOTS: ALS (NA)

ISC: LOS (CR)

PWR: VOLT-MISM (NA)

AOTS: AMPLI-INIT (NA)

ISC: LPBKFACILITY (NA)

SHELF: APC-DISABLED (MN)

AOTS: APC-CORR-SKIPPED (MN)

ISC: LPBKTERMINAL (NA)

SHELF: AS-CMD (NA)

AOTS: APC-DISABLED (MN)

ISC: MANUAL-REQ-SPAN (NA)

SHELF: AS-MT (NA)

AOTS: APC-OUT-OF-RANGE (MN)

ISC: OUT-OF-SYNC (NA)

SHELF: DUP-SHELF-ID (MJ)

AOTS: APC-WRONG-GAIN (NA)

ISC: SIGLOSS (MJ)

SHELF: MEA (MJ)

AOTS: AS-CMD (NA)

ISC: SQUELCHED (NA)

SHELF: SHELF-COMM-FAIL (MJ)

AOTS: AS-MT (NA)

ISC: SYNCLOSS (MJ)

STM1E: MS-AIS (NR)

AOTS: CASETEMP-DEG (MN)

ISC: WKSWPR (NA)

STM1E: MS-DEG (NA)

AOTS: FIBERTEMP-DEG (MN)

ISC: WTR (NA)

STM1E: MS-EXC (NA)

AOTS: GAIN-HDEG (MN)

ML100T: GFP-CSF (MJ)

STM1E: MS-RFI (NR)

AOTS: GAIN-HFAIL (CR)

ML100T: GFP-LFD (MJ)

STM1E: SD-L (NA)

AOTS: GAIN-LDEG (MN)

ML100T: GFP-UP-MISMATCH (MJ)

STM1E: SF-L (NA)

AOTS: GAIN-LFAIL (CR)

ML1000: GFP-CSF (MJ)

STMN: APSB (MN)

AOTS: LASER-APR (NA)

ML1000: GFP-LFD (MJ)

STMN: APSC-IMP (MN)

AOTS: LASERBIAS-DEG (MN)

ML1000: GFP-UP-MISMATCH (MJ)

STMN: APSCDFLTK (MN)

AOTS: LASERBIAS-FAIL (MJ)

MLMR: GFP-CSF (MJ)

STMN: APSCINCON (MN)

AOTS: LASERTEMP-DEG (MN)

MLMR: GFP-LFD (MJ)

STMN: APSCM (MN)

AOTS: OPWR-HDEG (MN)

MLMR: GFP-UP-MISMATCH (MJ)

STMN: APSCNMIS (MJ)

AOTS: OPWR-HFAIL (CR)

NE-SREF: FRCDSWTOINT (NA)

STMN: APSMM (MN)

AOTS: OPWR-LDEG (MN)

NE-SREF: FRCDSWTOPRI (NA)

STMN: AUTOLSROFF (CR)
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Table 2-8

Alarm List by Logical Object in Alarm Profile (continued)

AOTS: OPWR-LFAIL (CR)

NE-SREF: FRCDSWTOSEC (NA)

STMN: FE-FRCDWKSWBK-SPAN
(NA)

AOTS: OSRION (NA)

NE-SREF: FRCDSWTOTHIRD (NA)

STMN: FE-FRCDWKSWPR-SPAN
(NA)

AOTS: PARAM-MISM (NA)

NE-SREF: FRNGSYNC (NA)

STMN: FE-MANWKSWBK-SPAN (NA)

AOTS: VOA-HDEG (MN)

NE-SREF: FSTSYNC (NA)

STMN: FE-MANWKSWPR-SPAN (NA)

AOTS: VOA-HFAIL (CR)

NE-SREF: HLDOVRSYNC (NA)

STMN: FEPRLF (MN)

AOTS: VOA-LDEG (MN)

NE-SREF: MANSWTOINT (NA)

STMN: HELLO (MN)

AOTS: VOA-LFAIL (CR)

NE-SREF: MANSWTOPRI (NA)

STMN: ISIS-ADJ-FAIL (MN)

BITS: AIS (NR)

NE-SREF: MANSWTOSEC (NA)

STMN: LASEREOL (MN)

BITS: BPV (MN)

NE-SREF: MANSWTOTHIRD (NA)

STMN: LOCKOUT-REQ (NA)

BITS: HI-CCVOLT (NA)

NE-SREF: SSM-LNC (NA)

STMN: MANWKSWBK-NO-TRFSW
(NA)

BITS: LOF (MN)

NE-SREF: SSM-PRC (NA)

STMN: MANWKSWPR-NO-TRFSW
(NA)

BITS: LOS (MN)

NE-SREF: SSM-PRS (NA)

STMN: MS-AIS (NR)

BITS: SSM-DUS (NA)

NE-SREF: SSM-RES (NA)

STMN: MS-DEG (NA)

BITS: SSM-FAIL (MN)

NE-SREF: SSM-SDH-TN (NA)

STMN: MS-EOC (MN)

BITS: SSM-LNC (NA)

NE-SREF: SSM-SETS (NA)

STMN: MS-EXC (NA)

BITS: SSM-OFF (NA)

NE-SREF: SSM-SMC (NA)

STMN: MS-RFI (NR)

BITS: SSM-PRC (NA)

NE-SREF: SSM-ST2 (NA)

STMN: RS-EOC

BITS: SSM-PRS (NA)

NE-SREF: SSM-ST3 (NA)

STMN: RS-TIM

BITS: SSM-RES (NA)

NE-SREF: SSM-ST3E (NA)

STSMON: AIS-P (NR)

BITS: SSM-SDH-TN (NA)

NE-SREF: SSM-ST4 (NA)

STSMON: AUTOSW-AIS (NR)

BITS: SSM-SETS (NA)

NE-SREF: SSM-STU (NA)

STSMON: AUTOSW-LOP (NA)

BITS: SSM-SMC (NA)

NE-SREF: SSM-TNC (NA)

STSMON: AUTOSW-PDI (NA)

BITS: SSM-ST2 (NA)

NE-SREF: SWTOPRI (NA)

STSMON: AUTOSW-SDBER (NA)

BITS: SSM-ST3 (NA)

NE-SREF: SWTOSEC (NA)

STSMON: AUTOSW-SFBER (NA)

BITS: SSM-ST3E (NA)

NE-SREF: SWTOTHIRD (NA)

STSMON: AUTOSW-UNEQ (NA)

BITS: SSM-ST4 (NA)

NE-SREF: SYNCPRI (MJ)

STSMON: ERFI-P-CONN (NR)

BITS: SSM-STU (NA)

NE-SREF: SYNCSEC (MN)

STSMON: ERFI-P-SRVR (NR)

BITS: SSM-TNC (NA)

NE-SREF: SYNCTHIRD (MN)

STSMON: FAILTOSW-PATH (NA)

BITS: SYNC-FREQ (NA)

NE: APC-DISABLED (MN)

STSMON: FORCED-REQ (NA)

BPLANE: AS-CMD (NA)

NE: APC-END (NA)

STSMON: LOCKOUT-REQ (NA)

BPLANE: MFGMEM (CR)

NE: AS-CMD (NA)

STSMON: LOP-P (CR)

CE100T: GFP-CSF (MJ)

NE: AUD-LOG-LOSS (NA)

STSMON: LPBKCRS (NA)

CE100T: GFP-LFD (MJ)

NE: AUD-LOG-LOW (NA)

STSMON: PDI-P (NA)

CE100T: GFP-UP-MISMATCH (MJ)

NE: DATAFLT (MN)

STSMON: RFI-P (NA)
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Alarm List by Logical Object in Alarm Profile (continued)

CE1000: GFP-CSF (MJ)

NE: DBOSYNC (MJ)

STSMON: SD-P (NA)

CE1000: GFP-LFD (MJ)

NE: DUP-IPADDR (MN)

STSMON: SF-P (NA)

CE1000: GFP-UP-MISMATCH (MJ)

NE: DUP-NODENAME (MN)

STSMON: TIM-P (NA)

CEMR: GFP-CSF (MJ)

NE: ETH-LINKLOSS (NA)

STSMON: UNEQ-P (CR)

CEMR: GFP-LFD (MJ)

NE: HITEMP (CR)

STSTRM: AIS-P (NR)

CEMR: GFP-UP-MISMATCH (MJ)

NE: I-HITEMP (CR)

STSTRM: AS-MT-OOG (NA)

ENVALRM: EXT (MN)

NE: INTRUSION-PSWD (NA)

STSTRM: ENCAP-MISMATCH-P (CR)

EQPT: ALS-DISABLED (NA)

NE: LAN-POL-REV (NA)

STSTRM: ERFI-P-CONN (NR)

EQPT: APC-DISABLED (MN)

NE: SNTP-HOST (MN)

STSTRM: ERFI-P-SRVR (NR)

EQPT: AS-CMD (NA)

NE: SYSBOOT (MJ)

STSTRM: LOP-P (CR)

EQPT: AS-MT (NA)

NE: TEMP-MISM (NA)

STSTRM: PDI-P (NA)

EQPT: AUTORESET (MN)

OCH-TERM: FDI (NA)

STSTRM: RFI-P (NA)

EQPT: BKUPMEMP (CR)

OCH-TERM: OCHTERM-INC (NA)

STSTRM: SD-P (NA)

EQPT: CARLOSS (MJ)

OCH-TERM: OPWR-HDEG (MN)

STSTRM: SF-P (NA)

EQPT: CLDRESTART (NA)

OCH-TERM: OPWR-LDEG (MN)

STSTRM: TIM-P (NA)

EQPT: CONTBUS-DISABLED (CR)

OCH-TERM: OPWR-LFAIL (CR)

STSTRM: UNEQ-P (CR)

EQPT: CONTBUS-IO-A (CONTBUS-A) OCH-TERM: PARAM-MISM (NA)
(MN)

TRUNK: AIS (NR)

EQPT: CONTBUS-IO-B (CONTBUS-B)
(MN)

TRUNK: AIS-L (NR)

EQPT: CTNEQPT-MISMATCH (NA)

TRUNK: ALS (NA)

EQPT: DIAG (CR)

TRUNK: AS-CMD (NA)

EQPT: EQPT (CR)

TRUNK: AS-MT (NA)

EQPT: EXCCOL (MN)

OCH: APC-CORR-SKIPPED (MN)

TRUNK: CARLOSS (MJ)

EQPT: FAILTOSW (NA)

OCH: APC-DISABLED (MN)

TRUNK: DSP-COMM-FAIL (MJ)

EQPT: FAPS-CONFIG-MISMATCH
(MN)

OCH: APC-OUT-OF-RANGE (MN)

TRUNK: DSP-FAIL (MJ)

EQPT: FORCED-REQ (NA)

OCH: AS-CMD (NA)

TRUNK: EOC (MN)

EQPT: FP-LINK-LOSS (MN)

OCH: AS-MT (NA)

TRUNK: EOC-L (MN)

OCH: FDI (NA)

TRUNK: FAILTOSW (NA)

EQPT: FTA-MISMATCH (NA)

OCH: LOS-O (MN)

TRUNK: FAPS (NA)

EQPT: HI-LASERBIAS (MN)

OCH: LOS-P (CR)

TRUNK: FC-NO-CREDITS (MJ)

EQPT: HI-LASERTEMP (MN)

OCH: OPWR-HDEG (MN)

TRUNK: FEC-MISM (MJ)

EQPT: HI-TXPOWER (MN)

OCH: OPWR-HFAIL (CR)

TRUNK: FORCED-REQ-SPAN (NA)

EQPT: HITEMP (MN)

OCH: OPWR-LDEG (MN)

TRUNK: GCC-EOC (MN)

EQPT: IMPROPRMVL (CR)

OCH: OPWR-LFAIL (CR)

TRUNK: GE-OOSYNC (CR)

EQPT: INHSWPR (NA)

OCH: PARAM-MISM (NA)

TRUNK: HELLO (MN)

EQPT: INHSWWKG (NA)

OCH: PORT-FAIL (CR)

TRUNK: HI-LASERBIAS (MN)
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EQPT: LO-LASERBIAS (MN)

OCH: TRAIL-SIGNAL-FAIL (NA)

TRUNK: HI-RXPOWER (MN)

EQPT: LO-LASERTEMP (MN)

OCH: VOA-HDEG (MN)

TRUNK: HI-TXPOWER (MN)

EQPT: LO-TXPOWER (MN)

OCH: VOA-HFAIL (CR)

TRUNK: ILK-FAIL (CR)

EQPT: LOCKOUT-REQ (NA)

OCH: VOA-LDEG (MN)

TRUNK: ISIS-ADJ-FAIL (MN)

EQPT: MAN-REQ (NA)

OCH: VOA-LFAIL (CR)

TRUNK: LO-RXPOWER (MN)

EQPT: MANRESET (NA)

OCHNC-CONN: OCHNC-INC (NA)

TRUNK: LO-TXPOWER (MN)

EQPT: MEA (CR)

OCN: AIS-L (NR)

TRUNK: LOCKOUT-REQ (NA)

EQPT: MEM-GONE (MJ)

OCN: ALS (NA)

TRUNK: LOF (CR)

EQPT: MEM-LOW (MN)

OCN: APS-INV-PRIM (MN)

TRUNK: LOM (CR)

EQPT: OPEN-SLOT (NA)

OCN: APS-PRIM-FAC (NA)

TRUNK: LOS (CR)

EQPT: PEER-NORESPONSE (MJ)

OCN: APS-PRIM-SEC-MISM (MN)

TRUNK: LOS-P (CR)

EQPT: PROTNA (MN)

OCN: APSB (MN)

TRUNK: LPBKFACILITY (NA)

EQPT: PWR-FAIL-A (MN)

OCN: APSC-IMP (MN)

TRUNK: LPBKTERMINAL (NA)

EQPT: PWR-FAIL-B (MN)

OCN: APSCDFLTK (MN)

TRUNK: MANUAL-REQ-SPAN (NA)

EQPT: PWR-FAIL-RET-A (MN)

OCN: APSCINCON (MN)

TRUNK: ODUK-1-AIS-PM (NR)

EQPT: PWR-FAIL-RET-B (MN)

OCN: APSCM (MN)

TRUNK: ODUK-2-AIS-PM (NR)

EQPT: RS-EOC (MN)

OCN: APSCNMIS (MJ)

TRUNK: ODUK-3-AIS-PM (NR)

EQPT: RS-TIM (CR)

OCN: APSIMP (MN)

TRUNK: ODUK-4-AIS-PM (NR)

EQPT: RUNCFG-SAVENEED (NA)

OCN: APSMM (MN)

TRUNK: ODUK-AIS-PM (NR)

EQPT: SFTWDOWN (MN)

OCN: AS-CMD (NA)

TRUNK: ODUK-BDI-PM (NR)

EQPT: SW-MISMATCH (NA)

OCN: AS-MT (NA)

TRUNK: ODUK-LCK-PM (NR)

EQPT: UNEQ-P (CR)

OCN: AUTOLSROFF (CR)

TRUNK: ODUK-OCI-PM (NR)

EQPT: WKSWBK (NA)

OCN: CHANLOSS (NA)

TRUNK: ODUK-SD-PM (NA)

EQPT: WKSWPR (NA)

OCN: EOC (MN)

TRUNK: ODUK-SF-PM (NA)

EQPT: WORK-QUEUE-FULL (NA)

OCN: EOC-L (MN)

TRUNK: ODUK-TIM-PM (MJ)

EQPT: WTR (NA)

OCN: FAILTOSW (NA)

TRUNK: OTUK-AIS (NR)

ESCON: ALS (NA)

OCN: FE-FRCDWKSWBK-SPAN (NA)

TRUNK: OTUK-BDI (NR)

ESCON: AS-CMD (NA)

OCN: FE-FRCDWKSWPR-SPAN (NA)

TRUNK: OTUK-IAE (MN)

ESCON: AS-MT (NA)

OCN: FE-MANWKSWBK-SPAN (NA)

TRUNK: OTUK-LOF (CR)

ESCON: FAILTOSW (NA)

OCN: FE-MANWKSWPR-SPAN (NA)

TRUNK: OTUK-SD (NA)

ESCON: FORCED-REQ-SPAN (NA)

OCN: FEPRLF (MN)

TRUNK: OTUK-SF (NA)

ESCON: HI-LASERBIAS (MN)

OCN: FORCED-REQ-SPAN (NA)

TRUNK: OTUK-TIM (CR)

ESCON: HI-RXPOWER (MN)

OCN: FRCDWKSWBK-NO-TRFSW
(NA)

TRUNK: OUT-OF-SYNC (MJ)

ESCON: HI-TXPOWER (MN)

OCN: FRCDWKSWPR-NO-TRFSW
(NA)

TRUNK: PROV-MISMATCH (MJ)

ESCON: LO-RXPOWER (MN)

OCN: HELLO (MN)

TRUNK: PTIM (MJ)

ESCON: LO-TXPOWER (MN)

OCN: HI-LASERBIAS (MN)

TRUNK: RFI (NR)
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ESCON: LOCKOUT-REQ (NA)

OCN: HI-LASERTEMP (MN)

TRUNK: RFI-L (NR)

ESCON: LOS (CR)

OCN: HI-RXPOWER (MN)

TRUNK: SD (NA)

ESCON: LPBKFACILITY (NA)

OCN: HI-TXPOWER (MN)

TRUNK: SD-L (NA)

ESCON: LPBKTERMINAL (NA)

OCN: ISIS-ADJ-FAIL (MN)

TRUNK: SF (NA)

ESCON: MANUAL-REQ-SPAN (NA)

OCN: LASEREOL (MN)

TRUNK: SF-L (NA)

ESCON: SIGLOSS (MJ)

OCN: LOCKOUT-REQ (NA)

TRUNK: SIGLOSS (MJ)

ESCON: SQUELCHED (NA)

OCN: LO-LASERBIAS (MN)

TRUNK: SQUELCHED (NA)

ESCON: WKSWPR (NA)

OCN: LO-LASERTEMP (MN)

TRUNK: SSM-DUS (NA)

ESCON: WTR (NA)

OCN: LO-RXPOWER (MN)

TRUNK: SSM-FAIL (MN)

EXT-SREF: FRCDSWTOPRI (NA)

OCN: LO-TXPOWER (MN)

TRUNK: SSM-LNC (NA)

EXT-SREF: FRCDSWTOSEC (NA)

OCN: MANUAL-REQ-SPAN (NA)

TRUNK: SSM-OFF (NA)

EXT-SREF: FRCDSWTOTHIRD (NA)

OCN: MANWKSWBK-NO-TRFSW
(NA)

TRUNK: SSM-PRC (NA)

EXT-SREF: MANSWTOPRI (NA)

OCN: MANWKSWPR-NO-TRFSW
(NA)

TRUNK: SSM-PRS (NA)

EXT-SREF: MANSWTOSEC (NA)

OCN: RFI-L (NA)

TRUNK: SSM-RES (NA)

EXT-SREF: MANSWTOTHIRD (NA)

OCN: SD-L (NA)

TRUNK: SSM-SDH-TN (NA)

EXT-SREF: SWTOPRI (NA)

OCN: SF-L (NA)

TRUNK: SSM-SETS (NA)

EXT-SREF: SWTOSEC (NA)

OCN: SQUELCHED (NA)

TRUNK: SSM-SMC (NA)

EXT-SREF: SWTOTHIRD (NA)

OCN: TIM-S (CR)

TRUNK: SSM-ST2 (NA)

EXT-SREF: SYNCPRI (MN)

OMS: APC-DISABLED (MN)

TRUNK: SSM-ST3 (NA)

EXT-SREF: SYNCSEC (MN)

OMS: APC-CORR-SKIPPED (MN)

TRUNK: SSM-ST3E (NA)

EXT-SREF: SYNCTHIRD (MN)

OMS: APC-OUT-OF-RANGE (MN)

TRUNK: SSM-ST4 (NA)

FAN: EQPT-MISS (CR)

OMS: AS-CMD (NA)

TRUNK: SSM-STU (NA)

FAN: FAN (CR)

OMS: AS-MT (NA)

TRUNK: SSM-TNC (NA)

FAN: MEA (CR)

OMS: LOS-O (MN)

TRUNK: SYNC-FREQ (NA)

FAN: MFGMEM (CR)

OMS: LOS-P (CR)

TRUNK: SYNCLOSS (MJ)

FC: ALS (NA)

OMS: OPWR-HDEG (MN)

TRUNK: TIM (CR)

FC: AS-CMD (NA)

OMS: OPWR-HFAIL (CR)

TRUNK: TIM-MON (MN)

FC: AS-MT (NA)

OMS: OPWR-LDEG (MN)

TRUNK: TRAIL-SIGNAL-FAIL (NA)

FC: CARLOSS (MJ)

OMS: OPWR-LFAIL (CR)

TRUNK: UNC-WORD (NA)

FC: FAILTOSW (NA)

OMS: PARAM-MISM (NA)

TRUNK: UT-COMM-FAIL (MJ)

FC: FC-NO-CREDITS (MJ)

OMS: PMI (NA)

TRUNK: UT-FAIL (MJ)

FC: FORCED-REQ-SPAN (NA)

OMS: VOA-HDEG (MN)

TRUNK: WTR (NA)

FC: GE-OOSYNC (CR)

OMS: VOA-HFAIL (CR)

TRUNK: WVL-MISMATCH (MJ)

FC: HI-LASERBIAS (MN)

OMS: VOA-LDEG (MN)

VCMON-HP: AU-AIS (NR)

FC: HI-RXPOWER (MN)

OMS: VOA-LFAIL (CR)

VCMON-HP: AU-LOP (NA)
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FC: HI-TXPOWER (MN)

OSC-RING: RING-ID-MIS (MJ)

VCMON-HP: AUTOSW-AIS-SNCP
(NR)

FC: LO-RXPOWER (MN)

OTS: APC-CORR-SKIPPED (MN)

VCMON-HP: AUTOSW-LOP-SNCP
(NA)

FC: LO-TXPOWER (MN)

OTS: APC-DISABLED (MN)

VCMON-HP: AUTOSW-PDI-SNCP
(NA)

FC: LOCKOUT-REQ (NA)

OTS: APC-OUT-OF-RANGE (MN)

VCMON-HP: AUTOSW-SDBER-SNCP
(NA)

FC: LPBKFACILITY (NA)

OTS: AS-CMD (NA)

VCMON-HP: AUTOSW-SFBER-SNCP
(NA)

FC: LPBKTERMINAL (NA)

OTS: AS-MT (NA)

VCMON-HP: AUTOSW-UNEQ-SNCP
(NA)

FC: MANUAL-REQ-SPAN (NA)

OTS: AWG-DEG (MN)

VCMON-HP: FAILTOSW-HO (NA)

FC: OUT-OF-SYNC (MJ)

OTS: AWG-FAIL (CR)

VCMON-HP: FORCED-REQ (NA)

FC: SIGLOSS (MJ)

OTS: AWG-OVERTEMP (CR)

VCMON-HP: HP-DEG (NA)

FC: SQUELCHED (NA)

OTS: AWG-WARM-UP (NA)

VCMON-HP: HP-EXC (NA)

FC: SYNCLOSS (MJ)

OTS: DCU-LOSS-FAIL (MN)

VCMON-HP: HP-PLM (CR)

FC: WKSWPR (NA)

OTS: LASERBIAS-DEG (MN)

VCMON-HP: HP-RFI (NR)

FC: WTR (NA)

OTS: LOS (CR)

VCMON-HP: HP-TIM (MN)

FCMR: GFP-CSF (MJ)

OTS: LOS-O (MN)

VCMON-HP: HP-UNEQ (CR)

FCMR: GFP-LFD (MJ)

OTS: LOS-P (CR)

VCMON-HP: LOCKOUT-REQ (NA)

FCMR: GFP-UP-MISMATCH (MJ)

OTS: MT-OCHNC (NA)

VCMON-HP: LPBKCRS (NA)

GE: ALS (NA)

OTS: OPWR-HDEG (MN)

VCMON-HP: SFBER-EXCEED-HO
(NA)

GE: AS-CMD (NA)

OTS: OPWR-HFAIL (CR)

VCMON-LP: AUTOSW-AIS-SNCP
(NR)

GE: AS-MT (NA)

OTS: OPWR-LDEG (MN)

VCMON-LP: AUTOSW-LOP-SNCP
(NA)

GE: CARLOSS (MJ)

OTS: OPWR-LFAIL (CR)

VCMON-LP: AUTOSW-UNEQ-SNCP
(NA)

GE: FAILTOSW (NA)

OTS: OSRION (NA)

VCMON-LP: FORCED-REQ (NA)

GE: FORCED-REQ-SPAN (NA)

OTS: PARAM-MISM (NA)

VCMON-LP: LOCKOUT-REQ (NA)

GE: GE-OOSYNC (CR)

OTS: PMI (NA)

VCTRM-HP: AS-MT-OOG (NA)

GE: HI-LASERBIAS (MN)

OTS: SH-IL-VAR-DEG-HIGH (MN)

VCTRM-HP: AU-AIS (NR)

GE: HI-RXPOWER (MN)

OTS: SH-IL-VAR-DEG-LOW (MN)

VCTRM-HP: AU-LOP (CR)

GE: HI-TXPOWER (MN)

OTS: SHUTTER-OPEN (NA)

VCTRM-HP: HP-DEG (NA)

GE: LMP-FAIL (MN)

OTS: SPAN-NOT-MEASURED (NA)

VCTRM-HP: HP-ENCAP-MISMATCH
(CR)

GE: LMP-SD (MN)

OTS: SPANLEN-OUT-OF-RANGE
(MN)

VCTRM-HP: HP-EXC (NA)
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GE: LMP-SF (MN)

OTS: VOA-HDEG (MN)

VCTRM-HP: HP-PLM (CR)

GE: LMP-UNALLOC (NA)

OTS: VOA-HFAIL (CR)

VCTRM-HP: HP-TIM (CR)

GE: LO-RXPOWER (MN)

OTS: VOA-LDEG (MN)

VCTRM-HP: HP-UNEQ (CR)

GE: LO-TXPOWER (MN)

OTS: VOA-LFAIL (CR)

VCTRM-HP: SFBER-EXCEED-HO
(NA)

GE: LOCKOUT-REQ (NA)

OTS: WKSWBK (NA)

VCTRM-LP: AS-MT-OOG (NA)

GE: LPBKFACILITY (NA)

POS: ENCAP-MISMATCH-P (CR)

VCTRM-LP: SFBER-EXCEED-HO
(NA)

GE: LPBKTERMINAL (NA)

POS: FORCED-REQ (NA)

—

2.3 Trouble Characterizations
The ONS DWDM system reports trouble by utilizing standard alarm and condition characteristics,
standard severities following the rules in Telcordia GR-253-CORE, and graphical user interface (GUI)
state indicators.These notifications are described in the following paragraphs.
The ONS System uses standard Telcordia categories to characterize levels of trouble. The system reports
trouble notifications as alarms and status or descriptive notifications (if configured to do so) as
conditions in the CTC Alarms window. Alarms typically signify a problem that the user needs to remedy,
such as a loss of signal. Conditions do not necessarily require troubleshooting.

Note

Unless otherwise specified in this chapter, “ONS 15454” refers to both ANSI and ETSI versions of the
platform.

Note

For a description of CTC-view terminology, refer to the “Cisco Transport Controller Operation” chapter
in the Cisco ONS 15454 DWDM Reference Manual.

2.3.1 Alarm Characteristics
The ONS DWDM system uses standard alarm entities to identify what is causing trouble. All alarms
stem from hardware, software, environment, or operator-originated problems whether or not they affect
service. Current alarms for the network, CTC session, node, or card are listed in the Alarms tab. (In
addition, cleared alarms are also found in the History tab.)

2.3.2 Condition Characteristics
Conditions include any problem detected on an ONS DWDM shelf. They can include standing or
transient notifications. A snapshot of all current raised, standing conditions on the network, node, or card
can be retrieved in the CTC Conditions window or using TL1's set of RTRV-COND commands. (In
addition, some but not all cleared conditions are also found in the History tab.)
For a comprehensive list of all conditions, refer to the Cisco ONS SONET TL1 Command Guide. For
information about transients, see Chapter 3, “Transient Conditions.”
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Note

When an entity is put in the OOS,MT administrative state, the ONS 15454 suppresses all standing alarms
on that entity. You can retrieve alarms and events on the Conditions tab. You can change this behavior
for the LPBKFACILITY and LPBKTERMINAL alarms. To display these alarms on the Alarms tab, set
the NODE.general.ReportLoopbackConditionsOnPortsInOOS-MT to TRUE on the NE Defaults tab.

2.3.3 Severity
The ONS DWDM system uses Telcordia-devised standard severities for alarms and conditions:
Critical (CR), Major (MJ), Minor (MN), Not Alarmed (NA) and Not Reported (NR). These are
described below:
•

A Critical (CR) alarm generally indicates severe, Service-Affecting (SA) trouble that needs
immediate correction. Loss of traffic on an STS-1, which can hold 28 DS-1 circuits, would be a
Critical (CR), Service-Affecting (SA) alarm.

•

A Major (MJ) alarm is a serious alarm, but the trouble has less impact on the network. For example,
loss of traffic on more than five DS-1 circuits is Critical (CR), but loss of traffic on one to four DS-1
circuits is Major (MJ).

•

Minor (MN) alarms generally are those that do not affect service. For example, the automatic
protection switching (APS) byte failure (APSB) alarm indicates that line terminating equipment
(LTE) detects a byte failure on the signal that could prevent traffic from properly executing a traffic
switch.

•

Not Alarmed (NA) conditions are information indicators, such as for free-run synchronization state
(FRNGSYNC) or a forced-switch to primary (FRCSWTOPRI) timing event. They could or could
not require troubleshooting, as indicated in the entries.

•

Not Reported (NR) conditions occur as a secondary result of another event. For example, the alarm
indication signal (AIS), with severity NR, is inserted by a downstream node when an LOS (CR or
MJ) alarm occurs upstream. These conditions do not in themselves require troubleshooting, but are
to be expected in the presence of primary alarms.

Severities can be customized for an entire network or for single nodes, from the network level down to
the port level by changing or downloading customized alarm profiles. These custom severities are
subject to the standard severity-demoting rules given in Telcordia GR-474-CORE. Procedures for
customizing alarm severities are located in the “Manage Alarms” chapter in the Cisco ONS 15454
DWDM Procedure Guide.

2.3.4 Service Effect
Service-Affecting (SA) alarms—those that interrupt service—could be Critical (CR), Major (MJ), or
Minor (MN) severity alarms. Service-Affecting (SA) alarms indicate service is affected.
Non-Service-Affecting (NSA) alarms always have a Minor (MN) default severity.

2.3.5 State
The Alarms or History tab State (ST) column indicate the disposition of the alarm or condition as
follows:
•

A raised (R) event is one that is active.
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•

A cleared (C) event is one that is no longer active.

•

A transient (T) event is one that is automatically raised and cleared in CTC during system changes
such as user login, logout, loss of connection to node/shelf view, etc. Transient events do not require
user action. These are listed in Chapter 3, “Transient Conditions.”

2.4 Safety Summary
This section covers safety considerations designed to ensure safe operation of the ONS DWDM system.
Personnel should not perform any procedures in this chapter unless they understand all safety
precautions, practices, and warnings for the system equipment. Some troubleshooting procedures
require installation or removal of cards; in these instances users should pay close attention to the
following caution.

Caution

Hazardous voltage or energy could be present on the backplane when the system is operating. Use
caution when removing or installing cards.
Some troubleshooting procedures require installation or removal of OC-192 cards; in these instances
users should pay close attention to the following warnings.

Warning

On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Warning

Class 1 laser product. Statement 1008

Warning

Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed
circuitry could constitute an energy hazard. Statement 206

Warning

The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207
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2.5 Trouble-Clearing Procedures
This section list alarms alphabetically and includes some conditions commonly encountered when
troubleshooting alarms. The severity, description, and troubleshooting procedure accompany each alarm
and condition.

Note

When you check the status of alarms for cards, ensure that the alarm filter icon in the lower right corner
of the GUI is not indented. If it is, click it to turn it off. When you are done checking for alarms, you can
click the alarm filter icon again to turn filtering back on. For more information about alarm filtering,
refer to the “Manage Alarms” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Note

When checking alarms, ensure that alarm suppression is not enabled on the card or port. For more
information about alarm suppression, refer to the “Manage Alarms” chapter in the Cisco ONS 15454
DWDM Procedure Guide.

Note

When an entity is put in the OOS,MT administrative state, the ONS 15454 suppresses all standing alarms
on that entity. All alarms and events appear on the Conditions tab. You can change this behavior for the
LPBKFACILITY and LPBKTERMINAL alarms. To display these alarms on the Alarms tab, set the
NODE.general.ReportLoopbackConditionsOnPortsInOOS-MT to TRUE on the NE Defaults tab.

2.5.1 AIS
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Objects: BITS, FUDC, MSUDC
The Alarm Indication Signal (AIS) condition indicates that this node is detecting an alarm indication
signal in the incoming signal SONET overhead.
Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AIS Condition
Step 1

Determine whether there are alarms such as LOS on the upstream nodes and equipment or if there are
OOS,MT (or Locked,maintenance), or OOS,DSBLD (or Locked,disabled) ports.

Step 2

Clear the upstream alarms using the applicable procedures in this chapter.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.2 AIS-L
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
logical Objects: OCN, TRUNK
The AIS Line condition indicates that this node is detecting line-level AIS in the incoming signal. This
alarm is secondary to another alarm occurring simultaneously in an upstream node.
This condition can also be raised in conjunction with the “TIM-S” alarm if AIS-L is enabled. (For more
information about the TIM-S alarm, refer to the “Alarm Troubleshooting” chapter in the
Cisco ONS 15454 Troubleshooting Guide.

Note

ONS 15454 DS-3 terminal (inward) loopbacks do not transmit an AIS in the direction away from the
loopback. Instead of AIS, a continuance of the signal transmitted into the loopback is provided. A
DS3/EC1-48 card can be provisioned to transmit AIS for a terminal loopback.

Clear the AIS-L Condition
Step 1

Complete the “Clear the AIS Condition” procedure on page 2-26.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.3 AIS-P
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM
The AIS Path condition means that this node is detecting AIS in the incoming path. This alarm is
secondary to another alarm occurring simultaneously in an upstream node.

Clear the AIS-P Condition
Step 1

Complete the “Clear the AIS Condition” procedure on page 2-26.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.4 ALS
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, AOTS, ESCON, FC, GE, ISC, OCN, TRUNK
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The Automatic Laser Shutdown (ALS) condition occurs when an amplifier card (OPT-BST, or
OPT-PRE, OPT-AMP-C, or OMP-AMP-17-C) is switched on. The turn-on process lasts approximately
nine seconds, and the condition clears after approximately 10 seconds.

Note

ALS is an informational condition and does not require troubleshooting.

2.5.5 ALS-DISABLED
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Automatic Laser Shutdown (ALS) condition occurs when a DWDM Optical Preamplifier or Optical
Booster (OPT-BST) Amplifier card’s ALS is changed to Disabled from any other state (such as Enabled)
by user command.

Clear the ALS-DISABLED Condition
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-BST, or OPT-PRE,
OPT-AMP-C, or OMP-AMP-17-C card to display the card view.

Step 2

Click the Maintenance > ALS tabs.

Step 3

In the ALS Mode column, change the entry from Disabled to your required state.

Step 4

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.6 AMPLI-INIT
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: AOTS
The Amplifier Initialized condition occurs when an amplifier card (OPT-BST or OPT-PRE) is not able
to calculate gain. This condition typically accompanies the “APC-DISABLED” alarm on page 2-29.

Note

For basic information about amplifier cards, refer to the “Card Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual. For information abut gain, refer to the “Network
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the AMPLI-INIT Condition
Step 1

Complete the “Delete a Circuit” procedure on page 2-241 on the most recently created circuit.

Step 2

Recreate this circuit using the procedures in the “Create Channels and Circuits” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.
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Step 3

If the condition does not clear, log onto http://www.cisco.com/tac for more information or call TAC
(1-800-553-2447).

2.5.7 APC-CORR-SKIPPED
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OMS, OTS
The Automatic Power Control (APC) Correction Skipped condition occurs when the actual power level
of a DWDM channel exceeds the expected setting by 3 dBm or more. APC compares actual power levels
with previous power levels every hour or after any channel allocation is performed. If the power
difference to be compensated by APC exceeds the range of + 3 dBm or –3 dBm compared with the
previous value set, APC is designed not to correct the level and the APC-CORR-SKIPPED condition is
raised.
For more information about APC, refer to the “Network Reference” chapter in the Cisco ONS 15454
DWDM Reference Manual, and the “1.12.2 System Restart after a Fiber Cut” section on page 1-68.
The APC Correction Skipped alarm strongly limits network management (for example, a new circuit
cannot be turned into IS). The Force APC Correction button helps to restore normal conditions by
clearing the APC Correction Skipped alarm. For more information about the Force APC Correction
button, refer to the “Managing APC” section in “Network Reference” chapter of the Cisco ONS 15454
DWDM Reference Manual.

2.5.8 APC-DISABLED
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: NE, SHELF, AOTS, OTS, OMS, OCH, EQPT
The APC Disabled alarm occurs when the information related to the number of DWDM channels is not
reliable. The condition can occur when any of the following related alarms also occur: the “EQPT” alarm
on page 2-71, the “IMPROPRMVL” alarm on page 2-108, or the “MEA (EQPT)” alarm on page 2-155.
If the condition occurs with the creation of the first circuit, delete and recreate the circuit. (Refer to the
“Create Channels and Circuits” chapter of the Cisco ONS 15454 DWDM Procedure Guide for
information about this.) For more information about APC, refer to the “Network Reference” chapter in
the Cisco ONS 15454 DWDM Reference Manual.

Clear the APC-DISABLED Alarm
Step 1

Step 2

Complete the appropriate procedure to clear the main alarm:
•

Clear the EQPT Alarm, page 2-72

•

Clear the IMPROPRMVL Alarm, page 2-109

•

Clear the MEA (EQPT) Alarm, page 2-155

If the condition does not clear, complete the “Delete a Circuit” procedure on page 2-241 and then
recreate it using procedures in the “Create Channels and Circuits” chapter in the Cisco ONS 15454
DWDM Procedure Guide.
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Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.9 APC-END
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE
The APC Terminated on Manual Request condition is raised when APC terminates after it is manually
launched from CTC or TL1. APC-END is an informational condition that is raised and cleared
spontaneously by the system and is not visible in the CTC Condition window. It is visible only by
retrieving it in the Conditions or History tabs. For more information about APC, refer to the “Network
Reference” chapter in the Cisco ONS 15454 DWDM Reference Manual.

Note

APC-END is an informational condition and does not require troubleshooting.

2.5.10 APC-OUT-OF-RANGE
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OMS, OTS
The APC Out of Range condition is raised on amplifier cards (OPT-and OPT-BST); demultiplexer cards
() having a single variable optical attenuator (VOA); and optical add/drop multiplexer cards
(AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, and AD-4B-xx.x) when the requested gain or
attenuation setpoint cannot be set because it exceeds the port parameter range. For example, this
condition is raised when APC attempts to set the OPT-BST gain higher than 20 dBm (the card’s
maximum setpoint) or to set the attenuation on the express VOA lower than 0 dBm (its minimum
setpoint).

Note

A common cause of an amplifier trying to attain a value higher than the maximum setpoint or an
attenuator trying to attain a value lower than the minimum setpoint is the low input power.

Note

For general information about DWDM cards, refer to the “Card Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual. For more information about APC, refer to the “Network
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the APC-OUT-OF-RANGE Alarm
Step 1

There are various root causes for the APC-OUT-OF-RANGE condition. To determine the correct root
cause, complete the network-level troubleshooting procedures and node level problems located in
1.13 Node Level (Intranode) Problems of Chapter 1, “General Troubleshooting.”

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5

2-30

78-18342-02

Chapter 2

Alarm Troubleshooting
Trouble-Clearing Procedures

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.11 APC-WRONG-GAIN
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: AOTS
The APC-WRONG-GAIN condition is raised on the amplifier card (OMP-AMP-17-C), when the actual
gain of the card (17dB) does not match the expected gain calculated by APC. There is a margin of +1 or
-1 dB before the condition is raised.

Note

The APC-WRONG-GAIN condition indicates a system issue and not the card problem.

Clear the APC-WRONG-GAIN Alarm
The condition can be cleared by recovering the power at the input port:
Step 1

Check the incoming fiber connection and clean them.

Step 2

Check the regulation points (VOA and amplifiers) along the optical path upstream of the
OMP-AMP-17-C card.

Step 3

If the condition does not clear, log onto http://www.cisco.com/tac for more information or call TAC
(1-800-553-2447).

2.5.12 APSB
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN, STMN
The APS Channel Byte Failure alarm occurs when LTE detects protection switching byte failure or an
invalid switching code in the incoming APS signal. Some older SONET not manufactured by Cisco send
invalid APS codes if they are configured in a 1+1 protection group with newer SONET nodes, such as
the ONS 15454. These invalid codes cause an APSB alarm on an ONS 15454.

Clear the APSB Alarm
Step 1

Use an optical test set to examine the incoming SONET overhead to confirm inconsistent or invalid
K bytes. For specific procedures to use the test set equipment, consult the manufacturer. If corrupted
K bytes are confirmed and the upstream equipment is functioning properly, the upstream equipment
might not interoperate effectively with the ONS 15454.

Step 2

If the alarm does not clear and the overhead shows inconsistent or invalid K bytes, you could need to
replace the upstream cards for protection switching to operate properly. Complete the “Physically
Replace a Card” procedure on page 2-240.
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Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.13 APSCM
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN, STMN
The APS Channel Mismatch alarm occurs when the ONS 15454 expects a working channel but receives
a protect channel. In many cases, the working and protect channels are crossed and the protect channel
is active. If the fibers are crossed and the working line is active, the alarm does not occur. The APSCM
alarm occurs only on the ONS 15454 when bidirectional protection is used on OC-N cards in a 1+1
protection group configuration. The APSCM alarm does not occur in an optimized 1+1 protection
configuration.

Warning

On the ONS 15454 OC-192 card, the laser is on when the card is booted and the safety key is in the on
position (labeled 1). The port does not have to be in service for the laser to be on. The laser is off when
the safety key is off (labeled 0). Statement 293

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the APSCM Alarm
Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1

Verify that the working-card channel fibers are physically connected directly to the adjoining node’s
working-card channel fibers.

Step 2

If the fibers are correctly connected, verify that the protection-card channel fibers are physically
connected directly to the adjoining node’s protection-card channel fibers.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.
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2.5.14 APSIMP
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN, STMN
The APS Invalid Code alarm occurs if a 1+1 protection group is not properly configured at both nodes
to send or receive the correct APS byte. A node that is either configured for no protection or is configured
for path protection or BLSR protection does not send the right K2 APS byte anticipated by a system
configured for 1+1 protection. The 1+1 protect port monitors the incoming K2 APS byte and raises this
alarm if it does not receive the byte.
The alarm is superseded by an APSCM or APSMM alarm, but not by an AIS condition. It clears when
the port receives a valid code for 10 ms.

Clear the APSIMP Alarm
Step 1

Check the configuration of the other node in the 1+1 protection group. If the far end is not configured
for 1+1 protection, create the group. For procedures, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.

Step 2

If the other end of the group is properly configured or the alarm does not clear after you have provisioned
the group correctly, verify that the working ports and protect ports are cabled correctly.

Step 3

Ensure that both protect ports are configured for SONET.

Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.15 APS-INV-PRIM
Default Severity: Minor (MN), Non-Service Affecting (NSA)
Logical Object: OCN
The Optimized 1+1 APS Primary Facility condition occurs on OC-N cards in an optimized 1+1
protection system if the incoming primary section header does not indicate whether it is primary or
secondary.

Note

APS-INV-PRIM is an informational condition and does not require troubleshooting. If the APS switch
is related to other alarms, troubleshoot these alarms as necessary using the procedures in this chapter.

2.5.16 APSMM
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
SONET Logical Object: STMN
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An APS Mode Mismatch failure alarm occurs on OC-N cards when there is a mismatch of the protection
switching schemes at the two ends of the span, such as being bidirectional at one end and unidirectional
at the other. Each end of a span must be provisioned the same way: bidirectional and bidirectional, or
unidirectional and unidirectional. APSMM can also occur if third-party equipment is provisioned as 1:N
and the ONS 15454 is provisioned as 1+1.
If one end is provisioned for 1+1 protection switching and the other is provisioned for path protection
protection switching, an APSMM alarm occurs in the ONS 15454 that is provisioned for 1+1 protection
switching.

Clear the APSMM Alarm
Step 1

For the reporting ONS 15454, display node view and verify the protection scheme provisioning:
a.

Click the Provisioning > Protection tabs.

b.

Click the 1+1 protection group configured for the OC-N cards.
The chosen protection group is the protection group optically connected (with data communications
channel, or DCC, connectivity) to the far end.

c.

Click Edit.

d.

Record whether the Bidirectional Switching check box is checked.

Step 2

Click OK in the Edit Protection Group dialog box.

Step 3

Log into the far-end node and verify that the OC-N 1+1 protection group is provisioned.

Step 4

Verify that the Bidirectional Switching check box matches the checked or unchecked condition of the
box recorded in Step 1. If not, change it to match.

Step 5

Click Apply.

Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.17 APS-PRIM-FAC
Default Severity: Not Alarmed (NA), Non-Service Affecting (NSA)
Logical Object: OCN
The Optimized 1+1 APS Invalid Primary Section condition occurs on OC-N cards in an optimized 1+1
protection system if there is an APS status switch between the primary and secondary facilities to
identify which port is primary.

Note

APS-PRIM-FAC is an informational condition and does not require troubleshooting. If the APS switch
is related to other alarms, troubleshoot these alarms as necessary using the procedures in this chapter.

Clear the APS-PRIM-FAC Condition
Step 1

This condition clears when the card receives a valid primary section indication (1 or 2).
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Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.18 APS-PRIM-SEC-MISM
Default Severity: Minor (MN), Non-Service Affecting (NSA)
Logical Object: OCN
The Optimized 1+1 APS Primary Section Mismatch condition occurs on OC-N cards in an optimized
1+1 protection system if there is a mismatch between the primary section of the local node facility and
the primary section of the remote-node facility.

Clear the APS-PRIM-SEC-MISM Alarm
Step 1

Ensure that the local node and remote-node ports are correctly provisioned the same way. For more
information about optimized 1+1 configurations, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 Procedure Guide.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.19 AS-CMD
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, AOTS, BPLANE, EQPT, ESCON, FC, GE, ISC, NE, OCH, OCN/STMN,
OMS, OTS, PPM, PWR, SHELF, TRUNK
The Alarms Suppressed by User Command condition applies to the network element (NE object),
backplane (BPLANE object), a single MXP or TXP card, or a port on one of these cards. It occurs when
alarms are suppressed for that object and its subordinate objects. For example, suppressing alarms on a
card also suppresses alarms on its ports.

Note

For more information about suppressing alarms, refer to the “Manage Alarms” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

Note

This condition is not raised for multiservice transport platform (MSTP) cards such as amplifiers,
multiplexers, or demultiplexers.

Clear the AS-CMD Condition
Step 1

For all nodes, in node view (single-shelf mode) or shelf view (multishelf mode), click the Conditions tab.

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5
78-18342-02

2-35

Chapter 2

Alarm Troubleshooting

Trouble-Clearing Procedures

Step 2

Step 3

Click Retrieve. If you have already retrieved conditions, look under the Object column and Eqpt Type
column and note what entity the condition is reported against, such as a port, slot, or shelf.
•

If the condition is reported against a slot and card, alarms were either suppressed for the entire card
or for one of the ports. Note the slot number and continue with Step 3.

•

If the condition is reported against the backplane, go to Step 7.

•

If the condition is reported against the NE object, go to Step 8.

Determine whether alarms are suppressed for a port and if so, raise the suppressed alarms:
a.

Double-click the card to open the card view.

b.

Click the Provisioning > Alarm Profiles > Alarm Behavior tabs and complete one of the following
substeps:
•

If the Suppress Alarms column check box is checked for a port row, deselect it and click Apply.

•

If the Suppress Alarms column check box is not checked for a port row, from the View menu
choose Go to Previous View.

Step 4

If the AS-CMD condition is reported for a card and not an individual port, in node view (single-shelf
mode) or shelf view (multishelf mode), click the Provisioning > Alarm Profiles > Alarm Behavior tabs.

Step 5

Locate the row number for the reported card slot.

Step 6

Click the Suppress Alarms column check box to deselect the option for the card row.

Step 7

If the condition is reported for the backplane, the alarms are suppressed for cards such as the ONS 15454
AIP that are not in the optical or electrical slots. To clear the alarm, complete the following steps:

Step 8

Step 9

a.

Click the Provisioning > Alarm Profiles > Alarm Behavior tabs.

b.

In the backplane row, uncheck the Suppress Alarms column check box.

c.

Click Apply.

If the condition is reported for the shelf, cards and other equipment are affected. To clear the alarm,
complete the following steps:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Alarm
Profiles > Alarm Behavior tabs if you have not already done so.

b.

Click the Suppress Alarms check box located at the bottom of the window to deselect the option.

c.

Click Apply.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.20 AS-MT
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, AOTS, EQPT, ESCON, FC, GE, ISC, OCH, OCN/STMN, OMS, OTS, PPM,
SHELF, TRUNK
The Alarms Suppressed for Maintenance Command condition applies to MXP or TXP cards and occurs
when a client or trunk port is placed in the Out-of-Service and Management,
Maintenance (OOS-MA,MT or Locked,enabled, loopback & maintenance) service state for loopback
testing operations.
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Clear the AS-MT Condition
Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-242.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.21 AU-AIS
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCTRM-HP
An AU AIS condition applies to the administration unit, which consists of the virtual container (VC)
capacity and pointer bytes (H1, H2, and H3) in the SDH frame.
Generally, any AIS is a special SDH signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AU-AIS Condition
Step 1

Complete the “Clear the AIS Condition” procedure on page 2-26.

Step 2

If the condition does not clear, complete the “Clear the APSB Alarm” procedure on page 2-31.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.22 AU-LOP
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: VCMON-HP, VCTRM-HP
An AU-LOP alarm indicates that the SDH high order path overhead section of the administration unit
has detected a loss of path. AU-LOP occurs when there is a mismatch between the expected and
provisioned circuit size. For the TXP card, an AU-LOP is raised if a port is configured for an SDH signal
but receives a SDH signal instead. (This information is contained in the H1 byte bits 5 and 6.)

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
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Warning

Note

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

For more information about MXP and TXP cards, refer to the Cisco ONS 15454 SDH Reference Manual.

Clear the AU-LOP Alarm
Step 1

In node view, click the Circuits tab and view the alarmed circuit.

Step 2

Verify that the correct circuit size is listed in the Size column. If the size is different from what is
expected, such as a VC4-4c instead of a VC4, this causes the alarm.

Step 3

If you have been monitoring the circuit with optical test equipment, a mismatch between the provisioned
circuit size and the size expected by the test set can cause this alarm. Ensure that the test set monitoring
is set up for the same size as the circuit provisioning. For specific procedures to use the test set
equipment, consult the manufacturer.

Step 4

If you have not been using a test set, or if the test set is correctly set up, the error is in the provisioned
CTC circuit size. Complete the “Delete a Circuit” procedure on page 2-241.

Step 5

Recreate the circuit for the correct size. For procedures, refer to the “Create Circuits and Tunnels”
chapter in the Cisco ONS 15454 Procedure Guide.

Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country in order to report a
Service-Affecting (SA) problem.

2.5.23 AUTOLSROFF
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: STMN
The Auto Laser Shutdown alarm occurs when the STM-64 card temperature exceeds 194 degrees F
(90 degrees C). The internal equipment automatically shuts down the STM-64 laser when the card
temperature rises to prevent the card from self-destructing.

Warning

On the OC192 LR/STM64 LH 1550 card, the laser is on when the card is booted and the safety key is in
the on position (labeled 1). The port does not have to be in service for the laser to be on. The laser is
off when the safety key is off (labeled 0). Statement 293.

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
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Warning

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Clear the AUTOLSROFF Alarm
Step 1

View the temperature displayed on the ONS 15454 LCD front panel (Figure 2-2).
Figure 2-2 shows the shelf LCD panel.

Slot

Shelf LCD Panel

Status

Port

8/18/03
24˚C
04.06-002L-10
FAN FAIL

CRIT

MAJ

MIN

97758

Figure 2-1

Step 2

If the temperature of the shelf exceeds 194 degrees F (90 degrees C), the alarm should clear if you solve
the ONS 15454 temperature problem. Complete the “Clear the HITEMP Alarm” procedure on
page 2-99.

Step 3

If the temperature of the shelf is under 194 degrees F (90 degrees C), the HITEMP alarm is not the cause
of the AUTOLSROFF alarm. Complete the “Physically Replace a Card” procedure on page 2-240 for the
OC-192 card.

When you replace a card with the identical type of card, you do not need to make any changes
to the database.

Note

Step 4

If card replacement does not clear the alarm, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country in order to report a Service-Affecting (SA) problem.

2.5.24 AUTORESET
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Automatic System Reset alarm occurs when you change an IP address or perform any other
operation that causes an automatic card-level reboot. AUTORESET typically clears after a card reboots
(up to ten minutes).
Resets performed during a software upgrade also prompt the condition. This condition clears
automatically when the card finishes resetting. If the alarm does not clear, complete the following
procedure.
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Clear the AUTORESET Alarm
Step 1

Determine whether there are additional alarms that could have triggered an automatic reset. If there are,
troubleshoot these alarms using the applicable section of this chapter.

Step 2

If the card automatically resets more than once a month with no apparent cause, complete the “Physically
Replace a Card” procedure on page 2-240.

Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.25 AUTOSW-AIS
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STSMON, VT-MON
The Automatic Path Protection Switch Caused by an AIS condition indicates that automatic path
protection switching occurred because of an AIS condition. If the path protection is configured for
revertive switching, it reverts to the working path after the fault clears. The AIS also clears when the
upstream trouble is cleared.

Note

This condition is only reported if the path protection is set up for revertive switching.
Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AUTOSW-AIS Condition
Step 1

Complete the “Clear the AIS Condition” procedure on page 2-26.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.26 AUTOSW-AIS-SNCP
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCMON-LP
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The Automatic path protection Switch Caused by an AIS condition indicates that automatic path
protection protection switching occurred because of the TU-AIS condition. If the path protection ring is
configured for revertive switching, it switches back to the working path after the fault clears. The
AUTOSW-AIS-path protection clears when you clear the primary alarm on the upstream node.

Note

This condition is only reported if the SNCP is set up for revertive switching.
Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the AUTOSW-AIS-path protection Condition
Step 1

Complete the “Clear the AIS Condition” procedure on page 2-26.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.27 AUTOSW-LOP (STSMON)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON
The Automatic Path Protection Switch Caused by LOP condition for the STS monitor (STSMON)
indicates that automatic path protection switching occurred because of the “LOP-P” alarm on
page 2-130. If the path protection is configured for revertive switching, it reverts to the working path
after the fault clears.

Note

This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-LOP (STSMON) Condition
Step 1

Complete the “Clear the LOP-P Alarm” procedure on page 2-130.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.28 AUTOSW-LOP-SNCP
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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Logical Object: VCMON-HP, VCMON-LP
An Automatic path protection Switch Caused by LOP alarm indicates that an automatic path protection
protection switching occurred because of the “AU-LOP” alarm, page 2-37. If the path protection ring is
configured for revertive switching, it switches back to the working path after the fault clears.

Note

This condition is only reported if the SNCP is set up for revertive switching.

Clear the AUTOSW-LOP-SNCP Alarm
Step 1

Complete the “Clear the AU-LOP Alarm” procedure on page 2-38.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country.

2.5.29 AUTOSW-PDI
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, VT-MON
The Automatic Path Protection Switch Caused by Payload Defect Indication (PDI) condition indicates
that automatic path protection switching occurred because of a “PDI-P” alarm on page 2-183. If the path
protection is configured for revertive switching, it reverts to the working path after the fault clears.

Note

This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-PDI Condition
Step 1

Complete the “Clear the PDI-P Condition” procedure on page 2-184.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.30 AUTOSW-PDI-SNCP
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCMON-LP
The Automatic path protection Switch Caused by Payload Defect Indication (PDI) condition indicates
that automatic path protection protection switching occurred because of a PDI alarm. If the path
protection is configured for revertive switching, it reverts to the working path after the fault clears.
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Note

This condition is only reported if the SNCP is set up for revertive switching.

Clear the AUTOSW-PDI-SNCP Condition
Step 1

Complete the “Clear the PDI-P Condition” section on page 2-184.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.31 AUTOSW-SDBER
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, VT-MON
The Automatic Path Protection Switch Caused by Signal Degrade Bit Error Rate (SDBER) condition
indicates that a “SD-P” condition on page 2-199 caused automatic path protection switching to occur. If
the path protection is configured for revertive switching, the path protection reverts to the working path
when the SD-P is resolved.

Note

This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-SDBER Condition
Step 1

Complete the “Clear the SD-P Condition” procedure on page 2-199.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.32 AUTOSW-SDBER-SNCP
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCMON-LP
The Automatic path protection Switch Caused by Signal Degrade Bit Error Rate (SDBER) condition
indicates that a signal degrade caused automatic path protection protection switching to occur. If the path
protection ring is configured for revertive switching, it reverts to the working path when the SD is
resolved.

Note

This condition is only reported if the SNCP is set up for revertive switching.
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Clear the AUTOSW-SDBER-SNCP Condition
Step 1

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-197.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.33 AUTOSW-SFBER
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, VT-MON
The Automatic USPR Switch Caused by Signal Fail Bit Error Rate (SFBER) condition indicates that a
“SF-P” condition on page 2-202 caused automatic path protection switching to occur. If the path
protection is configured for revertive switching, the path protection reverts to the working path when the
SF-P is resolved.

Note

This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-SFBER Condition
Step 1

Complete the “Clear the SF-P Condition” procedure on page 2-202.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.34 AUTOSW-SFBER-SNCP
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCMON-LP
The Automatic path protection Switch Caused by Signal Fail Bit Error Rate (SFBER) condition indicates
that a signal fail caused automatic path protection protection switching to occur. If the path protection
ring is configured for revertive switching, it reverts to the working path when the SF is resolved.

Note

This condition is only reported if the SNCP is set up for revertive switching.

Clear the AUTOSW-SFBER-SNCP Condition
Step 1

Complete the “Clear the SF (TRUNK) Condition” procedure on page 2-201.
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.35 AUTOSW-UNEQ (STSMON)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON
The Automatic Path Protection Switch Caused by Unequipped condition indicates that an “UNEQ-P”
alarm on page 2-223, caused automatic path protection switching to occur. If the path protection is
configured for revertive switching, it reverts to the working path after the fault clears.

Note

This condition is only reported if the path protection is set up for revertive switching.

Clear the AUTOSW-UNEQ (STSMON) Condition
Step 1

Complete the “Clear the UNEQ-P Alarm” procedure on page 2-223.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.36 AUTOSW-UNEQ-SNCP (VCMON-HP)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP
The Automatic path protection Switch Caused by an Unequipped condition indicates that an HP-UNEQ
alarm caused automatic path protection protection switching to occur (see the “HP-UNEQ” alarm,
page 2-106). If the path protection ring is configured for revertive switching, it reverts to the working
path after the fault clears.

Warning

Class 1 laser product. Statement 1008

Warning

Class 1M laser radiation when open. Do not view directly with optical instruments. Statement 1053

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
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Warning

Note

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

This condition is only reported if the SNCP is set up for revertive switching.

Clear the AUTOSW-UNEQ-SNCP (VCMON-HP) Condition
Step 1

Complete the “Clear the HP-UNEQ Alarm” procedure on page 2-106.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country.

2.5.37 AWG-DEG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OTS
The Arrayed Waveguide Gratings (AWG) Degrade alarm occurs when a 32MUX-O, 40MUX, 32WSS-O,
40WSSC-C, 32DMX-O, 32DMX, or 40DMX card heater-control circuit degrades. The heat variance can
cause slight wavelength drift. The card does not need to be replaced immediately, but it should be at the
next opportunity.

Note

For General information about 32MUX-O, 40MUX, 32WSS-O, 40WSSC-C, 32DMX-O, 32DMX, and
40DMX cards, refer to the “Card Reference” chapter of the Cisco ONS 15454 DWDM Reference
Manual. For more information about changing their settings, refer to the “Change DWDM Card
Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the AWG-DEG Alarm
Step 1

For the alarmed 32MUX-O, 40MUX, 32WSS-O, 40WSSC-C, 32DMX-O, 32DMX, or 40DMX card,
complete the “Physically Replace a Card” procedure on page 2-240 at the next opportunity.

Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.38 AWG-FAIL
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OTS
The AWG Failure alarm occurs when a 32MUX-O, 40MUX, 32WSS-O, 40WSSC-C, 32DMX-O,
32DMX, or 40DMX card heater-control circuit completely fails. The circuit failure disables wavelength
transmission. The card must be replaced to restore traffic.

Note

For general information about 32MUX-O, 40MUX, 32WSS-O, 40WSSC-C, 32DMX-O, 32DMX, and
40DMX cards, refer to the “Card Reference” chapter of the Cisco ONS 15454 DWDM Reference
Manual. For information about changing their settings, refer to the “Change DWDM Card Settings”
chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the AWG-FAIL Alarm
Step 1

For the alarmed 32MUX-O, 40MUX, 32WSS-O, 40WSSC-C, 32DMX-O, 32DMX, or 40DMX card,
complete the “Physically Replace a Card” procedure on page 2-240.

Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.

2.5.39 AWG-OVERTEMP
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OTS
The AWG Over Temperature alarm is raised if a 32MUX-O, 40MUX, 32WSS-O, 40WSSC-C,
32DMX-O, 32DMX, or 40DMX card having an AWG-FAIL alarm is not replaced and its heater-control
circuit temperature exceeds 212 degrees F (100 degrees C). The card goes into protect mode and the
heater is disabled.

Note

For general information about these cards, refer to the “Card Reference” chapter in the Cisco ONS 15454
DWDM Reference Manual. For information about changing their settings, refer to the “Change DWDM
Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the AWG-OVERTEMP Alarm
Step 1

Complete the “Clear the AWG-FAIL Alarm” procedure on page 2-47.
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Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.

2.5.40 AWG-WARM-UP
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: OTS
The AWG Warm-Up condition occurs when a 32MUX-O, 40MUX, 32WSS-O, 40WSSC-C, 32DMX-O,
32DMX, or 40DMX card heater-control circuit is attaining its operating temperature during startup. The
condition lasts approximately 10 minutes but can vary somewhat from this period due to environmental
temperature.

Note

AWG-WARM-UP is an informational condition and does not require troubleshooting.

2.5.41 BAT-FAIL
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: PWR
The Battery Fail alarm occurs when one of the two power supplies (A or B) is not detected. This could
be because the supply is removed or is not operational. The alarm does not distinguish between the
individual power supplies, so onsite information about the conditions is necessary for troubleshooting.

Clear the BAT-FAIL Alarm
Step 1

At the site, determine which battery is not present or operational.

Step 2

Remove the power cable from the faulty supply. For procedures, refer to the “Install the Shelf and
Common Control Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide. Reverse the power
cable installation procedure.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.42 BKUPMEMP
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: EQPT
The Primary Nonvolatile Backup Memory Failure alarm refers to a problem with the TCC2/TCC2P card
flash memory. The alarm occurs when the TCC2/TCC2P card is in use and has one of four problems:
•

Flash manager fails to format a flash partition.
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•

Flash manager fails to write a file to a flash partition.

•

Problem at the driver level.

•

Code volume fails cyclic redundancy checking (CRC, which is a method to verify for errors in data
transmitted to the TCC2/TCC2P card).

The BKUPMEMP alarm can also cause the “EQPT” alarm, page 2-71. If the EQPT alarm is caused by
BKUPMEMP, complete the following procedure to clear the BKUPMEMP and the EQPT alarm.

Caution

A software update on a standby TCC2/TCC2P card can take up to 30 minutes.

Clear the BKUPMEMP Alarm
Step 1

Verify that both TCC2/TCC2P cards are powered and enabled by confirming lighted ACT/SBY LEDs
on the TCC2/TCC2P cards.

Step 2

Determine whether the active or standby TCC2/TCC2P card has the alarm.

Step 3

If both TCC2/TCC2P cards are powered and enabled, reset the TCC2/TCC2P card where the alarm is
raised. If the card is the active TCC2/TCC2P card, complete the “Reset an Active TCC2/TCC2P Card
and Activate the Standby Card” procedure on page 2-238. If the card is the standby TCC2/TCC2P card:

Step 4

Warning

a.

Right-click the standby TCC2/TCC2P card in CTC.

b.

Choose Reset Card from the shortcut menu.

c.

Click Yes in the Are You Sure dialog box. The card resets, the FAIL LED blinks on the physical card.

d.

Wait ten minutes to verify that the card you reset completely reboots.

If the TCC2/TCC2P card you reset does not reboot successfully, or the alarm has not cleared, call
Cisco TAC (1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the
“Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-239. If the
Cisco TAC technician tells you to remove the card and reinstall a new one, follow the “Physically
Replace a Card” procedure on page 2-240.

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

2.5.43 BPV
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: BITS
The 64K Clock Bipolar Density Violation alarm is raised on the TCC2P card if there is a frequency
variation in the 8K BITS clock.
The TCC2P card contains an 8K clock and a 64K clock. Each has some bipolar variation, which is
normal. This alarm is raised on the 8K clock if that variation discontinues. The BPV alarm is demoted
by an LOF or LOS against the BITS clock.

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5
78-18342-02

2-49

Chapter 2

Alarm Troubleshooting

Trouble-Clearing Procedures

Note

This alarm is not raised on the TCC2 card.

Clear the BPV Alarm
Step 1

Reestablish a normal BITS input signal to clear the alarm. Clear any alarms on the incoming signal or
against the BITS timing sources.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.44 CARLOSS (EQPT)
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: EQPT
A Carrier Loss on the LAN Equipment alarm generally occurs on MXP, TXP, or ADM-10G cards when
the ONS system and the workstation hosting CTC do not have a TCP/IP connection. The problem
involves the LAN or data circuit used by the RJ-45 (LAN) connector on the TCC2/TCC2P card or the
LAN backplane pin connection. This CARLOSS alarm does not involve an Ethernet circuit connected
to an Ethernet port. The problem is in the connection and not CTC or the node.
On TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, and MXP_2.5G_10G cards, CARLOSS is also
raised against trunk ports when ITU-T G.709 encapsulation is turned off.
A TXP_MR_2.5G card can raise a CARLOSS alarm when the payload is incorrectly configured for the
10 Gigabit Ethernet or 1 Gigabit Ethernet payload data types.

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Note

For more information about provisioning MXP or TXP PPMs (also called SFPs), refer to the “Turn Up
a Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For PPM (SFP) specifications, refer
to the “Hardware Specifications” appendix in the Cisco ONS 15454 DWDM Reference Manual. For
more information about MRC-12 and OC192-XFP/STM64-XFP cards, refer to the “Optical Cards”
chapter in the Cisco ONS 15454 Reference Manual.
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Note

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the CARLOSS (EQPT) Alarm
Step 1

If the reporting card is an MXP or TXP card in an ONS 15454 node, verify the data rate configured on
the PPM (also called SFP):
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting MXP or
TXP card.

b.

Click the Provisioning > Pluggable Port Modules tabs.

c.

View the Pluggable Port Modules area port listing in the Actual Equipment Type column and
compare this with the contents of the Selected PPM area Rate column for the MXP or TXP multirate
port.

d.

If the rate does not match the actual equipment, you must delete and recreate the selected PPM.
Select the PPM (SFP), click Delete, then click Create and choose the correct rate for the port rate.

Note

For more information about provisioning PPMs (SFPs), refer to the “Turn Up a Node”
chapter of the Cisco ONS 15454 DWDM Procedure Guide. For PPM (SFP) specifications,
refer to the “Hardware Specifications” appendix in the Cisco ONS 15454 DWDM Reference
Manual.

Step 2

If the reporting card is an OC-N/STM-N card, verify connectivity by pinging the ONS system that is
reporting the alarm by completing the “1.6.8 Verify PC Connection to the ONS 15454 (ping)” procedure
on page 1-40.

Step 3

If the ping is successful, it demonstrates that an active TCP/IP connection exists. Restart CTC:
a.

Exit from CTC.

b.

Reopen the browser.

c.

Log into CTC.

Step 4

Using optical test equipment, verify that proper receive levels are achieved. (For instructions about using
optical test equipment, refer to the manufacturer documentation.)

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 5

Verify that the optical LAN cable is properly connected and attached to the correct port. For more
information about fiber connections and terminations, refer to the “Turn Up a Node” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

Step 6

If the fiber cable is properly connected and attached to the port, verify that the cable connects the card
to another Ethernet device and is not misconnected to an OC-N/STM-N card.

Step 7

If you are unable to establish connectivity, replace the fiber cable with a new known-good cable. To do
this, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.
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Step 8

If you are unable to establish connectivity, perform standard network or LAN diagnostics. For example,
trace the IP route, verify cable continuity, and troubleshoot any routers between the node and CTC. To
verify cable continuity, follow site practices.

Step 9

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.45 CARLOSS (FC)
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: FC
The Carrier Loss for Fibre Channel (FC) alarm occurs on the client port of a TXP_MR_10G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G,
MXP_MR_2.5G, MXPP_MR_2.5G, MXP_MR_10DME_C, MXP_MR_10DME_L, supporting 1-Gb
Fibre Channel (FC1G), 2-Gb FC (FC2G), or 10Gb Fiber Channel (10G Fiber Channel) traffic. The loss
can be due to a misconfiguration, fiber cut, or client equipment problem.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the CARLOSS (FC) Alarm
Step 1

Complete the “Clear the CARLOSS (GE) Alarm” procedure on page 2-53.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.46 CARLOSS (GE)
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: GE
The Carrier Loss for Gigabit Ethernet (GE) alarm occurs on the client port of a TXP_MR_10G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G,
MXP_MR_2.5G, MXPP_MR_2.5G, MXP_MR_10DME_C, MXP_MR_10DME_L, GE-XP, 10GE-XP,
or ADM-10G cards supporting 1-Gbps or 10-Gbps traffic. The loss can be due to a misconfiguration,
fiber cut, or client equipment problem.
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Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the CARLOSS (GE) Alarm
Step 1

Ensure that the GE client is correctly configured:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b.

Click the Provisioning > Pluggable Port Modules tabs.

c.

View the Pluggable Port Modules area port listing in the Actual Equipment Type column and
compare this with the client equipment. If no PPM (SFP) is provisioned, refer to the “Turn Up a
Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide. PPM (SFP) specifications are
listed in the “Hardware Specifications” appendix in the Cisco ONS 15454 DWDM Reference
Manual.

d.

If a PPM (SFP) has been created, view the contents of the Selected PPM area Rate column for the
MXP or TXP MR card and compare this rate with the client equipment data rate. In this case, the
rate should be ONE_GE or 10G Ethernet. If the PPM (SFP) rate is differently provisioned, select
the PPM (SFP), click Delete, then click Create and choose the correct rate for the equipment type.

Note

For information about installing provisioning PPMs (SFPs), refer to the “Turn Up a Node”
chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

If there is no PPM (SFP) misprovisioning, check for a fiber cut. An LOS alarm would also be present.
If there is an alarm, complete the “Clear the LOS (OCN/STMN) Alarm” procedure located in Chapter 2,
“Alarm Troubleshooting,” of the Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454SDH
Troubleshooting Guide.

Step 3

If there is no fiber cut or provisioning error, check the client-side equipment for any transmission errors
on the line.

Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.47 CARLOSS (ISC)
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: ISC
The Carrier Loss for Inter-Service Channel (ISC) alarm occurs on the client port of a TXP_MR_10G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G,
MXP_MR_2.5G, and MXPP_MR_2.5G supporting ISC traffic. The loss can be due to a
misconfiguration, fiber cut, or client equipment problem.

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5
78-18342-02

2-53

Chapter 2

Alarm Troubleshooting

Trouble-Clearing Procedures

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the CARLOSS (ISC) Alarm
Step 1

Complete the “Clear the CARLOSS (GE) Alarm” procedure on page 2-53.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.48 CARLOSS (TRUNK)
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK
A Carrier Loss alarm is raised on the optical Trunk-RX port of a TXP_MR_10G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G, and
MXPP_MR_2.5G when the Ethernet payload is lost. This alarm only occurs when ITU-T G.709
encapsulation is disabled.

Note

For general information about TXP cards and their monitoring capabilities, refer to the “Card Reference”
chapter in the Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them,
refer to the “Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

Clear the CARLOSS (TRUNK) Alarm
Step 1

Check for any upstream equipment failures:
•

Verify that the far-end TXP or MXP is generating the signal to be received by the alarmed card.

•

Verify that the Trunk-Tx port is not reporting any performance monitoring (PM) problems.

•

Verify that the Client-Rx port is not reporting any PM problems that could cause the CARLOSS in
this card.

Note

Step 2

For more information about performance monitoring, refer to the “Performance Monitoring”
chapter of the Cisco ONS 15454 DWDM Reference Manual.

If there is no cause upstream, verify cabling continuity from the transmitting port of the DWDM card
(AD-xC-xx.x-xx.x, 32DMX-O, 32DMX, or 40DMX) connected to the TXP receiving port reporting this
alarm.
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Step 3

If a patch panel is used, ensure that the LC-LC adapter managing the connection is in good working
order.

Step 4

If the continuity is good, clean the fiber according to site practice. If none exists, complete the fiber
cleaning procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Step 5

If the signal is valid, ensure that the transmit and receive outputs from the patch panel to your equipment
are properly connected (that is, the correct wavelength is coming from the patch panel). For more
information about fiber connections and terminations, refer to the “Turn Up a Node” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

Step 6

If the correct port is in service but the alarm has not cleared, use an optical test set to confirm that a valid
signal exists on the input port of the alarmed TXP. For specific procedures to use the test set equipment,
consult the manufacturer. Test the line as close to the receiving card as possible.

Step 7

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240 for the
reporting card.

Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Step 8

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.49 CASETEMP-DEG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: AOTS
The Case Temperature Degrade alarm is raised when a DWDM card temperature sensor detects an
out-of-range external temperature at the shelf level. The working range for DWDM cards is from
23 degrees F (–5 degrees C) to 149 degrees F (65 degrees C).

Note

For specific temperature and environmental information about each DWDM card, refer to the “Hardware
Specifications” appendix in the Cisco ONS 15454 DWDM Reference Manual.

Clear the CASETEMP-DEG Alarm
Step 1

Determine whether the air filter needs replacement. Complete the “Inspect, Clean, and Replace the
Reusable Air Filter” procedure on page 2-243.

Step 2

If the filter is clean, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on
page 2-245.

Step 3

If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure
on page 2-245. The fan should run immediately when correctly inserted.
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Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.50 CHANLOSS
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: OCN
The SONET Section Layer DCC Termination Failure condition occurs when the ONS 15454 receives
unrecognized data in the section layer DCC bytes.

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning

Use of controls, adjustments, or performing procedures other than those specified may result in
hazardous radiation exposure. Statement 1057

Clear the CHANLOSS Condition
Step 1

In the absence of other alarms, determine whether the alarmed port is connected to another vendor’s
equipment. If so, you can mask the alarm on this path using a custom alarm profile. For more information
about custom profiles, refer to the “Manage Alarms” chapter in the Cisco ONS 15454 Procedure Guide.

Step 2

If alternate vendor equipment is not the cause of the alarm, complete the “Reset a Card in CTC”
procedure on page 2-237 for the traffic card.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 3

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240.

Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.51 CLDRESTART
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Cold Restart condition occurs when a card is physically removed and inserted, replaced, or when
the ONS 15454 power is initialized.
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Clear the CLDRESTART Condition
Step 1

Complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on
page 2-239.

Step 2

If the condition fails to clear after the card reboots, complete the “Remove and Reinsert (Reseat) Any
Card” procedure on page 2-240.

Step 3

If the condition does not clear, complete the “Physically Replace a Card” procedure on page 2-240 for
the card.

Step 4

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.52 CONTBUS-DISABLED
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: EQPT
The CONTBUS-DISABLED alarm is a function of the enhanced cell bus verification feature. This alarm
occurs when a card is defective upon insertion into the chassis or when a card already present in the
chassis becomes defective. (That is, the card fails the enhanced cell bus verification test.) The alarm
persists as long as the defective card remains in the chassis. When the card is removed,
CONTBUS-DISABLED will remain raised for a one-minute wait time. This wait time is designed as a
guard period so that the system can distinguish this outage from a briefer card reset communication
outage.
If no card is reinserted into the original slot during the wait time, the alarm clears. After this time, a
different, nondefective card (not the original card) should be inserted.
When CONTBUS-DISABLED is raised, no message-oriented communication is allowed to or from this
slot to the TCC2/TCC2P card (thus avoiding node communication failure).

Caution

CONTBUS-DISABLED clears only when the faulty card is removed for one minute. If any card at all is
reinserted before the one-minute guard period expires, the alarm does not clear.
CONTBUS-DISABLED overrides the IMPROPRMVL alarm during the one-minute wait period, but
afterward IMPROPRMVL can be raised because it is no longer suppressed. IMPROPRMVL is raised
after CONTBUS-DISABLED clears if the card is in the node database. If CONTBUS-DISABLED has
cleared but IMPROPRMVL is still active, inserting a card will clear the IMPROPRMVL alarm.

Clear the CONTBUS-DISABLED Alarm
Step 1

If the IMPROPRMVL alarm is raised, complete the “Physically Replace a Card” procedure on
page 2-240. (For general information about card installation, refer to the “Install Cards and Fiber-Optic
Cable” chapter of the Cisco ONS 15454 Procedure Guide.)
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.53 CONTBUS-IO-A
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
A TCCA to Shelf A Slot Communication Failure alarm occurs when the active Slot 7 TCC2/TCC2P card
(TCC A) has lost communication with another card in the shelf. The other card is identified by the Object
column in the CTC alarm window.
The CONTBUS-IO-A alarm can appear briefly when the ONS 15454 switches to the protect
TCC2/TCC2P card. In the case of a TCC2/TCC2P card protection switch, the alarm clears after the other
cards establish communication with the newly active TCC2/TCC2P card. If the alarm persists, the
problem lies with the physical path of communication from the TCC2/TCC2P card to the reporting card.
The physical path of communication includes the TCC2/TCC2P card, the other card, and the backplane.

Clear the CONTBUS-IO-A Alarm
Step 1

Ensure that the reporting card is physically present in the shelf. Record the card type. Click the
Inventory tab and view the Eqpt Type column to reveal the provisioned type.
If the actual card type and the provisioned card type do not match, see the “MEA (EQPT)” alarm,
page 2-155 for the reporting card.

Step 2

If the alarm object is any single card slot other than the standby Slot 11 TCC2/TCC2P card, perform a
CTC reset of the object card. Complete the “Reset a Card in CTC” procedure on page 2-237. For the
LED behavior, see the “2.7.2 Typical Traffic Card LED Activity During Reset” section on page 2-231.

Step 3

If the alarm object is the standby Slot 11 TCC2/TCC2P card, complete the “Reset a Card in CTC”
procedure on page 2-237 for it. The procedure is similar.
Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A
reset standby card remains standby.)

Step 4

If CONTBUS-IO-A is raised on several cards at once, complete the “Reset an Active TCC2/TCC2P Card
and Activate the Standby Card” procedure on page 2-238.
Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Step 5

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step 6

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-240 for the reporting card.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the middle-right outside edge of the shelf
assembly.
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Step 7

If the reset card has not rebooted successfully, or the alarm has not cleared, log into the Technical
Support Website at http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free TAC
numbers for your country. If the Technical Support technician tells you to reseat the card, complete the
“Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-239. If the
Technical Support technician tells you to remove the card and reinstall a new one, follow the “Physically
Replace a Card” procedure on page 2-240.

2.5.54 CONTBUS-IO-B
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
A TCC B to Shelf Communication Failure alarm occurs when the active Slot 11 TCC2/TCC2P card
(TCC B) has lost communication with another card in the shelf. The other card is identified by the Object
column in the CTC alarm window.
The CONTBUS-IO-B alarm could appear briefly when the ONS 15454 switches to the protect
TCC2/TCC2P card. In the case of a TCC2/TCC2P card protection switch, the alarm clears after the other
cards establish communication with the newly active TCC2/TCC2P card. If the alarm persists, the
problem lies with the physical path of communication from the TCC2/TCC2P card to the reporting card.
The physical path of communication includes the TCC2/TCC2P card, the other card, and the backplane.

Clear the CONTBUS-IO-B Alarm
Step 1

Ensure that the reporting card is physically present in the shelf. Record the card type. Click the
Inventory tab and view the Eqpt Type column to reveal the provisioned type.
If the actual card type and the provisioned card type do not match, see the “MEA (EQPT)” alarm,
page 2-155 for the reporting card.

Step 2

If the alarm object is any single card slot other than the standby Slot 7 TCC2/TCC2P card, perform a
CTC reset of the object card. Complete the “Reset a Card in CTC” procedure on page 2-237. For the
LED behavior, see the “2.7.2 Typical Traffic Card LED Activity During Reset” section on page 2-231.

Step 3

If the alarm object is the standby Slot 7 TCC2/TCC2P card, complete the “Reset a Card in CTC”
procedure on page 2-237 for it. The procedure is similar.
Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card. (A
reset standby card remains standby.)

Step 4

If CONTBUS-IO-B is raised on several cards at once, complete the “Reset an Active TCC2/TCC2P Card
and Activate the Standby Card” procedure on page 2-238.
Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Step 5

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. A green
ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

Step 6

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-240 for the reporting card.
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Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located lower-right edge of the shelf assembly.

Step 7

If the reset card has not rebooted successfully, or the alarm has not cleared, log into the Technical
Support Website at http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free TAC
numbers for your country. If the Technical Support technician tells you to reseat the card, complete the
“Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-239. If the
Technical Support technician tells you to remove the card and reinstall a new one, follow the “Physically
Replace a Card” procedure on page 2-240.

2.5.55 CTNEQPT-MISMATCH
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Connection Equipment Mismatch condition is raised when there is a mismatch between the
cross-connect card preprovisioned in the slot and the card actually present in the shelf. For example, an
XC-VXL card could be preprovisioned in Slot 10, but another card could be physically installed.

Note

Note

Cisco does not support configurations of unmatched cross-connect cards in Slot 8 and
Slot 10, although this situation could briefly occur during the upgrade process.

Note

The cross-connect card you are replacing should not be the active card. (It can be in SBY
state or otherwise not in use.)

During an upgrade, this condition occurs and is raised as its default severity, Not Alarmed (NA).
However, after the upgrade has occurred, if you wish to change the condition’s severity so that it is
Not Reported (NR), you can do this by modifying the alarm profile used at the node. For more
information about modifying alarm severities, refer to the “Manage Alarms” chapter in the
Cisco ONS 15454 Procedure Guide.

Clear the CTNEQPT-MISMATCH Condition
Step 1

Determine what kind of card is preprovisioned in the slot by completing the following steps:
a.

In node view, click the Inventory tab.

b.

View the slot’s row contents in the Eqpt Type and Actual Eqpt Type columns.
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The Eqpt Type column contains the equipment that is provisioned in the slot. The Actual Eqpt Type
contains the equipment that is physically present in the slot. For example, Slot 8 could be
provisioned for an XCVT card, which is shown in the Eqpt Type column, but a different
cross-connect card could be physically present in the slot. (This card would be shown in the Actual
Eqpt Type column.)
Step 2

Complete the “Physically Replace a Card” procedure on page 2-240 for the mismatched card.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.56 DATAFLT
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: NE
The Software Data Integrity Fault alarm occurs when the TCC2/TCC2P card exceeds its flash memory
capacity.

Caution

When the system reboots, the last configuration entered is not saved.

Clear the DATAFLT Alarm
Step 1

Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-238.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.57 DBOSYNC
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: NE
The Standby Database Out Of Synchronization alarm occurs when the standby TCC2/TCC2P card
database does not synchronize with the active database on the active TCC2/TCC2P card.

Caution

If you reset the active TCC2/TCC2P card while this alarm is raised, you lose current provisioning.
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Clear the DBOSYNC Alarm
Step 1

Save a backup copy of the active TCC2/TCC2P card database. Refer to the “Maintain the Node” chapter
in the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

Make a minor provisioning change to the active database to see if applying a provisioning change clears
the alarm:
a.

In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning >
General > General tabs.

b.

In the Description field, make a small change such as adding a period to the existing entry.
The change causes a database write but does not affect the node state. The write could take up to a
minute.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.58 DCU-LOSS-FAIL
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OTS
The DCU-LOSS-FAIL condition occurs when the DCU loss monitored value exceeds the board's
maximum acceptable DCU loss.

Clear the DCU-LOSS-FAIL Condition
Step 1

Verify that the optical fibers connecting the board (OPT-PRE, OPT-PRE-L, or OPT-AMP-L) and the
DCU unit are clean, correctly plugged in, and not damaged.

Step 2

If the condition does not clear, verify that appropriate DCU unit, according to the installation
requirements, is connected to the board and is correctly working.

Step 3

If the condition still does not clear, verify that the optical power signal is present on the DCU-TX port.

Step 4

If the alarm is still present, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.59 DISCONNECTED
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM
The Disconnected alarm is raised when CTC has been disconnected from the node. The alarm is cleared
when CTC is reconnected to the node.
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Clear the DISCONNECTED Alarm
Step 1

Restart the CTC application.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.5.60 DSP-COMM-FAIL
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK
The Digital Signal Processor (DSP) Communication Failure alarm indicates that there is a
communication failure between an MXP or TXP card microprocessor and the on-board DSP chip that
controls the trunk (or DWDM) port. This alarm typically occurs after a DSP code upgrade.
The alarm is temporary and does not require user action. The MXP or TXP card microprocessor attempts
to restore communication with the DSP chip until the alarm is cleared. (For general information about
MXP and TXP cards, refer to the “Card Reference” chapter of the Cisco ONS 15454 DWDM Reference
Manual.)
If the alarm is raised for an extended period, the MXP or TXP card raises the “DUP-IPADDR” alarm on
page 2-64 and could affect traffic.

Note

DSP-COMM-FAIL is an informational alarm and does not require troubleshooting.

2.5.61 DSP-FAIL
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK
The DSP Failure alarm indicates that a “DSP-COMM-FAIL” alarm, page 2-63, has persisted for an
extended period on an MXP or TXP card. It indicates that the card is faulty.

Clear the DSP-FAIL Alarm
Step 1

Complete the “Physically Replace a Card” procedure on page 2-240 for the reporting MXP or TXP card.

Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.
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2.5.62 DUP-IPADDR
Default Severity: Minor (MN), Non-Service Affecting (NSA)
Logical Object: NE
The Duplicate IP Address alarm indicates that the alarmed node IP address is already in use within the
same data communications channel (DCC) area. When this happens, CTC no longer reliably connects to
either node. Depending on how the packets are routed, CTC could connect to either node (having the
same IP address). If CTC has connected to both nodes before they shared the same address, it has two
distinct NodeModel instances (keyed by the node ID portion of the MAC address).

Clear the DUP-IPADDR Alarm
Step 1

Isolate the alarmed node from the other node having the same address:
a.

Connect to the alarmed node using the Craft port on the TCC2/TCC2P card.

b.

Begin a CTC session.

c.

In the login dialog box, uncheck the Network Discovery check box.

Step 2

In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning >
Network > General tabs.

Step 3

In the IP Address field, change the IP address to a unique number.

Step 4

Click Apply.

Step 5

Restart any CTC sessions that are logged into either of the duplicate IP addresses. (For procedures to log
in or log out, refer to the “Connect the PC and Log Into the GUI” chapter in the Cisco ONS 15454
DWDM Procedure Guide.

Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.63 DUP-NODENAME
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: NE
The Duplicate Node Name alarm indicates that the alarmed node alphanumeric name is already being
used within the same DCC area.

Clear the DUP-NODENAME Alarm
Step 1

In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > General >
General tabs.

Step 2

In the Node Name field, enter a unique name for the node.

Step 3

Click Apply.
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Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.64 DUP-SHELF-ID
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: SHELF
The Duplicated Shelf Identifier alarm applies to a shelf that has multishelf management enabled when
the TCC2/TCC2P detects that you have programmed an ID already in use by another shelf. For more
information about provisioning an NC shelf or SS shelf for multishelf configurations, refer to the “Turn
Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide and “Node Reference” chapter in
the Cisco ONS 15454 DWDM Reference Manual.

Clear the DUP-SHELF-ID Alarm
Step 1

Step 2

Unprovision the shelf ID of the duplicate shelf by completing the following steps:
a.

In shelf view (multishelf mode) or multishelf view (multishelf mode), click the node controller
Provisioning > General > Multishelf Config tabs.

b.

Enter a new value in the Shelf ID field.

c.

Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.65 EHIBATVG
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: PWR
The Extreme High Voltage Battery alarm occurs in a –48 VDC environment when a battery lead input
voltage exceeds the extreme high power threshold. This threshold, with a default value of –56.5 VDC,
is user-provisionable. The alarm remains raised until the voltage remains under the threshold for
120 seconds. (For information about changing this threshold, refer to the “Turn Up Node” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.)

Clear the EHIBATVG Alarm
Step 1

The problem is external to the ONS system. Troubleshoot the power source supplying the battery leads.
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Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.66 ELWBATVG
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: PWR
The Extreme Low Voltage Battery alarm occurs in a –48 VDC environment when a battery lead input
voltage falls below the extreme low power threshold. This threshold, with a default value of –40.5 VDC,
is user-provisionable. The alarm remains raised until the voltage remains over the threshold for
120 seconds. (For information about changing this threshold, refer to the “Turn Up a Node” chapter in
the Cisco ONS 15454 DWDM Procedure Guide.

Clear the ELWBATVG Alarm
Step 1

The problem is external to the ONS system. Troubleshoot the power source supplying the battery leads.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.67 ENCAP-MISMATCH-P
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: STSTRM
The Encapsulation C2 Byte Mismatch Path alarm applies to ML-Series Ethernet cards or the CE-1000
card. It occurs when the first three following conditions are met and one of the last two is false:
•

The received C2 byte is not 0x00 (unequipped).

•

The received C2 byte is not a PDI value.

•

The received C2 does not match the expected C2.

•

The expected C2 byte is not 0x01 (equipped unspecified).

•

The received C2 byte is not 0x01 (equipped unspecified).

For an ENCAP-MISMATCH-P to be raised, there is a mismatch between the received and expected C2
byte, with either the expected byte or received byte value being 0x01.
For example, an ENCAP-MISMATCH-P alarm is raised if a circuit created between two ML-Series or
two CE-1000 cards has generic framing procedure (GFP) framing provisioned on one end and HDLC
framing with LEX encapsulation provisioned on the other. The GFP framing card transmits and expects
a C2 byte of 0x1B, while the HDLC framing card transmits and expects a C2 byte of 0x01.
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A mismatch between the transmit and receive cards on any of the following parameters can cause the
alarm:
•

Mode (HDLC, GFP-F)

•

Encapsulation (LEX, HDLC, PPP)

•

CRC size (16 or 32)

•

Scrambling state (on or off)

This alarm is demoted by a PLM-P condition or a PLM-V condition.

Note

By default, an ENCAP-MISMATCH-P alarm causes an ML-Series or CE-1000 card data link to go
down. This behavior can be modified using the command line interface (CLI) command in interface
configuration mode: no pos trigger defect encap.

Note

For more information about the ML-Series or CE-1000 Ethernet cards, refer to the Ethernet Card
Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and
Cisco ONS 15327.

Clear the ENCAP-MISMATCH-P Alarm
Step 1

Step 2

Step 3

Ensure that the correct framing mode is in use on the receive card:
a.

In node view, double-click the receive ML-Series or CE-1000 card to open the card view.

b.

Click the Provisioning > Card tabs.

c.

In the Mode drop-down list, ensure that the same mode (GFP or HDLC) is selected. If it is not,
choose it and click Apply.

Ensure that the correct framing mode is in use on the transmit card, and that it is identical to the receiving
card:
a.

In node view, double-click the transmit ML-Series or CE-1000 card to open the card view.

b.

Click the Provisioning > Card tabs.

c.

In the Mode drop-down list, ensure that the same mode (GFP or HDLC) is selected. If it is not,
choose it and click Apply.

If the alarm does not clear, use the CLI to ensure that the remaining settings are correctly configured on
the ML-Series or CE-1000 card:
•

Encapsulation

•

CRC size

•

Scrambling state

To open the interface, click the IOS tab and click Open IOS Command Line Interface (CLI). Refer to
the Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454,
Cisco ONS 15454 SDH, and Cisco ONS 15327 entries on all three of these topics to obtain the full
configuration command sequences.
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Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.68 EOC
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: OCN/STMN, TRUNK
The SONET DCC Termination Failure alarm occurs when the ONS system loses its DCC. Although this
alarm is primarily SONET, it can apply to DWDM. For example, the OSCM card can raise this alarm on
its OC-3 section overhead.
The SDCC consists of three bytes, D1 through D3, in the SONET overhead. The bytes convey
information about operation, administration, maintenance, and provisioning (OAM&P). The ONS
system uses the DCC on the SONET section layer to communicate network management information.

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Note

If a circuit shows a partial state when this alarm is raised, the logical circuit is in place. The circuit is
able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.

Note

For general information about OSCM or other DWDM cards, refer to the “Card Reference” chapter in
the Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to
the “Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide. For
more information about the SONET (ANSI) or SDH (ETSI) overhead, refer to the “SONET Topologies
and Upgrades” chapter of the Cisco ONS 15454 Procedure Guide or the “SDH Topologies and
Upgrades” chapter of the Cisco ONS 15454 SDH Procedure Guide.

Note

The EOC alarm is raised on the DWDM trunk in MSTP systems. Its SDH (ETSI) counterpart, MS-EOC,
is not raised against the trunk port.
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Clear the EOC Alarm
Step 1

If the LOS (DS1) alarm or SF-L alarm is reported, complete the appropriate troubleshooting procedure
in the “Alarm Troubleshooting” chapter of the Cisco ONS 15454 Troubleshooting Guide.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 2

If the alarm does not clear on the reporting node, verify the physical connections between the cards and
that the fiber-optic cables are configured to carry SDCC traffic. For more information about fiber
connections and terminations, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

Step 3

If the physical connections are correct and configured to carry DCC traffic, ensure that both ends of the
fiber span have in-service (IS or Unlocked) ports. Verify that the ACT/SBY LED on each card is green.

Step 4

When the LEDs on the cards are correctly illuminated, complete the “Verify or Create Node Section
DCC Terminations” procedure on page 2-241 to verify that the DCC is provisioned for the ports at both
ends of the fiber span.

Step 5

Repeat Step 4 at the adjacent nodes.

Step 6

If DCC is provisioned for the ends of the span, verify that the port is active and in service by completing
the following steps:

Step 7

a.

Confirm that the card shows a green LED in CTC or on the physical card. A green ACT/SBY LED
indicates an active card. An amber ACT/SBY LED indicates a standby card.

b.

To determine whether the port is in service, in node view (single-shelf mode) or shelf view (multishelf
mode), double-click the card in CTC to open the card view.

c.

In card view, click the Provisioning > Line tabs.

d.

Verify that the Admin State column lists the port as IS (or Unlocked).

e.

If the Admin State column lists the port as OOS,MT (or Locked,maintenance) or OOS,DSBLD (or
Locked,disabled), click the column and choose IS , or Unlocked. Click Apply.

For all nodes, if the card is in service, use an optical test set to determine whether signal failures are
present on fiber terminations. For specific procedures to use the test set equipment, consult the
manufacturer.

Caution

Using an optical test set disrupts service on a card. It could be necessary to manually switch traffic
carrying circuits over to a protection path. Refer to the “2.8.2 Protection Switching, Lock Initiation, and
Clearing” section on page 2-233 for commonly used switching procedures.

Step 8

If no signal failures exist on terminations, measure power levels to verify that the budget loss is within
the parameters of the receiver. Refer to the “Hardware Specifications” appendix in the Cisco ONS 15454
DWDM Reference Manual for card power levels.

Step 9

If budget loss is within parameters, ensure that fiber connectors are securely fastened and properly
terminated. For more information about cabling, refer to the “Turn Up a Node” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

Step 10

If fiber connectors are properly fastened and terminated, complete the “Reset an Active TCC2/TCC2P
Card and Activate the Standby Card” procedure on page 2-238.
Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.
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Resetting the active TCC2/TCC2P card switches control to the standby TCC2/TCC2P card. If the alarm
clears when the ONS system node switches to the standby TCC2/TCC2P card, the user can assume that
the previously active card is the cause of the alarm.
Step 11

If the TCC2/TCC2P card reset does not clear the alarm, delete the problematic SDCC termination:
a.

From the View menu in card view, choose Go to Previous View if you have not already done so.

b.

In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning >
Comm Channels > SDCC tabs.

c.

Highlight the problematic DCC termination.

d.

Click Delete.

e.

Click Yes in the Confirmation Dialog box.

Step 12

Recreate the SDCC termination. Refer to the “Turn Up a Node” chapter of the Cisco ONS 15454 DWDM
Procedure Guide for procedures.

Step 13

Verify that both ends of the DCC have been recreated at the optical ports.

Step 14

If the alarm has not cleared, call Cisco TAC (1-800-553-2447). If the Cisco TAC technician tells you to
reseat the card, complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure
on page 2-239. If the Cisco TAC technician tells you to remove the card and reinstall a new one, follow
the “Physically Replace a Card” procedure on page 2-240.

Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

2.5.69 EOC-L
Default Severity: Minor (MN), Non-Service-Affecting (NSA) for OCN/STMN
Logical Object: TRUNK
The Line DCC (LDCC) Termination Failure alarm occurs when the ONS system loses its line data
communications channel (LDCC) termination. For example, the OSCM card can raise this alarm on its
OC-3 line overhead.
The LDCC consists of nine bytes, D4 through D12, in the SONET overhead. The bytes convey
information about OAM&P. The ONS system uses the LDCCs on the SONET line layer to communicate
network management information.

Warning

On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056
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Warning

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Note

If a circuit shows a partial status when the EOC or EOC-L alarm is raised, it occurs when the logical
circuit is in place. The circuit is able to carry traffic when the DCC termination issue is resolved. You
do not need to delete the circuit when troubleshooting this alarm.

Note

For general information about OSCM or other DWDM cards, refer to the “Card Reference” chapter in
the Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to
the “Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide. For
more information about the SONET (ANSI) or SDH (ETSI) overhead, refer to the “SONET Topologies
and Upgrades” chapter of the Cisco ONS 15454 Procedure Guide or the “SDH Topologies and
Upgrades” chapter of the Cisco ONS 15454 SDH Procedure Guide.

Clear the EOC-L Alarm
Step 1

Complete the “Clear the EOC Alarm” procedure on page 2-69.

Step 2

If the alarm has not cleared, call Cisco TAC (1-800-553-2447). If the Cisco TAC technician tells you to
reseat the card, complete the “Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure
on page 2-239. If the Cisco TAC technician tells you to remove the card and reinstall a new one, follow
the “Physically Replace a Card” procedure on page 2-240.

Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

2.5.70 EQPT
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AICI-AEP, AICI-AIE, EQPT, PPM
An Equipment Failure alarm indicates that a hardware failure has occurred on the reporting card. If the
EQPT alarm occurs with a “BKUPMEMP” alarm, page 2-48, refer to the procedure to clear the alarm.
(Clearing a BKUPMEMP alarm also clears an EQPT alarm.)
This alarm is also invoked if a diagnostic circuit detects a card application-specific integrated circuit
(ASIC) failure. In this case, if the card is part of a protection group, an APS switch occurs. If the card is
the protect card, switching is inhibited and a “PROTNA” alarm, page 2-187, is raised. The standby path
generates a path-type alarm. For more information about provisioning PPMs (SFPs), refer to the “Turn
Up a Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.
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Clear the EQPT Alarm
Step 1

If traffic is active on the alarmed port, you could need to switch traffic away from it. See the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233 for commonly used
traffic-switching procedures.

Step 2

Complete the “Reset a Card in CTC” procedure on page 2-237 for the reporting card.

Step 3

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED status. A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a
standby card.

Step 4

If the CTC reset does not clear the alarm, complete the “Remove and Reinsert (Reseat) Any Card”
procedure on page 2-240 for the reporting card.

Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Step 5

If the physical reseat of the card fails to clear the alarm, complete the “Physically Replace a Card”
procedure on page 2-240 for the reporting card.

Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.71 EQPT-DIAG
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: EQPT
An Equipment-Diagnostic Failure alarm indicates that a software or hardware failure has occurred on
the reporting card. This alarm can be raised against a traffic card or a cross-connect card.

Clear the EQPT-DIAG Alarm
Step 1

If traffic is active on the alarmed card, you could need to switch traffic away from it. Refer to the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233 for procedures.

Step 2

Complete the “Remove and Reinsert (Reseat) Any Card” procedure on page 2-240 for the alarmed card

Step 3

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240 if it is
raised against a traffic card, or complete the “2.8.5 Generic Signal and Circuit Procedures” procedure
on page 2-241 if the alarm is raised against the cross-connect card.

Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.72 EQPT-MISS
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: FAN
The Replaceable Equipment or Unit Missing alarm is reported against the fan-tray assembly unit. It
indicates that the replaceable fan-tray assembly is missing or is not fully inserted. It could also indicate
that the ribbon cable connecting the AIP to the system board is bad.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Clear the EQPT-MISS Alarm
Step 1

If the alarm is reported against the fan, verify that the fan-tray assembly is present.

Step 2

If the fan-tray assembly is present, complete the “Replace the Fan-Tray Assembly” procedure on
page 2-245.

Step 3

If no fan-tray assembly is present, obtain a fan-tray assembly and refer to the “Install the Fan-Tray
Assembly,” procedure in the “Install the Shelf and Common Control Cards” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

Step 4

If the alarm does not clear, replace the ribbon cable from the AIP to the system board with a known-good
ribbon cable.

Step 5

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.73 ERFI-P-CONN
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Objects: STSMON, STSTRM
The Three-Bit (Enhanced) Remote Failure Indication (ERFI) Path Connectivity condition is triggered on
DS-1, DS-3, or VT circuits when the “UNEQ-P” alarm on page 2-223 and the “TIM-P” alarm on
page 2-220 are raised on the transmission signal.

Clear the ERFI-P-CONN Condition
Step 1

Clear the UNEQ-P alarm. This should clear the ERFI condition.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.74 ERFI-P-SRVR
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM
The Three-Bit ERFI Path Server condition is triggered on DS-1, DS-3, or VT circuits when the “AIS-P”
condition, page 2-27 or the “LOP-P” alarm on page 2-130 is raised on the transmission signal.

Clear the ERFI-P-SRVR Condition
Step 1

Complete the “Clear the LOP-P Alarm” procedure on page 2-130. This should clear the ERFI condition.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.75 EXCCOL
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Excess Collisions on the LAN alarm indicates that too many collisions are occurring between data
packets on the network management LAN, and communications between the ONS system and CTC
could be affected. The network management LAN is the data network connecting the workstation
running the CTC software to the TCC2/TCC2P card. The problem causing the alarm is external to the
ONS system.
Troubleshoot the network management LAN connected to the TCC2/TCC2P card for excess collisions.
You might need to contact the system administrator of the network management LAN to accomplish the
following steps.

Clear the EXCCOL Alarm
Step 1

Verify that the network device port connected to the TCC2/TCC2P card has a flow rate set to 10 Mb,
half-duplex.

Step 2

If the port has the correct flow rate and duplex setting, troubleshoot the network device connected to the
TCC2/TCC2P card and the network management LAN.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.76 EXT
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: ENVALRM
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A Failure Detected External to the NE alarm occurs because an environmental alarm is present. For
example, a door could be open or flooding could have occurred.

Clear the EXT Alarm
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the AIC-I card to open the
card view.

Step 2

Double-click the Maintenance > External Alarms tabs.

Step 3

Follow your standard operating procedure to remedy environmental conditions that cause alarms. The
alarm clears when the situation is remedied.

Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.77 FAILTOSW (2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN, TRUNK
The Failure to Switch to Protection Facility condition for MXP and TXP client ports occurs in a Y-cable
protection group when a working or protect facility switches to its companion port by using a MANUAL
command. For example, if you attempt to manually switch traffic from an unused protect port to an
in-service working port, the switch will fail (because traffic is already present on the working port) and
you will see the FAILTOSW condition.

Note

For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

Clear the FAILTOSW (2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN) Condition
Step 1

Look up and troubleshoot the higher-priority alarm. Clearing the higher-priority condition frees the card
and clears the FAILTOSW.

Step 2

If the condition does not clear, replace the working card that is reporting the higher-priority alarm by
following the “Physically Replace a Card” procedure on page 2-240. This card is the working facility
using the protect facility and not reporting FAILTOSW.
Replacing the working card that is reporting the higher-priority alarm allows traffic to revert to the
working slot and the card reporting the FAILTOSW to switch to the protect card.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.78 FAILTOSW (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The Failure to Switch to Protection Facility condition applies to MXP and TXP trunk ports in splitter
protection groups and occurs when a working or protect trunk port switches to its companion port by
using a MANUAL command.

Note

For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

Clear the FAILTOSW (TRUNK) Condition
Step 1

Look up and troubleshoot the higher-priority alarm. Clearing the higher-priority condition frees the card
and clears the FAILTOSW.

Step 2

If the condition does not clear, replace the working card that is reporting the higher-priority alarm by
following the “Physically Replace a Card” procedure on page 2-240. This card is the working facility
using the protect facility and not reporting FAILTOSW.
Replacing the working card that is reporting the higher-priority alarm allows traffic to revert to the
working slot and the card reporting the FAILTOSW to switch to the protect card.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.79 FAILTOSW-HO
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP
The High-Order Path Failure to Switch to Protection condition occurs when a high-order path circuit
fails to switch to the working or protect electrical circuit using the MANUAL command.

Clear the FAILTOSW-HO Condition
Step 1

Complete the “Clear the FAILTOSW (2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN) Condition”
procedure on page 2-75.

Step 2

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.
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2.5.80 FAILTOSW-PATH
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, VT-MON
The Fail to Switch to Protection Path condition occurs when the working circuit does not switch to the
protection circuit on a path protection configuration. Common causes of the FAILTOSW-PATH alarm
include a missing or defective protect port, a lockout set on one of the path protection nodes, or
path-level alarms that would cause a path protection switch to fail including the “AIS-P” condition on
page 2-27, the “LOP-P” alarm on page 2-130, the “SD-P” condition, page 2-199, the “SF-P” condition
on page 2-202, and the “UNEQ-P” alarm on page 2-223.
The “SD-L” condition on page 2-198, or the “SF-L” condition on page 2-201 can also occur on the failed
path.

Clear the FAILTOSW-PATH Condition in a Path Protection Configuration
Step 1

Look up and clear the higher-priority alarm. Clearing this alarm frees the standby card and clears the
FAILTOSW-PATH condition. If the “AIS-P” condition on page 2-27, the “LOP-P” alarm on page 2-130,
the “UNEQ-P” alarm on page 2-223, the “SF-P” condition on page 2-202, the “SD-P” condition,
page 2-199, the “SD-L” condition on page 2-198, or the “SF-L” condition on page 2-201 are also
occurring on the reporting port, complete the applicable alarm clearing procedure.

Note

A higher-priority alarm is an alarm raised on the working electrical card using the 1:N card
protection group. The working DS-N card is reporting an alarm but not reporting a FAILTOSW
condition.

Step 2

If the condition does not clear, replace the active OC-N card that is reporting the higher-priority alarm.
Complete the “Physically Replace a Card” procedure on page 2-240. Replacing the active OC-N card
that is reporting the higher-priority alarm allows traffic to revert to the active slot. Reverting frees the
standby card, which can then take over traffic from the card reporting the lower-priority alarm and the
FAILTOSW-PATH condition.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.81 FAN
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: FAN
The Fan Failure alarm indicates a problem with the fan-tray assembly. When the fan-tray assembly is not
fully functional, the temperature of the ONS system can rise above its normal operating range.
The fan-tray assembly contains six fans and needs a minimum of five working fans to properly cool the
shelf. However, even with five working fans, the fan-tray assembly could need replacement because a
sixth working fan is required for extra protection against overheating.
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Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Clear the FAN Alarm
Step 1

Determine whether the air filter needs replacement. Complete the “Inspect, Clean, and Replace the
Reusable Air Filter” procedure on page 2-243.

Step 2

If the filter is clean, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on
page 2-245.

Step 3

If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure
on page 2-245. The fan should run immediately when correctly inserted.

Step 4

If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem (1-800-553-2447).

2.5.82 FAPS
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: TRUNK
The Fast Automatic Protection Switching condition is applicable to GEXP/10GEXP cards. This
condition occurs when the protection port, on the master card, switches from blocking to forwarding
state.

Clear the FAPS Alarm
Step 1

When the cause of switching disappears, the protection port switches from the forwarding to the
blocking state, and the FAPS alarm clears.

Step 2

If the alarm does not clear even after the protection port switches back to the blocking state, log into the
Technical Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1 800 553-2447).

2.5.83 FAPS-CONFIG-MISMATCH
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Fast Automatic Protection Switching Config Mismatch condition indicates that no trunk port of the
master card (GEXP/10GEXP) is in the blocking state.
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Clear the FAPS-CONFIG-MISMATCH Condition
Step 1

Check the configuration of the master card. Ensure that at least one of the trunk ports is in the blocking
state.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.84 FC-NO-CREDITS
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Objects: Client port
The Fibre Channel Distance Extension Credit Starvation alarm occurs on storage access networking
(SAN) Fibre Channel/Fiber Connectivity (FICON) DWDM cards when the congestion prevents the GFP
transmitter from sending frames to the DWDM card port. For example, the alarm can be raised when an
operator configures a card to autodetect framing credits but the card is not connected to an interoperable
FC-SW-standards-based Fibre Channel/FICON port.
FC-NO-CREDITS is raised only if transmission is completely prevented. (If traffic is slowed but still
passing, this alarm is not raised.)

Clear the FC-NO-CREDITS Alarm
Step 1

If the port is connected to a Fibre Channel/FICON switch, make sure it is configured for interoperation
mode using the manufacturer's instructions.

Step 2

If the port is not connected to a switch, turn off Autodetect Credits by completing the following steps:

Step 3

a.

Double-click the DWDM card.

b.

Click the Provisioning > Port > General tabs.

c.

Under Admin State, click the cell and choose OOS,MT (or Locked,maintenance).

d.

Click Apply.

e.

Click the Provisioning > Port > Distance Extension tabs.

f.

Uncheck the Autodetect Credits column check box.

g.

Click Apply.

h.

Click the Provisioning > Port > General tabs.

i.

Under Admin State, click the cell and choose IS , or Unlocked.

j.

Click Apply.

Program the Credits Available value based on the buffers available on the connected equipment by
completing the following steps:
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The NumCredits entry must be provisioned to a value smaller than or equal to the receive buffers
or credits available on the connected equipment.

Note

Step 4

a.

Double-click the DWDM card.

b.

Click the Provisioning > Port > Distance Extension tabs.

c.

Enter a new value in the Credits Available column.

d.

Click Apply.

If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem (1-800-553-2447).

2.5.85 FDI
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: OCH, OCH-TERM, OMS, OTS, EQPT
The Forward Defect Indication (FDI) condition is part of MSTP network-level alarm correlation in R7.0.
It is raised at the far end when the OCH optical payload is missing due to an optical channel signal
(LOS), light (LOS-P), or optical power (OPWR-LFAIL) alarm root cause.
An LOS, LOS-P, or OPWR-LFAIL alarm on an MSTP circuit causes multiple alarms for each channel.
Correlation simplifies troubleshooting by reporting a single alarm for multiple alarms having one root
cause, then demoting the root alarms so that they are only visible in the Conditions window (showing
their original severity.)
FDI clears when the optical channel is working on the aggregated or single-channel optical port.

Note

Network-level alarm correlation is only supported for MSTP communication alarms. It is not supported
for equipment alarms.

Clear the FDI Condition
Step 1

Step 2

Clear the root-cause service-affecting alarm by using one of the following procedures, as appropriate:
•

“Clear the LOS (OTS) Alarm” procedure on page 2-135

•

“Clear the LOS (TRUNK) Alarm” procedure on page 2-136

•

“Clear the LOS-P (OCH) Alarm” procedure on page 2-141

•

“Clear the LOS-P (AOTS, OMS, OTS) Alarm” procedure on page 2-138

•

“Clear the LOS-P (TRUNK) Alarm” procedure on page 2-144

•

“Clear the OPWR-LFAIL Alarm” procedure on page 2-176

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.86 FE-FRCDWKSWBK-SPAN
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STMN
The Far End Forced Switch Back to Working–Span condition is raised on a far-end 1+1 protect port when
it is Force switched to the working port.

Note

WKSWBK-type conditions apply only to nonrevertive circuits.

Clear the FE-FRCDWKSWBK-SPAN Condition
Step 1

Complete the “Clear a 1+1 Force or Manual Switch Command” procedure on page 2-235 for the far-end
port.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.87 FE-FRCDWKSWPR-SPAN
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STMN
The Far End Working Facility Forced to Switch to Protection Span condition occurs from a far-end node
when a span on a four-fiber BLSR is forced from working to protect using the Force Span command.
This condition is only visible on the network view Conditions tab. The port where the Force Switch
occurred is indicated by an “F” on the network view detailed circuit map. This condition is accompanied
by WKSWPR.

Clear the FE-FRCDWKSWPR-SPAN Condition
Step 1

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE-AIS condition from the OC-48 card in Slot 12 of Node 1 could link to the
main AIS condition from an OC-48 card in Slot 6 of Node 2.

Step 2

Log into the node that links directly to the card reporting the FE condition.

Step 3

Clear the main alarm.

Step 4

If the FE-FRCDWKSWPR-SPAN condition does not clear, complete the “Clear a BLSR External
Switching Command” procedure on page 2-237.
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Step 5

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.88 FE-MANWKSWBK-SPAN
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STMN
The Far End Manual Switch Back to Working—Span condition occurs when a far-end span is Manual
switches back to working.

Note

WKSWBK-type conditions apply only to nonrevertive circuits.

Clear the FE-MANWKSWBK-SPAN Condition
Step 1

To troubleshoot the FE condition, determine which node and card is linked directly to the card reporting
the FE condition. For example, an FE condition on a card in Slot 12 of Node 1 could relate to a main
alarm from a card in Slot 6 of Node 2.

Step 2

Log into the node that is linked directly to the card reporting the FE condition.

Step 3

Complete the “Clear a BLSR External Switching Command” procedure on page 2-237.

Step 4

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.89 FE-MANWKSWPR-SPAN
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STMN
The Far-End Span Manual Switch Working Facility to Protect condition occurs when a four-fiber BLSR
span is switched from working to protect at the far-end node using the Manual Span command. This
condition is only visible on the network view Conditions tab and is accompanied by WKSWPR. The port
where the Manual Switch occurred is indicated by an “M” on the network view detailed circuit map.

Clear the FE-MANWKSWPR-SPAN Condition
Step 1

To troubleshoot an FE condition, determine which node and card link directly to the card reporting the
FE alarm. For example, an FE condition on a card in Slot 12 of Node 1 could link to the main condition
from a card in Slot 6 of Node 2.
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Step 2

Log into the node that links directly to the card reporting the FE condition.

Step 3

Complete the “Clear a BLSR External Switching Command” alarm, page 2-237.

Step 4

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.90 FEC-MISM
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK
The Forward Error Correction (FEC) Mismatch alarm applies to all cards featuring FEC/E-FEC
capability: TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G,
TXPP_MR_2.5G, MXP_10G, MXP_MR_10E, and ADM-10G. FEC-MISMATCH is reported only on
the card configured in Standard FEC mode or with FEC disabled. A card configured in enhanced FEC
mode will report an “OTUK-LOF” alarm on page 2-179.
The alarm is related to ITU-T G.709 encapsulation and is only raised against a trunk port.

Note

For general information about MXP and TXP cards and their monitoring capabilities, refer to the “Card
Reference” chapter in the Cisco ONS 15454 DWDM Reference Manual. For information about
provisioning them, refer to the “Provision Transponder and Muxponder Cards” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

Clear the FEC-MISM Alarm
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP_MR_10G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G,
MXP_MR_10G, MXP_MR_10E, and ADM-10G card.

Step 2

Click the Provisioning > OTN > OTN Lines tabs.

Step 3

In the FEC column, click Enable to activate the FEC feature. This causes a different OTN frame to be
transmitted. Alternately, in the E-FEC column (TXP_MR_10E and MXP_MR_10E), click Enable to
activate the Enhanced FEC feature.

Step 4

Verify that the far-end card is configured the same way by repeating Step 1 through Step 3.

Step 5

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.
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2.5.91 FEPRLF
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN
The Far-End Protection Line Failure alarm occurs when there was an “SF (TRUNK)” condition on
page 2-200 condition on the protect card’s APS channel coming into the node.

Note

The FEPRLF alarm occurs on the ONS 15454 only when bidirectional protection is used on optical
(traffic) cards in a 1+1 protection group configuration.

Clear the FEPRLF Alarm on an BLSR
Step 1

To troubleshoot the FE alarm, determine which node and card is linked directly to the card reporting the
FE alarm. For example, an FE alarm or condition on a card in Slot 16 of Node 1 could relate to a main
alarm from a card in Slot 16 in Node 2.

Step 2

Log into the node that is linked directly to the card reporting the FE alarm.

Step 3

Clear the main alarm. Refer to the appropriate alarm section in this chapter for procedures.

Step 4

If the alarm does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.92 FIBERTEMP-DEG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: AOTS
The Fiber Temperature Degrade alarm occurs when a DWDM card internal heater-control circuit fails.
Degraded temperature can cause some signal drift. The card should be replaced at the next opportunity.

Note

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the FIBERTEMP-DEG Alarm
Step 1

Warning

For the alarmed card, complete the “Physically Replace a Card” procedure on page 2-240 at the next
opportunity.

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201
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Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.93 FORCED-REQ
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT, ML1000, ML100T, MLFX, STSMON, VT-MON
The Force Switch Request on Facility or Port condition occurs when you enter the Force command on a
port to force traffic from a working port to a protect port or protection span (or from a protect port to a
working port or span). You do not need to clear the condition if you want the Force switch to remain.
FORCED-REQ is raised for an IEEE 802.17b-based RPR span if the force was requested in the
Cisco IOS CLI using the “rpr-ieee protection request force-switch {east | west}” command. It clears
from the RPR-IEEE span when you remove the switch in the CLI. For the IEEE 802.17b-based RPR
interface, FORCED-REQ is suppressed by the RPR-PASSTHR alarm. It also suppresses the following
alarms:
•

MAN-REQ (for an ML-Series object)

•

RPR-SF

•

RPR-SD

•

WTR (for an ML-Series object)

Clear the FORCED-REQ Condition
Step 1

Complete the “Clear a 1+1 Force or Manual Switch Command” procedure on page 2-235.

Step 2

If the condition is raised on an IEEE 802.17b-based RPR span, enter the following command in the CLI
in RPR-IEEE interface configuration mode:
router(config-if)#no rpr-ieee protection request force-switch {east | west}

Step 3

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.94 FORCED-REQ-SPAN (2R, ESCON, FC, GE, ISC, OCN/STMN)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC, OCN/STMN
The Force Switch Request Span condition applies to Y-cable-protected TXP configurable clients (OC-3,
OC-12/STM-4,OC-48/STM-16, OC-192/STM-64, FC, ESCON, or FICON). If traffic is present on a
working port and you use the FORCE command to prevent it from switching to the protect port
(indicated by “FORCED TO WORKING”), FORCED-REQ-SPAN indicates this force switch. In this
case, the force is affecting not only the facility, but the span.
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Note

For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

2.5.95 FORCED-REQ-SPAN (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The Force Switch Request Span condition applies to MXP and TXP trunk ports in splitter protection
groups. If traffic is present on a working port and you use the FORCE command to prevent it from
switching to the protect port (indicated by “FORCED TO WORKING”), FORCED-REQ-SPAN
indicates this force switch. In this case, the force is affecting not only the facility, but the span.

Note

For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

2.5.96 FP-LINK-LOSS
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Front Port Link Loss condition occurs when a LAN cable is not connected to the front port of the
TCC2/TCC2P card.

Clear the FP-LINK-LOSS Condition
Step 1

Connect a LAN cable to the front port of the TCC2/TCC2P card.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.97 FRCDSWTOINT
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE-SREF
The Force Switch to Internal Timing condition occurs when the user issues a Force command to switch
to an internal timing source.

Note

FRCDSWTOINT is an informational condition and does not require troubleshooting.
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2.5.98 FRCDSWTOPRI
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF
The Force Switch to Primary Timing Source condition occurs when the user issues a Force command to
switch to the primary timing source.

Note

FRCDSWTOPRI is an informational condition and does not require troubleshooting.

2.5.99 FRCDSWTOSEC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF
The Force Switch to Second Timing Source condition occurs when the user issues a Force command to
switch to the second timing source.

Note

FRCDSWTOSEC is an informational condition and does not require troubleshooting.

2.5.100 FRCDSWTOTHIRD
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF
The Force Switch to Third Timing Source condition occurs when the user issues a Force command to
switch to a third timing source.

Note

FRCDSWTOTHIRD is an informational condition and does not require troubleshooting.

2.5.101 FRNGSYNC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE-SREF
The Free Running Synchronization Mode condition occurs when the reporting ONS system is in free-run
synchronization mode. External timing sources have been disabled and the node is using its internal
clock, or the node has lost its designated building integrated timing supply (BITS) timing source. After
the 24-hour holdover period expires, timing slips could begin to occur on an ONS system node relying
on an internal clock.

Note

If the ONS system is configured to operate from its internal clock, disregard the FRNGSYNC condition.
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Clear the FRNGSYNC Condition
Step 1

If the ONS system is configured to operate from an external timing source, verify that the BITS timing
source is valid. Common problems with a BITS timing source include reversed wiring and bad timing
cards. Refer to the “Timing” chapter in the Cisco ONS 15454 Reference Manual for more information.

Step 2

If the BITS source is valid, clear alarms related to the failures of the primary and secondary reference
sources, such as the “SYNCPRI” alarm on page 2-216 and the “SYNCSEC” alarm on page 2-216.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.102 FSTSYNC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE-SREF
A Fast Start Synchronization Mode condition occurs when the node is choosing a new timing reference.
The previous timing reference has failed.
The FSTSYNC alarm disappears after approximately 30 seconds. If the condition does not clear, log into
the Technical Support Website at http://www.cisco.com/techsupport for more information or call
Cisco TAC (1-800-553-2447).

Note

FSTSYNC is an informational condition. It does not require troubleshooting.

2.5.103 FTA-MISMATCH
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Fan Tray Mismatch condition is raised on the ADM-10G card. It indicates that an unsupported
version of the fan tray assembly (15454-FTA3 or 15454-FTA2) is installed in the shelf. The ADM-10G
card must be installed in a shelf that has FTA version 4 or higher.

Clear the FTA-MISMATCH Condition
Step 1

Obtain the correct fan tray assembly (15454-FTA4 or higher), and replace the existing FTA with the new
one by following the “Replace the Fan-Tray Assembly” procedure on page 2-245.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.104 GAIN-HDEG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: AOTS
The Gain High Degrade alarm is raised on an amplifier card (OPT-BST, OPT-PRE, or OPT-AMP-x-C)
when the amplifier reaches the Gain High Degrade Threshold. (This value is automatically provisioned
with the gain setpoint, but the alarm threshold is 2 dBm higher than the setpoint. The card should be
replaced at the first opportunity.

Note

This alarm is applicable only when the amplifier working mode is set to Control Gain.

Note

For general information about DWDM amplifier cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about control gain, refer to the “Node
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the GAIN-HDEG Alarm
Step 1

Verify that the LED is correctly illuminated on the physical card. A green ACT/SBY LED indicates an
active card. A red ACT/SBY LED indicates a failed card.

Step 2

Complete “Reset a Card in CTC” procedure on page 2-237 on the failing amplifier.

Step 3

If the alarm does not clear, identify all the OCHNC circuits applying to the failing card. Force all the
protected circuits on the optical path that the faulty amplifier does not belong to. Switch the OCHNC
administrative state of all these circuits to OOS,DSBLD (or Locked,disabled).

Caution

All remaining unprotected circuits will suffer for a traffic hit when you disable the circuits.

Step 4

Switch the administrative state of only one of the OCHNC circuits to IS,AINS (or
Unlocked,automaticInService. This forces the amplifier to recalculate its gain setpoint and value.

Step 5

If the alarm does not clear and no other alarms exist that could be the source of the GAIN-HDEG alarm,
or if clearing an alarm did not clear the GAIN-HDEG, place all of the card ports in OOS,DSBLD (or
Locked,disabled) administrative state.

Step 6

Complete the “Physically Replace a Card” procedure on page 2-240 for the reporting card.

Warning

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201
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Note

Step 7

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.105 GAIN-HFAIL
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: AOTS
The Gain High Degrade alarm is raised on an amplifier card (OPT-BST, OPT-PRE, or OPT-AMP-x-C)
when the amplifier reaches the Gain High Degrade Threshold. (This value is automatically provisioned
with the gain setpoint, but the alarm threshold is 5 dBm higher than the setpoint.) If the alarm cannot be
cleared, the card must be replaced.

Note

This alarm is applicable only when the amplifier working mode is set to Control Gain.

Note

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about control gain, refer to the “Node
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the GAIN-HFAIL Alarm
Step 1

For the alarmed card, complete the “Clear the GAIN-HDEG Alarm” procedure on page 2-89.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.

2.5.106 GAIN-LDEG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: AOTS
The Gain High Degrade alarm is raised on an amplifier card (OPT-BST, OPT-PRE, or OPT-AMP-x-C)
when the amplifier does not reach Gain High Degrade Threshold. (This value is automatically
provisioned with the gain setpoint, but the alarm threshold is 2 dBm lower than the setpoint.) The card
should be replaced at the first opportunity.

Note

This alarm is applicable only when the amplifier working mode is set to Control Gain.
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Note

For general information about DWDM amplifier cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about control gain, refer to the “Node
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the GAIN-LDEG Alarm
Step 1

For the alarmed card, complete the “Clear the GAIN-HDEG Alarm” procedure on page 2-89.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.107 GAIN-LFAIL
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: AOTS
The Gain High Degrade alarm is raised on an amplifier card (OPT-BST, OPT-PRE, or OPT-AMP-x-C)
when the amplifier does not reach Gain High Degrade Threshold. (This value is automatically
provisioned with the gain setpoint, but the alarm threshold is 5 dBm lower than the setpoint. If the alarm
cannot be cleared, the card must be replaced.

Note

This alarm is applicable only when the amplifier working mode is set to Control Gain.

Note

For general information about DWDM amplifier cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about control gain, refer to the “Node
Reference” chapter in the same manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the GAIN-LFAIL Alarm
Step 1

For the alarmed card, complete the “Clear the GAIN-HDEG Alarm” procedure on page 2-89.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.108 GCC-EOC
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: TRUNK, EQPT
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The GCC Embedded Operation Channel Failure alarm applies to the optical transport network (OTN)
communication channel for TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, MXP_2.5G_10E, and ADM-10G cards. The
GCC-EOC alarm is raised when the channel cannot operate.
This alarm applies to trunk ports only when ITU-T G.709 encapsulation is enabled and a general
communication channel (GCC) has been provisioned between the two TXP/MXP cards.

Note

For more information about GCC circuits, please refer to the “Create Channels and Circuits” chapter in
the Cisco ONS 15454 DWDM Procedure Guide.

Clear the GCC-EOC Alarm
Step 1

Complete the “Clear the EOC Alarm” procedure on page 2-69.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.109 GE-OOSYNC (FC, GE, ISC)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: FC, GE, ISC
The Gigabit Ethernet Out of Synchronization alarm applies to TXP_MR_10G,TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G,TXPP_MR_2.5G,MXP_MR_2.5G,
MXPP_MR_2.5G, GE-XP, 10GE, and ADM-10G cards when the Ethernet signal incoming on the
Client-Rx port is out of synchronization.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the GE-OOSYNC (FC, GE, ISC) Alarm
Step 1

Ensure that the incoming signal from the Client-Rx port is provisioned with the correct physical-layer
protocol (Ethernet).

Step 2

Ensure that the line is provisioned with the correct line speed (10G or 1G Ethernet).

Step 3

Verify that the optical power and the optical signal-to-noise range (OSNR) of the incoming Client-Rx
port optical signal are within the accepted ranges. You can find XFP/SFP ranges in the “Hardware
Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.
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Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.110 GE-OOSYNC (TRUNK)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: TRUNK
The Gigabit Ethernet Out of Synchronization alarm applies to TXP_MR_10G,TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, TXP_MR_2.5G,TXPP_MR_2.5G,MXP_MR_2.5G,
MXPP_MR_2.5G, GE-XP, 10GE, and ADM-10G cards only when the ITU-T G.709 encapsulation
framer is disabled.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the GE-OOSYNC (TRUNK) Alarm
Step 1

Verify that ITU-T G.709 encapsulation is disabled:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to display the
card view.

b.

Click the Provisioning > OTN > OTN Lines tabs.

c.

If the G.709 OTN column says Enable, choose Disable from the drop-down list.

d.

Click Apply.

Step 2

For the TRUNK-RX port, double-click the card and click the Performance > OTN PM > FEC PM tabs.
If post-FEC errors are present, troubleshoot this problem first. If not, move to next step.

Step 3

Verify the status of far-end TXP/MXP connected to the faulty near-end card. Look for any alarms
reported by the Client-Rx port of far-end card. If these alarms exist, troubleshoot them.

Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.111 GFP-CSF
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: CEMR, CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX
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The GFP Client Signal Fail Detected alarm is a secondary alarm raised on local GFP data ports when a
remote Service-Affecting (SA) alarm causes invalid data transmission. The alarm is raised locally on
CE-100T-8, CE-1000-4, CE-MR-10, FC_MR-4, ML100T, ML1000, ML100X-8, ML-MR-10,
MXP_MR_25G, and MXPP_MR_25G GFP data ports and does not indicate that a
Service-Affecting (SA) failure is occurring at the local site, but that a CARLOSS, LOS, or SYNCLOSS
alarm caused by an event such as a pulled receive cable is affecting a remote data port's transmission
capability. This alarm can be demoted when a facility loopback is placed on the FC_MR-4 port.

Note

For more information about provisioning MXP or TXP cards, refer to the Cisco ONS 15454 DWDM
Reference Manual. For more information about Ethernet cards, refer to the Ethernet Card Software
Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and
Cisco ONS 15327.

Clear the GFP-CSF Alarm
Step 1

Clear the Service-Affecting (SA) alarm at the remote data port.

Step 2

If the GFP-CSF alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447) to report
a Service-Affecting (SA) problem.

2.5.112 GFP-LFD
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: CEMR, CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX
The GFP Loss of Frame Delineation alarm applies to Fibre Channel, FICON GFP, and Ethernet ports.
This alarm occurs if there is a faulty SONET connection, if SONET path errors cause GFP header errors
in the check sum calculated over payload length (PLI/cHEC) combination, or if the GFP source port
sends an invalid PLI/cHEC combination. This loss causes traffic stoppage.

Note

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-LFD Alarm
Step 1

Look for and clear any associated SONET path errors such as LOS or the “AU-AIS” alarm on page 2-37
that originate at the transmit node.

Step 2

If the GFP-LFD alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447) to report
a Service-Affecting (SA) problem.
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2.5.113 GFP-UP-MISMATCH
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: CEMR, CE1000, CE100T, FCMR, GFP-FAC, ML1000, ML100T, MLFX
The GFP User Payload Mismatch is raised against Fibre Channel/FICON ports supporting GFP. It occurs
when the received frame user payload identifier (UPI) does not match the transmitted UPI and all frames
are dropped. The alarm is caused by a provisioning error, such as the port media type not matching the
remote port media type. For example, the local port media type could be set to Fibre Channel—1 Gbps
ISL or Fibre Channel—2 Gbps ISL and the remote port media type could be set to FICON—1 Gbps ISL
or FICON—2 Gbps ISL.

Note

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the GFP-UP-MISMATCH Alarm
Step 1

Step 2

Step 3

Ensure that the transmit port and receive port are identically provisioned for distance extension by
completing the following steps:
a.

Double-click the card to open the card view.

b.

Click the Provisioning > Port > Distance Extension tabs.

c.

Check the check box in the Enable Distance Extension column.

d.

Click Apply.

Ensure that both ports are set for the correct media type. For each port, complete the following steps:
a.

Double-click the card to open the card view (if you are not already in card view).

b.

Click the Provisioning > Port > General tabs.

c.

Choose the correct media type (Fibre Channel - 1Gbps ISL, Fibre Channel - 2 Gbps ISL,
FICON - 1 Gbps ISL, or FICON - 2 Gbps ISL) from the drop-down list.

d.

Click Apply.

If the GFP-UP-MISMATCH alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447) to report
a Service-Affecting (SA) problem.

2.5.114 HELLO
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN
The Open Shortest Path First (OSPF) Hello alarm is raised when the two end nodes cannot bring an
OSPF neighbor up to the full state. Typically, this problem is caused by an area ID mismatch, and/or
OSPF HELLO packet loss over the DCC.
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Clear the HELLO Alarm
Step 1

Step 2

Ensure that the area ID is correct on the missing neighbor by completing the following steps:
a.

In node view, click the Provisioning > Network > OSPF tabs.

b.

Ensure that the IP address in the Area ID column matches the other nodes.

c.

If the address does not match, click the incorrect cell and correct it.

d.

Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country.

2.5.115 HIBATVG
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: PWR
The High Voltage Battery alarm occurs in a –48 VDC environment when a battery lead input voltage
exceeds the high power threshold. This threshold, with a default value of –52 VDC, is
user-provisionable. The alarm remains raised until the voltage remains under the threshold for
120 seconds.

Clear the HIBATVG Alarm
Step 1

The problem is external to the ONS system. Troubleshoot the power source supplying the battery leads.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.116 HI-CCVOLT
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: BITS
The 64K Composite Clock High NE Voltage alarm occurs when the 64K signal peak voltage exceeds
1.1 VDC.

Clear the HI-CCVOLT Condition
Step 1

Lower the source voltage to the clock.

Step 2

If the condition does not clear, add more cable length or add a 5 dBm attenuator to the cable.
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Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.117 HI-LASERBIAS
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN, PPM, TRUNK
The Equipment High Transmit Laser Bias Current alarm is raised against TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L,
MXP_2.5G_10G, OC192-XFP, and ADM-10G card laser performance. The alarm indicates that the card
laser has reached the maximum laser bias tolerance.
Laser bias typically starts at about 30 percent of the manufacturer maximum laser bias specification and
increases as the laser ages. If the HI-LASERBIAS alarm threshold is set at 100 percent of the maximum,
the laser usability has ended. If the threshold is set at 90 percent of the maximum, the card is still usable
for several weeks or months before it needs to be replaced.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. Specific hardware values are listed in the “Hardware
Specifications” appendix of the same manual.

Clear the HI-LASERBIAS Alarm
Step 1

Complete the “Physically Replace a Card” procedure on page 2-240. Replacement is not urgent and can
be scheduled during a maintenance window.

Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Caution

Removing an active card can cause a traffic hit. To avoid this, perform an external switch if a switch has
not already occurred. See the “2.8.2 Protection Switching, Lock Initiation, and Clearing” section on
page 2-233 for commonly used traffic-switching procedures.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.118 HI-LASERTEMP
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
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Logical Objects: EQPT, OCN/STMN, PPM
The Equipment High Laser Optical Transceiver Temperature alarm applies to the TXP, MXP, and
ADM-10G cards. HI-LASERTEMP occurs when the internally measured transceiver temperature
exceeds the card setting by 35.6 degrees F (2 degrees C). A laser temperature change affects the
transmitted wavelength.
When the TXP or MXP card raises this alarm, the laser is automatically shut off. The LOS (OCN/STMN)
alarm is raised at the far-end node and the “DUP-IPADDR” alarm, page 2-64, is raised at the near end.
(For instructions to clear either of these alarms, you can also refer to the “Alarm Troubleshooting”
chapter in the Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454SDH Troubleshooting
Guide.)

Note

For information about MXP and TXP cards and PPMs (SFPs), refer to the “Card Reference” chapter in
the Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Turn Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the HI-LASERTEMP Alarm
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP or MXP card to
open the card view.

Step 2

Click the Performance > Optics PM > Current Values tabs.

Step 3

Verify the card laser temperature levels. Maximum, minimum, and average laser temperatures are shown
in the Current column entries in the Laser Temp rows.

Step 4

Complete the “Reset a Card in CTC” procedure on page 2-237 for the MXP or TXP card.

Step 5

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240 for the
reporting MXP or TXP card.

Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.119 HI-RXPOWER
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC, OCN/STMN, TRUNK, EQPT
The Equipment High Receive Power alarm is an indicator of the optical signal power that is transmitted
to the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, MXP_2.5G_10G, OC192-XFP, GE-XP, 10GE-XP, or ADM-10G card.
HI-RXPOWER occurs when the measured optical power of the received signal exceeds the threshold.
The threshold value is user-provisionable.

Note

For general information about MXP and TXP cards and their power levels, refer to the “Card Reference”
chapter in the Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them,
refer to the “Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.
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Clear the HI-RXPOWER Alarm
Step 1

Check the PM of the TRUNK-RX port. Verify that received power is above the optics threshold:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to display the
card view.

b.

For the TRUNK-RX port, double-click the card and click the Performance > Optics PM >
Historical PM tabs, choose the port in the Port drop-down list, and click Refresh.

c.

Compare the refreshed PM values with the threshold (ensuring that it is above the threshold value)
by clicking the Performance > Optics PM > Current Values tabs.

d.

Ensure that a proper threshold has been provisioned for the receive value. (Refer to the “Provision
Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.) If
an incorrect threshold has been set, adjust it to a value within the allowed limits. If instead the alarm
condition does not clear, move to next step.

Step 2

Verify that the Trunk-Rx port is cabled correctly, and clean the fiber connecting the faulty TXP/MXP to
the Drop port of the DWDM card (32DMX, 32DMX-O, 40DMX, or AD-xC-xx.x). If no site cleaning
practices are available, refer to the fiber cleaning procedure in the “Maintain the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

Step 3

Determine whether a bulk attenuator is specified by the Cisco TransportPlanner (MP) design. If so,
verify that the proper fixed attenuation value has been used.

Step 4

Using a test set, check the optical power value of the Drop port of the DWDM card (32DMX, 32DMX-O,
40DMX, or AD-xC-xx.x) connected to the faulty TXP/MXP. If the read value is different (+1 dBm or
–1 dBm) from the ANS setpoint for “Padd&drop-Drop power,” move to next step.

Step 5

Look for and troubleshoot any alarm reported by the DWDM cards belonging to the OCHNC circuit
destinating at the faulty TXP/MXP. Possible alarms include amplifier Gain alarms (the “GAIN-HDEG”
alarm on page 2-89, the “GAIN-HFAIL” alarm on page 2-90, the “GAIN-LDEG” alarm on page 2-90,
or “GAIN-LFAIL” alarm on page 2-91); APC alarms (“APC-CORR-SKIPPED” alarm on page 2-29 or
“APC-OUT-OF-RANGE” alarm on page 2-30), or LOS-P alarms on the Add or Drop ports involved in
the OCHNC circuit.

Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.120 HITEMP
Default Severity: Critical (CR), Service-Affecting (SA) for NE; Default Severity: Minor (MN),
Non-Service-Affecting (NSA) for EQPT
Logical Objects: EQPT, NE
The High Temperature alarm occurs when the temperature of the ONS system is above 122 degrees F
(50 degrees C).

Clear the HITEMP Alarm
Step 1

View the temperature displayed on the ONS system LCD front panel. For example, the ONS 15454 front
panel is illustrated in Figure 2-2.
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Slot

Shelf LCD Panel

Status

Port

8/18/03
24˚C
04.06-002L-10
FAN FAIL

CRIT

MAJ

MIN

97758

Figure 2-2

Step 2

Verify that the environmental temperature of the room is not abnormally high.

Step 3

If the room temperature is not abnormal, physically ensure that nothing prevents the fan-tray assembly
from passing air through the ONS system shelf.

Step 4

If airflow is not blocked, physically ensure that blank faceplates fill the ONS system shelf empty slots.
Blank faceplates help airflow.

Step 5

If faceplates fill the empty slots, determine whether the air filter needs replacement. Refer to the
“Inspect, Clean, and Replace the Reusable Air Filter” procedure on page 2-243.

Step 6

If the fan does not run or the alarm persists, complete the “Replace the Fan-Tray Assembly” procedure
on page 2-245.

Note
Step 7

The fan should run immediately when correctly inserted.

If the replacement fan-tray assembly does not operate correctly, log into the Technical Support Website
at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem (1-800-553-2447) if it applies to the NE, or a
Non-Service-Affecting (NSA) problem if it applies to equipment.

2.5.121 HI-TXPOWER
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN, PPM, TRUNK
The Equipment High Transmit Power alarm is an indicator on the TXP_MR_E, TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10G, OC192-XFP, or ADM-10G card transmitted
optical signal power. HI-TXPOWER occurs when the measured optical power of the transmitted signal
exceeds the threshold.

Note

For general information about MXP and TXP cards and power levels, refer to the “Card Reference”
chapter in the Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them,
refer to the “Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.
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Clear the HI-TXPOWER Alarm
Step 1

Step 2

Check the PM of the Trunk-Tx port. Verify that received power is above the optics threshold:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to display the
card view.

b.

For the Trunk-Tx port, double-click the card and click the Performance > Optics PM >
Historical PM tabs, choose the port in the Port drop-down list, and click Refresh.

c.

Compare the refreshed PM values with the threshold (ensuring that it is above the threshold value)
by clicking the Performance > Optics PM > Current Values tabs.

d.

Ensure that a proper threshold has been provisioned for the receive value. (Refer to the “Provision
Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.) If
an incorrect threshold has been set, adjust it to a value within the allowed limits. If instead the alarm
condition does not clear, move to next step.

Physically verify, by using a standard power meter that the optical output power is overcoming the
expected power threshold. If so, the card should be replaced at first opportunity

Note

The higher power level is not a major issue for the DWDM card (32MUX-O, 40MUX,
32WSS-O, 40WSS-C, or AD-xC-xx.x) connected to the faulty TXP/MXP, because an
internal VOA can automatically decrease the optical power to the expected level.

Step 3

Complete the “Physically Replace a Card” procedure on page 2-240.

Step 4

If the alarm does not clear after the replacement, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in order to
report a Service-Affecting (SA) problem. If the alarm does not clear, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1-800-553-2447).

2.5.122 HLDOVRSYNC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE-SREF
The Holdover Synchronization Mode condition is caused by loss of the primary and second timing
references in the node. Timing reference loss occurs when line coding on the timing input is different
from the configuration on the node, and it often occurs during the selection of a new node reference
clock. The condition clears when primary or second timing is reestablished. After the 24-hour holdover
period expires, timing slips could begin to occur on an ONS system relying on an internal clock.

Clear the HLDOVRSYNC Condition
Step 1

Clear additional alarms that relate to timing, such as:
•

2.5.101 FRNGSYNC, page 2-87

•

2.5.102 FSTSYNC, page 2-88
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•

2.5.152 LOF (BITS), page 2-125

•

2.5.162 LOS (BITS), page 2-133

•

2.5.186 MANSWTOINT, page 2-153

•

2.5.187 MANSWTOPRI, page 2-153

•

2.5.188 MANSWTOSEC, page 2-154

•

2.5.189 MANSWTOTHIRD, page 2-154

•

2.5.287 SWTOPRI, page 2-213

•

2.5.288 SWTOSEC, page 2-214

•

2.5.289 SWTOTHIRD, page 2-214

•

2.5.290 SYNC-FREQ, page 2-214

•

2.5.292 SYNCPRI, page 2-216

•

2.5.293 SYNCSEC, page 2-216

•

2.5.294 SYNCTHIRD, page 2-217

Step 2

Reestablish a primary and secondary timing source according to local site practice. If none exists, refer
to the “Turn Up the Network” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447) in order to
report a Service-Affecting (SA) problem.

2.5.123 HP-DEG
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VMMON-HP, VCTRM-HP
An HP-DEG condition is similar to the “SD (TRUNK)” condition, page 2-197, but it applies to the HP
layer of the SDH overhead. A HP-DEG alarm travels on the B3 byte of the SDH overhead.
For path protection protected circuits, the BER threshold is user-provisionable and has a range for
HP-DEG from 1E–9 dBm to 1E–5 dBm. For MS-SPRing 1+1 and unprotected circuits, the BER
threshold value is not user-provisionable and the error rate is hard-coded to 1E–6 dBm.
On path protection configurations, an HP-DEG condition causes a switch from the working card to the
protect card at the path level. On MS-SPRing, 1+1, and on unprotected circuits, an HP-DEG condition
does not cause switching.
The BER increase that causes the condition is sometimes caused by a physical fiber problem such as a
poor fiber connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.
HP-DEG clears when the BER level falls to one-tenth of the threshold level that triggered the alarm.

Clear the HP-DEG Condition
Step 1

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-197.
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.124 HP-ENCAP-MISMATCH
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: VCTRM-HP
The High-Order Path Encapsulation C2 Byte Mismatch alarm applies to ML-Series Ethernet cards. It
occurs when the first three following conditions are met and one of the last two is false:
•

The received C2 byte is not 0x00 (unequipped).

•

The received C2 byte is not a PDI value.

•

The received C2 does not match the expected C2.

•

The expected C2 byte is not 0x01 (equipped unspecified).

•

The received C2 byte is not 0x01 (equipped unspecified).

(This is in contrast to LP-PLM, which must meet all five criteria.) For an HP-ENCAP-MISMATCH to
be raised, there is a mismatch between the received and expected C2 byte, with either the expected byte
or received byte value being 0x01.
An example situation that would raise an HP-ENCAP-MISMATCH alarm is if a circuit created between
two ML-Series cards has GFP framing provisioned on one end and high-level data link control (HDLC)
framing with LEX encapsulation provisioned on the other. The GFP framing card transmits and expects
a C2 byte of 0x1B, while the HDLC framing card transmits and expects a C2 byte of 0x01.
A mismatch between the transmit and receive cards on any of the following parameters can cause the
alarm:
•

Mode (HDLC, GFP-F)

•

Encapsulation (LEX, HDLC, PPP)

•

CRC size (16 or 32)

•

Scrambling state (on or off)

This alarm is demoted by a path label mismatch (PLM) such as LP-PLM.

Note

By default, an HP-ENCAP-MISMATCH alarm causes an ML-Series card data link to go down. This
behavior can be modified using the command-line interface (CLI) command no pos trigger defect
encap.

Note

For more information about the ML-Series Ethernet card, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.
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Clear the HP-ENCAP-MISMATCH Alarm
Step 1

Step 2

Step 3

Ensure that the correct framing mode is in use on the receiving card by completing the following steps:
a.

In node view, double-click the ML-Series card to display the card view.

b.

Click the Provisioning > Card tabs.

c.

In the Mode drop-down list, ensure that the correct mode (GFP-F or HDLC) is selected. If it is not,
choose it and click Apply.

Ensure that the correct framing mode is in use on the transmit card, and that it is identical to the framing
mode used on the receiving card by completing the following steps:
a.

In node view, double-click the ML-Series card to display the card view.

b.

Click the Provisioning > Card tabs.

c.

In the Mode drop-down list, ensure that the same mode (GFP-F or HDLC) is selected. If it is not,
choose it and click Apply.

If the alarm does not clear, use the ML-Series card CLI to ensure that the remaining settings are correctly
configured:
•

Encapsulation

•

CRC size

•

Scrambling state

To open the interface, click the card view IOS tab and click Open IOS Connection. Refer to the
Ethernet Card Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454
SDH, and Cisco ONS 15327 entries on all three of these topics to obtain the full configuration command
sequences.
Step 4

If the alarm does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.125 HP-EXC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: VCMON-HP, VCTRM-HP
An HP-EXC condition is similar to the “SF (TRUNK)” condition, page 2-200, but it applies to the path
layer B3 byte of the SONET overhead. It can trigger a protection switch.
The HP-EXC condition clears when the BER level falls to one-tenth of the threshold level that triggered
the condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

Clear the HP-EXC Condition
Step 1

Complete the “Clear the SF (TRUNK) Condition” procedure on page 2-201.
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.126 HP-PLM
The HP-PLM condition is not used in this platform in this release. It is reserved for development.

2.5.127 HP-RFI
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP
The High-Order Remote Failure Indication (RFI) condition indicates that there is a remote failure
indication in the high-order (VC-4 or VC-3) path, and that the failure has persisted beyond the maximum
time allotted for transmission system protection. The HP-RFI is sent as the protection switch is initiated.
Resolving the fault in the adjoining node clears the HP-RFI condition in the reporting node.

Clear the HP-RFI Condition
Step 1

Log into the node at the far end of the reporting ONS 15454.

Step 2

Determine whether there are any related alarms, especially the LOS(STM1E, STMN).

Step 3

Clear the main alarm. See the appropriate alarm section in this chapter for procedures.

Step 4

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.128 HP-TIM
Default Severities: Critical (CR), Service-Affecting (SA) for VCTRM-HP; Minor (MN),
Non-Service-Affecting (NSA) for VCMON-HP
Logical Objects: VCMON-HP, VCTRM-HP
The TIM High-Order TIM Failure alarm indicates that the trace identifier J1 byte of the high-order
(VC-4 or VC-3) overhead is faulty. HP-TIM occurs when there is a mismatch between the transmitted
and received J1 identifier byte in the SONET path overhead. The error can originate at the transmit end
or the receive end.
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Clear the HP-TIM Alarm
Step 1

Use an optical test set capable of viewing SONET path overhead to determine the validity of the J1 byte.
For specific procedures to use the test set equipment, consult the manufacturer. Examine the signal as
near to the reporting card as possible.
•

Examine the signal as close as possible to the output card.

Step 2

If the output card signal is valid, complete the “Clear the SYNCPRI Alarm” procedure on page 2-216.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country. If the alarm applies to
VCTRM-HP, it is a service-affecting problem.

2.5.129 HP-UNEQ
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: VCMON-HP, VCTRM-HP
The signal label mismatch fault (SLMF) Unequipped High-Order Path alarm applies to the C2 path
signal label byte in the high-order (VC-4) path overhead. HP-UNEQ occurs when no C2 byte is received
in the SONET path overhead.

Clear the HP-UNEQ Alarm
Step 1

From the View menu, choose Go to Network View.

Step 2

Right-click the alarm to display the Select Affected Circuits shortcut menu.

Step 3

Click Select Affected Circuits.

Step 4

When the affected circuits appear, look in the Type column for a virtual circuit (VC).

Step 5

If the Type column does not contain a VC, there are no VCs. Go to Step 7.

Step 6

If the Type column does contain a VC, attempt to delete these row(s) by completing the following steps:

Note

Step 7

The node does not allow you to delete a valid VC.

a.

Click the VC row to highlight it. Complete the “Delete a Circuit” procedure on page 2-241.

b.

If an error message dialog box appears, the VC is valid and not the cause of the alarm.

c.

If any other rows contain VT, repeat Steps a through b.

If all ONS nodes in the ring appear in the CTC network view, verify that the circuits are all complete by
completing the following steps:
a.

Click the Circuits tab.

b.

Verify that INCOMPLETE is not listed in the Status column of any circuits.
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Step 8

If you find circuits listed as incomplete, verify that these circuits are not working circuits that continue
to pass traffic, using an appropriate optical test set and site-specific procedures. For specific procedures
to use the test set equipment, consult the manufacturer.

Step 9

If the incomplete circuits are not needed or are not passing traffic, delete the incomplete circuits.
Complete the “Delete a Circuit” procedure on page 2-241.

Step 10

Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and Tunnels” chapter in
the Cisco ONS 15454 Procedure Guide for circuit procedures.

Step 11

Log back in and verify that all circuits terminating in the reporting card are active by completing the
following steps:

Step 12

a.

Click the Circuits tab.

b.

Verify that the Status column lists all circuits as active.

If the alarm does not clear, clean the far-end optical fiber according to site practice. If no site practice
exists, complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 Procedure
Guide.

Warning

On the OC192 LR/STM64 LH 1550 card, the laser is on when the card is booted and the safety key is in
the on position (labeled 1). The port does not have to be in service for the laser to be on. The laser is
off when the safety key is off (labeled 0). Statement 293

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Step 13

Caution

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240 for the
optical and/or electrical cards.

Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To avoid this,
perform an external switch if a switch has not already occurred. Refer to the “Maintain the Node” chapter
in the Cisco ONS 15454 Procedure Guide for information.

Note

Step 14

When you replace a card with the identical type of card, you do not need to make any changes
to the database.

If the alarm does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country in order to report a Service-Affecting (SA) problem.
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2.5.130 I-HITEMP
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: NE
The Industrial High Temperature alarm occurs when the temperature of the ONS system is above
149 degrees F (65 degrees C) or below –40 degrees F (–40 degrees C). This alarm is similar to the
HITEMP alarm but is used for the industrial environment. If this alarm is used, you can customize your
alarm profile to ignore the lower-temperature HITEMP alarm.

Clear the I-HITEMP Alarm
Step 1

Complete the “Clear the HITEMP Alarm” procedure on page 2-99.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447) in order to report a Service-Affecting (SA) problem.

2.5.131 ILK-FAIL
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK
The ADM Peer Group Interlink Failure condition is raised on the ADM-10G card. This condition occurs
when one of the following SONET/OTN alarms is detected on the interlink ports of the ADM-10G card.
•

“LOS (TRUNK)” alarm, page 2-135

•

“LOF (TRUNK)” alarm, page 2-126

•

“SF (TRUNK)” alarm, page 2-200

Clear the ILK-FAIL Alarm
Step 1

Step 2

Clear the root-cause service-affecting alarm by using one of the following procedures, as appropriate:
•

“Clear the LOS (TRUNK) Alarm” procedure on page 2-136

•

“Clear the LOF (TRUNK) Alarm” procedure on page 2-126

•

“Clear the SF (TRUNK) Condition” procedure on page 2-201

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447) in order to report a Service-Affecting (SA) problem.

2.5.132 IMPROPRMVL
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: EQPT, PPM
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The Improper Removal (IMPROPRMVL) alarm occurs under the following conditions:
•

A card is removed when the card was rebooting. It is recommended that after the card completely
reboots, delete the card in CTC and only then remove the card physically. When you delete the card,
CTC loses connection with the node view (single-shelf mode) or shelf view (multishelf mode), and
goes to network view.

•

When a card is physically removed from its slot before it is deleted from CTC. It is recommended
that any card be deleted in CTC before physically removing the card from the chassis.

Note

CTC provides the user approximately 15 seconds to physically remove the card before it begins
rebooting the card.
It can take up to 30 minutes for software to be updated on a standby TCC2/TCC2P card.

•

A card is inserted into a slot but is not fully plugged into the backplane.

•

A PPM (SFP) is provisioned but the physical module is not inserted into the port.

•

Removal of an SFP from the client ports of a Y-cable protection group card causes an
IMPROPRMVL (PPM) alarm.
The working port raises the CR,IMPROPRMVL,SA alarm and the protected port raises the
MN,IMPROPRMVL,NSA alarm. The severity on the client ports is changed according to the
protection switch state.
For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.
For more information about provisioning PPMs (SFPs), refer to the “Turn Up a Node” chapter of
the Cisco ONS 15454 DWDM Procedure Guide. For specific PPM (SFP) values, refer to the
“Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.

•

Electrical issues such as short circuit or failure of DC-DC conversion.

Clear the IMPROPRMVL Alarm
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), right-click the card reporting the
IMPROPRMVL.

Step 2

Choose Delete from the shortcut menu.

Note

Step 3

Caution

CTC does not allow you to delete the reporting card if the card is in service, does have circuits
mapped to it, is paired in a working protection scheme, has DCC enabled, or is used as a timing
reference.

If any ports on the card are in service, place them out of service (OOS,MT or Locked,maintenance):

Before placing a port out of service (OOS,MT or Locked,maintenance) or OOS,DSBLD (or
Locked,disabled), ensure that no live traffic is present.
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting card to
open the card view.

b.

Click the Provisioning > Line tabs.
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Step 4

Caution
Step 5

Step 6

Step 7

Step 8

c.

Click the Admin State column of any in-service (IS or Unlocked) ports.

d.

Choose OOS,MT (or Locked,maintenance) to take the ports out of service.

If a circuit has been mapped to the card, complete the “Delete a Circuit” procedure on page 2-241.

Before deleting the circuit, ensure that the circuit does not carry live traffic.
If the card is paired in a protection scheme, delete the protection group by completing the following
steps:
a.

Click View > Go to Previous View to return to node view (single-shelf mode) or shelf view (multishelf
mode).

b.

If you are already in node view (single-shelf mode) or shelf view (multishelf mode), click the
Provisioning > Protection tab.

c.

Click the protection group of the reporting card.

d.

Click Delete.

If the card is provisioned for DCC, delete the DCC provisioning by completing the following steps:
a.

In node view (single-shelf mode) or multishelf view (multishelf mode), click the ONS system
Provisioning > Comm Channels > SDCC (or Provisioning > Comm Channels > MS DCC) tabs.

b.

Click the slots and ports listed in DCC terminations.

c.

Click Delete and click Yes in the dialog box that appears.

If the card is used as a timing reference, change the timing reference by completing the following steps:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing >
General tabs.

b.

Under NE Reference, click the drop-down arrow for Ref-1.

c.

Change Ref-1 from the listed OC-N/STM-N card to Internal Clock.

d.

Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.133 INHSWPR
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Inhibit Switch To Protect Request on Equipment condition occurs on traffic cards when the ability
to switch to protect has been disabled. If the card is part of a 1:1 or 1+1 protection scheme, traffic
remains locked onto the working system. If the card is part of a 1:N protection scheme, traffic can be
switched between working cards when the switch to protect is disabled.
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Clear the INHSWPR Condition
Step 1

If the condition is raised against a 1+1 port, complete the “Initiate a 1+1 Manual Switch Command”
procedure on page 2-234.

Step 2

If it is raised against a 1:1 card, complete the “Initiate a 1:1 Card Switch Command” procedure on
page 2-234 to switch it back.

Step 3

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.134 INHSWWKG
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Inhibit Switch To Working Request on Equipment condition occurs on traffic cards when the ability
to switch to working has been disabled. If the card is part of a 1:1 or 1+1 protection scheme, traffic
remains locked onto the protect system. If the card is part of a 1:N protection scheme, traffic can be
switched between protect cards when the switch to working is disabled.

Note

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the INHSWWKG Condition
Step 1

If the condition is raised against a 1+1 port, complete the “Initiate a 1+1 Manual Switch Command”
procedure on page 2-234.

Step 2

If it is raised against a 1:1 card, complete the “Initiate a 1:1 Card Switch Command” procedure on
page 2-234 to switch it back.

Step 3

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.135 INCOMPATIBLE-SEND-PDIP
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM
The Incompatible Software alarm is raised when CTC’S send PDI-P provisioning differs from the host
node's provisioning.
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Clear the INCOMPATIBLE-SEND-PDIP Alarm
Step 1

Reconfigure CTC’s send PDI-P alarm capability to align with the host node settings.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.5.136 INCOMPATIBLE-SW
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM
The Incompatible Software alarm is raised when CTC cannot connect to the NE due to differing,
incompatible versions of software between CTC and the NE. The alarm is cleared by restarting CTC in
order to redownload the CTC JAR files from the NE.

Clear the INCOMPATIBLE-SW Alarm
Step 1

Restart the CTC application.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.5.137 INTRUSION-PSWD
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE
The Security Intrusion Incorrect Password condition occurs after a user attempts a provisionable (by
Superuser) number of unsuccessful logins, a login with an expired password, or an invalid password. The
alarmed user is locked out of the system, and INTRUSION-PSWD condition is raised. This condition is
only shown in Superuser login sessions, not in login sessions for lower-level users. The
INTRUSION-PSWD condition is automatically cleared when a provisionable lockout timeout expires,
or it can be manually cleared in CTC by the Superuser if the lockout is permanent.

Clear the INTRUSION-PSWD Condition
Step 1

Log in as a user ID with superuser rights. (For more information about this, refer to the “Connect the PC
and Log Into the GUI” chapter in the Cisco ONS 15454 DWDM Procedure Guide.)

Step 2

In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > Security >
Users tabs.

Step 3

Click Clear Security Intrusion Alarm.
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Step 4

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.138 INVMACADR
Default Severity: Major (MJ), Non-Service Affecting (NSA)
Logical Object: AIP
The Equipment Failure Invalid MAC Address alarm occurs when the ONS system MAC address is
invalid. Each ONS system has a unique, permanently assigned MAC address. The address resides on an
AIP EEPROM. The TCC2/TCC2P card reads the address value from the AIP chip during boot-up and
keeps this value in its synchronous dynamic RAM (SDRAM).
Under normal circumstances, the read-only MAC address can be viewed in the node view (single-shelf
mode) or multishelf view (multishelf mode) Provisioning > Network tab in CTC.
The ONS system uses both IP and MAC addresses for circuit routing. When an INVMACADR alarm
exists on a node, you see a PARTIAL circuit in the CTC circuit status column. The circuit works and is
able to carry traffic, but CTC cannot logically display the circuit end-to-end information.
An invalid MAC address can be caused when:
•

There is a read error from the AIP during boot-up; in this case, the reading TCC2/TCC2P card uses
the default MAC address (00-10-cf-ff-ff-ff).

•

There is a read error occurring on one of the redundant TCC2/TCC2P cards that read the address
from the AIP; these cards read the address independently and could therefore each read different
address values.

•

An AIP component failure causes a read error.

•

The ribbon cable connecting the AIP card to the backplane is bad.

Clear the INVMACADR Alarm
Step 1

Check for any outstanding alarms that were raised against the active and standby TCC2/TCC2P card and
resolve them.

Step 2

If the alarm does not clear, determine whether the LCD display on the fan tray (Figure 2-2 on
page 2-100) is blank or if the text is garbled. If so, proceed to Step 8. If not, continue with Step 3.

Step 3

At the earliest maintenance window, reset the standby TCC2/TCC2P card:

Note

The reset requires approximately five minutes. Do not perform any other step until the reset is
complete.

a.

Log into a node on the network. If you are already logged in, continue with Step b.

b.

Identify the active TCC2/TCC2P card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

c.

In node view (single-shelf mode) or shelf view (multishelf mode), right-click the standby
TCC2/TCC2P card in CTC.
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d.

Choose Reset Card from the shortcut menu.

e.

Click Yes in the Are You Sure dialog box.
The card resets, the FAIL LED blinks on the physical card, and connection to the node is lost. CTC
switches to network view.

f.

Verify that the reset is complete and error-free, and that no new related alarms appear in CTC. A
green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

g.

Double-click the node and ensure that the reset TCC2/TCC2P card is still in standby mode and that
the other TCC2/TCC2P card is active.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

h.

Ensure that no new alarms associated with this reset appear in the CTC Alarms window.

If the standby TCC2/TCC2P card fails to boot into standby mode and reloads continuously, the AIP is
probably defective. In this case, the standby TCC2/TCC2P card is unsuccessfully attempting to read the
EEPROM located on the AIP. The TCC2/TCC2P card reloads until it reads the EEPROM. Proceed to
Step 8.
Step 4

If the standby TCC2/TCC2P card rebooted successfully into standby mode, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-239.
Resetting the active TCC2/TCC2P card causes the standby TCC2/TCC2P card to become active. The
standby TCC2/TCC2P card keeps a copy of the chassis MAC address. If its stored MAC address is valid,
the alarm should clear.

Step 5

After the reset, note whether or not the INVMACADR alarm has cleared or is still present.

Step 6

Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-238 again to place the standby TCC2/TCC2P card back into active mode.
After the reset, note whether or not the INVMACADR alarm has cleared or is still present. If the
INVMACADR alarm remains standing through both TCC2/TCC2P card resets, this indicates that the
AIP is probably defective. Proceed to Step 8.
If the INVMACADR was raised during one TCC2/TCC2P card reset and cleared during the other, the
TCC2/TCC2P card that was active while the alarm was raised needs to be replaced. Continue with
Step 7.

Step 7

If the faulty TCC2/TCC2P card is currently in standby mode, complete the “Physically Replace a Card”
procedure on page 2-240 for this card. If the faulty TCC2/TCC2P card is currently active, during the next
available maintenance window complete the “Reset an Active TCC2/TCC2P Card and Activate the
Standby Card” procedure on page 2-238 and then complete the “Physically Replace a Card” procedure
on page 2-240.

Note

If the replacement TCC2/TCC2P card is loaded with a different software version from the
current TCC2/TCC2P card, the card boot-up could take up to 30 minutes. During this time, the
card LEDs flicker between Fail and Act/Sby as the active TCC2/TCC2P card version software
is copied to the new standby card.

Step 8

Open a case with Cisco TAC (1 800 553-2447) for assistance with determining the node’s previous MAC
address.

Step 9

Replace the ribbon cable between the system board and the AIP with a known-good cable.

Step 10

If the alarm persists, complete the “Replace an Alarm Interface Panel” procedure located in the “Alarm
Troubleshooting” chapter of the Cisco ONS 15454 Troubleshooting Guide.
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Step 11

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.139 ISIS-ADJ-FAIL
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN
The Open System Interconnection (OSI) Intermediate System to Intermediate-System (IS-IS) Adjacency
Failure alarm is raised by an intermediate system (node routing IS Level 1 or Level 1 and 2) when no IS
or end system (ES) adjacency is established on a point-to-point subnet. The Intermediate-System
Adjacency Failure alarm is not supported by ES. It is also not raised by IS for disabled routers.
The alarm is typically caused by a misconfigured router manual area adjacency (MAA) address. For
more information about IS-IS OSI routing and MAA configuration, refer to the “Management Network
Connectivity” chapter in the Cisco ONS 15454 SDH Reference Manual. For more information about
configuring OSI, refer to the “Turn Up Node” chapter in the Cisco ONS 15454 Procedure Guide for
procedures.

Clear the ISIS-ADJ-FAIL Alarm
Step 1

Ensure that both ends of the communication channel are using the correct Layer 2 protocol and settings
(LAPD or PPP). To do this, complete the following steps:
a.

At the local node, in node view, click the Provisioning > Comm Channels >MSDCC tabs.

b.

Click the row of the circuit. Click Edit.

c.

In the Edit MSDCC termination dialog box, view and record the following selections: Layer 2
protocol (LAPD or PPP); Mode radio button selection (AITS or UITS); Role radio button selection
(Network or User); MTU value; T200 value, and T203 selections.

d.

Click Cancel.

e.

Log in to the remote node and follow the same steps, also recording the same information for this
node.

Step 2

If both nodes do not use the same Layer 2 settings, you will have to delete the incorrect termination and
recreate it. To delete it, click the termination and click Delete. To recreate it, refer to the “Turn Up Node”
chapter in the Cisco ONS 15454 Procedure Guide for the procedure.

Step 3

If the nodes use PPP Layer 2, complete the “Clear the RS-EOC Alarm” procedure on page 2-195. If the
alarm does not clear, go to Step 7.

Step 4

If both nodes use the LAPD Layer 2 protocol but have different Mode settings, change the incorrect
node’s entry by clicking the correct setting radio button in the Edit MSDCC termination dialog box and
clicking OK.

Step 5

If the Layer 2 protocol and Mode settings are correct, ensure that one node is using the Network role and
the other has the User role. If not (that is, if both have the same mode settings), correct the incorrect one
by clicking the correct radio button in the Edit MSDCC termination dialog box and clicking OK.

Step 6

If the Layer 2, Mode, and Role settings are correct, compare the MTU settings for each node. If one is
incorrect, choose the correct value in the Edit MSDCC dialog box and click OK.
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Step 7

Step 8

Tip

Step 9

If all of the preceding settings are correct, ensure that OSI routers are enabled for the communications
channels at both ends by completing the following steps:
a.

Click Provisioning > OSI > Routers > Setup.

b.

View the router entry under the Status column. If the status is Enabled, check the other end.

c.

If the Status is Disabled, click the router entry and click Edit.

d.

Check the Enabled check box and click OK.

If the routers on both ends are enabled and the alarm still has not cleared, ensure that both ends of the
communications channel have a common MAA by completing the following steps:
a.

Click the Provisioning > OSI > Routers > Setup tabs.

b.

Record the primary MAA and secondary MAAs, if configured.

You can record long strings of information such as the MAA address by using the CTC export and print
functions. Export it by choosing File > Export > html. Print it by choosing File > Print.
c.

Log into the other node and record the primary MAA and secondary MAAs, if configured.

d.

Compare this information. There should be at least one common primary or secondary MAA in
order to establish an adjacency.

e.

If there is no common MAA, one must be added to establish an adjacency. Refer to the “Turn Up
Node” chapter of the Cisco ONS 15454 Procedure Guide for procedures to do this.

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.140 LASER-APR
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: AOTS
The Laser Automatic Power Reduction (APR) alarm condition is raised by OSC-CSM, OSCM,
OPT-BST, OPT-PRE, OPT-AMP-C, and OPT-AMP-17-C cards when the laser is working in power
reduction mode. The condition clears as soon as safety conditions are released and the power value
reaches the normal setpoint.

Warning

Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into
beams or view directly with optical instruments. Statement 1051.

Note

Only inactivate the APR function temporarily for installation or maintenance reasons. Activate APR
immediately after maintenance or installation.
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Note

LASER-APR is an informational condition and does not require troubleshooting. For more information
about optical amplifier APR, refer to the “Card Reference” chapter in the Cisco ONS 15454 DWDM
Reference Manual.

2.5.141 LASERBIAS-DEG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OTS
The Laser Bias Current Degrade alarm occurs on an amplifier card (OPT-BST, OPT-PRE, OPT-AMP-C,
or OPT-AMP-17-C) when laser aging causes a degrade, but not failure, of laser transmission. The card
should be replaced at the next opportunity.

Note

For general information about optical amplifier cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the LASERBIAS-DEG Alarm
Step 1

Warning

For the alarmed card, complete the “Physically Replace a Card” procedure on page 2-240 at the next
opportunity.

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Note

Step 2

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.142 LASERBIAS-FAIL
Default Severity: Major (MJ), Non-Service-Affecting (NSA)
Logical Object: AOTS
The Laser Bias Current Failure alarm occurs on an amplifier card (OPT-BST, OPT-PRE, OPT-AMP-C,
and OPT-AMP-17-C) when the laser control circuit fails or if the laser itself fails service. The card must
be replaced to restore traffic.
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Note

For general information about optical amplifier cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the LASERBIAS-FAIL Alarm
Step 1

Warning

For the alarmed card, complete the “Physically Replace a Card” procedure on page 2-240.

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

Note

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.143 LASEREOL
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCN
The Laser Approaching End of Life alarm applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G,
TXP_MR_10E, and MXP_2.5G_10G cards. It is typically accompanied by the “HI-LASERBIAS” alarm
on page 2-97. It is an indicator that the laser in the card must be replaced. How soon the replacement
must happen depends upon the HI-LASERBIAS alarm’s threshold. If the threshold is set under 100
percent, the laser replacement can usually be done during a maintenance window. But if the
HI-LASERBIAS threshold is set at 100 percent and is accompanied by data errors, LASEREOL
indicates the card must be replaced sooner.

Note

For more information about MXP or TXP cards, refer to the Cisco ONS 15454 DWDM Reference
Manual.

Clear the LASEREOL Alarm
Step 1

Complete the “Physically Replace a Card” procedure on page 2-240.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.144 LASERTEMP-DEG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: AOTS
The Laser Temperature Degrade alarm occurs when the Peltier control circuit fails on an amplifier card
(OPT-BST, OPT-PRE, OPT-AMP-C, and OPT-AMP-17-C). The Peltier control provides cooling for the
amplifier. The card should be replaced at the next opportunity.

Note

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the LASERTEMP-DEG Alarm
Step 1

For the alarmed DWDM card, complete the “Physically Replace a Card” procedure on page 2-240 at the
next opportunity.

Warning

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

Note

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.145 LMP-FAIL
Default Severity:Minor (MN), Non-Service-Affecting (NSA)
Logical Object: GE
The Link Management Protocol Fail alarm is raised by the TCC2/TCC2P card when an LMP control
channel fails or when there is a traffic engineering (TE) link correlation error. When the alarm is raised
against a control channel, it uses a control channel (CTRLx) AID. When the alarm is raised against a TE
link, a TE link AID (TLINKx) is used.
The alarm clears when the control channel or TE link is restored.

Note

LMP-FAIL occurs independently of the condition hierarchy between LMP-SD, page 121, LMP-SF,
page 121, or LMP-UNALLOC, page 123.
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Note

When the LMP-FAIL alarm is reported against a control channel (CTRLx) AID, it only refers to control
channel failure. It does not directly indicate data link or traffic engineering link status.

Note

When the LMP-FAIL alarm is reported against a TE link AID (TLINKx), it refers only to TE link status,
not to control channel or data link status.

Clear the LMP-FAIL Alarm
Step 1

Verify the AID (CTRLx or TLINKx) of the alarm.

Step 2

If the alarm is against the control channel AID, this is caused by mismatched control channel parameters
between the near-end ONS 15454 and the far-end node (which may be another vendor’s equipment).
Complete the following steps:
a.

Step 3

•

Click the Provisioning > Comm Channels > LMP > Control Channels tabs and view the
Admin State column content for the channel.

•

If the status does not say IS or Unlocked, change it and click Apply.

b.

Determine whether the near-end node LMP configuration contains the far-end node’s IP address as
its remote node IP. Also verify that the near-end node’s LMP configuration uses the LMP node ID
as its own remote node ID. If one or more of these values is incorrect, enter it correctly.

c.

Determine whether the far-end node LMP configuration contains the near-end node's IP address as
its remote node IP. Also verify that the far-end node’s LMP configuration uses the LMP node ID as
its own remote node ID. If one or more of these values is incorrect, enter it correctly.

d.

Verify that the far-end node is using the near-end node’s IP address as its remote node IP address,
and that the far end is also using the LMP node ID as its remote node ID. Update the far end’s values
if they are incorrect.

If instead the alarm is raised against the TE link AID, complete the following steps:
a.

Step 4

Determine whether both near-end and far-end sides of the control channel are in the IS or Unlocked
administrative state:

Determine whether both near-end and far-end sides of the TE link are in the IS or Unlocked
administrative state. If either end is currently down, update its administrative state to IS or
Unlocked:
•

Click the Provisioning > Comm Channels > LMP > TE links tab.

•

If the status does not say IS or Unlocked, change it and click Apply.

b.

Determine whether the near-end node’s remote TE link ID matches the far-end node’s local TE link
ID. If the near-end node’s remote value is incorrect, enter it correctly.

c.

Determine whether the far-end node’s remote TE link ID corresponds to the near-end node’s local
TE link ID. If the far-end node’s remote value is incorrect, enter it correctly.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.146 LMP-SD
Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: GE
The LMP Data Link Signal Degrade condition occurs for when the TCC2/TCC2P receives an LMP link
summary or channel status message that the control channel is not available from the far end, so the data
link level of service is not guaranteed. The degrade range is provisionable.
LMP-SD clears when the TCC2/TCC2P receives a link summary or channel status message reporting
that the data link is in the Signal Okay (OK) state.
LMP-SD is part of an alarm hierarchy that includes LMP-SF, page 121, and LMP-UNALLOC, page 123.
The hierarchy is as follows: If LMP-UNALLOC is raised, LMP-SF and LMP-SD are suppressed. If
LMP-SF is raised, it suppresses LMP-SD. LMP-SF and LMP-UNALLOC both suppress near-end
LOS-type alarms for DWDM clients. LMP-SD, however, does not suppress LOS alarms.
This condition clears when the far-end trouble has been cleared.

Clear the LMP-SD Condition
Step 1

Look for and clear any of the following alarms in Table 2-9 and Table 2-10 occurring on the far-end port.
Table 2-9

Trunk Port Alarm

LMP Failure

Direction

SD

SD

Tx

OTUK-SD

SD

Tx

ODUK-SD-PM

SD

Tx

ODUK-SD-TCM1

SD

Tx

ODUK-SD-TCM2

SD

Tx

Table 2-10

Step 2

Transponder Trunk Alarms that Cause LMP-SD

Transponder Client Alarm that Causes LMP-SD

Client Port Alarm

LMP Failure

Direction

SD

SD

Rx

If the LMP-SD condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.147 LMP-SF
Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: GE
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The LMP Data Link Signal Fail condition notifies the near-end user of a far-end problem (and thus is
NSA for the near end). The near-end’s TCC2/TCC2P receives an LMP link summary or channel status
message that the data link service has failed. The signal fail threshold provisionable.
LMP-SF clears when the TCC2/TCC2P receives a link summary or channel status message reporting that
the data link is in the Signal Okay (OK) state.
LMP-SF is part of an alarm hierarchy that includes LMP-SD, page 121, and LMP-UNALLOC, page 123.
The hierarchy is as follows: If LMP-UNALLOC is raised, LMP-SF and LMP-SD are suppressed. If
LMP-SF is raised, it suppresses LMP-SD. LMP-SF and LMP-UNALLOC both suppress near-end
LOS-type alarms for DWDM clients, but LMP-SD does not suppress LOS-type alarms.
This condition clears when the far-end trouble has been cleared.

Clear the LMP-SF Condition
Step 1

Look for and clear any of the following alarms in Table 2-11, Table 2-12, or Table 2-13 occurring on the
far-end port.
Table 2-11

Transponder Card Alarms that Cause LMP-SF

Card Alarm

LMP Failure

Direction

EQPT

SF

Tx

IMPROPRMVL

SF

Tx

Table 2-12

Transponder Trunk Alarms that Cause LMP-SF

Trunk Port Alarm

LMP Failure

Direction

LOS

SF

Tx

OTUK-LOF

SF

Tx

OTUK-AIS

SF

Tx

LOM

SF

Tx

OTUK-SF

SF

Tx

ODUK-SF-PM

SF

Tx

ODUK-SF-TCM1

SF

Tx

ODUK-SF-TCM2 SF

SF

Tx

FEC-MISM

SF

Tx

Table 2-13

Transponder Client Alarms that Cause LMP-SF

Client Alarm

LMP Failure

Direction

LOS

SF

Rx

SIGLOSS

SF

Rx

SYNCLOSS

SF

Rx
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Table 2-13

Step 2

Transponder Client Alarms that Cause LMP-SF (continued)

Client Alarm

LMP Failure

Direction

CARLOSS

SF

Rx

LOF

SF

Rx

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.148 LMP-UNALLOC
Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: GE
The LMP Data Link Unallocated condition is raised when the TCC2/TCC2P receives an LMP link
summary or channel status message reporting that the data link as unallocated for data traffic. The
condition clears when the data link is allocated and sends an LMP link summary or channel status
message to this effect. If a data link has the LMP-UNALLOC alarm raised against it, this should suppress
all other alarms on the client port, since the far-end node is not using the errored port. (Consequently
you do not have to clear any alarms on the far-end node’s unused port.)
LMP-UNALLOC is part of an alarm hierarchy that includes LMP-SD, page 121, and LMP-SF, page 121.
The hierarchy is as follows: If LMP-UNALLOC is raised, LMP-SF and LMP-SD are suppressed. If
LMP-SF is raised, it suppresses LMP-SD. LMP-SF and LMP-UNALLOC both suppress near-end
LOS-type DWDM client alarms, but LMP-SD does not.
In most cases, this condition is an informational notice at the near-end node that the far-end port is not
being utilized. If, however, the far-end port should be allocated for traffic, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1-800-553-2447).

2.5.149 LOCKOUT-REQ
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC, TRUNK
The Lockout Switch Request on Facility or Equipment condition occurs when a user initiates a lockout
switch request for an OC-N port in a 1+1 facility protection group. This can be accomplished by locking
traffic onto the working port with the LOCK ON command (thus locking it off the protect port), or
locking it off the protect port with the LOCK OUT command. In either case, the protect port will show
“Lockout of Protection,” and the Conditions window will show the LOCKOUT-REQ condition.
A lockout prevents protection switching. Clearing the lockout again allows protection switching and
clears the LOCKOUT-REQ condition.
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Clear the LOCKOUT-REQ Condition
Step 1

Complete the “Clear a Lock-On or Lockout Command” procedure on page 2-236.

Step 2

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.150 LOCKOUT-REQ (2R, EQPT, ESCON, FC, GE, ISC)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC
The Lockout Switch Request on Facility or Equipment condition occurs in a Y-cable MXP or TXP client
protection group for the above-listed clients when a user initiates a lockout switch request. The condition
is raised when you lock traffic onto the working port with the Lock On command (thus locking it off the
protect port), or you lock it off the protect port with the Lock Out command. In either case, the protect
port will show “Lockout of Protection,” and the Conditions window will show the LOCKOUT-REQ
condition.
A lockout prevents protection switching. Clearing the lockout again allows protection switching and
clears the LOCKOUT-REQ condition.

Clear the LOCKOUT-REQ (2R, EQPT, ESCON, FC, GE, ISC) Condition
Step 1

Complete the “Clear a Lock-On or Lockout Command” procedure on page 2-236.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.151 LOCKOUT-REQ (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The Lockout Switch Request on Facility or Equipment condition occurs in an MXP or TXP trunk port
splitter protection group when you lock traffic onto the working port with the Lock On command (thus
locking it off the protect port), or lock it off the protect port with the Lock Out command. In either case,
the protect port will show “Lockout of Protection,” and the Conditions window will show the
LOCKOUT-REQ condition.
A lockout prevents protection switching. Clearing the lockout again allows protection switching and
clears the LOCKOUT-REQ condition.
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Clear the LOCKOUT-REQ (TRUNK) Condition
Step 1

Complete the “Clear a Lock-On or Lockout Command” procedure on page 2-236.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.152 LOF (BITS)
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: BITS
The Loss of Frame (LOF) BITS alarm occurs when a port on theTCC2/TCC2P card BITS input detects
an LOF on the incoming BITS timing reference signal. LOF indicates that the receiving ONS system has
lost frame delineation in the incoming data.

Note

The procedure assumes that the BITS timing reference signal is functioning properly. It also assumes the
alarm is not appearing during node turn-up.

Clear the LOF (BITS) Alarm
Step 1

Verify that the line framing and line coding match between the BITS input and the TCC2/TCC2P card:
a.

In node or card view, note the slot and port reporting the alarm.

b.

Find the coding and framing formats of the external BITS timing source. The formats should be in
the user documentation for the external BITS timing source or on the timing source itself.

c.

In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing >
BITS Facilities tabs.

d.

Verify that the Coding setting matches the coding of the BITS timing source, either B8ZS or AMI.

e.

If the coding does not match, click Coding and choose the appropriate coding from the drop-down
list.

f.

Verify that Framing matches the framing of the BITS timing source, either ESF or SF (D4).

g.

If the framing does not match, click Framing and choose the appropriate framing from the
drop-down list.

Note

Step 2

On the timing subtab, the B8ZS coding field is normally paired with ESF in the Framing
field and the AMI coding field is normally paired with SF (D4) in the Framing field.

If the alarm does not clear when the line framing and line coding match between the BITS input and the
TCC2/TCC2P card, complete the “Physically Replace a Card” procedure on page 2-240 for the
TCC2/TCC2P card.
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Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.153 LOF (TRUNK)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK, OCN
The Loss of Frame for the DWDM trunk applies to the trunk optical or electrical signal that is carried to
TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, MXP_2.5G_10G, ADM-10G cards. It indicates that the receiving ONS system has
lost frame delineation in the incoming data from trunk that serves the cards. LOF occurs when the
SONET overhead loses a valid framing pattern for 3 milliseconds. Receiving two consecutive valid
A1/A2 framing patterns clears the alarm.

Note

In R7.01, when an LOF alarm occurs on TXP or MXP trunks, G709/SONET/SDH TCAs are suppressed.
For details, see the “Alarm and TCA Monitoring and Management” chapter in the Cisco ONS 15454
DWDM Reference Manual.

Clear the LOF (TRUNK) Alarm
Step 1

Using site practices, verify fiber continuity to the port. Refer to the “Network Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

Step 2

If the cabling is good, verify that the correct port is in service by completing the following steps:
a.

Confirm that the LED is correctly illuminated on the physical card. A green ACT/SBY LED
indicates an active card. An amber ACT/SBY LED indicates a standby card.

b.

To determine whether the port is in service, in node view (single-shelf mode) or shelf view (multishelf
mode), double-click the card in CTC to open the card view.

c.

Click the Provisioning > Line tabs.

d.

Verify that the Admin State column lists the port as IS (or Unlocked).

e.

If the Admin State column lists the port as OOS,MT (or Locked,maintenance) or OOS,DSBLD (or
Locked,disabled), click the column and choose IS , or Unlocked.

f.

Click Apply.

Step 3

If the correct port is in service, clean the fiber according to site practice. If no site practice exists,
complete the fiber cleaning procedure in the “Maintain the Node” chapter of the Cisco ONS 15454
DWDM Procedure Guide.

Step 4

If the alarm does not clear, verify that the power level of the optical signal is within the TXP or MXP
card receiver specifications. (These specifications are listed in the “Hardware Specifications” appendix
of the Cisco ONS 15454 DWDM Reference Manual.)

Step 5

If the optical power level is within specifications, use an optical test set to verify that a valid signal exists
on the line. For specific procedures to use the test set equipment, consult the manufacturer. Test the line
as close to the receiving card as possible.
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Step 6

If a valid signal exists, replace the connector on the backplane.

Step 7

Repeat Steps 1 to 6 for any other port on the card reporting the LOF.

Step 8

If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of
the problem.

Step 9

If no other alarms exist that could be the source of the LOF, or if clearing an alarm did not clear the LOF,
complete the “Physically Replace a Card” procedure on page 2-240 for the reporting card.

Step 10

If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call
Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.

2.5.154 LOGBUFR90
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM
The Log Buffer Over 90 alarm indicates that the per-NE queue of incoming alarm, event, or update
capacity of 5000 entries is over 90 percent full. LOGBUFR90 will clear if CTC recovers. If it does not
clear, LOGBUFROVFL occurs.

Note

LOGBUFR90 is an informational alarm and does not require troubleshooting.

2.5.155 LOGBUFROVFL
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM
The Log Buffer Overflow alarm indicates that the CTC per-NE queue of incoming alarm, event, or
updates, which has a capacity of 5,000 entries, has overflowed. This happens only very rarely. However
if it does, you must restart the CTC session. It is likely that some updates will have been missed if this
alarm occurs.

Clear the LOGBUFROVFL Alarm
Step 1

Restart the CTC session.s

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call TAC (1-800-553-2447).

2.5.156 LO-LASERBIAS
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: EQPT, OCN/STMN, PPM
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The Equipment Low Transmit Laser Bias Current alarm is raised against the TXP and MXP card laser
performance. The alarm indicates that the card laser has reached the minimum laser bias tolerance.
If the LO-LASERBIAS alarm threshold is set at 0 percent (the default), the laser's usability has ended.
If the threshold is set at 5 percent to 10 percent, the card is still usable for several weeks or months before
you need to replace it.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LO-LASERBIAS Alarm
Step 1

Complete the “Physically Replace a Card” procedure on page 2-240.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.157 LO-LASERTEMP
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: EQPT, OCN/STMN, PPM
The Equipment Low Laser Optical Transceiver Temperature alarm applies to the TXP and MXP cards.
LO-LASERTEMP occurs when the internally measured transceiver temperature falls below the card
setting by35.6 degrees F or 2 degrees C. A laser temperature change affects the transmitted wavelength.
(This temperature is equivalent to about 200 picometers of wavelength.)
When the TXP or MXP card raises this alarm, the laser is automatically shut off. The An LOS for
OCN/STMN is raised at the far-end node and the “DUP-IPADDR” alarm on page 2-64 is raised at the
near end. (Both of these alarms are described in the “Alarm Troubleshooting” chapter of the
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454SDH Troubleshooting Guide). To
verify the card laser temperature level, double-click the card in node view (single-shelf mode) or shelf
view (multishelf mode) and click the Performance > Optics PM > Current Values tabs. Maximum,
minimum, and average laser temperatures are shown in the Current column entries in the Laser Temp
rows.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LO-LASERTEMP Alarm
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), complete the “Reset a Card in CTC”
procedure on page 2-237 for the reporting MXP or TXP card.
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Step 2

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240 for the
reporting MXP or TXP card.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.158 LOM
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK, EQPT
The Optical Transport Unit (OTU) Loss of Multiframe alarm is an OTN alarm for the trunk port and
occurs when the Multi Frame Alignment Signal (MFAS) is corrupted. The alarm applies to
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, TXPP_MR_2.5G, and ADM-10G cards when the MFAS) overhead field is errored for
more than five frames and persists for more than 3 milliseconds.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LOM Alarm
Step 1

Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

Step 2

If the bit error rate (BER) threshold is correct and at the expected level, use an optical test set to measure
the power level of the line to ensure it is within guidelines. For specific procedures to use the test set
equipment, consult the manufacturer.

Step 3

If the optical power level is good, verify that optical receive levels are within the acceptable range.
Ranges for ONS 15454 DWDM cards are located in the “Hardware Specifications” appendix of the
Cisco ONS 15454 DWDM Reference Manual.

Step 4

If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the fiber cleaning procedure in the “Maintain the Node” chapter in the Cisco ONS 15454
DWDM Procedure Guide.

Step 5

If the condition does not clear, verify that single-mode fiber is used.

Step 6

If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.

Step 7

Clean the fiber connectors at both ends for a signal degrade according to site practice.

Step 8

Verify that a single-mode laser is used at the far end.

Step 9

If the problem does not clear, the transmitter at the other end of the optical line could be failing and
require replacement. Refer to the “2.8.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-238.
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Step 10

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.159 LOP-P
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: STSMON, STSTRM
A Loss of Pointer Path alarm indicates that the SONET path pointer in the overhead has been lost. LOP
occurs when valid H1/H2 pointer bytes are missing from the overhead. Receiving equipment monitors
the H1/H2 pointer bytes to locate the SONET payload. An LOP-P alarm occurs when eight, nine, or ten
consecutive frames do not have valid pointer values. The alarm clears when three consecutive valid
pointers are received.
The LOP-P alarm can occur when the received payload does not match the provisioned payload. The
alarm is caused by a circuit type mismatch on the concatenation facility. For example, if an STS-1 is sent
across a circuit provisioned for STS-3c, an LOP-P alarm occurs.
For the FC_MR-4 card, an LOP-P is raised if a port is configured for a SONET signal but receives an
SONET signal instead. (This information is contained in the H1 byte bits 5 and 6.)

Clear the LOP-P Alarm
Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1

In node view, click the Circuits tab and view the alarmed circuit.

Step 2

Verify the circuit size listed in the Size column. If the size is different from what is expected, such as an
STS3c instead of an STS1, this causes the alarm.

Step 3

If you have been monitoring the circuit with optical test equipment, a mismatch between the provisioned
circuit size and the size expected by the test set can cause this alarm. For specific procedures to use the
test set equipment, consult the manufacturer. Ensure that the test set monitoring is set up for the same
size as the circuit provisioning.
Refer to the manufacturer’s instructions for test-set use.

Step 4

If the error is not due to an incorrectly configured test set, the error is in the provisioned CTC circuit
size. Complete the “Delete a Circuit” procedure on page 2-241.

Step 5

Recreate the circuit for the correct size. For procedures, refer to the “Create Circuits and VT Tunnels”
chapter in the Cisco ONS 15454 Procedure Guide.

Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.
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2.5.160 LO-RXPOWER
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC, OCN/STMN, TRUNK
The Equipment Low Receive Power alarm is an indicator for TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G,
OC192-XFP, and ADM-10G card received optical signal power. LO-RXPOWER occurs when the
measured optical power of the received signal falls below the threshold value, which is
user-provisionable.

Note

For general information about MXP and TXP cards and their necessary levels, refer to the “Card
Reference” chapter and the “Hardware Specifications” appendix in the Cisco ONS 15454 DWDM
Reference Manual.

Clear the LO-RXPOWER Alarm
Step 1

Check the PM of the TRUNK-RX port. Verify that received power is above the optics threshold:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to display the
card view.

b.

For the TRUNK-RX port, double-click the card and click the Performance > Optics PM >
Historical PM tabs, choose the port in the Port drop-down list, and click Refresh.

c.

Compare the refreshed PM values with the threshold (ensuring that they are above the threshold
value) by clicking the Performance > Optics PM > Current Values tabs.

d.

Ensure that a proper threshold has been provisioned for the receive value. (Refer to the “Provision
Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.) If
an incorrect threshold has been set, adjust it to a value within the allowed limits. If instead the alarm
condition does not clear, move to next step.

Step 2

Verify that the Trunk-Rx port is cabled correctly, and clean the fiber connecting the faulty TXP/MXP to
the Drop port of the DWDM card (32DMX, 32DMX-O, 40DMX, or AD-xC-xx.x). If no site cleaning
practices are available, refer to the “Maintain the Node” chapter of the Cisco ONS 15454 DWDM
Procedure Guide.

Step 3

Determine whether a bulk attenuator is specified by the Cisco TransportPlanner design. If so, verify that
the proper fixed attenuation value has been used.

Step 4

Using a test set, check the optical power value of the Drop port of the DWDM card (32DMX, 32DMX-O,
40DMX, or AD-xC-xx.x) connected to the faulty TXP/MXP. If the read value is different (+1 dBm or
–1 dBm) from the ANS setpoint for “Padd&drop-Drop power,” move to next step. If not, complete the
“Physically Replace a Card” section on page 2-240.

Step 5

Look for any alarm reported by the DWDM cards belonging to the OCHNC circuit whose destination is
the faulty TXP/MXP and first troubleshoot that alarm. Possible alarm related include: amplifier Gain
alarms (the “GAIN-HDEG” alarm on page 2-89, the “GAIN-HFAIL” alarm on page 2-90, the
“GAIN-LDEG” alarm on page 2-90, or “GAIN-LFAIL” alarm on page 2-91); APC alarms (the
“APC-CORR-SKIPPED” alarm on page 2-29 or “APC-OUT-OF-RANGE” alarm on page 2-30), and
LOS-P alarms on the Add or Drop ports belonging to the OCHNC circuit.
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Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.161 LOS (2R)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: 2R
The Loss of Signal for a 2R client applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, and MXP_2.5G_10G cards. The alarm is raised
when the card port is not receiving input. An AIS is sent upstream.

Caution

Note

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly. To
verify cable continuity, follow site practices.

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual.

Clear the LOS (2R) Alarm
Step 1

Ensure that the signal entering the Client-Rx port is provisioned with the correct physical-layer protocol.

Step 2

Ensure that the signal feeding the Client-Rx port is provisioned with the correct line speed.

Step 3

Check the PM of the Client-Rx port.

Step 4

Verify that received power is above the optics threshold.

Step 5

Ensure that a proper threshold has been provisioned. (Refer to the “Provision Transponder and
Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide. Refer to the SFP/XFP
plug-in specifications located in the “Hardware Specifications” appendix of the Cisco ONS 15454
DWDM Reference Manual.) If an incorrect threshold has been set, adjust it to a value within the allowed
limits.

Step 6

Verify the proper cabling and clean the fibers according with the site practice. Cabling procedures are
located in the “Turn Up a Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide, and a
fiber-cleaning procedure is located in the “Maintain the Node” chapter of the same guide.

Step 7

Verify using an optical test set that a valid signal exists on the line and feeds the Client-Rx port. (For
specific procedures to use the test set equipment, consult the manufacturer.) Test the line as close to the
receiving card as possible. If the alarm condition does not clear, move to next step.

Step 8

Complete the “Install an SFP or XFP Connector” procedure on page 1-57 or the “Physically Replace a
Card” procedure on page 2-240 as appropriate for your purposes.

Step 9

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.
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2.5.162 LOS (BITS)
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: BITS
The LOS (BITS) alarm indicates that the TCC2/TCC2P card has an LOS from the BITS timing source.
LOS for BITS means the BITS clock or the connection to it failed.

Clear the LOS (BITS) Alarm
Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1

Verify the wiring connection from the BITS clock pin fields on the ONS system backplane to the timing
source.

Step 2

If wiring is good, verify that the BITS clock is operating properly.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.163 LOS (ESCON)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: ESCON
The ESCON LOS alarm occurs on the TXP_MR_2.5G or TXPP_MR_2.5G card when there is a loss of
signal for this payload, usually due to a physical error such as incorrect cabling connections, faulty
cabling, or a break. It can also be caused by an incorrectly configured SFP.

Clear the LOS (ESCON) Alarm
Step 1

Check for any upstream equipment failures that could cause the ESCON LOS alarm in this node.

Step 2

If there is no cause upstream, verify cabling continuity from the transmitting port to the receiving port
reporting this LOS. To verify cable continuity, follow site practices.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 3

If the continuity is good, clean the fiber according to site practice. If none exists, complete the
fiber-cleaning procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.
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Step 4

Ensure that the PPM (SFP) is correctly configured for this payload:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b.

Click the Provisioning > Pluggable Port Modules tabs.

c.

Check the Pluggable Port Modules area for the PPM (SFP) associated with the port.

d.

In the Pluggable Ports area, ensure that the rate for the errored PPM (SFP) is ESCON.

Note

Step 5

For information about provisioning PPMs (SFPs), refer to the “Turn Up a Node” chapter in
the Cisco ONS 15454 DWDM Procedure Guide. PPM (SFP) specifications are listed in the
“Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.

If the physical cabling and PPM (SFP) are good but the alarm does not clear, verify that the correct port
is actually in service:
a.

Confirm that the LED is correctly lit on the physical TXP card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b.

To determine whether the port is in service, double-click the card in CTC to open the card view.

c.

Click the Provisioning > Line tabs.

d.

Verify that the Admin State column lists the port as IS (or Unlocked).

e.

If the Admin State column lists the port as OOS,MT (or Locked,maintenance) or OOS,DSBLD (or
Locked,disabled), click the column and choose IS , or Unlocked. Click Apply.

Step 6

If the correct port is in service but the alarm has not cleared, use an optical test set to confirm that a valid
signal exists on the line. For specific procedures to use the test set equipment, consult the manufacturer.
Test the line as close to the receiving card as possible.

Step 7

If the signal is valid, ensure that the transmit and receive outputs from the patch panel to your equipment
are properly connected. For more information about fiber connections and terminations, refer to the
“Turn Up a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step 8

If a valid signal exists but the alarm does not clear, replace the cable connector on the ONS system.

Step 9

Repeat Steps 2 through 6 for any other port on the card that reports the LOS (ESCON).

Step 10

If the alarm does not clear, the cabling could still be faulty despite correct attachments. Use the test set
to locate the bad cable and replace it using the procedures in the “Manage the Node” chapter in the
Cisco ONS 15454 DWDM Procedure Guide.

Step 11

If the alarm does not clear, look for any card-level alarm that could cause this port alarm.

Step 12

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240 for the
reporting card.

Step 13

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.164 LOS (ISC)
Default Severity: Critical (CR), Service-Affecting (SA)
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Logical Object: ISC
The LOS alarm for the ISC port applies to TXPP_MR_2.5G or TXP_MR_2.5G client PPMs (SFPs)
provisioned at the ISC port rate. Troubleshooting is similar to the LOS (2R) alarm.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LOS (ISC) Alarm
Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1

Complete the “Clear the LOS (2R) Alarm” procedure on page 2-132.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.165 LOS (OTS)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OTS
The Loss of Signal for the OTS applies to the OSC-3-RX port of the OPT-BST or OPT-AMP-x-C
amplifier cards and the LINE-2-RX port of the OSCM or OSC-CSM card. It indicates that a fiber cut has
occurred and no power is being received from the span. The alarm is raised when both LOS-P and LOS-O
alarms occur, and demotes them.

Clear the LOS (OTS) Alarm
Step 1

To troubleshoot this alarm, see the “1.12.1 Fiber Cut Detection” section on page 1-59.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.166 LOS (TRUNK)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK
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The Loss of Signal (LOS) for a TRUNK applies to GE-XP, 10GE-XP, TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, and
ADM-10G cards.

Note

The MXP_2.5G_10E card has no LOS (TRUNK) option, because G.709 cannot be disabled on the card.
The alarm is raised when the card port is not receiving input. An AIS is sent upstream.
The purpose of the LOS (TRUNK) alarm is to alert the user that no optical power is being received from
the fiber. A typical fault condition signalled by the LOS (TRUNK) alarm is a fiber cut. In this case,
neither the payload nor the overhead signals are being received.

Note

With G.709 off, the alarm coming from the trunk is LOS (TRUNK) in accordance with SONET
standards.

Note

In R7.01, when an LOS (TRUNK) alarm occurs on TXP and MXP trunks, G709/SONET/SDH TCAs are
suppressed. For details, see the “Alarm and TCA Monitoring and Management” chapter in the
Cisco ONS 15454 DWDM Reference Manual.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide

Clear the LOS (TRUNK) Alarm
Step 1

Check the PMs of the TRUNK-RX port and verify that the received power is above the optics threshold.

Step 2

Check that a proper threshold has been provisioned. (For procedures, refer to the “Provision Transponder
and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.) If an incorrect
threshold has been set, adjust it to a value within the allowed limits. If the alarm condition does not clear,
move to next step.

Step 3

Verify the cabling of the Trunk-Rx port and clean the fiber connecting the faulty TXP/MXP to the Drop
port of the DWDM card (32DMX, 32DMX-O, 40DMX, or AD-xC-xx.x). For fiber cleaning procedures,
refer to the “Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Step 4

Using an optical test set, verify that a valid signal exists on the line and feeds the TRUNK-RX port.(For
specific procedures to use the test set equipment, consult the manufacturer.) Test the line as close to the
receiving card as possible. If the alarm condition does not clear, move to next step.

Step 5

Verify whether a bulk attenuator is specified in the Cisco TransportPlanner design. If so, verify that the
proper fixed attenuation value has been used.

Step 6

Check the Drop port optical power value of the DWDM card (32DMX, 32DMX-O, 40DMX, or
AD-xC-xx.x) connected to the faulty TXP/MXP. If the read value is different (+1 dBm or –1 dBm)
compared to the ANS setpoint “Padd&drop-Drop power,” move to next step. If not, complete the
“Physically Replace a Card” procedure on page 2-240.
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Step 7

If the alarm does not clear after the replacement, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447) in order to
report a Service-Affecting (SA) problem.

Step 8

Look for and troubleshoot any alarms reported by the DWDM cards belonging to the OCHNC circuit
whose destination is the faulty TXP/MXP. Possible alarms include: amplifier gain alarms (the
“GAIN-HDEG” alarm on page 2-89, the “GAIN-HFAIL” alarm on page 2-90, the “GAIN-LDEG” alarm
on page 2-90 or “GAIN-LFAIL” alarm on page 2-91); APC alarms (the “APC-CORR-SKIPPED” alarm
on page 2-29 and “APC-OUT-OF-RANGE” alarm on page 2-30), OR LOS-P alarms on the Add or Drop
ports belonging to the OCHNC circuit.

Step 9

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1 800 553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.167 LOS-O
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: OCH, OMS, OTS
The Incoming Overhead Loss of Signal alarm applies to the OSC-TX port of OPT-BST or
OPT-AMP-x-C cards (LINE-1-RX), the OSC-RX internal optical port of OSC-CSM card (LINE-3-RX
Port 3). It is raised when the monitored input power crosses the FAIL-LOW threshold associated to the
OSC Power received. The is alarm is demoted if another LOS alarm is also present.

Clear the LOS-O Alarm
Step 1

Verify fiber continuity to the port by following site practices. Refer to the “Network Reference” chapter
of the Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

Step 2

If the cabling is good, confirm that the LED is correctly illuminated on the physical card. A green
ACT/SBY LED indicates an active card. A red ACT/SBY LED indicates a failed card.

Step 3

Display the optical thresholds by clicking one of the following tabs:

Step 4

•

For the OPT-BST or OPT-AMP-x-C cards, click the Provisioning > Opt. Ampli. Line > Optics
Thresholds tabs and click the Alarm checkbox in the Type panel.

•

For the OSC-CSM cards, click the Provisioning > Optical Line > Optics Thresholds tabs.

Verify that OSC Fail Low thresholds are correct according with Cisco TransportPlanner configuration
file. To identify the MP value:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning >
WDM-ANS > Provisioning tabs.

b.

Identify the following parameter: east or west side Rx channel OSC LOS threshold.

Step 5

If the port power is below the threshold, verify that OSC connections have been created on the other side
of the span. If the connections are not present, refer to the “Provision Channels and Circuits” chapter of
the Cisco ONS 15454 DWDM Procedure Guide for procedures.

Step 6

If OSC connections are present, check the OSC transmitted power using CTC on the far-end node. Refer
to the “TurnUp Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide for the proper
procedure.
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Step 7

If the transmitted OSC value is out of range, troubleshoot that problem first.

Step 8

If the OSC value is within range, come back to the port reporting the LOS-O alarm and clean the fiber
according to site practice. If no site practice exists, complete the fiber-cleaning procedure in the
“Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Step 9

If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of
the problem.

Step 10

If no other alarms exist that could be the source of the LOS-O, place all of the card ports in OOS,DSBLD
(or Locked,disabled) administrative state.

Step 11

Complete the “Physically Replace a Card” procedure on page 2-240 for the reporting card.

Step 12

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.168 LOS-P (AOTS, OMS, OTS)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AOTS, OMS, OTS
The Loss of Signal for Optical Channel alarm (OMS and OTS layer) applies to all input ports of the
following DWDM cards: AD-1B-xx.x, AD-4B-xx.x, 32DMX, 32DMX-O, 40DMX-C, 40DMX-CE,
OPT-PRE, OPT-BST, OPT-AMP-C, OPT-AMP-17-C, and OSC-CSM.
For AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, 32MUX-O, 32WSS, 40WSS-C, and WXC cards, this alarm
applies only to the input ports where an aggregate signal is managed, such as the COM-RX, EXP-RX,
or xxBAND-RX ports). These ports are solely used for the AOTS, OMS, and OTS layers.
LOS-P (AOTS, OMS, or OTS) indicates a loss of receive signal, which means that the monitored input
power value has crossed the Power Failure Low Threshold associated to the port.

Note

When the LOS-P alarm is raised on the LINE-RX port of the OPT-BST, OPT-AMP-x-C, or OSC-CSM
card, it can indicate a fiber cut. Refer to the “Network Reference” chapter of the Cisco ONS 15454
DWDM Reference Manual for a fiber cut detection procedure.

Note

When the LOS-P alarm is raised on the COM-RX port of the 32DMX-C, 32DMX-L, 40DMX-C,
40-DMX-CE, or WXC cards, it can indicate the presence of undesirable counter-propagating light
entering the card from the drop ports. The counter-propagating light can be inserted into these cards as
a result of incorrect cabling of transponder or line cards to the fiber patch-panel (in particular, swapping
RX with TX patchcords). This behavior is only applicable to optical modules with vendor IDs 2049,
2050, 2304, and 2306. You can view the vendor IDs at CTC > Card View > Inventory tab.

Clear the LOS-P (AOTS, OMS, OTS) Alarm
Step 1

Verify that the card has the correct physical behavior by checking the LED on the physical card. A green
ACT/SBY LED indicates an active card, and a red ACT/SBY LED indicates a failed card. If the LED is
red, complete the “Physically Replace a Card” procedure on page 2-240 and continue to Step 7.
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When you replace a card with an identical type of card, you do not need to make any changes to
the database other than restoring the card’s port to the IS,AINS or Unlocked,automaticInService
administrative state.

Note

Step 2

Verify that there truly is a loss of input signal by completing the following steps:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b.

Verify the proper input power values by clicking one of the following tabs as appropriate:

c.

Tip

•

For the OPT-BST, OPT-AMP-C, and OPT-AMP-17-C cards, click the Provisioning > Optical
Line > Parameters tabs.

•

For the OPT-PRE, OPT-AMP-C, and OPT-AMP-17-C cards, click the Provisioning > Optical
Line > Parameters tabs.

•

For the AD-xC-xx.x card, click the Provisioning > Optical Line > Parameters tabs.

•

For the AD-xB-xx.x card, click the Provisioning > Optical Band > Parameters tabs.

•

For the 32MUX-O and 40MUX cards, click the Provisioning > Optical Line > Parameters
tabs.

•

For the 32WSS and 40WSS-C cards, click the Provisioning > Optical Line > Parameters tabs.

•

For the 32DMX-O card, click the Provisioning > Optical Line > Parameters tabs.

•

For the 32DMX and 40DMX cards, click the Provisioning > Optical Line > Parameters tabs.

•

For the OSC-CSM card, click the Provisioning > Optical Line > Parameters tabs.

Display the proper Power Failure Low threshold by clicking one of the following tabs as appropriate:
•

For the OPT-BST, OPT-AMP-C, and OPT-AMP-17-C cards, click the Provisioning > Optical
Line > Optics Thresholds tabs.

•

For the OPT-BST, OPT-AMP-C, and OPT-AMP-17-C cards, click the Provisioning > Optical
Line > Optics Thresholds tabs.

•

For the AD-xC-xx.x card, click the Provisioning > Optical Line > Optics Thresholds tabs.

•

For the AD-xB-xx.x card, click the Provisioning > Optical Band > Optics Thresholds tabs.

•

For the AD-xB-xx.x card, click the Provisioning > Optical Line > Optics Thresholds tabs.

•

For the 32MUX-O and 40MUX cards, click the Provisioning > Optical Line > Optics
Thresholds tabs.

•

For the 32WSS and 40WSS-C cards, click the Provisioning > Optical Line > Optics
Thresholds tabs.

•

For the 32DMX-O card, click the Provisioning > Optical Line > Optics Thresholds tabs.

•

For the 32DMX and 40DMX, click the Provisioning > Optical Line > Optics Thresholds tabs.

•

For the OSC-CSM card, click the Provisioning > Optical Line > Optics Thresholds tabs.

To view the alarm thresholds (as opposed to the warning thresholds), check the Alarm check box on the
bottom-left of the Optics Thresholds tab and click Reset.
d.

Compare the actual Power value with the Alarm Threshold value and complete one of the following
actions:
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•

If the Power value is less than the Fail Low threshold, go to Step 3.

•

If the Power value is greater than the Fail Low threshold plus the alarm hysteresis (allowance
value) default of 1 dBm, complete the “Reset a Card in CTC” procedure on page 2-237 for the
card.

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240 and
continue to Step 7.

Note

When you replace a card with an identical type of card, you do not need to make any changes
to the database other than restoring the card’s port to the IS,AINS or
Unlocked,automaticInService administrative state.

Step 3

Verify the fiber continuity to the port by following site practices. Refer to the “Network Reference”
chapter of the Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

Step 4

Check the “Internal Connections” file generated by Cisco TransportPlanner for the node where the
errored card is located. If necessary, recable the node cabling in accordance with the MP file connections
list. To cable a DWDM node, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

Step 5

If the cabling is good, use an optical test set to measure the power value on the output port connected to
the alarmed card. For specific procedures to use the test set equipment, consult the manufacturer. If the
power difference reported is greater than 1 dBm (standard fiber jumper insertion loss is 0.3 dBm), clean
the fiber according to site practice. If no site practice exists, complete the fiber-cleaning procedure in
the “Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Note

Unplugging the fiber can cause a traffic hit. To avoid this, perform a traffic switch if possible. Refer to
the “Manage the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide for detailed
information.

Step 6

If the alarm does not clear, follow the general troubleshooting rules in the “Network Reference” chapter
in the Cisco ONS 15454 DWDM Reference Manual for identifying any other upstream alarm in the
logical signal flow that could be the root cause of the outstanding alarm.

Step 7

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.

2.5.169 LOS-P (OCH)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OCH
The Loss of Signal for Optical Channel alarm on the OCH layer applies to the channel Add or
pass-through ports on the AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, 32MUX-O, 40MUX, 32WSS-O,
40WSS-C, GE-XP, 10GE-XP, and ADM-10G DWDM cards.
For the 32WSS-O and 40WSS-C, the LOS-P alarm can be associated with Add ports as well as
pass-through internal ports. If the LOS-P (OCH) alarm is raised against this kind of port a different
troubleshooting procedure is needed because the port does not have an optical power source directly
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connected to it. In this case, follow the general troubleshooting rules for network-level (inter-node)
troubleshooting in Chapter 1, “General Troubleshooting,” to identify upstream alarms in the logical
signal flow that could cause an LOS-P.
LOS-P (OCH) indicates a loss of received signal, which means the monitored input power value has
crossed the Power Failure Low threshold associated with the port in accordance with the specific VOA
power reference setpoint provisioned on VOA along the path.

Note

For more information about provisioning VOA setpoints, refer to the “Network Reference” chapters of
the Cisco ONS 15454 DWDM Reference Manual.

Clear the LOS-P (OCH) Alarm
Step 1

Verify that the card is exhibiting correct behavior by checking the LED behavior on the physical card. A
green ACT/SBY LED indicates an active card, and a red ACT/SBY LED indicates a failed card. If the
LED is red, complete the “Physically Replace a Card” procedure on page 2-240 and continue to Step 9.

When you replace a card with an identical type of card, you do not need to make any changes to
the database other than restoring the card’s port to the IS,AINS or Unlocked,automaticInService
administrative state.

Note

Step 2

Verify that there truly is a loss of received signal by completing the following steps:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b.

View the proper input power values by clicking one of the following tabs as appropriate:

c.

Tip

•

For the AD-xC-xx.x card, click the Provisioning > Optical Chn > Parameters tabs.

•

For the ADM-10G card, click Performance > Optics PM > Current Values tabs.

•

For the 32MUX-O and 40MUX cards, click the Provisioning > Optical Chn > Parameters
tabs.

•

For the 32WSS-O and 40WSS-C cards, click the Provisioning > Optical Chn: Optical
Connector x > Parameters tabs.

Display the proper Power Failure Low threshold by clicking one of the following tabs as appropriate:
•

For the AD-xC-xx.x card, click the Provisioning > Optical Chn > Optics Thresholds tabs.

•

For the ADM-10G card, click Provisioning > Optics Thresholds tabs.

•

For the 32MUX-O and 40MUX cards, click the Provisioning > Optical Chn > Optics
Thresholds tabs.

•

For the 32WSS-O and 40WSS-C cards, click the Provisioning > Optical Chn: Optical
Connector x > Optics Thresholds tabs.

To view the alarm thresholds (as opposed to the warning thresholds), check the Alarm check box on the
bottom-left of the Optics Thresholds tab and click Reset.
d.

Compare the actual assigned Power value with the Alarm Threshold value and complete one of the
following actions:
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•

If the Power value is less than the Fail Low threshold, go to Step 3.

•

If the Power value is greater than the Fail Low threshold plus the alarm hysteresis (or allowance
value) default of 1 dBm, complete the “Reset a Card in CTC” procedure on page 2-237 for the
card.

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240 and
continue to Step 9.

Note

When you replace a card with an identical type of card, you do not need to make any changes
to the database other than restoring the card’s port to the IS,AINS or
Unlocked,automaticInService administrative state.

Step 3

Verify the fiber continuity to the port using site practices. Refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

Step 4

Check the “Internal Connections” file generated by Cisco TransportPlanner for the node where the card
is located. If necessary, recable the node in accordance with the MP file connections list. For procedures
to cable a DWDM node, refer to the “Turn Up a Node” chapter of the Cisco ONS 15454 DWDM
Procedure Guide.

Step 5

If the cabling is good, verify that each involved optical signal source, including TXP, MXP or ITU-T line
card trunk transmit ports, is in the IS (or Unlocked) administrative state. To do this, click the following
tabs as appropriate:
•

For the ADM-10G card, click the Provisioning > Line > Ports tabs.

•

For the TXP_MR_10G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

•

For the TXP_MR_10E card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

•

For the TXP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

•

For the TXPP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

•

For the MXP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

•

For the MXPP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

•

For the MXP_2.5G_10E card, click the Provisioning > Line > Trunk tabs.

•

For the MXP_2.5G_10G card, click the Provisioning > Line > SONET (or Provisioning > Line >
SDH) tabs.

If the port administrative state is not IS (or Unlocked), choose IS , or Unlocked, from the Admin state
drop-down list. If the alarm does not clear, continue with Step 9.

Note

If the LOS-P (OCH) alarm applies to a 32WSS-O passthrough port, it means that a single optical source
is not directly connected to the port. In this case, follow the general troubleshooting rules given in
“Network Level (Internode) Troubleshooting” to identify any other alarm upstream to the logical signal
flow that could be the root cause for the outstanding alarm.
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Step 6

If the signal source is in IS (or Unlocked) administrative state, use an optical test set to verify that the
transmit laser is active. For specific procedures to use the test set equipment, consult the manufacturer.

Step 7

If the laser is active, compare the card’s provisioned transmit optical power value with the expected
range in the “Provision Transponder and Muxponder Cards” chapter of the Cisco ONS 15454 DWDM
Procedure Guide. To display the provisioned transmit optical power values, click the following tabs as
appropriate:

Step 8

•

For the ADM-10G card, click Performance > Optics PM > Current Values tabs.

•

For the TXP_MR_10G card, click the Performance > Optics PM > Current Values > Trunk Port
tabs.

•

For the TXP_MR_10E card, click the Performance > Optics PM > Current Values > Trunk Port
tabs.

•

For the MXP_2.5G_10E card, click the Performance > Optics PM > Current Values >
Trunk Port tabs.

•

For the MXP_2.5G_10G card, click the Performance > Optics PM > Current Values >
Trunk Port tabs.

Use a standard power meter to measure actual transmit optical power for the following cards as
applicable:
•

GE-XP

•

10GE-XP

•

ADM-10G

•

TXP_MR_2.5G

•

TXPP_MR_2.5G

•

MXP_MR_2.5G

•

MXPP_MR_2.5G

•

Every ITU-T line card

If the tested optical transmit optical power is within the expected range, go to Step 9. If the actual power
value is outside the specification range, complete the “Physically Replace a Card” procedure on
page 2-240. (These are listed in the “Hardware Specifications” appendix of the Cisco ONS 15454
DWDM Reference Manual.) When the newly installed card becomes active, verify that the LOS-P (OCH)
alarm clears. If it does not, continue with Step 9.

Tip

If a spare card is unavailable and the transmit power still functions, you can temporarily clear the LOS-P
alarm by following the general procedure to add path VOAs during startup failure as noted in the
“Perform Node Acceptance Tests” chapter of the Cisco ONS 15454 DWDM Procedure Guide. For more
information about provisioning VOA setpoints, refer to the “Network Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual.

Step 9

If the power is within the expected range, return to the port that reported LOS-P and clean the alarmed
port’s fiber according to site practice. If no site practice exists, complete the procedure in the “Maintain
the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.
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Note

Unplugging the fiber can cause a traffic hit. To avoid this, perform a traffic switch if possible. Refer to
the “2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233 for basic
instructions, or refer to the “Manage the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide for more detailed information.

Step 10

If the alarm does not clear, add path VOAs during startup failure as noted in the “Perform Node
Acceptance Tests” chapter of the Cisco ONS 15454 DWDM Procedure Guide to remedy the problem.

Step 11

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.

2.5.170 LOS-P (TRUNK)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK
The Loss of Signal Payload (LOS-P) alarm for the trunk layer indicates that the incoming payload signal
is absent at the input trunk port. There still may be optical power on the fiber, but the payload data is
missing. This alarm applies to the following cards: TXP_MR_10G, TXP_MR_10E, MXP_2.5G_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, MXP_MR_2.5G, MXPP_MR_2.5G, GE-XP, 10GE-XP, ADM-10G,
and every ITU-T line card.

Note

The MXP_2.5G_10E has no LOS-P (TRUNK) option, because ITU-T G.709 encapsulation on the card
cannot be disabled.

Note

With ITU-T G.709 encapsulation on, the alarm coming from the trunk is LOS-P (TRUNK) in accordance
with the OTN standards.

Note

In R7.01, when an LOS-P (TRUNK) alarm occurs on TXP and MXP trunks, G709/SONET/SDH TCAs
are suppressed. For details, see “Alarm and TCA Monitoring and Management” chapter in the
Cisco ONS 15454 DWDM Reference Manual.

Clear the LOS-P (TRUNK) Alarm
Step 1

Verify that the card behaves correctly by checking the LED behavior on the physical card. A green
ACT/SBY LED indicates an active card, and a red ACT/SBY LED indicates a failed card. If the LED is
red, complete the “Physically Replace a Card” procedure on page 2-240 and continue to Step 7.

Note

When you replace a card with an identical type of card, you do not need to make any changes to
the database other than restoring the card’s port to the IS,AINS or Unlocked,automaticInService
administrative state.
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Step 2

Step 3

Verify that there truly is a loss of received optical power by completing the following steps:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the alarmed card to
open the card view.

b.

Click the Performance > Optics PM > Current Values > Trunk Port tabs and view the RX Optical
Pwr value.

c.

Compare the actual power levels with the expected power range given in the “Hardware
Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual. Complete one of the
following actions:
•

If power is higher than –40 dBm (that is, –20 dBm, –1 dBm, 0 dBm or 10 dBm) and within the
accepted range go to Step 4.

•

or if the power is lower than –40 dBm (that is, –40 dBm, –45 dBm or –50 dBm) complete the
“Reset a Card in CTC” procedure on page 2-237 for the card.

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240 for the
reporting card and then go to Step 9.

Note

When you replace a card with an identical type of card, you do not need to make any changes to
the database other than restoring the card’s port to the IS,AINS or Unlocked,automaticInService
administrative state.

Step 4

Verify the fiber continuity to the port by following site practices. Refer to the “Network Reference”
chapter of the Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

Step 5

Check the “Internal Connections” file generated by Cisco TransportPlanner for the node containing the
alarmed card. If necessary, recable the node in accordance with the MP file connections list. For
procedures to cable a DWDM node, refer to the “Turn Up a Node” chapter of the Cisco ONS 15454
DWDM Procedure Guide.

Step 6

If the cabling is good, use a test set to verify the power value on the DWDM CH_DROP-TX port on the
AD-xC-xx.x, 32DMX-O, 32DMX, or 40DMX. For specific procedures to use the test set equipment,
consult the manufacturer.

Step 7

If the power difference reported is greater than 1 dBm (standard fiber jumper insertion loss is 0.3 dBm),
clean the fiber according to site practice. If no site practice exists, complete the procedure in the
“Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Note

Unplugging the fiber can cause a traffic hit. To avoid this, perform a traffic switch if possible. Refer to
the “2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233 for basic
instructions, or to the “Manage the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide for
more detailed information.

Step 8

If the alarm does not clear, follow the general troubleshooting rules stated in the “Network Reference”
chapter of the Cisco ONS 15454 DWDM Reference Manual to identify upstream alarms in the logical
signal flow that could cause an LOS-P.

Step 9

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.
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2.5.171 LO-TXPOWER
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC, OCN/STMN, PPM, TRUNK
The Equipment Low Transmit Power alarm is an indicator for the TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G,
OC192-XFP, and ADM-10G card transmitted optical signal power. LO-TXPOWER occurs when the
measured optical power of the transmitted signal falls under the threshold. The threshold value is
user-provisionable.

Note

For more information about MXP and TXP cards and their power levels, refer to the “Card Reference”
in the Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to
the “Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LO-TXPOWER Alarm
Step 1

In node view (single-shelf mode) or single-shelf view (multishelf mode), display the TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L,
MXP_2.5G_10G, OC192-XFP, or ADM-10G card view.

Step 2

Click the Provisioning > Optics Thresholds > Current Values tabs.

Step 3

For the ADM-10G card, click the Performance > Optics PM > Current Values tabs.

Step 4

Increase the TX Power Low column value by 0.5 dBm.

Step 5

If the card transmit power setting cannot be increased without affecting the signal, complete the
“Physically Replace a Card” procedure on page 2-240.

Step 6

If no ports are shown bad and the alarm does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.172 LPBKCRS
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: STSMON, STSTRM
The Loopback Cross-Connect condition indicates that there is a software cross-connect loopback active
between an optical card and an OC-192 card. A cross-connect loopback test occurs below line speed and
does not affect traffic.

Note

Cross-connect loopbacks occur below line speed. They do not affect traffic.
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Clear the Condition
Step 1

To remove the loopback cross-connect condition, double-click the optical card in CTC to display the
card view.

Step 2

Complete the “Clear an STM-N Card XC Loopback Circuit” procedure on page 2-243.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.173 LPBKFACILITY (ESCON)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: ESCON
The LPBKFACILITY (ESCON) condition occurs on a TXP_MR_2.5G or TXPP_MR_2.5G card PPM
(SFP) provisioned for FICON1G or FICON 2G line speed when there is a facility loopback active on the
card.
For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Clear the LPBKFACILITY (ESCON) Condition
Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-242.

Step 2

If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call
Cisco TAC to report a Service-Affecting (SA) problem (1-800-553-2447).

2.5.174 LPBKFACILITY (FC)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: FC
A Loopback Facility condition for the FC payload occurs on a fibre channel (FC) line when a software
facility (line) loopback is active for an MXPP_MR_2.5G, MXP_MR_2.5G, TXPP_MR_2.5G, and
TXP_MR_2.5G card client PPM (SFP) provisioned at the FC1G, FC2G, FICON1G, or FICON 2G line
speed.
For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.
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Note

For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provisioning Tranponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LPBKFACILITY (FC) Condition
Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-242.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.175 LPBKFACILITY (GE)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: GE
A Loopback Facility condition for a Gigabit Ethernet (GE) port occurs when a software facility (line)
loopback is active for an MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G,
GE-XP, 10GE-XP, and ADM-10G card client PPM (SFP) provisioned at the ONE_GE port rate. For the
TXP_MR_10E and TXP_MR_10G cards, this condition occurs when there is a facility loopback on a
client PPM (SFP) provisioned at the TEN_GE port rate.
For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Note

For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LPBKFACILITY (GE) Condition
Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-242.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.176 LPBKFACILITY (ISC)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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Logical Object: ISC
A Loopback Facility condition for an ISC port occurs when a software facility (line) loopback is active
for a TXPP_MR_2.5G or TXP_MR_2.5G client PPM (SFP) provisioned at the ISC port rate.
For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Note

For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LPBKFACILITY (ISC) Condition
Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-242.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.177 LPBKFACILITY (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service Affecting (NSA)
Logical Object: TRUNK
A Loopback Facility condition on MXP, TXP, GE-XP, 10GE-XP, and ADM-10G card trunk ports
indicates that there is an active facility (line) loopback on the port. For this condition to be present, the
administrative state is OOS,MT (or Locked,maintenance).
For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Caution

CTC permits loopbacks on an in-service (IS or Unlocked) circuit. Loopbacks are service-affecting.

Clear the LPBKFACILITY (TRUNK) Condition
Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-242.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.178 LPBKTERMINAL (ESCON)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: ESCON
The LPBKTERMINAL (ESCON) condition occurs on a TXP_MR_2.5G or TXPP_MR_2.5G card PPM
(SFP) provisioned for FICON1G or FICON 2G line speed when there is a terminal loopback active on
the card.
For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Clear the LPBKTERMINAL (ESCON) Condition
Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-242.

Step 2

If the alarm does not clear, or if you need assistance conducting network troubleshooting tests, call
Cisco TAC to report a Service-Affecting (SA) problem (1-800-553-2447).

2.5.179 LPBKTERMINAL (FC)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: FC
A Loopback Terminal condition for the FC payload occurs on an FC when a software terminal (inward)
loopback is active for an MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G,
GE-XP, and 10GE-XP card client PPM (SFP) provisioned at the FC1G, FC2G, FICON1G, or FICON2G
line speed.
For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Note

For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provisioning Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LPBKTERMINAL (FC) Condition
Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-242.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.180 LPBKTERMINAL (GE)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: GE
A Loopback Terminal condition for a GE port occurs when a software terminal (inward) loopback is
active for an MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, and TXPP_MR_2.5G card client
PPM (SFP) provisioned at the ONE_GE port rate. For the TXP_MR_10E and TXP_MR_10G cards, this
condition occurs when there is a facility loopback on a client PPM (SFP) provisioned at the TEN_GE
port rate.
For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Note

For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the LPBKTERMINAL (GE) Condition
Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-242.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.181 LPBKTERMINAL (ISC)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: ISC
A Loopback Terminal condition for an ISC port occurs when a software terminal (inward) loopback is
active for a TXPP_MR_2.5G or TXP_MR_2.5G client PPM (SFP) provisioned at the ISC port rate.
For information about troubleshooting these circuits with loopbacks, refer to the “1.2 Troubleshooting
MXP, TXP, XP, or ADM-10G Circuit Paths With Loopbacks” section on page 1-7.

Note

For more information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manualand “Provisioning Transponder and Muxponder Cards”
chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the LPBKTERMINAL (ISC) Condition
Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-242.
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.182 LPBKTERMINAL (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service Affecting (NSA)
Logical Object: TRUNK
A Loopback Terminal condition on MXP or TXP trunk card indicates that there is an active terminal
(inward) loopback on the port.
For information about troubleshooting, refer to the “1.2 Troubleshooting MXP, TXP, XP, or ADM-10G
Circuit Paths With Loopbacks” section on page 1-7.

Clear the LPBKTERMINAL (TRUNK) Condition
Step 1

Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit”
procedure on page 2-242.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.183 LWBATVG
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: PWR
The Low Voltage Battery alarm occurs in a –48 VDC environment when a battery lead input voltage falls
below the low power threshold. This threshold, with a default value of –44 VDC, is user-provisionable.
The alarm remains raised until the voltage remains above the threshold for 120 seconds. (For
information about changing this threshold, refer to the “Turn Up Node” chapter in the Cisco ONS 15454
DWDM Procedure Guide.

Clear the LWBATVG Alarm
Step 1

The problem is external to the ONS system. Troubleshoot the power source supplying the battery leads.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.184 MAN-REQ
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
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Logical Object: EQPT
The Manual Switch Request condition occurs when a user initiates a Manual switch request on an
OC-N/STM-N port. Clearing the Manual switch clears the MAN-REQ condition. You do not need to
clear the switch if you want the Manual switch to remain.

Clear the MAN-REQ Condition
Step 1

Complete the “Initiate a 1+1 Manual Switch Command” procedure on page 2-234.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.185 MANRESET
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT
A User-Initiated Manual Reset condition occurs when you right-click a card in CTC and choose Reset.

Note

MANRESET is an informational condition and does not require troubleshooting.

2.5.186 MANSWTOINT
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE-SREF
The Manual Switch To Internal Clock condition occurs when the NE timing source is manually switched
to an internal timing source.

Note

MANSWTOINT is an informational condition and does not require troubleshooting.

2.5.187 MANSWTOPRI
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF
The Manual Switch To Primary Reference condition occurs when the NE timing source is manually
switched to the primary timing source.

Note

MANSWTOPRI is an informational condition and does not require troubleshooting.
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2.5.188 MANSWTOSEC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF
The Manual Switch To Second Reference condition occurs when the NE timing source is manually
switched to a second timing source.

Note

MANSWTOSEC is an informational condition and does not require troubleshooting.

2.5.189 MANSWTOTHIRD
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF
The Manual Switch To Third Reference condition occurs when the NE timing source is manually
switched to a third timing source.

Note

MANSWTOTHIRD is an informational condition and does not require troubleshooting.

2.5.190 MANUAL-REQ-SPAN (2R, ESCON, FC, GE, ISC, OCN/STMN)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC, OCN/STMN
The Manual Switch Request on Ring condition for clients occurs when a user initiates a Manual Span
command on an MXP or TXP client for the above-listed client types to move traffic from a working span
to a protect span. This condition appears on the network view Alarms, Conditions, and History tabs. The
port where the MANUAL SPAN command was applied is marked with an “M” on the network view
detailed circuit map.

Note

For more information about protection schemes, refer to the “Network Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual.

2.5.191 MANUAL-REQ-SPAN (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The Manual Switch Request on Ring condition for the trunk occurs when a user initiates a Manual Span
command on an MXP or TXP trunk port in a splitter protection group to move traffic from a working
span to a protect span. This condition appears on the network view Alarms, Conditions, and History tabs.
The port where the MANUAL SPAN command was applied is marked with an “M” on the network view
detailed circuit map.
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Note

For more information about protection schemes, refer to the “Network Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual.

2.5.192 MEA (AIP)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: AIP
If the Mismatch of Equipment Attributes (MEA) alarm is reported against the AIP, the fuse in the AIP
board blew or is missing. The MEA alarm also occurs when an old AIP board with a 2-A fuse is installed
in a newer ANSI 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD).

Clear the MEA (AIP) Alarm
Step 1

Complete the “Replace the Alarm Interface Panel” procedure on page 2-246.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.193 MEA (EQPT)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: EQPT
The MEA alarm for equipment is reported against a card slot when the physical card inserted into a slot
does not match the card type that is provisioned for that slot in CTC. Removing the incompatible cards
clears the alarm. For more information about card compatibility, refer to the “Card Reference” chapter
of the Cisco ONS 15454 DWDM Reference Manual.

Note

For more information about protection schemes, refer to the “Network Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual.

Clear the MEA (EQPT) Alarm
Step 1

Physically verify the type of card that is installed in the slot reporting the MEA alarm. In node view
(single-shelf mode) or shelf view (multishelf mode), click the Inventory tab and compare it to the actual
installed card.

Step 2

Determine whether the ONS system shelf assembly is a newer 10-Gbps-compatible shelf assembly
(15454-SA-ANSI or 15454-SA-HD) or an earlier shelf assembly. Under the HW Part # column, if the
part number is 800-19857-XX or 800-19856-XX, then you have a 15454-SA-ANSI shelf. If the part
number is 800-24848-XX, then you have a 15454-SA-HD shelf. If the number is not one of those listed
here, then you are using an earlier shelf assembly.
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Note

On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and
15454-SA-R1 (P/N: 800-07149) shelves, the AIP cover is clear plastic. On the 15454-SA-ANSI
shelf (P/N: 800-19857), the AIP cover is metal.

Step 3

If you prefer the card type depicted by CTC, complete the “Physically Replace a Card” procedure on
page 2-240 for the reporting card.

Step 4

If you prefer the card that physically occupies the slot but the card is not in service, does not have circuits
mapped to it, and is not part of a protection group, place the cursor over the provisioned card in CTC
and right-click to choose Delete Card.
The card that physically occupies the slot reboots, and CTC automatically provisions the card type into
that slot.

Note

Step 5

Caution

Step 6

Caution
Step 7

If the card is in service, does have circuits mapped to it, is paired in a working protection scheme,
has DCC communications turned on, or is used as a timing reference, CTC does not allow you
to delete the card.

If any ports on the card are in service, place them out of service (OOS,MT or Locked,maintenance):

Before placing ports out of service, ensure that live traffic is not present.
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting card to
open the card view.

b.

Click the Provisioning tab.

c.

Click the administrative state of any in-service ports.

d.

Choose OOS,MT (or Locked,maintenance) to take the ports out of service.

If a circuit has been mapped to the card, complete the “Delete a Circuit” procedure on page 2-241.

Before deleting the circuit, ensure that live traffic is not present.
If the card is paired in a protection scheme, delete the protection group:
a.

node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Protection
tabs.

b.

Choose the protection group of the reporting card.

c.

Click Delete.

Step 8

Right-click the card reporting the alarm.

Step 9

Choose Delete.
The card that physically occupies the slot reboots, and CTC automatically provisions the card type into
that slot.

Step 10

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5

2-156

78-18342-02

Chapter 2

Alarm Troubleshooting
Trouble-Clearing Procedures

2.5.194 MEA (FAN)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: FAN
The MEA alarm is reported against the fan-tray assembly when a newer fan-tray assembly (15454-FTA3)
with a 5-A fuse is used with an older shelf assembly or when an older fan-tray assembly with a 2-A fuse
is used with a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) that
contains cards introduced in Release 3.1 or later. If a 10-Gbps-compatible shelf assembly contains only
cards introduced before Release 3.1, then an older fan-tray assembly (15454-FTA-2) can be used and
does not report an MEA alarm.

Clear the MEA (FAN) Alarm
Step 1

Determine whether the shelf assembly is a newer 10-Gbps-compatible shelf assembly (15454-SA-ANSI
or 15454-SA-HD) or an earlier shelf assembly. In node view (single-shelf mode) or shelf view (multishelf
mode), click the Inventory tab.
Under the HW Part # column, if the part number is 800-19857-XX or 800-19856-XX, then you have a
15454-SA-ANSI shelf. If the part number is 800-24848-XX, you have a 15454-SA-HD shelf.
Under the HW Part # column, if the number is not one of those listed here, then you are using an earlier
shelf assembly.

Step 2

If you have a 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD), the alarm
indicates that an older incompatible fan-tray assembly is installed in the shelf assembly. Obtain a newer
fan-tray assembly (15454-FTA3) with a 5-A fuse and complete the “Replace the Fan-Tray Assembly”
procedure on page 2-245.

Step 3

If you are using an earlier shelf assembly, the alarm indicates that you are using a newer fan-tray
assembly (15454-FTA3), which is incompatible with the earlier version of the shelf assembly. Obtain an
earlier version of the fan-tray assembly (15454-FTA2) and complete the “Replace the Fan-Tray
Assembly” procedure on page 2-245.

Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.195 MEA (PPM)
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: PPM
The Missing Equipment Attributes alarm for the PPM (SFP) is raised on TXP, MXP, MRC-12 and
OC192-XFP/STM-64-XP cards when the PPM (SFP) is misprovisioned or unsupported. It can occur
when you provision the PPM (SFP) for a wavelength that is explicitly not the first tunable wavelength.
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Note

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For PPM (SFP) specifications, refer to the “Hardware
Specifications” appendix in the same manual. For information about MRC-12 cards, refer to the “Optical
Cards” chapter in the Cisco ONS 15454 Reference Manual.

Clear the MEA (PPM) Alarm
Step 1

To provision the PPM (SFP), you must first create it in CTC. To do this, complete the following steps:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting card to
open the card view.

b.

Click the Provisioning > Pluggable Port Modules tabs. (If you already see the PPM [SFP] listed
in the Pluggable Port Modules Area, go to Step 2.)

c.

Under the Pluggable Port Modules area, click Create.

d.

In the Create PPM dialog box, choose the card PPM (SFP) number from the drop-down list (for
example, PPM 1).

e.

Choose the PPM (SFP) type from the second drop-down list, for example PPM (1 Port).

f.

Click OK.

Note

Step 2

For more information about provisioning MXP or TXP PPMs (SFPs), refer to the “Turn Up
a Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide. For information to
provision PPMs (SFPs) for the MRC-12 and OC192/STM64-XFP, refer to the “Optical
Cards” chapter in the Cisco ONS 15454 Reference Manual.

After you have created the PPM (SFP), or if you see it listed in the Pluggable Port Modules area but not
in the Selected PPM area, choose the port rate:
a.

Under the Selected PPM area, click Create.

b.

In the Create Port dialog box, choose the port (for example, 1-1) from the drop-down list.

c.

Choose the correct port type from the drop-down list. (For more information about selecting PPM
(SFP) port types, refer to the “Provision Transponder and Muxponder Cards” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.)

d.

Click OK.

Step 3

If you see the port listed in the Pluggable Port Modules area and the Selected PPM area, the MEA
indicates that the incorrect port rate was selected. Click the port in the Selected PPM area and click
Delete.

Step 4

Complete Step 2 to correctly provision the port rate.

Step 5

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.196 MEA (SHELF)
Default Severity: Critical (CR), Service-Affecting (SA)
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Logical Object: SHELF
The MEA (Shelf) condition is raised when ANSI and ETSI shelves exist in the same node. For example,
an ANSI subtended shelf is configured on an ETSI node controller or an ETSI subtended shelf is
configured on an ANSI node controller.

Clear the MEA (SHELF) Condition
Step 1 Ensure that the shelves in the node are either ANSI only or ETSI only.
Step 2 If the condition does not clear, log onto http://www.cisco.com/tac for more information or call
TAC (1-800-553-2447).

2.5.197 MEM-GONE
Default Severity: Major (MJ), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Memory Gone alarm occurs when data generated by software operations exceeds the memory
capacity of the TCC2/TCC2P card. The TCC2/TCC2P cards which exceed the memory capacity reboot
to avoid failure of card operations.

Note

The alarm does not require user intervention. The MEM-LOW alarm always preceeds the MEM-GONE
alarm.

2.5.198 MEM-LOW
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Free Memory of Card Almost Gone alarm occurs when data generated by software operations is
close to exceeding the memory capacity of the TCC2/TCC2P card. The alarm clears when additional
memory becomes available. If additional memory is not made available and the memory capacity of the
card is exceeded, CTC ceases to function.
The alarm does not require user intervention. If the alarm does not clear, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1-800-553-2447).

2.5.199 MFGMEM
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AICI-AEP, AICI-AIE, AIP, BPLANE, FAN, PPM
The Manufacturing Data Memory Failure alarm occurs when the EEPROM fails on a card or component,
or when the TCC2/TCC2P card cannot read this memory. EEPROM stores manufacturing data that a
system TCC2/TCC2P card uses to determine system compatibility and shelf inventory status.
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Unavailability of this information can cause less-significant problems. The AIP EEPROM also stores the
system MAC address. If the MFGMEM alarm indicates EEPROM failure on these panels, IP
connectivity could be disrupted and the system icon is grayed out in CTC network view.

Tip

When you lose LAN connectivity with an ONS system due to an MFGMEM alarm on the AIP, you can
reestablish node management by disconnecting the Ethernet cable from the panel and connecting it to
the active TCC2/TCC2P card LAN port.

Clear the MFGMEM Alarm
Step 1

Complete the “Reset an Active TCC2/TCC2P Card and Activate the Standby Card” procedure on
page 2-238.
Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Step 2

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC
(1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-239. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, complete the “Physically Replace a Card”
procedure on page 2-240.

Step 3

If the MFGMEM alarm continues to report after replacing the TCC2/TCC2P cards, the problem lies with
the EEPROM.

Step 4

If the MFGMEM is reported from the fan-tray assembly, obtain a fan-tray assembly and complete the
“Replace the Fan-Tray Assembly” procedure on page 2-245.

Step 5

If the MFGMEM is reported from the AIP, the backplane, or the alarm persists after the fan-tray
assembly is replaced, log into the Technical Support Website at http://www.cisco.com/techsupport for
more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.

2.5.200 MS-AIS
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STM1E, STMN
The Multiplex Section (MS) AIS condition indicates that there is a defect in the multiplexing section
layer of the SONET overhead. The multiplex section refers to the segment between two SONET devices
in the circuit and is also known as a maintenance span. The multiplex section layer of the SONET
overhead deals with payload transport, and its functions include multiplexing and synchronization.
Generally, any AIS is a special SONET signal that communicates to the receiving node when the transmit
node does not send a valid signal. AIS is not considered an error. It is raised by the receiving node on
each input when it detects the AIS instead of a real signal. In most cases when this condition is raised,
an upstream node is raising an alarm to indicate a signal failure; all nodes downstream from it only raise
some type of AIS. This condition clears when you resolved the problem on the upstream node.

Clear the MS-AIS Condition
Step 1

Complete the “Clear the AIS Condition” procedure on page 2-26.
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Step 2

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.201 MS-DEG
Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STM1E
The Multiplex Section Signal Degrade condition is similar to the “SDBER-EXCEED-HO” alarm on
page 2-199, but applies only to the multiplex section overhead of the EQPT object.

Clear the MS-DEG Condition
Step 1

Complete the “Clear the SDBER-EXCEED-HO Condition” procedure on page 2-200.

Step 2

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.202 MS-EOC
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: STMN
The MS-DCC Termination Failure alarm occurs when the ONS 15454 loses its data communications
channel. The DCC is nine bytes, D4 through D 12, in the SONET overhead. The bytes convey
information about Operation, Administration, Maintenance, and Provisioning (OAM&P). The
ONS 15454 uses the DCC on the SONET section overhead to communicate network management
information.

Clear the MS-EOC Alarm
Step 1

Complete the “Clear the RS-EOC Alarm” procedure on page 2-195.

Step 2

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.
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2.5.203 MS-EXC
Default Severity:Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STM1E
The Multiplex Section Signal Excessive BER condition is similar to the “SDBER-EXCEED-HO” alarm
on page 2-199, but applies only to the multiplex section overhead of the EQPT object.

Clear the MS-EXC Condition
Step 1

Complete the “Clear the SDBER-EXCEED-HO Condition” procedure on page 2-200.

Step 2

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.204 MS-RFI
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STM1E, STMN
The MS Remote Fault Indication (RFI) condition indicates that there is an RFI occurring at the SONET
overhead multiplexing section level.
An RFI occurs when the ONS 15454 detects an RFI in the SONET overhead because of a fault in another
node. Resolving the fault in the adjoining node clears the MS-RFI condition in the reporting node.

Clear the MS-RFI Condition
Step 1

Log into the far-end node of the reporting ONS 15454.

Step 2

Determine whether there are other alarms, especially the LOS(STM1E, STMN).

Step 3

Clear the main alarm. See the appropriate alarm section in this chapter for the procedure.

Step 4

If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country.

2.5.205 MT-OCHNC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: OTS
The MT-OCHNC condition occurs when the user provisions (tunes) a specific wavelength for
maintenance on a WXC card from an input port (EXP1-8, ADD-RX) to the output port (COM-TX).
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Clear the MT-OCHNC Condition
Step 1

Delete the provisioned wavelength that was specifically tuned for maintenance purposes on a WXC card.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.5.206 NON-CISCO-PPM
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: PPM
The Non-Cisco PPM Inserted condition occurs when a PPM that is plugged into a card’s port fails the
security code check. The check fails when the PPM used is not a Cisco PPM.

Clear the NON-CISCO-PPM Condition
Step 1

Obtain the correct Cisco PPM and replace the existing PPM with the new one.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.207 NOT-AUTHENTICATED
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: SYSTEM
The NOT-AUTHENTICATED alarm is raised by CTC (not by the NE) when CTC fails to log into a node.
This alarm only appears in CTC where the login failure occurred. This alarm differs from the
“INTRUSION-PSWD” alarm, page 2-112, because INTRUSION-PSWD occurs when a user exceeds the
login failures threshold.

Note

NOT-AUTHENTICATED is an informational alarm and is resolved when CTC successfully logs into the
node.

2.5.208 OCHNC-INC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: OCHNC-CONN
The Optical Channel (OCH) Incomplete Cross-Connection condition is raised when an OCH cross
connection on a two-way circuit is deleted. For example, if you create an OCH circuit on a linear DWDM
structure with Nodes A, B and C—originating at Node A, traversing through Node B, and terminating
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at Node C—then mistakenly delete a cross-connect (such as by TL1 command DLT-WLEN) on Nodes
B or C, this condition is raised on the source node (A). The condition is corrected by regenerating the
cross-connect. The alarm also follows these guidelines:

Note

•

Two-way circuit with Nodes A, B, and C (as described in the preceding example): Deleting a
cross-connection on Nodes B or C will raise OCHNC-INC on the Node A cross connection.

•

Two-way circuit with Nodes A, B, and C: Deleting a cross connection on Node A will raise an
OCHNC-INC alarm on the Node C cross connection.

•

One-way circuit with Nodes A, B and C: Deleting a cross connection on Nodes B or C will raise an
OCHNC-INC alarm on Node A cross connection.

•

One-way circuit with Nodes A, B, and C: Deleting a cross connection on Node A will not raise an
OCHNC-INC alarm.

If you delete one of the cross-connects, you might not be able to recreate this same circuit with CTC
because the wavelength is already being used on the other component nodes for add, drop, or express.
The OCHNC-INC alarm can also be raised if you restore one node’s database that is inconsistent with
other node databases, following the guidelines previously listed. (That is, an inconsistent database that
does not contain up-to-date circuit cross-connection information will cause the same problem as if you
had deleted the cross-connect.)

Caution

It is important to create a backup version of the database for each node of a topology during a
known-stable situation. You should give the saved files names that indicate their version and date or any
other information needed to verify their consistency. For procedures to back up or restore database files,
refer to the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the OCHNC-INC Alarm
Step 1

To recreate the missing cross-connect itself, establish a Telnet connection with the node where it was
deleted and use the ENT-WLEN command with the Add port, Drop port, or Express port on the node.
For information about establishing a TL1 session connection, refer to the Cisco ONS SONET TL1
Reference Guide. For more information about ENT-WLEN and other TL1 commands, as well as their
syntax, refer to the Cisco ONS SONET TL1 Command Guide.

Step 2

If the alarm is not due to a deleted cross-connect but instead to an inconsistent database being restored
on a node, correct the problem by restoring the correct backup version to that node. For the restore
procedure, refer to the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Note

When you restore a database on a node, it replaces the database being used on both (ACT and SBY)
TCC2/TCC2P cards as the cards synchronize this version into their active flash memory. If the active
(ACT) TCC2/TCC2P card is reset, the standby (SBY) TCC2/TCC2P card will therefore use the same
database version from its active flash memory. In the case of a power-up, both TCC2/TCC2P cards boot
and choose which database to use from two criteria: (1) the most recent version compatible with the node
software, and (2) the most recently loaded version of that compatible database (with the highest sequence
number).
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Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.209 OCHTERM-INC
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: OCHTERM
The Optical Termination Incomplete condition is raised against an OCH termination of there is no peer
OCH termination at the other end of a span.

Clear the OCHTERM-INC Condition
Step 1

Create an OCH termination at the other end of the span. For procedures to do this, refer to the “Create
Channels and Circuits” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.210 ODUK-1-AIS-PM
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The ODUK-1-AIS-PM is a secondary condition raised on MXP and ADM-10G cards trunk signals when
they experience an LOS (2R). Although the ODUK-1-AIS-PM is raised against the TRUNK object, it
actually refers to the client signals contained within the trunk.
A single ODUK-x-AIS-PM can occur when one far-end client signal is lost; multiple ODK-x-AIS-PMs
can occur (ODUK-1-AIS-PM, ODUK-2-AIS-PM, ODUK-3-AIS-PM, ODUK-4-AIS-PM) if more than
one far-end client is lost. If the entire trunk signal is lost, LOS (TRUNK) occurs and demotes any LOS
(2R) alarms.

Clear the ODUK-1-AIS-PM Condition
Step 1

Look for and clear the LOS (2R) alarm on the far-end client. This should clear the ODUK-1-AIS-PM
condition on the trunk.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.211 ODUK-2-AIS-PM
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The ODUK-2-AIS-PM is a secondary condition raised on MXP and ADM-10G cards trunk signals when
they experience an LOS (2R). Although the ODUK-2-AIS-PM is raised against the TRUNK object, it
actually refers to the client signals contained within the trunk.

Clear the ODUK-2-AIS-PM Condition
Step 1

Complete the “Clear the ODUK-1-AIS-PM Condition” procedure on page 2-165.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.212 ODUK-3-AIS-PM
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The ODUK-3-AIS-PM is a secondary condition raised on MXP and ADM-10G cards trunk signals when
they experience an LOS (2R). Although the ODUK-3-AIS-PM is raised against the TRUNK object, it
actually refers to the client signals contained within the trunk.

Clear the ODUK-3-AIS-PM Condition
Step 1

Complete the “Clear the “Clear the ODUK-1-AIS-PM Condition” procedure on page 2-165.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.213 ODUK-4-AIS-PM
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The ODUK-4-AIS-PM is a secondary condition raised on MXP and ADM-10G cards trunk signals when
they experience an LOS (2R). Although the ODUK-4-AIS-PM is raised against the TRUNK object, it
actually refers to the client signals contained within the trunk.

Clear the ODUK-4-AIS-PM Condition
Step 1

Complete the “Clear the ODUK-1-AIS-PM Condition” procedure on page 2-165.
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.214 ODUK-AIS-PM
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The Optical Data Unit (ODUK) AIS Path Monitoring (PM) condition applies to TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L,
MXP_2.5G_10G, and ADM-10G cards when ITU-T G.709 encapsulation is enabled for the cards.
ODUK-AIS-PM is a secondary condition that indicates a more serious condition such as the LOS
(OCN/STMN) alarm occurring downstream. (This is described in the “Alarm Troubleshooting” chapter
of the Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454SDH Troubleshooting Guide.)
The ODUK-AIS-PM condition is reported in the path monitoring area of the optical data unit wrapper
overhead. ODUK-AIS-PM is caused by the upstream 2.5.217 ODUK-OCI-PM, page 2-169.
ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP). For information about provisioning the
TXP card or MXP card to enable ITU-T G.709 encapsulation, refer to the “Provision Transponder and
Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-AIS-PM Condition
Step 1

Determine whether upstream nodes and equipment have alarms, especially the LOS (OCN/STMN)
alarm, or OOS (or Locked) ports.

Step 2

Clear the upstream alarms using the “Clear the LOS (OCN/STMN) Procedure” located in the
Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454SDH Troubleshooting Guide.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.215 ODUK-BDI-PM
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
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The ODUK Backward Defect Indicator (BDI) PM condition applies to TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, and
ADM-10G cards when ITU-T G.709 encapsulation is enabled for the cards. It indicates that there is a
path termination error upstream in the data. The error is read as a BDI bit in the path monitoring area of
the digital wrapper overhead.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-BDI-PM Condition
Step 1

Complete the “Clear the OTUK-BDI Condition” procedure on page 2-178.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.216 ODUK-LCK-PM
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The ODUK Locked Defect (LCK) PM condition applies to TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, and
ADM-10G cards when ITU-T G.709 encapsulation is enabled for the cards. ODUK-LCK-PM indicates
that a signal is being sent downstream to indicate that the upstream connection is locked, preventing the
signal from being passed. The lock is indicated by the STAT bit in the path overhead monitoring fields
of the optical transport unit overhead of the digital wrapper.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-LCK-PM Condition
Step 1

Unlock the upstream node signal.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.217 ODUK-OCI-PM
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The ODUK Open Connection Indication (OCI) PM condition applies to TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L,
MXP_2.5G_10G, and ADM-10G cards when ITU-T G.709 encapsulation is enabled for the cards. It
indicates that the upstream signal is not connected to a trail termination source. The error is read as a
STAT bit in the path monitoring area of the digital wrapper overhead. ODUK-OCI-PM causes a
downstream “ODUK-LCK-PM” alarm on page 2-168.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-OCI-PM Condition
Step 1

Verify the fiber connectivity at nodes upstream.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.218 ODUK-SD-PM
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The ODUK Signal Degrade (SD) PM condition applies to TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, and
ADM-10G cards when ITU-T G.709 encapsulation is enabled. ODUK-SD-PM indicates that incoming
signal quality is poor, but the incoming line BER has not passed the fail threshold. The BER problem is
indicated in the path monitoring area of the optical data unit frame overhead.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-SD-PM Condition
Step 1

Complete the “Clear the OTUK-SD Condition” procedure on page 2-180.
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Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.219 ODUK-SF-PM
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The ODUK Signal Fail (SF) PM condition (ODUK-SD-PM) applies to TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, MXP_2.5G_10G, and ADM-10G cards when ITU-T G.709 encapsulation is enabled.
ODUK-SF-PM indicates that incoming signal quality is poor and the incoming line BER has passed the
fail threshold. The BER problem is indicated in the path monitoring area of the optical data unit frame
overhead.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-SF-PM Condition
Step 1

Complete the “Clear the SF (DS1, DS3) Condition” procedure located in the “Alarm Troubleshooting”
chapter of the Cisco ONS 15454 Troubleshooting Guide.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.220 ODUK-TIM-PM
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK
The ODUK-TIM- PM condition applies to the path monitoring area of the OTN overhead for
TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, MXP_2.5G_10G, and ADM-10G cards. The condition occurs when there is a trace
identifier mismatch in the data stream. ODUK-TIM-PM causes an 2.5.215 ODUK-BDI-PM,
page 2-167, downstream.
The ODUK-TIM-PM condition applies to TXP cards and MXP cards when ITU-T G.709 encapsulation
is enabled for the cards. It indicates that there is an error upstream in the optical transport unit overhead
of the digital wrapper.
ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP). For information about provisioning the
TXP card or MXP card to enable ITU-T G.709 encapsulation, refer to the “Provision Transponder and
Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.
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Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the ODUK-TIM-PM Condition
Step 1

Complete the “Clear the TIM-P Condition” procedure located in the “Alarm Troubleshooting” chapter
of the Cisco ONS 15454 Troubleshooting Guide.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.221 OPEN-SLOT
Default Severity: Not Alarmed (NA), Minor (MN)
Logical Object: EQPT
The Open Slot condition indicates that there is an open slot in the system shelf. Slot covers assist with
airflow and cooling.

Clear the OPEN-SLOT Condition
Step 1

To install a slot cover and clear this condition, refer to the procedures located in the “Install Shelf and
Common Control Cards” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1 800 553-2447).

2.5.222 OPTNTWMIS
Default Severity: Major (MJ), Non-Service-Affecting (NSA)
Logical Object: NE
The Optical Network Type Mismatch alarm is raised when DWDM nodes are not configured for the same
type of network, either MetroCore or MetroAccess. All DWDM nodes on the same network must be
configured for the same network type because APC and ANS behave differently on each of these network
types. For more information about APC and ANS, refer to the “Network Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual.
When the OPTNTWMIS alarm occurs, the “APC-DISABLED” alarm on page 2-29 could also be raised.
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Note

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the OPTNTWMIS Alarm
Step 1

In node view (single-shelf mode) or multishelf view (multishelf mode) of the alarmed node, click the
Provisioning > WDM-ANS > Provisioning tabs.

Step 2

Choose the correct option from the Network Type list box, and click Apply.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.223 OPWR-HDEG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OCH-TERM, OMS, OTS
The Output Power High Degrade alarm occurs on all DWDM ports that use a power setpoint, including
the OPT-BST, OPT-PRE, OPT-AMP-C, and OPT-AMP-17-C cards AOTS ports in control-power mode;
the 32DMX, 32DMX-O, 40DMX, 32MUX-O, 32WSS, 40WSS-C, and WXC card OCH ports; and the
OSC-CSM and OSCM OSC-TX ports.
The alarm generally indicates that an internal signal transmission problem prevents the signal output
power from maintaining its setpoint and the signal has crossed the high-degrade threshold. For 32DMX,
32DMX-O, 40DMX, 32MUX-O, 32WSS, 40WSS-C, WXC OCH ports and OSC-CSM and OSCM
OSC-TX ports, OPWR-HDEG indicates that the card has a VOA control circuit failure affecting its
attenuation capability. The alarmed card should be replaced at the next opportunity.

Note

For more information about provisioning gain setpoints and VOA setpoints, refer to the “Node
Reference” and “Network Reference” chapters, respectively, of the Cisco ONS 15454 DWDM Reference
Manual. The “Hardware Specifications” appendix in the same manual contains power level tables for
each card.

Clear the OPWR-HDEG Alarm
Step 1

Verify fiber continuity to the port by following site practices. Refer to the “Network Reference” chapter
of the Cisco ONS 15454 DWDM Reference Manual for a procedure to detect a fiber cut.

Step 2

If the cabling is good, confirm that the LED is correctly illuminated on the physical card. A green
ACT/SBY LED indicates an active card. A red ACT/SBY LED indicates a failed card.

Step 3

Verify that the power read by photodiode on the port is within the expected range as projected by
Cisco TransportPlanner. The application generates a spreadsheet of values containing this information.
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Step 4

If the optical power level is within specifications, check the opwrMin threshold. (These are listed in the
“Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.) Refer to the
Cisco MetroPlanner DWDM Operations Guide and decide what value to use for modifying the power
level:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b.

Display the optical thresholds by clicking the following tabs:
•

For the OPT-BST, OPT-AMP-C, or OPT-AMP-17-C cards, click the Provisioning > Opt. Ampli.
Line > Optics Thresholds tabs.

•

For the OPT-PRE, OPT-AMP-C, or OPT-AMP-17-C cards, click the Provisioning > Opt. Ampli.
Line > Optics Thresholds tabs.

•

For the WXC card, click the Provisioning > Optical Chn > Optics Thresholds tabs.

•

For the AD-xC-xx.x card, click the Provisioning > Optical Chn > Optics Thresholds tabs.

•

For the AD-xB-xx.x card, click the Provisioning > Optical Band > Optics Thresholds tabs.

•

For the 32DMX, 32DMX-O, or 40DMX cards, click the Provisioning > Optical Chn > Optics
Thresholds tabs.

•

For the 32MUX-O card, click the Provisioning > Optical Chn > Optics Thresholds tabs.

•

For the 32WSS card, click the Provisioning > Optical Chn: Optical Connector x >
Optics Thresholds tabs.

•

For the OSCM or OSC-CSM cards, click the Provisioning > Optical Line > Optics Thresholds
tabs.

Step 5

If the received optical power level is within specifications, refer to the Cisco MetroPlanner DWDM
Operations Guide to determine the correct levels and check the opwrMin threshold. (These are listed in
the “Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.) If
necessary, modify the value as required.

Step 6

If the optical power is outside of the expected range, verify that all involved optical signal sources,
namely the TXP or MXP trunk port or an ITU-T line card, are in IS or Unlocked administrative state by
clicking the correct tab:
•

For the MXPP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning >
Line > SDH) tabs.

•

For the MXP_2.5G_10E card, click the Provisioning > Line > Trunk tabs.

•

For the MXP_2.5G_10G card, click the Provisioning > Line > SONET (or Provisioning >
Line > SDH) tabs.

•

For the MXP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line
> SDH) tabs.

•

For the TXPP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning >
Line > SDH) tabs.

•

For the TXP_MR_10E card, click the Provisioning > Line > SONET (or Provisioning > Line
> SDH) tabs.

•

For the TXP_MR_10G card, click the Provisioning > Line > SONET (or Provisioning > Line
> SDH) tabs.

•

For the TXP_MR_2.5G card, click the Provisioning > Line > SONET (or Provisioning > Line
> SDH) tabs.
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If it is not IS or Unlocked, choose IS (or Unlocked) from the administrative state drop-down list. This
creates the IS-NR or Unlocked,enabled service state.
Step 7

If the port is in IS (or Unlocked) state but its output power is outside of the specifications, complete the
“Clear the LOS-P (OCH) Alarm” procedure on page 2-141. (These specifications are listed in the
“Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference Manual.)

Step 8

If the signal source is IS or Unlocked and within expected range, come back to the unit reporting
OPWR-HDEG and clean all connected fiber in the same line direction as the reported alarm according
to site practice. If no site practice exists, complete the procedure in the “Maintain the Node” chapter of
the Cisco ONS 15454 DWDM Procedure Guide.

Note

Unplugging fiber can cause a traffic hit. To avoid this, perform a traffic switch if possible. Refer
to the procedures in the “2.8.2 Protection Switching, Lock Initiation, and Clearing” section on
page 2-233. For more detailed protection switching information, refer to the “Manage the Node”
chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step 9

Repeat Steps 1 to 8 for any other port on the card reporting the OPWR-HDEG alarm.

Step 10

If the alarm does not clear, look for and troubleshoot any other alarm that could identify the source of
the problem.

Step 11

If no other alarms exist that could be the source of the OPWR-HDEG, or if clearing an alarm did not
clear the alarm, place all of the card ports in OOS,DSBLD (or Locked,disabled) administrative state.

Step 12

Complete the “Physically Replace a Card” procedure on page 2-240 for the reporting card.

Step 13

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.224 OPWR-HFAIL
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AOTS, OCH, OMS, OTS
The Output Power Failure alarm occurs on an amplifier card (OPT-BST, OPT-PRE, OPT-AMP-C, or
OPT-AMP-17-C) AOTS and WXC card OCH port if the transmitted power exceeds the high fail
threshold. This alarm is raised only in control power working mode. The alarmed card should be replaced
at the next opportunity.

Note

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about changing their settings, refer to the
“Change DWDM Card Settings” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Clear the OPWR-HFAIL Alarm
Step 1

Complete the “Clear the OPWR-HDEG Alarm” procedure on page 2-172.
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Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.225 OPWR-LDEG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OCH-TERM, OMS, OTS
The Output Power Low Degrade alarm occurs on all DWDM ports that use a setpoint, including the an
amplifier card (OPT-BST, OPT-PRE, OPT-AMP-C, or OPT-AMP-17-C) AOTS ports in control-power
mode; the 32DMX, 32DMX-O, 40DMX, 32MUX-O, 40MUX, 32WSS, and 40WSS-C card OCH ports;
and the OSC-CSM and OSCM card OSC-TX ports.
The alarm generally indicates that an internal signal transmission problem prevents the signal output
power from maintaining its setpoint and the signal has crossed the low degrade threshold. For the
32DMX, 32DMX-O, 40DMX, 32MUX-O, 40MUX, 32WSS, and 40WSS-C card OCH ports and the
OSC-CSM and OSCM card OSC-TX ports, the OPWR-HDEG alarm indicates that the card has a VOA
control circuit failure affecting its attenuation capability. The alarmed card should be replaced at the next
opportunity.

Note

The OPWR-LDEG alarm may be raised on the WSS pass through ports of a ROADM configuration when
the attenuation is increased at the span level.

Note

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For more information about provisioning VOA setpoints,
refer to the “Network Reference” chapter in the same manual.

Clear the OPWR-LDEG Alarm
Step 1

Complete the “Clear the OPWR-HDEG Alarm” procedure on page 2-172.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.226 OPWR-LFAIL
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AOTS, OCH, OCH-TERM, OMS, OTS
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The Output Power Failure alarm applies to an amplifier card (OPT-BST, OPT-PRE, OPT-AMP-C, or
OPT-AMP-17-C) AOTS ports. It also applies to AD-1B-xx.x, AD-4B-xx.x, AD-1C-xx.x, AD-2C-xx.x,
AD-4C-xx.x, OPT-PRE, OPT-BST, OPT-AMP-C, or OPT-AMP-17-C, 32MUX-O, 40MUX, 32DMX,
32DMX-O, 32DMX, 40DMX, 32WSS, 40WSS-C, and OSC-CSM transmit ports. The alarm is raised
when monitored input power crosses the low fail threshold.
For the AD-1B-xx.x, AD-4B-xx.x, AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x card OCH ports and the
32MUX-O, 40MUX, 32DMX, 32DMX-O, 32DMX, 40DMX, 32WSS, 40WSS-C, OSCM, and
OSC-CSM cards, OPWR-LFAIL indicates that the card has a VOA control circuit failure that affects its
attenuation capability.

Note

For general information about DWDM cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For more information about provisioning VOA setpoints,
refer to the “Network Reference” chapter in the same manual.

Clear the OPWR-LFAIL Alarm
Step 1

Complete the “Clear the OPWR-HDEG Alarm” procedure on page 2-172.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.227 OSRION
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OTS
The Optical Safety Remote Interlock On condition is raised an amplifier card (OPT-BST or OPT-PRE)
when OSRI is set to ON. The condition does not correlate with the “OPWR-LFAIL” alarm on
page 2-175, which is also reported on the same port.

Clear the OSRION Condition
Step 1

Step 2

Turn the OSRI off:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b.

Click the Maintenance > ALS tabs.

c.

In the OSRI column, choose OFF from the drop-down list.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.228 OTUK-AIS
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The Optical Transport Unit (OTUK) AIS condition applies to TXP_MR_10G, TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G,
MXP_2.5G_10E, and ADM-10G cards when ITU-T G.709 encapsulation is enabled for the cards.
OTUk-AIS is a generic AIS signal with a repeating AIS PN-11 sequence. This pattern is inserted by the
card in the ITU-T G.709 frame (Trunk) when a faulty condition is present on the client side.
The detection of an OTUK-AIS on the RX-Trunk port of a near-end TXP or MXP is a secondary
condition that indicates a more serious issue occurring on the far-end TXP/MXP card connected
upstream, most likely on the client side. OTUK-AIS is reported in the optical transport unit overhead of
the digital wrapper.
ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).

Note

For information about MXP and TXP cards and their monitoring capabilities, refer to the “Card
Reference” and “Provision Transponder and Muxponder Cards” chapters in the Cisco ONS 15454
DWDM Procedure Guide.

Clear the OTUK-AIS Condition
Step 1

Complete the “Clear the AIS Condition” procedure on page 2-26.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.229 OTUK-BDI
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The Section Monitoring Backward Defect Indication (OTUK BDI) condition applies to TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L,
MXP_2.5G_10G, MXP_2.5G_10E, and ADM-10G cards when ITU-T G.709 encapsulation feature is
enabled for the cards. The presence of OTUK-BDI is detected by ITU-T G.709 frame section-monitoring
overhead field. The BDI bit is a single bit defined to convey the signal fail status detected in a section
termination sink in the upstream direction.

Note

If the near-end TXP detects an OTUK-BDI condition on its Trunk-RX port, this means that the far-end
TXP has inserted the BDI bit in the transmitted (Trunk-Tx) frame, because a failure such as LOS or SD
was detected on the Trunk-RX port. Troubleshoot the failure on the far-end side to clear this condition.
For information about various DWDM LOS alarms, refer to the appropriate sections in this chapter. For
an OC-N/STM-N LOS failure or an SD, refer to the “Alarm Troubleshooting” chapter of the
Cisco ONS 15454 Troubleshooting Guide.
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ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-BDI Condition
Step 1

At the near-end node, use site practices to clean trunk transmitting fiber toward the far-end node and the
client receiving fiber. If no site practice exists, complete the procedure in the “Maintain the Node”
chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

At the far-end node, determine whether an “OTUK-AIS” condition, page 2-177, is present on the
Trunk-RX. If so, the root cause to be investigated is the Trunk-Tx side on the near-end card (the one
alarmed for OTUK-BDI) because that is the section where the AIS bit is inserted.

Step 3

If there is no OTUK-AIS at the far-end node, continue to investigate performances of the Trunk-Rx:
Look for other OTU-related alarms, such as the “OTUK-LOF” condition on page 2-179 or “OTUK-SD”
condition on page 2-180 at the far-end Trunk-RX. If either is present, resolve the condition using the
appropriate procedure in this chapter.

Step 4

If the OTUK-BDI alarm does not clear, use an OTN test set such as the Agilent OmniBerOTN tester to
to check near-end transmitting signal quality. (For specific procedures to use the test set equipment,
consult the manufacturer.)

Step 5

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.230 OTUK-IAE
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The OTUK Section-Monitoring Incoming Alignment Error (IAE) alarm occurs on TXP_MR_10G,
TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L,
MXP_2.5G_10G, MXP_2.5G_10E, and ADM-10G cards when ITU-T G.709 encapsulation is enabled
for the cards and the trunk connection is present. This alarm is raised on the near-end node to indicate
that the far-end node it has detected errors in the received OTUK frames, but they are not bad enough to
cause an “OTUK-LOF” alarm, page 2-179.
The IAE bit in the section overhead allows the ingress point (in this case, the far-end node) to inform its
corresponding egress (near-end) point that the alignment error is detected on the incoming signal OTUK
frame alignment errors from NE. The error is an out-of-frame (OOF) alignment, in which the optical
transport unit overhead frame alignment (FAS) area is errored for more than five frames.
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Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-IAE Alarm
Step 1

At the near-end and far-end node, use site practices to clean transmitting fiber on near-end node's
reporting port and receiving fiber on correspondent far-end port. If no site practice exists, complete the
procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

If the OTUK-IAE alarm does not clear, look for other OTU-related alarm, such as the “OTUK-LOF”
alarm, page 2-179, at the far-end node and resolve it using the appropriate procedure in this guide.

Step 3

If the OTUK-IAE alarm does not clear, use an OTN test set such as the Agilent OmniBerOTN tester to
to check near-end transmitting signal quality. For specific procedures to use the test set equipment,
consult the manufacturer.

Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.231 OTUK-LOF
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK
The OTUK-LOF alarm applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, MXP_2.5G_10E, GE-XP, 10GE-XP, and
ADM-10G cards when ITU-T G.709 encapsulation is enabled for the cards. The alarm indicates that the
card has lost frame delineation on the input data. Loss of frame occurs when the optical transport unit
overhead frame alignment (FAS) area is errored for more than five frames and that the error persists more
than three milliseconds.
ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-LOF Alarm
Step 1

Verify cabling continuity to the port reporting the alarm.
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Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly. To
verify cable continuity, follow site practices.

Step 2

At the far-end node, verify the cabling of the Trunk-TX port of the TXP or MXP connected to alarmed
card in the near-end. Clean the fibers according with site practice.(If no site practice exists, refer to the
“Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide for procedures.)

Step 3

At the far-end node, verify the ITU-T G.709 encapsulation configuration of the Trunk-TX of the
TXP/MXP connected to alarmed card in the near end.

Step 4

Look for other OTU-related alarms at the far-end Trunk-TX and resolve them if necessary using the
appropriate procedure in this guide.

Step 5

If the OTUK-LOF alarm does not clear on the near end, use an OTN test set such as the Agilent OmniBer
OTN tester to check far-end ITU-T G.709 transmitting signal quality. (For specific procedures to use the
test set equipment, consult the manufacturer.)

Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.232 OTUK-SD
Default Severity: Not Alarmed (NA) Non-Service-Affecting (NSA)
Logical Object: TRUNK
The OTUK-SD condition applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, MXP_2.5G_10E, and ADM-10G cards when
ITU-T G.709 encapsulation is enabled. The condition indicates that incoming signal quality is poor, but
the incoming line BER has not passed the fail threshold. The BER value is calculated on the Trunk-Rx
port’s incoming ITU-T G.709 encapsulation frame. If FEC or E-FEC feature is enabled, the BER is a
pre-FEC measurement.
ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-SD Condition
Step 1

Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.
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Step 2

If the BER threshold is correct and at the expected level, use an optical test set to measure the power
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment,
consult the manufacturer.

Step 3

If the optical power level is good, verify that optical receive levels are within the acceptable range.

Step 4

If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Step 5

If the condition does not clear, verify that single-mode fiber is used.

Step 6

If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.

Step 7

Clean the fiber connectors at both ends for a signal degrade according to site practice.

Step 8

Verify that a single-mode laser is used at the far end.

Step 9

If the problem does not clear, the transmitter at the other end of the optical line could be failing and
require replacement. Refer to the “2.8.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-238.

Step 10

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.233 OTUK-SF
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The OTUK-SF condition applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, MXP_2.5G_10E, and ADM-10G cards when
ITU-T G.709 encapsulation is enabled. The condition indicates that incoming signal quality is poor and
that the BER for the incoming line has passed the fail threshold. The BER value is calculated on the
Trunk-Rx port’s incoming ITU-T G.709 encapsulation frame. If FEC or E-FEC feature is enabled, the
BER is a pre-FEC measurement.
ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-SF Condition
Step 1

Complete the “Clear the OTUK-SD Condition” procedure on page 2-180.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5
78-18342-02

2-181

Chapter 2

Alarm Troubleshooting

Trouble-Clearing Procedures

2.5.234 OTUK-TIM
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK
The OTUK-TIM alarm applies to TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E,
TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G, MXP_2.5G_10E, and ADM-10G cards when
ITU-T G.709 encapsulation is enabled and section trace mode is set to manual. The alarm indicates that
the expected section-monitoring trail trace identifier (TT1) string does not match the received TTI string
and raises a Trace Identifier Mismatch (TIM) alarm. The TIM alarm in turn, triggers an “OTUK-BDI”
alarm, page 2-177.
ITU-T G.709 encapsulation refers to a digital data wrapper that is transparent across networking
standards such as SONET and protocols (such as Ethernet or IP).

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OTUK-TIM Condition
Step 1

Complete the “Clear the TIM Alarm” procedure on page 2-219.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.235 OUT-OF-SYNC
Default Severity: Major (MJ), Service-Affecting (SA); Not Alarmed (NA),
Non-Service-Affecting (NSA) for ISC
Logical Objects: FC, GE, ISC, TRUNK
The Ethernet Out of Synchronization condition occurs on TXP_MR_2.5, TXPP_MR_2.5, GE-XP,
10GE-XP, and ADM-10G cards when the PPM (SFP) port is not correctly configured for the Gigabit
Ethernet payload rate.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the OUT-OF-SYNC Condition
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the alarmed card to open
the card view.
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Step 2

Click the Provisioning > Pluggable Port Modules tabs.

Step 3

Delete the provisioning for the PPM (SFP) by completing the following steps:

Step 4

Step 5

Step 6

a.

Click the PPM (SFP) in the Selected PPM area.

b.

Click Delete.

Recreate the PPM (SFP):
a.

In the Pluggable Port Modules area, click Create.

b.

In the Create PPM dialog box, choose the PPM (SFP) number you want to create.

c.

Click OK.

After the PPM (SFP) is created, provision the port’s data rate:
a.

In the Pluggable Ports area, click Create.

b.

In Create Port dialog box, choose ONE_GE from the Port Type drop-down list.

c.

Click OK.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.236 PARAM-MISM
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OCH-TERM, OMS, OTS
The Plug-in Module Range Settings Mismatch condition is raised an amplifier card (OPT-BST ,
OPT-PRE, OPT-AMP-C, and OPT-AMP-17-C), optical add-drop multiplexer (OADM) card
(AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, and AD-4B-xx.x), multiplexer card (32MUX-O,
32WSS, 40WSS-C, and 40WXC), or demultiplexer cards (32DMX-O, 32DMX, 40-DMX-C, and
40DMX-CE) when the parameter range values stored on the card are different from the parameters stored
in TCC2/TCC2P card database. The condition is not user-serviceable. Log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1-800-553-2447).

2.5.237 PDI-P
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM
PDI-P is a set of application-specific codes indicating a signal label mismatch failure (SLMF) in the
ONS 15454 STS path overhead. The condition indicates to downstream equipment that there is a defect
in one or more of the directly mapped payloads contained in that STS synchronous payload envelope
(SPE). For example, the mismatch could occur in the overhead to the path selector in a downstream node
configured as part of a path protection. The PDI-P codes appear in the STS Signal Label (C2 byte).
An SLMF often occurs when the payload (for example, ATM) does not match what the signal label is
reporting. The “AIS” condition, page 2-26 often accompanies a PDI-P condition. If the PDI-P is the only
condition reported with the AIS, clearing PDI-P clears the AIS. PDI-P can also occur during an upgrade,
but usually clears itself and is not a valid condition.
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A PDI-P condition reported on an OC-N port supporting a G-Series card circuit could result from the
end-to-end Ethernet link integrity feature of the G-Series card. If the link integrity is the cause of the
path defect, it is typically accompanied by the TPTFAIL (G1000) or the CARLOSS (G1000) reported
against one or both Ethernet ports terminating the circuit. If this is the case, clear the TPTFAIL and
CARLOSS alarms to resolve the PDI-P condition.
A PDI-P condition reported on an OC-N port supporting an ML-Series card circuit could result from the
end-to-end Ethernet link integrity feature of the ML-Series card. If the link integrity is the cause, it is
typically accompanied by the TPTFAIL (ML100T, ML1000, MLFX) reported against one or both POS
ports terminating the circuit. If TPTFAIL is reported against one or both of the POS ports,
troubleshooting the accompanying alarm clears the PDI-P condition. Refer to the Ethernet Card
Software Feature and Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and
Cisco ONS 15327 for more information about ML-Series cards.

Warning

On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Note

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the PDI-P Condition
Step 1

Verify that all circuits terminating in the reporting card are DISCOVERED:
a.

Click the Circuits tab.

b.

Verify that the Status column lists the circuit as active.

c.

If the Status column lists the circuit as PARTIAL, wait 10 minutes for the ONS 15454 to initialize
fully. If the PARTIAL status does not change after full initialization, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC to report a
Service-Affecting (SA) problem (1-800-553-2447).

Step 2

After determining that the circuit is DISCOVERED, ensure that the signal source to the card reporting
the alarm is working.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
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Step 3

Caution

If traffic is affected, complete the “Delete a Circuit” procedure on page 2-241.

Deleting a circuit can affect existing traffic.

Step 4

Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels” chapter
in the Cisco ONS 15454 Procedure Guide for detailed procedures to create circuits.

Step 5

If circuit deletion and re-creation does not clear the condition, verify that there is no problem stemming
from the far-end OC-N card providing STS payload to the reporting card.

Step 6

If the condition does not clear, confirm the cross-connect between the OC-N card and the reporting card.

Step 7

If the condition does not clear, clean the far-end optical fiber according to site practice. If no site practice
exists, complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure
Guide.

Step 8

If the condition does not clear, complete the “Physically Replace a Card” procedure on page 2-240 for
the optical/electrical cards.

Step 9

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.238 PEER-NORESPONSE
Default Severity: Major (MJ), Non-Service-Affecting (NSA)
Logical Object: EQPT
The switch agent raises a Peer Card Not Responding alarm if either traffic card in a protection group
does not receive a response to the peer status request message. PEER-NORESPONSE is a software
failure and occurs at the task level, as opposed to a communication failure, which is a hardware failure
between peer cards.

Clear the PEER-NORESPONSE Alarm
Step 1

Complete the “Reset a Card in CTC” procedure on page 2-237 for the reporting card.

Step 2

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED appearance: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates
a standby card.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.239 PMI
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical objects: OCH, OMS, OTS
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The Payload Missing Indication (PMI) condition is part of MSTP network-level alarm correlation. It is
raised at the far end when OTS or OMS optical payload is missing due to an LOS, LOS-P, or
OPWR-LFAIL alarm root cause. A single PMI condition is sent when every channel on the aggregated
port is lost--that is, when there are no pass-through channels or active added channels in service.
An LOS, LOS-P, or OPWR-LFAIL alarm on an MSTP circuit causes multiple alarms for each channel.
R7.0 correlation simplifies troubleshooting by reporting a single alarm for multiple alarms having one
root cause, then demoting the root alarms so that they are only visible in the Conditions window (with
Not Reported [NR] severity.)
PMI clears when the optical channel is working on the aggregated or single-channel optical port.

Note

Network-level alarm correlation is only supported for MSTP communication alarms. It is not supported
for equipment alarms.

Clear the PMI Condition
Step 1

Step 2

Clear the root-cause service-affecting alarm by using one of the following procedures, as appropriate:
•

“Clear the LOS (OTS) Alarm” procedure on page 2-135

•

“Clear the LOS (TRUNK) Alarm” procedure on page 2-136

•

“Clear the LOS-P (OCH) Alarm” procedure on page 2-141

•

“Clear the LOS-P (AOTS, OMS, OTS) Alarm” procedure on page 2-138

•

“Clear the LOS-P (TRUNK) Alarm” procedure on page 2-144

•

“Clear the OPWR-LFAIL Alarm” procedure on page 2-176

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.240 PORT-FAIL
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OCH
The APC Port Failure alarm occurs when amplifier margins and VOA are saturated for a port, so APC
cannot apply any control. For example, it is raised if APC attempts to set an OPT-BST or OPT-AMP-x-C
port’s gain higher than 20 dBm (the maximum setpoint) or its attenuation on Express VOA lower than
0 dBm (the minimum setpoint).

Note

For more information about provisioning VOA setpoints, refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual.
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Clear the PORT-FAIL Alarm
Step 1

If a maintenance operation such as fiber repair, adding a card, or replacing a card has just been performed
on the optical network (whether at the node raising the PORT-FAIL alarm or at any other node),
determine whether this operation has added extra loss. This can happen if the repair is imperfect or if a
patchcord is dirty. To test for signal loss, refer to procedures in the “Network Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual.

Step 2

If there is loss added and fiber has been repaired or removed, first try cleaning the fiber by completing
the procedures in the “Maintain the Node” chapter of the Cisco ONS 15454 DWDM Procedure Guide.

Step 3

If the alarm does not clear and fiber has been repaired, perform the repair again with new fiber if
necessary. For fibering procedures, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454
DWDM Procedure Guide. If the alarm does not clear, go to Step 4.

Warning

Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do
not view directly with optical instruments. Viewing the laser output with certain optical instruments
(for example, eye loupes, magnifiers, and microscopes) within a distance of 100 mm may pose an eye
hazard. Statement 1056

Note

Step 4

Before disconnecting any optical amplifier card fiber for troubleshooting, ensure that the optical
amplifier card is unplugged.

If a maintenance operation has not been recently executed on the network, the alarm indicates that the
network has consumed all of its allocated aging margins. In this case, log into the Technical Support
Website at http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447)
in order to report a Service-Affecting (SA) problem.

2.5.241 PROTNA
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Protection Unit Not Available alarm is caused by an OOS (or Locked) protection card when a
TCC2/TCC2P card or cross-connect card that has been provisioned as part of a protection group is not
available. The alarm clears if the device or facility is brought back in service.

Clear the PROTNA Alarm
Step 1

If the PROTNA alarm occurs and does not clear, and if it is raised against a controller card, ensure that
there is a redundant TCC2/TCC2P card installed and provisioned in the chassis.

Step 2

If the alarm is raised against a line card, verify that the ports have been taken out of service (OOS,MT
or Locked,maintenance):
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting card to
open the card view.

b.

Click the Provisioning tab.
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c.

Click the administrative state of any in-service (IS or Unlocked) ports.

d.

Choose OOS,MT (or Locked,maintenance) to take the ports out of service.

Step 3

Complete the “Reset a Card in CTC” procedure on page 2-237 for the reporting card.

Step 4

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. Verify the
LED appearance: A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates
a standby card.

Step 5

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-240 for the reporting card.

Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.242 PROV-MISMATCH
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: PPM
The Provisioning Mismatch for a PPM alarm is raised against a PPM connector on MXP_2.5G_10E,
MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_2.5G_10G, MXP_MR_2.5G, MXPP_MR_2.5G,
TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXPP_MR_2.5G, GE_XP,
10GE_XP, and ADM-10G under one of the following circumstances:
•

The physical PPM’s range or wavelength does not match the provisioned value. PPMs have static
wavelength values which must match the wavelengths provisioned for the card in the case of
non-DWDM PPMs.

•

The PPM’s reach (loss) value does not meet the reach value needed for the card.

•

The reach of the inserted PPM does not match the physical PPM.

This alarm is raised on GE_XP and 10GE_XP cards, if the following settings are configured:
•

Double Add and Translate Add selective modes

•

CVLAN Ingress CoS

•

MAC address learning on SVLAN

Until this alarm is cleared, provisioning on the GE_XP and 10GE_XP cards is not possible.

Clear the PROV-MISMATCH Alarm
To clear the alarm when the physical PPM’s range or wavelength does not match the provisioned value,
perform the following steps:
Step 1

Determine what the PPM wavelength range should be by viewing the frequency provisioned for the card:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b.

Click the Maintenance > Info tabs.

c.

Record the value shown in the Value column.
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Step 2

Step 3

Remove the incorrect PPM connector:
a.

Unplug the PPM connector and fiber from the reporting card.

b.

If the PPM connector has a latch securing the fiber cable, pull the latch upward to release the cable.

c.

Pull the fiber cable straight out of the connector.

Replace the unit with the correct PPM connector:
a.

Plug the fiber into a Cisco-supported PPM connector. For more information about supported PPMs,
refer to the “Hardware Specifications” appendix of the Cisco ONS 15454 DWDM Reference
Manual.

b.

If the new PPM connector has a latch, close the latch over the cable to secure it.

c.

Plug the cabled PPM connector into the card port until it clicks.

To clear the alarm when the PPM’s reach (loss) value does not meet the reach value needed for the card,
perform the following steps:
Step 1

Note

Determine what the reach distance of the PPM should be by viewing the reach value provisioned for the
card:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the
card view.

b.

Click the Provisioning > Line tabs.

In GE_XP cards, click Provisioning > Ether Ports tabs.
c.

Step 2

Step 3

Record the value shown in the Reach column.

Check the reach value of the PPM:
a.

In the node view (single-shelf mode), click the Inventory tab.

b.

Check the reach distance in the Product ID column.

If there is a mismatch in the values recorded in step1c and step2b, change the PPM to match the
provisioned value or reprovision the card.

To clear the alarm on GE_XP or 10GE_XP cards with Double Add and Translate Add selective modes,
CVLAN Ingress CoS, or MAC address learning on SVLAN configuration, perform the following steps:
Step 1

Remove Double Add and Translate Add selective modes, CVLAN Ingress CoS, or MAC address
learning on SVLAN configuration.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).
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2.5.243 PTIM
Default Severity: Major (MJ), Non-Service-Affecting (NSA)
Logical Object: TRUNK, EQPT
The Payload Type Identifier Mismatch alarm occurs when there is a mismatch between the way the
ITU-T G.709 encapsulation option is configured on MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G,
TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXPP_MR_2.5G, or ADM-10G card at each end
of the optical span.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the PTIM Alarm
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the alarmed
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, or TXPP_MR_2.5G, or ADM-10G card to open the card view.

Step 2

Click the Provisioning > OTN > OTN Lines tabs.

Step 3

Ensure that the G.709 OTN check box is checked. If not, check it and click Apply.

Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.244 PWR-FAIL-A
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Equipment Power Failure at Connector A alarm occurs when there is no power supply from the main
power connector to the equipment. This alarm occurs on the electrical interface assemblies (EIA),
TCC2/TCC2P, or I/O cards.

Warning

The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207

Clear the PWR-FAIL-A Alarm
Step 1

If a single card has reported the alarm, take the following actions depending on the reporting card:
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•

If the reporting card is an active traffic line port in a 1+1 protection group or part of a path protection
configuration, ensure that an APS traffic switch has occurred to move traffic to the protect port.

Note

Removing a card that currently carries traffic on one or more ports can cause a traffic hit. To
avoid this, perform an external switch if a switch has not already occurred. See the
“2.8.2 Protection Switching, Lock Initiation, and Clearing” section on page 2-233 for
commonly used traffic-switching procedures.

•

If the alarm is reported against a TCC2/TCC2P card, complete the “Reset an Active TCC2/TCC2P
Card and Activate the Standby Card” procedure on page 2-238.

•

If the alarm is reported against an OC-N/STM-N card, complete the “Reset a Card in CTC”
procedure on page 2-237.

Step 2

If the alarm does not clear, complete the “Remove and Reinsert (Reseat) Any Card” procedure on
page 2-240.

Step 3

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240 for the
reporting card.

Step 4

If the single card replacement does not clear the alarm, or if multiple cards report the alarm, verify the
office power. Refer to the “Install the Shelf and Common Control Cards” chapter in the
Cisco ONS 15454 DWDM Procedure Guide for procedures. See the “1.10 Power Supply Problems”
section on page 1-57 as necessary.

Step 5

If the alarm does not clear, reseat the power cable connection to the connector.

Step 6

If the alarm does not clear, physically replace the power cable connection to the connector.

Step 7

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.245 PWR-FAIL-B
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Equipment Power Failure at Connector B alarm occurs when there is no power supply from the main
power connector to the equipment. This alarm occurs on the electrical interface assemblies (EIA),
TCC2/TCC2P, or I/O cards.

Warning

The power supply circuitry for the equipment can constitute an energy hazard. Before you install or
replace the equipment, remove all jewelry (including rings, necklaces, and watches). Metal objects
can come into contact with exposed power supply wiring or circuitry inside the DSLAM equipment.
This could cause the metal objects to heat up and cause serious burns or weld the metal object to the
equipment. Statement 207

Clear the PWR-FAIL-B Alarm
Step 1

Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-190.

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5
78-18342-02

2-191

Chapter 2

Alarm Troubleshooting

Trouble-Clearing Procedures

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.246 PWR-FAIL-RET-A
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Equipment Power Failure at Connector A alarm occurs when there is no power supplied to the
backup power connector on the shelf. This alarm occurs on the electrical interface assemblies (EIA) or
TCC2/TCC2P.

Clear the PWR-FAIL-RET-A Alarm
Step 1

Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-190.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.247 PWR-FAIL-RET-B
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Equipment Power Failure at Connector B alarm occurs when there is no power supplied to the
backup power connector on the shelf. This alarm occurs on the electrical interface assemblies (EIA) or
TCC2/TCC2P.

Clear the PWR-FAIL-RET-A Alarm
Step 1

Complete the “Clear the PWR-FAIL-A Alarm” procedure on page 2-190.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.248 RFI
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The Remote Failure Indication condition is raised against an MXP_2.5G_10G, TXP_MR_10G,
TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, TXPP_MR_2.5G, or ADM-10G
card when the card has the “AIS” condition, page 2-26. The MXP or TXP cards only raise AIS (or remote
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failure indication [RFI]) when they are in line or section termination mode, that is, when the MXP or
TXP cards in line termination mode or section termination mode have improperly terminated overhead
bytes.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the RFI Condition
Step 1

Complete the “Delete a Circuit” procedure on page 2-241 and then recreate the circuit.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.249 RFI-L
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: TRUNK
A RFI Line condition occurs when the ONS 15454 detects an RFI in OC-N card SONET overhead
because of a fault in another node. Resolving the fault in the adjoining node clears the RFI-L condition
in the reporting node. RFI-L indicates that the condition is occurring at the line level.

Clear the RFI-L Condition
Step 1

Log into the node at the far-end node of the reporting ONS 15454.

Step 2

Identify and clear any alarms, particularly the LOS (OCN) alarm.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.250 RFI-P
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM
The RFI Path condition occurs when the ONS 15454 detects an RFI in the an STS-1 signal SONET
overhead because of a fault in another node. Resolving the fault in the adjoining node clears the RFI-P
condition in the reporting node. RFI-P occurs in the terminating node in that path segment.
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Clear the RFI-P Condition
Step 1

Verify that the ports are enabled and in service (IS-NR or Unlocked,enabled) on the reporting
ONS 15454:
a.

Confirm that the LED is correctly illuminated on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b.

To determine whether the OC-N port is in service, double-click the card in CTC to open the card
view.

c.

Click the Provisioning > Line tabs.

d.

Verify that the Admin State column lists the port as IS or Unlocked.

e.

If the Admin State column lists the port as OOS,MT or Locked,maintenance or Locked,disabled,
click the column and choose IS or Unlocked. Click Apply.

Note

If ports managed into IS or Unlocked admin state are not receiving signals, the LOS alarm
is either raised or remains, and the port service state transitions to OOS-AU,FLT.

Step 2

To find the path and node failure, verify the integrity of the SONET STS circuit path at each of the
intermediate SONET nodes.

Step 3

Clear alarms in the node with the failure, especially the “UNEQ-P” alarm on page 2-223.

Step 4

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.251 RS-EOC
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SONET Data Communications Channel (DCC) Termination Failure alarm occurs when the
ONS 15454 loses its data communications channel. Although this alarm is primarily SONET, it can
apply to DWDM. For example, the OSCM card can raise this alarm on its STM-1 section overhead.
The RS-DCC consists of three bytes, D1 through D3, in the SONET overhead. The bytes convey
information about operation, administration, maintenance, and provisioning (OAM&P). The ONS 15454
uses the DCC on the SONET section overhead to communicate network management information.

Warning

Class 1 laser product. Statement 1008

Warning

Class 1M laser radiation when open. Do not view directly with optical instruments. Statement 1053
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Warning

On the OC192 LR/STM64 LH 1550 card, the laser is on when the card is booted and the safety key is in
the on position (labeled 1). The port does not have to be in service for the laser to be on. The laser is
off when the safety key is off (labeled 0). Statement 293

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Note

If a circuit shows an incomplete state when this alarm is raised, the logical circuit is in place. The circuit
is able to carry traffic when the connection issue is resolved. You do not need to delete the circuit when
troubleshooting this alarm.

Clear the RS-EOC Alarm
Step 1

If the alarm does not clear on the reporting node, verify the physical connections between the cards and
that the fiber-optic cables are configured to carry RS-DCC traffic. If they are not, correct them. For more
information about OC-N fiber connections and terminations, refer to the “Install Cards and Fiber-Optic
Cable” chapter in the Cisco ONS 15454 Procedure Guide.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located lower-right edge of the shelf assembly.
If the physical connections are correct and configured to carry DCC traffic, ensure that both ends of the
fiber span have unlocked ports. Verify that the ACT/SBY LED on each card is green.

Step 2

When the LEDs on the cards are correctly illuminated, complete the “Verify or Create Node RS-DCC
Terminations” procedure on page 2-242 to verify that the DCC is provisioned for the ports at both ends
of the fiber span.

Step 3

Repeat Step 2 at the adjacent nodes.

Step 4

If DCC is provisioned for the ends of the span, verify that the port is active and in service by completing
the following steps:
a.

Confirm that the card shows a green LED in CTC or on the physical card.
A green ACT/SBY LED indicates an active card. An amber ACT/SBY LED indicates a standby card.

b.

To determine whether the port is in service, double-click the card in CTC to display the card view.

c.

For an OC-N card, click the Provisioning > Line tabs. For the OSCM card, click the Provisioning >
STM-1 Line tabs.

d.

Verify that the Admin State column lists the port as IS or Unlocked.
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e.

If the Admin State column lists the port as OOS,MT or Locked,maintenance or Locked,disabled,
click the column and click IS or Unlocked from the drop-down list. Click Apply.

Note

If a port in the unlocked admin state does not receive a signal, the LOS alarm is raised and
the port service state transitions to Locked-disabled, automaticInService & failed.

Step 5

For all nodes, if the card is in service, use an optical test set to determine whether signal failures are
present on fiber terminations. For specific procedures to use the test set equipment, consult the
manufacturer.

Caution

Using an optical test set disrupts service on an OC-N card. It could be necessary to manually switch
traffic carrying circuits over to a protection path. Refer to the “2.8.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-233 for commonly used switching procedures.

Step 6

If no signal failures exist on terminations, measure power levels to verify that the budget loss is within
the parameters of the receiver.

Step 7

If budget loss is within parameters, ensure that fiber connectors are securely fastened and properly
terminated. For more information refer to “Install Cards and Fiber-Optic Cables” chapter in the
Cisco ONS 15454 Procedure Guide.

Step 8

If fiber connectors are properly fastened and terminated, complete the “Reset an Active TCC2/TCC2P
Card and Activate the Standby Card” procedure on page 2-238.
Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.
Resetting the active TCC2/TCC2P card switches control to the standby TCC2/TCC2P card. If the alarm
clears when the ONS 15454 node switches to the standby TCC2/TCC2P card, the user can assume that
the previously active card is the cause of the alarm.

Step 9

If the TCC2/TCC2P card reset does not clear the alarm, delete the problematic RS-DCC termination by
completing the following steps:
a.

From card view, click View > Go to Previous View if you have not already done so.

b.

Click the Provisioning > Comm Channels > RS-DCC tabs.

c.

Highlight the problematic DCC termination.

d.

Click Delete.

e.

Click Yes in the Confirmation Dialog box.

Step 10

Recreate the RS-DCC termination. Refer to the “Turn Up Network” chapter in the Cisco ONS 15454
Procedure Guide for procedures.

Step 11

Verify that both ends of the DCC have been recreated at the optical ports.

Step 12

If the alarm has not cleared, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or log into http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to
obtain a directory of toll-free Technical Support numbers for your country. If the Technical Support
technician tells you to reseat the card, complete the “Remove and Reinsert (Reseat) Any Card” procedure
on page 2-240. If the Technical Support technician tells you to remove the card and reinstall a new one,
follow the “Physically Replace a Card” procedure on page 2-240.
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2.5.252 RS-TIM
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: STMN
The Regenerator Section TIM alarm occurs when the expected J0 path trace string does not match the
received string.
If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed or
someone entered a new incorrect value into the Current Transmit String field. Follow the procedure
below to clear either instance.

Clear the RS-TIM Alarm
Step 1

Complete the “Clear the TIM Alarm” procedure on page 2-219 for the J0 byte.

Step 2

If the alarm does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country in order to report a Service-Affecting (SA) problem.

2.5.253 SD (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
A Signal Degrade (SD) condition on the trunk occurs when the quality of an optical signal to the
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, TXPP_MR_2.5G, GE-XP, 10GE-XP, and ADM-10G card has BER on the incoming
optical line that passes the signal degrade threshold. The alarm applies to the card ports and the trunk
carrying optical or electrical signals to the card.
Signal degrade is defined by Telcordia as a soft failure condition. SD and SF both monitor the incoming
BER and are similar, but SD is triggered at a lower BER than SF. The BER threshold on the ONS system
is user-provisionable and has a range for SD from 1E–9 dBm to 1E–5 dBm.

Note

For more information about MXP and TXP cards and their thresholds, refer to the “Card Reference”
chapter and the “Hardware Specifications” appendix respectively in the Cisco ONS 15454 DWDM
Reference Manual.

Clear the SD (TRUNK) Condition
Step 1

Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.
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Step 2

If the BER threshold is correct and at the expected level, use an optical test set to measure the power
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment,
consult the manufacturer.

Step 3

If the optical power level is good, verify that optical receive levels are within the acceptable range.

Step 4

If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Step 5

If the condition does not clear, verify that single-mode fiber is used.

Step 6

If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.

Step 7

Clean the fiber connectors at both ends for a signal degrade according to site practice.

Step 8

Verify that a single-mode laser is used at the far end.

Step 9

If the problem does not clear, the transmitter at the other end of the optical line could be failing and
require replacement. Refer to the “2.8.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-238.

Step 10

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.254 SD-L
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STMN
An SD Line condition is similar to the “SD (TRUNK)” condition, page 2-197. It applies to the line level
of the SONET signal and travels on the B2 byte of the SONET overhead.
An SD-L on an Ethernet or OC-N card does not cause a protection switch. If the alarm is reported on a
card that has also undergone a protection switch, the SD BER count continues to accumulate. The
condition is superseded by higher-priority alarms such as the LOF and LOS alarms.

Note

For more information about Ethernet cards, refer to the Ethernet Card Software Feature and
Configuration Guide for the Cisco ONS 15454, Cisco ONS 15454 SDH, and Cisco ONS 15327.

Clear the SD-L Condition
Step 1

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-197.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.255 SD-L (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
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A Signal Degrade (SD) condition on the trunk occurs when the quality of an optical signal to the
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, TXPP_MR_2.5G, GE-XP, 10GE-XP, and ADM-10G card has bit error rate (BER) on
the incoming optical line that passes the signal degrade threshold. The alarm applies to the card ports
and the trunk carrying optical or electrical signals to the card.

Clear the SD-L (TRUNK) Condition
Step 1

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-197.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.256 SD-P
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM
An SD Path condition is similar to the “SD (TRUNK)” condition, page 2-197, but it applies to the path
(STS) layer of the SONET overhead. A path or STS-level SD alarm travels on the B3 byte of the SONET
overhead.
For path protection protected circuits, the BER threshold is user-provisionable and has a range for SD
from 1E–9 dBm to 1E–5 dBm. For BLSR 1+1 and unprotected circuits, the BER threshold value is not
user-provisionable and the error rate is hard-coded to 1E–6 dBm.
On path protection configurations, an SD-P condition causes a switch from the working card to the
protect card at the path (STS) level. On BLSR, 1+1, and on unprotected circuits, an SD-P condition does
not cause switching.
The BER increase that causes the condition is sometimes caused by a physical fiber problem such as a
poor fiber connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.
The SD clears when the BER level falls to one-tenth of the threshold level that triggered the alarm.

Clear the SD-P Condition
Step 1

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-197.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.257 SDBER-EXCEED-HO
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: VCMON-HP, VCTRM-HP
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The Signal Degrade Threshold Exceeded for High Order condition indicates that the signal degrade BER
threshold has been exceeded for a high-order (VC-4) path on optical (traffic) cards.
SDBER-EXCEED-HO occurs when the signal BER falls within the degrade threshold (typically
1E-7 dBm) set on the node.

Warning

Class 1 laser product. Statement 1008

Warning

Class 1M laser radiation when open. Do not view directly with optical instruments. Statement 1053

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Clear the SDBER-EXCEED-HO Condition
Step 1

Determine the BER threshold. Complete the “Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G
Card Loopback Circuit” procedure on page 2-242.

Step 2

If adjustment is acceptable in site practices, adjust the threshold.
Using an optical test set, measure the input power level of the line and ensure that the level is within the
guidelines. For specific procedures to use the test set equipment, consult the manufacturer.

Step 3

Verify the input fiber cable connections to the reporting card.

Step 4

Clean the input fiber cable ends according to site practice. If no site practice exists, complete the
procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure Guide.
If the condition does not clear, log into the Cisco Technical Support Website at
http://www.cisco.com/techsupport for more information or log into
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of toll-free
Technical Support numbers for your country. If the condition applies to VCMON-HP, it is
Service-Affecting (SA).

2.5.258 SF (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
A Signal Fail (SF) condition for the trunk occurs when the quality of an optical signal to the
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, TXPP_MR_2.5G, GE-XP, 10GE-XP, or ADM-10G card has BER on the incoming
optical line that passes the signal fail threshold. The alarm applies to the card ports and the trunk carrying
optical or electrical signals to the card.
Signal fail is defined by Telcordia as a hard failure condition. SF monitors the incoming BER and is
triggered when the BER surpasses the default range.
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Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Note

For more information about MXP and TXP cards and their thresholds, refer to the “Card Reference”
chapter and the “Hardware Specifications” appendix respectively in the Cisco ONS 15454 DWDM
Reference Manual.

Clear the SF (TRUNK) Condition
Step 1

Caution

Step 2

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-197.

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.259 SF-L
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT
An SF Line condition is similar to the “SD (TRUNK)” condition, page 2-197, but it applies to the line
layer B2 overhead byte of the SONET signal. It can trigger a protection switch.
The SF-L condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.
The condition is superseded by higher-priority alarms such as the LOF and LOS alarms.

Clear the SF-L Condition
Step 1

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-197.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.260 SF-L (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
A Signal Fail (SF) condition is raised on the trunk when the quality of an incoming optical signal to the
MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, TXPP_MR_2.5G, or ADM-10G card has high BER due to bent or degraded fiber
connected to the trunk, on the incoming optical line that passes the signal fail threshold. The alarm
applies to the card ports and the trunk carrying optical or electrical signals to the card.
The SF-L condition monitors the incoming BER and is triggered when the BER surpasses the default
range.

Clear the SF-L (TRUNK) Condition
Step 1

Caution

Step 2

Complete the “Clear the SD (TRUNK) Condition” procedure on page 2-197.

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly. For
detailed instructions on how to wear the ESD wristband, refer to the Cisco ONS Electrostatic Discharge
and Grounding Guide.
If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.261 SF-P
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: STSMON, STSTRM
An SF Path condition is similar to the “SF (TRUNK)” condition, page 2-200, but it applies to the path
(STS) layer B3 byte of the SONET overhead. It can trigger a protection switch.
The SF-P condition clears when the BER level falls to one-tenth of the threshold level that triggered the
condition. A BER increase is sometimes caused by a physical fiber problem, including a poor fiber
connection, a bend in the fiber that exceeds the permitted bend radius, or a bad fiber splice.

Clear the SF-P Condition
Step 1

Complete the “Clear the SF (TRUNK) Condition” procedure on page 2-201.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).
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2.5.262 SFTWDOWN
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: EQPT
A Software Download in Progress alarm occurs when the TCC2/TCC2P card is downloading or
transferring software.
If the active and standby TCC2/TCC2P cards have the same versions of software, it takes approximately
three minutes for software to be updated on a standby TCC2/TCC2P card.
If the active and standby TCC2/TCC2P cards have different software versions, the transfer can take up
to 30 minutes. Software transfers occur when different software versions exist on the two cards. After
the transfer completes, the active TCC2/TCC2P card reboots and goes into standby mode after
approximately three minutes.
No action is necessary. Wait for the transfer or the software download to complete. If the alarm does not
clear, log into the Technical Support Website at http://www.cisco.com/techsupport for more information
or call Cisco TAC (1-800-553-2447).

Note

SFTWDOWN is an informational alarm.

2.5.263 SHELF-COMM-FAIL
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: SHELF
The Shelf Communication Failure alarm applies to optical equipment when an NC shelf is unable to
communicate with an SS shelf. Typically this occurs when there is a fiber disconnection. But the alarm
can also occur if an SS shelf is resetting.

Clear the SHELF-COMM-FAIL Alarm
Step 1

Determine whether an SS shelf controller is being reset. If it is being reset, you must wait for the shelf
to reset for this alarm to clear.

Step 2

If the alarm does not clear or if no shelf is being reset, check the cabling between the TCC2/TCC2P and
the MS-ISC card. Correct it if necessary.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) to report a Service-Affecting (SA) problem.

2.5.264 SH-IL-VAR-DEG-HIGH
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OTS
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The Switch Insertion Loss Variation Degrade High alarm occurs as the OSC-CSM card optical switch
ages and slowly increases its insertion loss. This alarm indicates that the insertion loss has crossed the
high degrade threshold. The card must eventually be replaced.

Note

For more information about insertion loss, refer to the APC section of the “Network Reference” chapter
of the Cisco ONS 15454 DWDM Reference Manual.

Clear the SH-IL-VAR-DEG-HIGH Alarm
Step 1

For the alarmed card, complete the “Physically Replace a Card” procedure on page 2-240 as appropriate.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.265 SH-IL-VAR-DEG-LOW
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OTS
The Switch Insertion Loss Variation Degrade Low alarm occurs as the OSC-CSM card optical switch
ages and slowly decreases its insertion loss. This alarm indicates that the insertion loss has crossed the
low degrade threshold. The card must eventually be replaced.

Note

For more information about insertion loss, refer to the APC section in the “Network Reference” chapter
of the Cisco ONS 15454 DWDM Reference Manual.

Clear the SH-IL-VAR-DEG-LOW Alarm
Step 1

For the alarmed card, complete the “Physically Replace a Card” procedure on page 2-240 as appropriate.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.266 SHUTTER-OPEN
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: OTS
The SHUTTER-OPEN condition occurs if an OSC-CSM card laser shutter remains open after the “LOS
(OTS)” alarm on page 2-135 is detected. A laser shutter remains open if an optical safety issue is present
and closes when the OSC-CSM card LINE-RX port receives OSC power for three consecutive seconds.
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Clear the SHUTTER-OPEN Condition
Step 1

Complete the “Clear the LOS (OTS) Alarm” procedure on page 2-135.

Step 2

If the SHUTTER-OPEN condition still does not clear, it indicates that the unit shutter is not working
properly. Complete the “Physically Replace a Card” procedure on page 2-240.

Step 3

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.267 SIGLOSS
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Objects: FC, GE, ISC, TRUNK
The Signal Loss on Data Interface alarm is raised on XP and MXP cards FC and ISC client data ports
when there is a loss of signal. (Loss of Gigabit Ethernet client signal results in a CARLOSS [GE], not
SIGLOSS.) SIGLOSS can also be raised on the XP and MXP trunk port.
If the SYNCLOSS alarm was previously raised on the port, the SIGLOSS alarm will demote it.

Clear the SIGLOSS Alarm
Step 1

Ensure that the port connection at the near end of the SONET or SDH (ETSI) link is operational.

Step 2

Verify fiber continuity to the port. To verify fiber continuity, follow site practices.

Step 3

Check the physical port LED on the card. The port LED looks clear (that is, not lit green) if the link is
not connected.

Step 4

If the alarm does not clear, log onto http://www.cisco.com/techsupport for more information or call
Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA) problem.

2.5.268 SNTP-HOST
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: NE
The Simple Network Timing Protocol (SNTP) Host Failure alarm indicates that an ONS system serving
as an IP proxy for the other ONS system nodes in the ring is not forwarding SNTP information to the
other nodes in the network. The forwarding failure can result from two causes: either the IP network
attached to the ONS system proxy node is experiencing problems, or the ONS system proxy node itself
is not functioning properly.
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Clear the SNTP-HOST Alarm
Step 1

Ping the SNTP host from a workstation in the same subnet to ensure that communication is possible
within the subnet by completing the “1.6.8 Verify PC Connection to the ONS 15454 (ping)” procedure
on page 1-40.

Step 2

If the ping fails, contact the network administrator who manages the IP network that supplies the SNTP
information to the proxy and determine whether the network is experiencing problems, which could
affect the SNTP server/router connecting to the proxy ONS system.

Step 3

If no network problems exist, ensure that the ONS system proxy is provisioned correctly:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), for the ONS system serving as the
proxy, click the Provisioning > General > General tabs.

b.

Ensure that the Use NTP/SNTP Server check box is checked.

c.

If the Use NTP/SNTP Server check box is not checked, click it.

d.

Ensure that the Use NTP/SNTP Server field contains a valid IP address for the server.

Step 4

If proxy is correctly provisioned, refer to the “Timing” chapter in the Cisco ONS 15454 Reference
Manual for more information on SNTP Host.

Step 5

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.269 SPANLEN-OUT-OF-RANGE
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OTS
The SPANLEN-OUT-OF-RANGE alarm is raised when span loss measured by CTC is higher than the
maximum expected span loss (or lower than the minimum expected span loss).
The TCC2/TCC2P automatically measures span loss every hour, or it calculates it when you perform the
“Calculate Span Loss” operation. (For procedures to perform this operation, refer to the “Manage the
Node” chapter in the Cisco ONS 15454 DWDM Procedure Guide.)
To create its span calculation, CTC compares far-end POSC power with the near-end OSC power to
create the span length measurement. The loss is recalculated in each MSTP node, since the OSC channel
is regenerated in each MSTP node.

Clear the SPANLEN-OUT-OF-RANGE Alarm
Step 1

Determine the maximum and minimum expected span loss values provided by Cisco TransportPlanner
and confirm that they are correctly entered in CTC.

Step 2

Determine whether the measured span length falls between these two values.

Note

Cisco TransportPlanner determines the span length range according to span length and allocated
margins. If this value is set to zero in CTC, the SPANLEN-OUT-OF-RANGE alarm is never
raised.
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Step 3

If the value falls outside this range, check the following factors in the fibering:
•

Clearance

•

Integrity

•

Connection

Step 4

Determine whether any site variations are present which conflict with the Cisco TransportPlanner design
and correct them.

Step 5

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.270 SPAN-NOT-MEASURED
SPAN-NOT-MEASURED is a transient condition. For more information about it, refer to Chapter 3,
“Transient Conditions.”

2.5.271 SQUELCHED
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC, OCN/STMN, TRUNK
The Client Signal Squelched condition is raised by a TXP_MR_10G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10G, MXP_2.5G_10E,
MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_MR_2.5G, MXPP_MR_2.5G, GE-XP, 10GE-XP, and
ADM-10G card.
The condition can be raised in the following situations:
•

An MXP or TXP client facility detects that an upstream receive facility has experienced a loss of
signal (such as an Ethernet CARLOSS, DWDM SIGLOSS, or optical LOS). In response, the
facility’s transmit is turned off (SQUELCHED). The upstream receive facilities are the trunk receive
on the same card as the client, as well as the client receive on the card at the other end of the trunk
span.

•

The client will squelch if the upstream trunk receive (on the same card) experiences a SIGLOSS,
Ethernet CARLOSS, LOS, or LOS (TRUNK) alarm. In some transparent modes, the client is
squelched if the trunk detects an AIS condition or a TIM alarm.

•

The client will squelch if the upstream client receive (on the card at the other end of the DWDM
span) experiences CARLOSS, SIGLOSS, or LOS.

In an example situation, an upstream MXP_2.5G_10G client port receive experiences a “loss of light,”
and this port raises CARLOSS, SIGLOSS, or LOS (determined by the payload type) locally.
The local client raises SQUELCHED if it also raises one of the following alarms for the client, all of
which are signalled by the upstream node:
•

2.5.210 ODUK-1-AIS-PM, page 2-165

•

2.5.211 ODUK-2-AIS-PM, page 2-166

•

2.5.212 ODUK-3-AIS-PM, page 2-166

•

2.5.213 ODUK-4-AIS-PM, page 2-166
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On the MXP_MR_10G, the local client raises a SQUELCHED condition if the upstream client detects
one of the following alarms. Note that no corresponding local alarm is raised to indicate which of these
conditions is present upstream.
•

LOS for the clients including the “LOS (2R)” alarm on page 2-132, the “LOS (ESCON)” alarm on
page 2-133, and the “LOS (ISC)” alarm on page 2-134

•

CARLOSS for the clients including the “CARLOSS (FC)” alarm on page 2-52, the “CARLOSS
(GE)” alarm on page 2-52, and the “CARLOSS (ISC)” alarm on page 2-53

The local client raises a SQUELCHED condition if the local trunk raises one of the following alarms:
•

2.5.231 OTUK-LOF, page 2-179

•

2.5.228 OTUK-AIS, page 2-177

•

2.5.166 LOS (TRUNK), page 2-135

•

2.5.234 OTUK-TIM, page 2-182 (squelching enabled)

•

2.5.214 ODUK-AIS-PM, page 2-167

•

2.5.216 ODUK-LCK-PM, page 2-168

•

2.5.220 ODUK-TIM-PM, page 2-170 (squelching enabled)

•

2.5.297 TIM, page 2-218 (for the OCN/STMN, squelching enabled)

•

LOF (OCN/STMN) alarm in the “Alarm Troubleshooting” chapter of the Cisco ONS 15454
Troubleshooting Guide or Cisco ONS 15454SDH Troubleshooting Guide

•

LOS (OCN/STMN) alarm the “Alarm Troubleshooting” chapter of the Cisco ONS 15454
Troubleshooting Guide or Cisco ONS 15454SDH Troubleshooting Guide

•

2.5.48 CARLOSS (TRUNK), page 2-54

•

2.5.317 WVL-MISMATCH, page 2-229 (client or trunk)

When troubleshooting the SQUELCHED condition locally, look for failures progressing upstream in the
following order. (If you are troubleshooting this alarm remotely, reverse the order of progress.)

Note

•

Local client alarms, as previously listed

•

Local trunk alarms, as previously listed

•

Remote (upstream) client receive alarms, as previously listed

If you see a SQUELCHED condition on the trunk, this can only be caused by a transponder (TXP) card.

Clear the SQUELCHED Condition
Step 1

If the object is reported against any object besides ESCON, determine whether the remote node and local
node reports and LOF or the LOS alarm (for the client trunk, as listed here). If it does, turn to the relevant
section in this chapter and complete the troubleshooting procedure.

Step 2

If no LOF or LOS is reported, determine whether any other listed remote node or local node conditions
as listed here have occurred. If so, turn to the relevant section of this chapter and complete the
troubleshooting procedure.
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Step 3

Step 4

If none of these alarms is reported, determine whether the local port reporting the SQUELCHED
condition is in loopback. (You will see LPBKFACILITY OR LPBKTERMINAL in the condition window
for this port.) If it is in loopback, complete the following steps:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the client card to open
the card view.

b.

Click the Maintenance > Loopback > Port tabs.

c.

If the port Admin State column says OOS,MT (or Locked,maintenance) or OOS,DSBLD (or
Locked,disabled), click the cell to highlight it and choose IS , or Unlocked, from the drop-down list.
Changing the state to IS (or Unlocked) also clears any loopback provisioned on the port.

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.272 SSM-DUS
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The Synchronization Status (SSM) Message Quality Changed to Do Not Use (DUS) condition occurs on
ADM-10G and MXP trunk ports when the synchronization status message (SSM) quality level degrades
to DUS or is manually changed to DUS.
The signal is often manually changed to DUS to prevent timing loops from occurring. Sending a DUS
prevents the timing from being reused in a loop. The DUS signal can also be sent for line maintenance
testing.

Note

SSM-DUS is an informational condition and does not require troubleshooting.

2.5.273 SSM-FAIL
Single Failure Default Se verity: Minor (MN), Non-Service-Affecting (NSA); Double Failure
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK
The SSM Failed alarm occurs on ADM-10G and MXP trunk ports when the synchronization status
messaging received by the system fails. The problem is external to the ONS system. This alarm indicates
that although the ONS system is set up to receive SSM, the timing source is not delivering valid SSM
messages.

Clear the SSM-FAIL Alarm
Step 1

Verify that SSM is enabled on the external timing source.

Step 2

If timing is enabled, use an optical test set to determine that the external timing source is delivering SSM.
For specific procedures to use the test set equipment, consult the manufacturer.
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Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.274 SSM-LNC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM Local Node Clock (LNC) Traceable condition occurs on ADM-10G and MXP trunk ports when
the SSM (S1) byte of the SONET overhead multiplexing section has been changed to signify that the line
or BITS timing source is the LNC.

Note

SSM-LNC is an informational condition and does not require troubleshooting.

2.5.275 SSM-OFF
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM Off condition applies to references used for timing related to the ADM-10G and MXP trunk
ports. It occurs when the SSM for the reference has been turned off. The node is set up to receive SSM,
but the timing source is not delivering SSM messages.

Clear the SSM-OFF Condition
Step 1

Complete the “Clear the SSM-FAIL Alarm” procedure on page 2-209.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.276 SSM-PRC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM Primary Reference Clock (PRC) Traceable condition occurs when the SONET transmission
level for ADM-10G and MXP trunk ports is PRC.

Note

SSM-PRC is an informational condition and does not require troubleshooting.
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2.5.277 SSM-PRS
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM Primary Reference Source (PRS) Traceable condition occurs when the SSM transmission level
for ADM-10G and MXP trunk ports is Stratum 1 Traceable.

Note

SSM-PRS is an informational condition and does not require troubleshooting.

2.5.278 SSM-RES
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM Reserved (RES) For Network Synchronization Use condition occurs when the synchronization
message quality level for ADM-10G and MXP trunk ports is RES.

Note

SSM-RES is an informational condition and does not require troubleshooting.

2.5.279 SSM-SMC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM SONET Minimum Clock (SMC) Traceable condition occurs when the synchronization
message quality level for ADM-10G and MXP trunk ports is SMC. The login node does not use the clock
because the node cannot use any reference beneath its internal level, which is ST3.

Note

SSM-SMC is an informational condition and does not require troubleshooting.

2.5.280 SSM-ST2
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM Stratum 2 (ST2) Traceable condition occurs when the synchronization message quality level
for ADM-10G and MXP trunk ports is ST2.

Note

SSM-ST2 is an informational condition and does not require troubleshooting.
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2.5.281 SSM-ST3
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM Stratum 3 (ST3) Traceable condition occurs when the synchronization message quality level
for ADM-10G and MXP trunk ports is ST3.

Note

SSM-ST3 is an informational condition and does not require troubleshooting.

2.5.282 SSM-ST3E
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM Stratum 3E (ST3E) Traceable condition indicates that the synchronization message quality
level for ADM-10G and MXP trunk ports is ST3E. SSM-ST3E is a Generation 2 SSM and is used for
Generation 1.

Note

SSM-ST3E is an informational condition and does not require troubleshooting.

2.5.283 SSM-ST4
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM Stratum 4 (ST4) Traceable condition occurs when the synchronization message quality level
is ST4 for ADM-10G and MXP trunk ports. The message quality is not used because it is below ST3.

Note

SSM-ST4 is an informational condition and does not require troubleshooting.

2.5.284 SSM-STU
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM Synchronization Traceability Unknown (STU) condition occurs when the reporting node is
timed to a reference that does not support SSM, but the ONS system has SSM support enabled (for the
ADM-10G and MXP trunk ports). SSM-STU can also occur if the timing source is sending out SSM
messages but SSM is not enabled on the ONS system.
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Clear the SSM-STU Condition
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing > BITS
Facilities tabs.

Step 2

Complete one of the following depending upon the status of the Sync Messaging Enabled check box:
•

If the Sync. Messaging Enabled check box for the BITS source is checked, uncheck the box.

•

If the Sync. Messaging Enabled check box for the BITS source is not checked, check the box.

Step 3

Click Apply.

Step 4

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.285 SSM-TNC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The SSM Transit Node Clock (TNC) Traceable condition occurs when the synchronization message
quality level is TNC for ADM-10G and MXP trunk ports.

Note

SSM-TNC is an informational condition and does not require troubleshooting.

2.5.286 SW-MISMATCH
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: EQPT
The Software Mismatch condition occurs during software upgrade when there is a mismatch between
software versions. The card connecting to the TCC2/TCC2P card is running an older version than the
TCC2/TCC2P card is.

Clear the SW-MISMATCH Condition
Step 1

Complete the “Reset a Card in CTC” procedure on page 2-237 for the errored card.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.287 SWTOPRI
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF
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The Synchronization Switch to Primary Reference condition occurs when the ONS system switches to
the primary timing source (reference 1). The ONS system uses three ranked timing references. The
timing references are typically two BITS-level or line-level sources and an internal reference.

Note

SWTOPRI is an informational condition and does not require troubleshooting.

2.5.288 SWTOSEC
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF
The Synchronization Switch to Secondary Reference condition occurs when the ONS system has
switched to a secondary timing source (reference 2).

Clear the SWTOSEC Condition
Step 1

To clear the condition, clear alarms related to failures of the primary source, such as the “SYNCPRI”
alarm on page 2-216.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.289 SWTOTHIRD
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF
The Synchronization Switch to Third Reference condition occurs when the ONS system has switched to
a third timing source (reference 3).

Clear the SWTOTHIRD Condition
Step 1

To clear the condition, clear alarms related to failures of the primary source, such as the “SYNCPRI”
alarm on page 2-216 or the “SYNCSEC” alarm on page 2-216.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.290 SYNC-FREQ
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
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The Synchronization Reference Frequency Out of Bounds condition is reported against any reference
that is out of the bounds for valid references. The login node fails the reference and chooses another
internal or external reference to use.

Clear the SYNC-FREQ Condition
Step 1

Use an optical test set to verify the timing frequency of the line or BITS timing source and ensure that
it falls within the proper frequency. For specific procedures to use the test set equipment, consult the
manufacturer.
For BITS, the proper timing frequency range is approximately –15 PPM to 15 PPM. For optical line
timing, the proper frequency range is approximately –16 PPM to 16 PPM.

Step 2

If the reference source frequency is not outside of bounds, complete the “Physically Replace a Card”
procedure on page 2-240 for the TCC2/TCC2P card.

It takes up to 30 minutes for the TCC2/TCC2P card to transfer the system software to the newly
installed TCC2/TCC2P card. Software transfer occurs in instances where different software
versions exist on the two cards. When the transfer completes, the active TCC2/TCC2P card
reboots and goes into standby mode after approximately three minutes.

Note

Step 3

If the SYNC-FREQ condition continues to report after replacing the TCC2/TCC2P card, log into the
Technical Support Website at http://www.cisco.com/techsupport for more information or call Cisco TAC
(1-800-553-2447).

2.5.291 SYNCLOSS
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Objects: FC, GE, ISC, TRUNK, EQPT
The Loss of Synchronization on Data Interface alarm is raised on MXP card client and trunk ports when
there is a loss of signal synchronization on the port. This alarm is demoted by the SIGLOSS alarm.

Clear the SYNCLOSS Alarm
Step 1

Ensure that the data port connection at the near end of the SONET or SDH (ETSI) link is operational.

Step 2

Verify fiber continuity to the port. To do this, follow site practices.

Step 3

View the physical port LED to determine whether the alarm has cleared.

Step 4

•

If the LED is green, the alarm has cleared.

•

If the port LED is clear (that is, not lit green), the link is not connected and the alarm has not cleared.

•

If the LED is red, this indicates that the fiber is pulled.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) to report a service-affecting problem.
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2.5.292 SYNCPRI
Default Severity:
Minor (MN), Non-Service-Affecting (NSA) for EXT-SREF; Major (MJ), Service-Affecting (SA)
for NE-SREF (For SONET)
Minor (MN), Non-Service-Affecting (NSA) for EXT-SREF; Major (MJ), Non-Service-Affecting
(NSA) for NE-SREF (For SDH)
Logical Objects: EXT-SREF, NE-SREF
A Loss of Timing on Primary Reference alarm occurs when the ONS system loses the primary timing
source (reference 1). The ONS system uses three ranked timing references. The timing references are
typically two BITS-level or line-level sources and an internal reference. If SYNCPRI occurs, the ONS
system should switch to its secondary timing source (reference 2). Switching to the secondary timing
source also triggers the “SWTOSEC” alarm, page 2-214.

Clear the SYNCPRI Alarm
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing >
General tabs.

Step 2

Verify the current configuration for REF-1 of the NE Reference.

Step 3

If the primary timing reference is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure
on page 2-133.

Step 4

If the primary reference clock is an incoming port on the ONS system, complete the “Clear the LOS
(OCN/STMN) Alarm” procedure located in the “Alarm Troubleshooting” chapter of the
Cisco ONS 15454 Troubleshooting Guide or Cisco ONS 15454SDH Troubleshooting Guide.

Step 5

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.293 SYNCSEC
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF
A Loss of Timing on Secondary Reference alarm occurs when the ONS system loses the secondary
timing source (reference 2). If SYNCSEC occurs, the ONS system should switch to a third timing source
(reference 3) to obtain valid timing for the ONS system. Switching to a third timing source also triggers
the “SWTOTHIRD” alarm, page 2-214.

Clear the SYNCSEC Alarm
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing >
General tabs.

Step 2

Verify the current configuration of REF-2 for the NE Reference.
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Step 3

If the secondary reference is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure on
page 2-133.

Step 4

Verify that the BITS clock is operating properly.

Step 5

If the secondary timing source is an incoming port on the ONS system, complete the “Clear the LOS
(OCN/STMN) Alarm” procedure located in the “Alarm Troubleshooting” chapter of the
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454SDH Troubleshooting Guide.

Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.294 SYNCTHIRD
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: EXT-SREF, NE-SREF
A Loss of Timing on Third Reference alarm occurs when the ONS system loses the third timing source
(reference 3). If SYNCTHIRD occurs and the ONS system uses an internal reference for source three,
the TCC2/TCC2P card could have failed. The ONS system often reports either the “FRNGSYNC”
condition on page 2-87 or the “HLDOVRSYNC” condition on page 2-101 after a SYNCTHIRD alarm.

Clear the SYNCTHIRD Alarm
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Provisioning > Timing >
General tabs.

Step 2

Verify that the current configuration of REF-3 for the NE Reference. For more information about
references, refer to the “Timing” chapter in the Cisco ONS 15454 Reference Manual.

Step 3

If the third timing source is a BITS input, complete the “Clear the LOS (BITS) Alarm” procedure on
page 2-133.

Step 4

If the third timing source is an incoming port on the ONS system, complete the “Clear the LOS
(OCN/STMN) Alarm” procedure located in the “Alarm Troubleshooting” chapter of the
Cisco ONS 15454 Troubleshooting Guide or the Cisco ONS 15454SDH Troubleshooting Guide.

Caution

Step 5

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
If the third timing source uses the internal ONS system timing, complete the “Reset an Active
TCC2/TCC2P Card and Activate the Standby Card” procedure on page 2-238.
Wait ten minutes to verify that the card you reset completely reboots and becomes the standby card.

Step 6

If the reset card has not rebooted successfully, or the alarm has not cleared, call Cisco TAC
(1-800-553-2447). If the Cisco TAC technician tells you to reseat the card, complete the “Remove and
Reinsert (Reseat) the Standby TCC2/TCC2P Card” procedure on page 2-239. If the Cisco TAC
technician tells you to remove the card and reinstall a new one, follow the “Physically Replace a Card”
procedure on page 2-240.
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2.5.295 SYSBOOT
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: NE
The System Reboot alarm indicates that new software is booting on the TCC2/TCC2P card. No action
is required. The alarm clears when all cards finish rebooting the new software. The reboot takes up to
30 minutes.
If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

Note

SYSBOOT is an informational alarm. It only requires troubleshooting if it does not clear.

2.5.296 TEMP-MISM
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: NE
Temperature Reading Mismatch Between Control Cards is raised when the temperature readings on the
two TCC2/TCC2P cards are out of range of each other by more than some predefined difference (such
as 5 degrees C). A message containing power monitoring and temperature information is exchanged
between the two TCC2/TCC2P cards, allowing the values to be compared. The temperature of each
TCC2/TCC2P card is read from a system variable.
This condition can be caused by a clogged fan filter or by fan tray stoppage.

Clear the TEMP-MISM Condition
Step 1

Complete the “Inspect, Clean, and Replace the Reusable Air Filter” procedure on page 2-243.

Step 2

If the condition does not clear, complete the “Remove and Reinsert a Fan-Tray Assembly” procedure on
page 2-245.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.297 TIM
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: TRUNK
The Section TIM alarm occurs when the expected J0 section trace string does not match the received
section trace string. This occurs because the data being received is not correct, and the receiving port
could not be connected to the correct transmitter port.
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If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed due to
a fibering misconnection, a TL1 routing change, or to someone entering an incorrect value in the Current
Transmit String field.
TIM occurs on a port that has previously been operating without alarms if someone switches optical
fibers that connect the ports. TIM is usually accompanied by other alarms, such as the LOS
(OCN/STMN) or UNEQ-P (or HP-UNEQ) alarms. (For instructions to clear these alarms, refer to the
“Alarm Troubleshooting” chapter of the Cisco ONS 15454 Troubleshooting Guide and the
Cisco ONS 15454SDH Troubleshooting Guide.) If these alarms accompany a TIM alarm, reattach or
replace the original cables/fibers to clear the alarms. If a Transmit or Expected String was changed,
restore the original string.

Clear the TIM Alarm
Step 1

Ensure that the physical fibers are correctly configured and attached. To do this, consult site documents.
For more information about cabling an ONS system DWDM node, refer to the “Turn Up a Node” chapter
in the Cisco ONS 15454 DWDM Procedure Guide.

Step 2

If the alarm does not clear, you can compare the J0 expected and transmitted strings and, if necessary,
change them:
a.

Log into the circuit source node and click the Circuits tab.

b.

Select the circuit reporting the condition, then click Edit.

c.

In the Edit Circuit window, check the Show Detailed Circuit Map check box and click Apply.

d.

On the detailed circuit map, right-click the source circuit port and choose Edit J0 Path Trace (port)
from the shortcut menu.

e.

Compare the Current Transmit String and the Current Expected String entries in the Edit J0 Path
Trace dialog box.

f.

If the strings differ, correct the Transmit or Expected strings and click Apply.

g.

Click Close.

Step 3

If the alarm does not clear, ensure that the signal has not been incorrectly routed. (Although the ONS
system routes circuits automatically, the circuit route could have been changed using TL1.) If necessary,
manually correct the routing using TL1. For instructions, refer to the Cisco ONS SONET TL1 Reference
Guide and the Cisco ONS SONET TL1 Command Guide.

Step 4

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem if necessary.

2.5.298 TIM-MON
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: TRUNK

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5
78-18342-02

2-219

Chapter 2

Alarm Troubleshooting

Trouble-Clearing Procedures

The TIM Section Monitor TIM alarm is similar to the “TIM” alarm on page 2-218, but it applies to
TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C,
TXP_MR_10E_L, and MXP_2.5G_10G cards when they are configured in transparent mode. (In
transparent termination mode, all SONET overhead bytes are passed through from client ports to the
trunk ports or from trunk ports to client ports.)

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the TIM-MON Alarm
Step 1

Complete the “Clear the TIM Alarm” procedure on page 2-219.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.299 TIM-P
Default Severity: Critical (CR), Service-Affecting (SA) for STSTRM; Default Severity:
Minor (MN), Non-Service-Affecting (NSA) for STSMON
Logical Object: STSMON, STSTRM
The TIM Path alarm occurs when the expected path trace string does not match the received path trace
string. Path Trace Mode must be set to Manual or Auto for the TIM-P alarm to occur.
In manual mode at the Path Trace window, the user types the expected string into the Current Expected
String field for the receiving port. The string must match the string typed into the Transmit String field
for the sending port. If these fields do not match, the login node raises the TIM-P alarm. In Auto mode
on the receiving port, the card sets the expected string to the value of the received string. If the alarm
occurs on a port that has been operating with no alarms, the circuit path has changed or someone entered
a new incorrect value into the Current Transmit String field. Complete the following procedure to clear
either instance.

Clear the TIM-P Alarm
Step 1

Complete the “Clear the TIM Alarm” procedure on page 2-219. (The option will say “Edit J1 Path Trace”
rather than “Edit J0 Path Trace.”)

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447). If the alarm applies to the STSTRM object,
it is Service-Affecting (SA).
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2.5.300 TIM-S
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: OCN
The TIM for Section Overhead alarm occurs when there is a mismatch between the expected and
received J0 section overhead strings in either Manual or Auto mode.
In manual mode at the DS3/EC1-48 card Section Trace window, the user enters the expected string into
the Current Expected String field for the receiving port. The string must match the string typed into the
Transmit String field for the sending port. If these fields do not match, the login node raises the TIM-S
alarm.
In Auto mode on the receiving port, the card sets the expected string to the value of the received string.
If the alarm occurs on a port that has been operating with no alarms, the circuit path has changed or
someone entered a new incorrect value into the Current Transmit String field. Complete the following
procedure to clear either problem.
TIM-S also occurs on a port that has previously been operating without alarms if someone switches the
cables or optical fibers that connect the ports. If TIM-S is enabled on the port, the “AIS-L” alarm on
page 2-27 can be raised downstream and the “RFI-L” alarm on page 2-193 can be raised upstream.

Note

AIS-L and RFI-L are disabled or enabled in the Provisioning > EC1 > Section Trace tab Disable
AIS/RDI on TIM-S? check box.

Clear the TIM-S Alarm
Step 1

Double-click the DS3/EC1-48 card to open the card view.

Step 2

Click the Provisioning > EC1 > Section Trace tabs.

Step 3

Choose the port from the Port pull-down.

Step 4

In the Expected area, enter the correct string into the Current Expected String field.

Step 5

Click Apply.

Step 6

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447). If the alarm applies to the STSTRM object,
it is Service-Affecting (SA).

2.5.301 TRAIL-SIGNAL-FAIL
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: OCH, TRUNK
The Trail Signal Fail condition is raised on a DWDM trunk port or OCH port to correlate with the
“LOS-P (TRUNK)” alarm on page 2-144 when the trunk port’s administrative state is set to
OOS,DSBLD (or Locked,disabled).
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Clear the TRAIL-SIGNAL-FAIL Condition
Step 1

Switch the OCHNC administrative state of the errored OCH or trunk port to IS , or Unlocked.:

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.302 UNC-WORD
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The Uncorrected FEC Word condition indicates that the FEC capability could not sufficiently correct the
frame.

Note

For general information about MXP and TXP cards, refer to the “Card Reference” chapter in the
Cisco ONS 15454 DWDM Reference Manual. For information about provisioning them, refer to the
“Provision Transponder and Muxponder Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Clear the UNC-WORD Condition
Step 1

Ensure that the fiber connector for the card is completely plugged in. For more information about fiber
connections and card insertion, refer to the “Turn Up a Node” chapter in the Cisco ONS 15454 DWDM
Procedure Guide.

Step 2

Ensure that the ports on the far end and near end nodes have the same port rates and FEC settings. For
more information about port rates and FEC settings, refer to the “Provision Transponder and Muxponder
Cards” chapter in the Cisco ONS 15454 DWDM Procedure Guide.

Step 3

If the BER threshold is correct and at the expected level, use an optical test set to measure the power
level of the line to ensure it is within guidelines. For specific procedures to use the test set equipment,
consult the manufacturer.

Step 4

If the optical power level is good, verify that optical receive levels are within the acceptable range.

Step 5

If receive levels are good, clean the fibers at both ends according to site practice. If no site practice exists,
complete the procedure in the “Maintain the Node” chapter in the Cisco ONS 15454 DWDM Procedure
Guide.

Step 6

If the condition does not clear, verify that single-mode fiber is used.

Step 7

If the fiber is of the correct type, verify that a single-mode laser is used at the far-end node.

Step 8

Clean the fiber connectors at both ends for a signal degrade according to site practice.

Step 9

Verify that a single-mode laser is used at the far end.

Step 10

If the problem does not clear, the transmitter at the other end of the optical line could be failing and
require replacement. Refer to the “2.8.4 Physical Card Reseating, Resetting, and Replacement” section
on page 2-238.
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Step 11

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.303 UNEQ-P
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Object: STSMON, STSTRM
An SLMF UNEQ Path alarm occurs when the path does not have a valid sender. The UNEQ-P indicator
is carried in the C2 signal path byte in the SONET overhead. The source of the problem is the node that
is transmitting the signal into the node reporting the UNEQ-P.
The alarm could result from a PARTIAL circuit or an empty VT tunnel. UNEQ-P occurs in the node that
terminates a path.

Note

If a newly created circuit has no signal, a UNEQ-P alarm is reported on the OC-N cards and the AIS-P
condition is reported on the terminating cards. These alarms clear when the circuit carries a signal.

Clear the UNEQ-P Alarm
Step 1

In node view, choose Go to Network View from the View menu.

Step 2

Right-click the alarm to display the Select Affected Circuits shortcut menu.

Step 3

Click Select Affected Circuits.

Step 4

When the affected circuits appear, look in the Type column for VTT, which indicates a VT tunnel circuit.
A VT tunnel with no VTs assigned could be the cause of an UNEQ-P alarm.

Step 5

If the Type column does not contain VTT, there are no VT tunnels connected with the alarm. Go to
Step 7.

Step 6

If the Type column does contain VTT, attempt to delete these rows:

Note

Step 7

The node does not allow you to delete a valid VT tunnel or one with a valid VT circuit inside.

a.

Click the VT tunnel circuit row to highlight it. Complete the “Delete a Circuit” procedure on
page 2-241.

b.

If an error message dialog box appears, the VT tunnel is valid and not the cause of the alarm.

c.

If any other rows contain VTT, repeat Step 6.

If all nodes in the ring appear in the CTC network view, determine whether the circuits are complete:
a.

Click the Circuits tab.

b.

Verify that PARTIAL is not listed in the Status column of any circuits.

Step 8

If you find circuits listed as PARTIAL, use an optical test set to verify that these circuits are not working
circuits that continue to pass traffic. For specific procedures to use the test set equipment, consult the
manufacturer.

Step 9

If the PARTIAL circuits are not needed or are not passing traffic, delete the PARTIAL circuits.
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Complete the “Delete a Circuit” procedure on page 2-241.
Step 10

Recreate the circuit with the correct circuit size. Refer to the “Create Circuits and VT Tunnels” chapter
in the Cisco ONS 15454 Procedure Guide.

Step 11

Log back in and verify that all circuits terminating in the reporting card are active:

Step 12

a.

Click the Circuits tab.

b.

Verify that the Status column lists all circuits as active.

If the alarm does not clear, clean the far-end optical fiber according to site practice. If no site practice
exists, complete the procedure in the “Maintain the Node” chapter of the Cisco ONS 15454 Procedure
Guide.

Warning

On the OC-192 card, the laser is on when the card is booted and the safety key is in the on position
(labeled 1). The port does not have to be in service for the laser to be on. The laser is off when the
safety key is off (labeled 0). Statement 293

Warning

Invisible laser radiation could be emitted from the end of the unterminated fiber cable or connector.
Do not stare into the beam directly with optical instruments. Viewing the laser output with certain
optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance of
100 mm could pose an eye hazard. Statement 1056

Warning

Use of controls, adjustments, or performing procedures other than those specified could result in
hazardous radiation exposure. Statement 1057

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 13

If the alarm does not clear, complete the “Physically Replace a Card” procedure on page 2-240 for the
OC-N and electrical cards.

Step 14

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.304 UNQUAL-PPM
Default Severity: Not Reported (NR), Non-Service-Affecting (NSA)
Logical Objects: PPM
The Unqualified PPM Inserted condition occurs when a PPM with a nonqualified product ID is plugged
into the card’s port; that is, the PPM passes the security code check as a Cisco PPM but is not qualified
for use on the particular card.
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Clear the UNQUAL-PPM Condition
Step 1

Obtain the correct Cisco PPM and replace the existing PPM with the new one.

Step 2

If the condition does not clear, log into the Technical Support Website at
http://www.cisco.com/techsupport for more information or call Cisco TAC (1-800-553-2447).

2.5.305 UNREACHABLE-TARGET-POWER
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Object: OCH
The Unreachable Port Target Power alarm occurs on WSS32 cards during startup as the card laser attains
its correct power level. The condition disappears when the card successfully boots.

Note

Card power levels are listed in the "Hardware Specifications" appendix of the Cisco ONS 15454 DWDM
Reference Manual.

Note

UNREACHABLE-TARGET-POWER is an informational condition. It only requires troubleshooting if
it does not clear.

2.5.306 UT-COMM-FAIL
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK
The Universal Transponder (UT) Module Communication Failure alarm is raised on MXP_2.5G_10E
and TXP_MR_10E cards when there is a universal transponder communication failure because the
universal transponder (UT) has stopped responding to the TCC2/TCC2P card.

Clear the UT-COMM-FAIL Alarm
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card to open the card
view.

Step 2

Request a laser restart:

Step 3

a.

Click the Maintenance > ALS tabs.

b.

Check the Request Laser Restart check box.

c.

Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.
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2.5.307 UT-FAIL
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK
The Universal Transponder Module Hardware Failure alarm is raised against MXP_2.5G_10E and
TXP_MR_10E cards when a UT-COMM-FAIL alarm persists despite being reset.

Clear the UT-FAIL Alarm
Step 1

Complete the “Physically Replace a Card” procedure on page 2-240 for the alarmed card.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.

2.5.308 VOA-HDEG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OMS, OTS
The VOA High Degrade alarm is raised on DWDM cards when an equipped VOA exceeds the setpoint
due to an internal problem. The alarm indicates that the attenuation has crossed the high degrade
threshold. The alarmed card should be replaced at the next opportunity.

Note

For more information about provisioning VOA setpoints, refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual. For general information about DWDM cards, refer to
the “Card Reference” chapter in the same manual.

Clear the VOA-HDEG Alarm
Step 1

Complete the “Physically Replace a Card” procedure on page 2-240 for the alarmed card.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.309 VOA-HFAIL
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AOTS, OCH, OMS, OTS
The VOA High Fail alarm is raised on DWDM cards when an equipped VOA exceeds the setpoint due
to an internal problem. The alarm indicates that the attenuation has crossed the high fail threshold. The
card must be replaced.
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Note

For more information about provisioning VOA setpoints, refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual. For general information about DWDM cards, refer to
the “Card Reference” chapter in the same manual.

Clear the VOA-HFAIL Alarm
Step 1

Complete the “Physically Replace a Card” procedure on page 2-240 for the alarmed card.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.310 VOA-LDEG
Default Severity: Minor (MN), Non-Service-Affecting (NSA)
Logical Objects: AOTS, OCH, OMS, OTS
The VOA Low Degrade alarm is raised on DWDM cards when an equipped VOA does not reach the
setpoint due to an internal problem. The alarm indicates that the attenuation has crossed the low degrade
threshold. The alarmed card should be replaced at the next opportunity.

Note

For more information about provisioning VOA setpoints, refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual. For general information about DWDM cards, refer to
the “Card Reference” chapter in the same manual.

Clear the VOA-LDEG Alarm
Step 1

Complete the “Physically Replace a Card” procedure on page 2-240 for the alarmed card.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.311 VOA-LFAIL
Default Severity: Critical (CR), Service-Affecting (SA)
Logical Objects: AOTS, OCH, OMS, OTS
The VOA Low Fail alarm is raised on DWDM cards when an equipped VOA does not reach the setpoint
due to an internal problem. The alarm indicates that the attenuation has crossed the low fail threshold.
The card must be replaced.
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Note

For more information about provisioning VOA setpoints, refer to the “Network Reference” chapter of
the Cisco ONS 15454 DWDM Reference Manual. For general information about DWDM cards, refer to
the “Card Reference” chapter in the same manual.

Clear the VOA-LFAIL Alarm
Step 1

Complete the “Physically Replace a Card” procedure on page 2-240 for the alarmed card.

Step 2

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a Service-Affecting (SA)
problem.

2.5.312 VOLT-MISM
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: PWR
The Power Monitoring Mismatch Between Control Cards alarm is raised against the shelf when the
power voltages of both TCC2/TCC2P cards are out of range of each other by more than 5 VDC.

Clear the VOLT-MISM Condition
Step 1

Check the incoming voltage level to the shelf using a voltmeter. Follow site practices or refer to the
“Install the Shelf and Common Control Cards” chapter in the Cisco ONS 15454 DWDM Procedure
Guide for power installation procedures.

Step 2

Correct any incoming voltage issues.

Step 3

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447).

2.5.313 WKSWPR (2R, EQPT, ESCON, FC, GE, ISC)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, EQPT, ESCON, FC, GE, ISC
This condition is raised when you use the FORCE SPAN, FORCE RING, or MANUAL SPAN command
at for a Y-Cable-protected MXP or TXP client port (set for one the above-listed client configurations).
WKSWPR is visible on the network view Alarms, Conditions, and History tabs.

Note

For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.
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2.5.314 WKSWPR (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
This condition is raised when you use the FORCE SPAN, FORCE RING, or MANUAL SPAN command
at for a splitter-protection enabled MXP or TXP trunk port. WKSWPR is visible on the network view
Alarms, Conditions, and History tabs.

Note

For more information about protection schemes, refer to the “Manage the Node” chapter of the
Cisco ONS 15454 DWDM Procedure Guide.

2.5.315 WTR (2R, ESCON, FC, GE, ISC)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Objects: 2R, ESCON, FC, GE, ISC
The Wait To Restore condition occurs for client ports in the above-listed types of configuration in a
Y-cable protection group when the “WKSWPR (TRUNK)” condition, page 2-229, is raised. The
condition occurs when the wait-to-restore time has not expired, meaning that the active protect path
cannot revert to the working path. The condition clears when the timer expires and traffic switches back
to the working path.

Note

WTR is an informational condition and does not require troubleshooting.

2.5.316 WTR (TRUNK)
Default Severity: Not Alarmed (NA), Non-Service-Affecting (NSA)
Logical Object: TRUNK
The Wait To Restore condition occurs when the “WKSWPR (TRUNK)” condition, page 2-229, is raised
for MXP or TXP splitter protection scheme ports. The condition occurs when the wait-to-restore time
has not expired, meaning that the active protect path cannot revert to the working path. The condition
clears when the timer expires and traffic switches back to the working path.

Note

WTR is an informational condition and does not require troubleshooting.

2.5.317 WVL-MISMATCH
Default Severity: Major (MJ), Service-Affecting (SA)
Logical Object: TRUNK
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The Equipment Wavelength Mismatch alarm applies to the following cards: TXP_MR_2.5G,
TXPP_MR_2.5G, TXP_MR_10E, TXP_MR_10E_C, TXP_MR_10E_L, MXP_2.5G_10G,
MXP_2.5G_10E, MXP_2.5G_10E_C, MXP_2.5G_10E_L, MXP_MR_2.5G, MXPP_MR_2.5G,
MXP_MR_10DME_C, MXPP_MR_10DME_C. cards, and ADM-10G. It occurs when you provision the
card in CTC with a wavelength that the card does not support.

Note

For more information about supported card wavelengths, refer to the “Hardware Specifications”
appendix in the Cisco ONS 15454 DWDM Reference Manual.

Clear the WVL-MISMATCH alarm
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the TXP or MXP card to
open the card view.

Step 2

Click the Provisioning > Line > Wavelength Trunk Provisioning tabs.

Step 3

In the Wavelength field, view the provisioned card wavelength.

Step 4

If you have access to the site, compare the wavelength listed on the card faceplate with the provisioned
wavelength. If you are remote, compare this wavelength with the card identification in the inventory:
a.

In node view (single-shelf mode) or shelf view (multishelf mode), click the Inventory tab.

b.

Locate the slot where the TXP or MXP card is installed and view the card wavelength in the name.

Step 5

If the card was provisioned for the wrong wavelength, double-click the card in node view (single-shelf
mode) or shelf view (multishelf mode) to open the card view.

Step 6

Click the Provisioning > Line > Wavelength Trunk Provisioning tabs.

Step 7

In the Wavelength field, click the drop-down list and choose the correct wavelength.

Step 8

Click Apply.
If the wavelength does not appear because the wavelength band of the card, either C or L, differs from
the band that was provisioned in CTC, complete the following steps:

Step 9

a.

In the Wavelength field, click the drop-down list and choose First Tunable Wavelength.

b.

Click Apply.

c.

In the Wavelength field, click the drop-down list and choose the correct wavelength.

d.

Click Apply.

If the alarm does not clear, log into the Technical Support Website at http://www.cisco.com/techsupport
for more information or call Cisco TAC (1-800-553-2447) in order to report a service-affecting problem.

2.6 DWDM Card LED Activity
The following sections list the DWDM card LED sequences during card insertion and reset.
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2.6.1 DWDM Card LED Activity After Insertion
When an DWDM card is inserted in the shelf, the following LED activities occur:
1.

The FAIL LED illuminates for approximately 35 seconds.

2.

The FAIL LED blinks for approximately 40 seconds.

3.

All LEDs illuminate and then turn off within 5 seconds.

4.

If new software is being downloaded to the card, the ACT and SF LEDs blink for 20 seconds to
3.5 minutes, depending on the card type.

5.

The ACT LED illuminates.

6.

The SF LED stays illuminated until all card ports connect to their far-end counterparts and a signal
is present.

2.6.2 DWDM Card LED Activity During Reset
When an DWDM card resets (by software or hardware), the following LED activities occur:
1.

The FAIL LED switches on for few seconds.

2.

The FAIL LED on the physical card blinks and turns off.

3.

The white LED with the letters “LDG” appears on the reset card in CTC.

4.

The green ACT LED appears in CTC.

2.7 Traffic Card LED Activity
ONS system traffic card LED behavior patterns are listed in the following sections. These sections give
behavior for card insertion, reset, and side-switch.

2.7.1 Typical Traffic Card LED Activity After Insertion
When a non-DWDM card is inserted, the following LED activities occur:
1.

The red FAIL LED turns on and remains illuminated for 20 to 30 seconds.

2.

The red FAIL LED blinks for 35 to 45 seconds.

3.

All LEDs blink once and turn off for 5 to 10 seconds.

4.

The ACT or ACT/SBY LED turns on. The SF LED can persist until all card ports connect to their
far-end counterparts and a signal is present.

2.7.2 Typical Traffic Card LED Activity During Reset
While a non-DWDM card resets, the following LED activities occur:
1.

The FAIL LED on the physical card blinks and turns off.

2.

The white LED with the letters “LDG” appears on the reset card in CTC.

3.

The green ACT LED appears in CTC.
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2.7.3 Typical Card LED State After Successful Reset
When a non-DWDM card successfully resets, the following LED states are present:
•

If you are looking at the physical ONS system, the ACT/SBY LED is illuminated.

•

If you are looking at node view (single-shelf mode) or shelf view (multishelf mode) of the ONS system,
the current standby card has an amber LED depiction with the initials “SBY,” and this has replaced
the white “LDG” depiction on the card in CTC.

•

If you are looking at node view (single-shelf mode) or shelf view (multishelf mode) of the ONS system,
the current active card has a green LED depiction with the initials “ACT,” and this has replaced the
white “LDG” depiction on the card in CTC.

2.8 Frequently Used Alarm Troubleshooting Procedures
This section gives common procedures that are frequently used when troubleshooting alarms. Most of
these procedures are summarized versions of fuller procedures existing elsewhere in the ONS system
documentation. They are included in this chapter for the user’s convenience. For further information,
please refer to the Cisco ONS 15454 DWDM Procedure Guide or the Cisco ONS 15454 DWDM
Reference Manual as appropriate to your purpose

2.8.1 Node and Ring Identification, Change, Visibility, and Termination
The following procedures relate how to identify or change BLSR names and node IDs, and how to verify
visibility from other nodes.

Identify a BLSR Ring Name or Node ID Number
Step 1

Log into a node on the network.

Step 2

In node view, choose Go to Network View from the View menu.

Step 3

Click the Provisioning > BLSR tabs.

Step 4

From the Ring Name column, record the ring name, or in the Nodes column, record the Node IDs in the
BLSR. The Node IDs are the numbers in parentheses next to the node name.

Change a BLSR Ring Name
Step 1

Log into a node on the network.

Step 2

In node view, choose Go to Network View from the View menu.

Step 3

Click the Provisioning > BLSR tabs.

Step 4

Highlight the ring and click Edit.

Step 5

In the BLSR window, enter the new name in the Ring Name field.

Step 6

Click Apply.
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Step 7

Click Yes in the Changing Ring Name dialog box.

Change a BLSR Node ID Number
Step 1

Log into a node on the network.

Step 2

In node view, choose Go to Network View from the View menu.

Step 3

Click the Provisioning > BLSR tabs.

Step 4

Highlight the ring and click Edit.

Step 5

In the BLSR window, right-click the node on the ring map.

Step 6

Select Set Node ID from the shortcut menu.

Step 7

In the Edit Node ID dialog box, enter the new ID. The Node ID is the number in parentheses after the
Node Name.

Step 8

Click OK.

Verify Node Visibility for Other Nodes
Step 1

Log into a node on the network.

Step 2

In node view, click the Provisioning > BLSR tabs.

Step 3

Highlight a BLSR.

Step 4

Click Ring Map.

Step 5

In the BLSR Ring Map window, verify that each node in the ring appears on the ring map with a node
ID and IP address.

Step 6

Click Close.

2.8.2 Protection Switching, Lock Initiation, and Clearing
The following sections give instructions for port, ring, and span switching and switch-clearing
commands, as well as lock-ons and lockouts.

Initiate a 1+1 Protection Port Force Switch Command
The following sections give instructions for port switching and switch-clearing commands.
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

Step 2

In the Protection Groups area, select the protection group with the port you want to switch.
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Step 3

In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out
this command for the working or protect port. For example, if you need to replace the card with the
Protect/Standby port, click this port.

Step 4

In the Switch Commands area, click Force.

Step 5

Click Yes in the Confirm Force Operation dialog box.

Step 6

If the switch is successful, the group says “Force to working” in the Selected Groups area.

Initiate a 1+1 Manual Switch Command
This procedure switches 1+1 protection group traffic from one port in the group to the other using a
Manual switch.

Note

A Manual command switches traffic if the path has an error rate less than the signal degrade. A Manual
switch is preempted by a Force switch.

Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

Step 2

In the Protection Groups area, select the protection group with the port you want to switch.

Step 3

In the Selected Groups area, select the port belonging to the card you are replacing. You can carry out
this command for the working or protect port. For example, if you need to replace the card with the
protect/standby port, click this port.

Step 4

In the Switch Commands area, click Manual.

Step 5

Click Yes in the Confirm Force Operation dialog box.

Step 6

If the switch is successful, the group now says “Manual to working” in the Selected Groups area.

Initiate a 1:1 Card Switch Command
Note

The Switch command only works on the active card, whether this card is working or protect. It does not
work on the standby card.

Step 1

In node view, click the Maintenance > Protection tabs.

Step 2

Click the protection group that contains the card you want to switch.

Step 3

Under Selected Group, click the active card.

Step 4

Next to Switch Commands, click Switch.
The working slot should change to Working/Active and the protect slot should change to
Protect/Standby.
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Clear a 1+1 Force or Manual Switch Command
Note

If the 1+1 protection group is configured as revertive, clearing a Force switch to protect (or working)
moves traffic back to the working port. In revertive operation, the traffic always switches back to
working. There is no revert to the protect. If ports are not configured as revertive, clearing a Force switch
to protect does not move traffic back.

Note

If the Force Switch was user-initiated, the reversion occurs immediately when the clear command is
issued. The five-minute WTR period is not needed in this case. If the Force was system-initiated, allow
the five-minute waiting period (during WTR) before the reversion occurs.

Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

Step 2

In the Protection Groups area, choose the protection group containing the port you want to clear.

Step 3

In the Selected Group area, choose the port you want to clear.

Step 4

In the Switching Commands area, click Clear.

Step 5

Click Yes in the Confirmation Dialog box.
The Force switch is cleared. Traffic immediately reverts to the working port if the group was configured
for revertive switching.

Initiate a Lock-On Command
Note

For 1:1 and 1:N electrical protection groups, working or protect cards can be placed in the Lock On state.
For a 1+1 optical protection group, only the working port can be placed in the Lock On state.

Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

Step 2

In the Protection Groups list, click the protection group where you want to apply a lock-on.

Step 3

If you determine that the protect card is in standby mode and you want to apply the lock-on to the protect
card, make the protect card active if necessary:
a.

In the Selected Group list, click the protect card.

b.

In the Switch Commands area, click Force.

Step 4

In the Selected Group list, click the active card where you want to lock traffic.

Step 5

In the Inhibit Switching area, click Lock On.

Step 6

Click Yes in the confirmation dialog box.
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Initiate a Card or Port Lockout Command
Note

For 1:1 or 1:N electrical protection groups, working or protect cards can be placed in the Lock Out state.
For a 1+1 optical protection group, only the protect port can be placed in the Lock Out state.

Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

Step 2

In the Protection Groups list, click the protection group that contains the card you want to lockout.

Step 3

In the Selected Group list, click the card where you want to lock out traffic.

Step 4

In the Inhibit Switching area, click Lock Out.

Step 5

Click Yes in the confirmation dialog box.
The lockout has been applied and traffic is switched to the opposite card.

Clear a Lock-On or Lockout Command
Step 1

In node view (single-shelf mode) or shelf view (multishelf mode), click the Maintenance > Protection
tabs.

Step 2

In the Protection Groups list, click the protection group that contains the card you want to clear.

Step 3

In the Selected Group list, click the card you want to clear.

Step 4

In the Inhibit Switching area, click Unlock.

Step 5

Click Yes in the confirmation dialog box.
The lock-on or lockout is cleared.

Initiate a Lockout on a BLSR Protect Span
Step 1

From the View menu choose Go to Network View.

Step 2

Click the Provisioning > BLSR tabs.

Step 3

Choose the BLSR and click Edit.

Step 4

Right-click the BLSR node channel (port) and choose Set West Protection Operation (if you chose a
west channel) or Set East Protection Operation (if you chose an east channel).

Step 5

In the Set West Protection Operation dialog box or the Set East Protection Operation dialog box, choose
Lockout Protect Span from the drop-down list.

Step 6

Click OK.

Step 7

Click Yes in the two Confirm BLSR Operation dialog boxes.
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Clear a BLSR External Switching Command
Step 1

Log into a node on the network.

Step 2

From the View menu, choose Go to Network View.

Step 3

Click the Provisioning > BLSR tabs.

Step 4

Click the BLSR you want to clear.

Step 5

Right-click the west port of the BLSR node where you invoked the switch and choose Set West
Protection Operation.

Step 6

In the Set West Protection Operation dialog box, choose Clear from the drop-down list.

Step 7

Click OK.

Step 8

Click Yes in the Confirm BLSR Operation dialog box.

2.8.3 CTC Card Resetting and Switching
This section gives instructions for resetting traffic cards and TCC2/TCC2P cards.

Caution

For TXP and MXP cards placed in a Y-cable protection group, do not perform a software reset on both
cards simultaneously. Doing so will cause a traffic hit of more than one minute. For more information
about Y-cable protection groups, refer to the “Card Reference” chapter of the Cisco ONS 15454 DWDM
Reference Manual.

Caution

Resetting the active card in a Y-cable group will cause a traffic outage if the standby card is down for
any reason.

Note

When an AIC-I card is rest in CTC, any subsequent user client operations (such as CTC or TL1 activity)
is paused for approximately 5-10 seconds. The reset does not cause any conditions to be raised.

Note

For more information about MXP and TXP cards, refer to the “Card Reference” chapter of the
Cisco ONS 15454 DWDM Reference Manual.

Reset a Card in CTC
Step 1

Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2

In node view (single-shelf mode) or shelf view (multishelf mode), position the cursor over the optical or
electrical traffic card slot reporting the alarm.

Step 3

Right-click the card. Choose Reset Card from the shortcut menu.
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Step 4

Click Yes in the Resetting Card dialog box.

Reset an Active TCC2/TCC2P Card and Activate the Standby Card
Caution

Note

Resetting an active TCC2/TCC2P card can be service-affecting.

Before you reset the TCC2/TCC2P card, you should wait at least 60 seconds after the last provisioning
change you made to avoid losing any changes to the database.

Step 1

Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2

Identify the active TCC2/TCC2P card:
If you are looking at the physical ONS system shelf, the ACT/SBY LED of the active card is green. The
ACT/STBLY LED of the standby card is amber.

Step 3

In node view (single-shelf mode) or shelf view (multishelf mode), right-click the active TCC2/TCC2P card
in CTC.

Step 4

Choose Reset Card from the shortcut menu.

Step 5

Click Yes in the Confirmation Dialog box.
The card resets, the FAIL LED blinks on the physical card, and connection to the node is lost. CTC
switches to network view.

Step 6

Verify that the reset is complete and error-free and that no new related alarms appear in CTC. For LED
appearance, see the “2.7.3 Typical Card LED State After Successful Reset” section on page 2-232.

Step 7

Double-click the node and ensure that the reset TCC2/TCC2P card is in standby mode and that the other
TCC2/TCC2P card is active. Verify the following:
•

If you are looking at the physical ONS system shelf, the ACT/SBY LED of the active card is green.
The ACT/STBLY LED of the standby card is amber.

•

No new alarms appear in the Alarms window in CTC.

2.8.4 Physical Card Reseating, Resetting, and Replacement
This section gives instructions for physically reseating and replacing TCC2/TCC2P cards and traffic
cards.

Caution

Do not physically replace a card without first making provisions to switch or move traffic to a different
card or circuit. General procedures for this are located in the “2.8.2 Protection Switching, Lock
Initiation, and Clearing” section on page 2-233.
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Remove and Reinsert (Reseat) the Standby TCC2/TCC2P Card
Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution

Do not perform this action without the supervision and direction of Cisco TAC (1-800-553-2447).

Caution

The TCC2/TCC2P card reseat could be service-affecting. Refer to the “2.8.2 Protection Switching,
Lock Initiation, and Clearing” section on page 2-233 for traffic-switching procedures.

Note

Before you reset the TCC2/TCC2P card, you should wait at least 60 seconds after the last provisioning
change you made to avoid losing any changes to the database.

Note

When a standby TCC2/TCC2P card is removed and reinserted (reseated), all three fan lights could
momentarily turn on, indicating that the fans have also reset.

Step 1

Log into a node on the network.
Ensure that the TCC2/TCC2P card you want to reseat is in standby mode. A standby card has an amber
ACT/SBY (Active/Standby) LED illuminated.

Step 2

When the TCC2/TCC2P card is in standby mode, unlatch both the top and bottom ejectors on the
TCC2/TCC2P card.

Step 3

Physically pull the card at least partly out of the slot until the lighted LEDs turn off.

Step 4

Wait 30 seconds. Reinsert the card and close the ejectors.

Note

The TCC2/TCC2P card requires several minutes to reboot and display the amber standby LED
after rebooting. Refer to the xxx Cisco ONS 15454 DWDM Reference Manual for more
information about LED behavior during a card reboot.
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Remove and Reinsert (Reseat) Any Card
Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1

Open the card ejectors.

Step 2

Slide the card halfway out of the slot along the guide rails.

Step 3

Slide the card all the way back into the slot along the guide rails.

Step 4

Close the ejectors.

Physically Replace a Card
Warning

Warning: High-performance devices on this card can get hot during operation. To remove the card,
hold it by the faceplate and bottom edge. Allow the card to cool before touching any other part of it or
before placing it in an antistatic bag. Statement 201

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Caution

Removing an active card can cause a traffic hit. To avoid this, perform an external switch if a switch has
not already occurred. See the “2.8.2 Protection Switching, Lock Initiation, and Clearing” section on
page 2-233 for commonly used traffic-switching procedures.
When you replace a card with the identical type of card, you do not need to make any changes to the
database.

Step 1

Open the card ejectors.

Step 2

Slide the card out of the slot.

Step 3

Open the ejectors on the replacement card.

Step 4

Slide the replacement card into the slot along the guide rails.

Step 5

Close the ejectors.

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5

2-240

78-18342-02

Chapter 2

Alarm Troubleshooting
Frequently Used Alarm Troubleshooting Procedures

2.8.5 Generic Signal and Circuit Procedures
This section gives instructions for verify BER thresholds, deleting circuits, provisioning SDCC (or
MS DCC) terminations, and clearing loopbacks.

Verify the Signal BER Threshold Level
This procedure is used for MXP or TXP cards.
Step 1

Log into a node on the network.

Step 2

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the card reporting the alarm
to open the card view.

Step 3

Click the Provisioning > Line > SONET (or SDH) tabs.

Step 4

Under the SD BER (or SF BER) column in the Provisioning window, verify that the cell entry is
consistent with the originally provisioned threshold. The default setting is 1E-7.

Step 5

If the entry is consistent with the original provisioning, go back to your original procedure.

Step 6

If the entry is not consistent with what the system was originally provisioned for, click the cell to reveal
the range of choices and click the original entry.

Step 7

Click Apply.

Delete a Circuit
Step 1

Log into a node on the network.

Step 2

In node view (single-shelf mode) or shelf view (multishelf mode), click the Circuits tab.

Step 3

Click the circuit row to highlight it and click Delete.

Step 4

Click Yes in the Delete Circuits dialog box.

Verify or Create Node Section DCC Terminations
Step 1

Log into a node on the network.

Step 2

In node view (single-shelf mode) or multishelf view (multishelf mode), click the Provisioning > Comm
Channels > SDCC (or Provisioning > Comm Channels > MS DCC) tab.

Step 3

View the Port column entries to see where terminations are present for a node. If terminations are
missing, proceed to Step 4.

Step 4

If necessary, create a DCC termination:
a.

Click Create.

b.

In the Create SDCC Terminations (or Create MS DCC Terminations) dialog box, click the ports
where you want to create the DCC termination. To select more than one port, press the Shift key.

c.

In the port state area, click the Set to IS or Unlocked (or Set to Unlocked) radio button.
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d.

Verify that the Disable OSPF on Link check box is unchecked.

e.

Click OK.

Clear an MXP, TXP, GE-XP, 10GE-XP, and ADM-10G Card Loopback Circuit
Step 1

Log into a node on the network.

Step 2

In node view (single-shelf mode) or shelf view (multishelf mode), double-click the reporting card in CTC
to open the card view.

Step 3

Click the Maintenance > Loopback tabs.

Step 4

In the Loopback Type column, determine whether any port row shows a state other than None.

Step 5

If a row contains another state besides None, click in the column cell to display the drop-down list and
select None.

Step 6

In the Admin State column, determine whether any port row shows an administrative state other than IS
or Unlocked, for example, OOS,MT or Locked,maintenance.

Step 7

If a row shows an administrative state other than IS or Unlocked, click in the column cell to display the
drop-down list and select IS , or Unlocked.

Note

Step 8

If ports managed into IS (or Unlocked) administrative state are not receiving signals, the LOS
alarm is either raised or remains, and the port service state transitions to OOS-AU,FLT (or
Locked-disabled, automaticInService & failed).

Click Apply.

Verify or Create Node RS-DCC Terminations
Note

Portions of this procedure are different for ONS 15454 DWDM nodes.

Step 1

Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2

In node view, click the Provisioning > Comm Channels > RS-DCC tab.

Step 3

View the Port column entries to see where terminations are present for a node. If terminations are
missing, proceed to Step 4.

Step 4

If necessary, create a DCC termination by completing the following steps:
a.

Click Create.

b.

In the Create RS-DCC Terminations dialog box, click the ports where you want to create the DCC
termination. To select more than one port, press the Shift key.

c.

In the port state area, click the Set to Unlocked radio button.

d.

Verify that the Disable OSPF on Link check box is unchecked.
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e.

Click OK.

Clear an STM-N Card XC Loopback Circuit
Step 1

Log into a node on the network. If you are already logged in, continue with Step 2.

Step 2

Double-click the reporting card in CTC to display the card view.

Step 3

Click the Maintenance > Loopback > VC4 tabs.

Step 4

Click Apply.

2.8.6 Air Filter and Fan Procedures
This section gives instructions for cleaning or replacing the air filter and reseating or replacing the fan
tray assembly.

Inspect, Clean, and Replace the Reusable Air Filter
To complete this task, you need a vacuum cleaner or detergent and water faucet, a spare filter, and a
pinned hex key.

Warning

Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed
circuitry could constitute an energy hazard. Statement 206

Although the filter works if it is installed with either side facing up, Cisco recommends that you install
it with the metal bracing facing up to preserve the surface of the filter.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.

Step 1

Verify that you are replacing a reusable air filter. The reusable filter is made of a gray, open-cell,
polyurethane foam that is specially coated to provide fire and fungi resistance. NEBS 3E and later
versions of the ONS system use a reusable air filter.

Step 2

If the air filter is installed in the external filter brackets, slide the filter out of the brackets while being
careful not to dislodge any dust that could have collected on the filter. If the filter is installed beneath
the fan tray and not in the external filter brackets, open and remove the front door assembly by
completing the following steps:
a.

Open the front door of the shelf assembly by completing the following substeps.(If it is already open
or if the shelf assembly does not have a front door, continue with Step 3.)
•

Open the front door lock.

•

Press the door button to release the latch.

•

Swing the door open.
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b.

Remove the front door by completing the following substeps (optional):
•

Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

•

Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

•

Secure the dangling end of the ground strap to the door or chassis with tape.

Step 3

Push the outer side of the handles on the fan-tray assembly to expose the handles.

Step 4

Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait
until the fans stop.

Step 5

When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Step 6

Gently remove the air filter from the shelf assembly. Be careful not to dislodge any dust that could have
collected on the filter.

Step 7

Visually inspect the air filter material for dirt and dust.

Step 8

If the reusable air filter has a concentration of dirt and dust, either vacuum or wash the air filter. Prior to
washing the air filter, replace the dirty air filter with a clean air filter and also reinsert the fan-tray
assembly. Wash the dirty air filter under a faucet with a light detergent.
Spare ONS system filters should be kept in stock for this purpose.

Note

Step 9

Caution

Cleaning should take place outside the operating environment to avoid releasing dirt and dust
near the equipment.

If you washed the filter, allow it to completely air dry for at least eight hours.

Do not put a damp filter back in the ONS system.

Step 10

If the air filter should be installed in the external filter brackets, slide the air filter all the way to the back
of the brackets to complete the procedure.

Step 11

If the filter should be installed beneath the fan-tray assembly, remove the fan-tray assembly and slide the
air filter into the recessed compartment at the bottom of the shelf assembly. Put the front edge of the air
filter flush against the front edge of the recessed compartment. Push the fan tray back into the shelf
assembly.

Caution

If the fan tray does not slide all the way to the back of the shelf assembly, pull the fan tray out and
readjust the position of the reusable filter until the fan tray fits correctly.

Note

On a powered-up ONS system, the fans start immediately after the fan-tray assembly is correctly
inserted.

Step 12

To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray
assembly is activated and displays node information.

Step 13

Rotate the retractable handles back into their compartments.

Step 14

Replace the door and reattach the ground strap.
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Remove and Reinsert a Fan-Tray Assembly
Step 1

Use the retractable handles embedded in the front of the fan-tray assembly to pull it forward several
inches.

Step 2

Push the fan-tray assembly firmly back into the ONS system.

Step 3

Close the retractable handles.

Replace the Fan-Tray Assembly
Caution

The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 system R3.1 and later shelf
assemblies (15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). It includes a pin that
does not allow it to be installed in ONS 15454 shelf assemblies released before ONS 15454 R3.1
(15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1, P/N: 800-07149). Equipment damage can
result from attempting to install the 15454-FTA3 in a incompatible shelf assembly.

Caution

Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or
the connectors on the backplane.

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS system.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
To replace the fan-tray assembly, it is not necessary to move any of the cable management facilities.

Step 1

Step 2

Open the front door of the shelf assembly by completing the following steps. If the shelf assembly does
not have a front door, continue with Step 3.
a.

Open the front door lock.

b.

Press the door button to release the latch.

c.

Swing the door open.

Remove the front door (optional):
a.

Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b.

Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c.

Secure the dangling end of the ground strap to the door or chassis with tape.

Step 3

Push the outer side of the handles on the fan-tray assembly to expose the handles.

Step 4

Fold out the retractable handles at the outside edges of the fan tray.

Step 5

Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait
until the fans stop.

Step 6

When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Step 7

If you are replacing the fan-tray air filter and it is installed beneath the fan-tray assembly, slide the
existing air filter out of the shelf assembly and replace it before replacing the fan-tray assembly.
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If you are replacing the fan-tray air filter and it is installed in the external bottom bracket, you can slide
the existing air filter out of the bracket and replace it at anytime. For more information on the fan-tray
air filter, see the “Inspect, Clean, and Replace the Reusable Air Filter” section on page 2-243.
Step 8

Slide the new fan tray into the shelf assembly until the electrical plug at the rear of the tray plugs into
the corresponding receptacle on the backplane.

Step 9

To verify that the tray has plugged into the backplane, check that the LCD on the front of the fan tray is
activated.

Step 10

If you replace the door, be sure to reattach the ground strap.

2.8.7 Interface Procedures
This section includes instructions for replacing an AIP.

Replace the Alarm Interface Panel
Caution

Do not use a 2A AIP with a 5A fan-tray assembly; doing so causes a blown fuse on the AIP.

Caution

If any nodes in an Ethernet circuit are not using Software R4.0 or later, there is a risk of Ethernet traffic
disruptions. Contact Cisco TAC at 1 800 553-2447 when prompted to do so in the procedure.

Note

Perform this procedure during a maintenance window. Resetting the active TCC2/TCC2P card can cause
a service disruption of less then 50 ms to OC-N or DS-N traffic. Resetting the active TCC2/TCC2P card
can cause a service disruption of 3 to 5 minutes on all Ethernet traffic due to spanning tree reconvergence
if any nodes in the Ethernet circuit are not using Software R4.0 or later.

Caution

Do not perform this procedure on a node with live traffic. Hot-swapping the AIP can affect traffic and
result in a loss of data. For assistance with AIP replacement contact Cisco TAC (1-800-553-2447).

Caution

Always use the supplied electrostatic discharge wristband when working with a powered ONS 15454.
Plug the wristband cable into the ESD jack located on the lower-right edge of the shelf assembly.
This procedure replaces an existing AIP with a new AIP on an in-service node without affecting traffic.
Ethernet circuits that traverse nodes with a software release prior to R4.0 is affected.
You need a #2 Phillips screwdriver.

Step 1

Ensure that all nodes in the affected network are running the same software version before replacing the
AIP and repairing circuits:
a.

In network view, click the Maintenance > Software tabs. The working software version for each
node is listed in the Working Version column.
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b.

Step 2

If you need to upgrade the software on a node, refer to the release-specific software upgrade
document for procedures. No hardware should be changed or circuit repair performed until after the
software upgrade is complete. If you do not need to upgrade software or have completed the software
upgrade, proceed to Step 2.

Record the MAC address of the old AIP:
a.

Log into the node where you are replacing the AIP. For login procedures, refer to the “Connect the
PC and Log into the GUI” chapter in the Cisco ONS 15454 Procedure Guide.

b.

In node view, click the Provisioning > Network > General tabs.

c.

Record the MAC address.

Step 3

Call Cisco TAC (1-800-553-2447) for assistance in replacing the AIP and maintaining the original MAC
address.

Step 4

Unscrew the five screws that hold the lower backplane cover in place.

Step 5

Grip the lower backplane cover and gently pull it away from the backplane.

Step 6

Unscrew the two screws that hold the AIP cover in place.

Step 7

Grip the cover and gently pull away from the backplane.

Note

On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and
15454-SA-R1 (P/N: 800-07149) shelves the AIP cover is clear plastic. On the 15454-SA-ANSI
shelf (P/N: 800-19857), the AIP cover is metal.

Step 8

Grip the AIP and gently pull it away from the backplane.

Step 9

Disconnect the fan-tray assembly power cable from the AIP.

Step 10

Set the old AIP aside for return to Cisco.

Caution

The type of shelf the AIP resides in determines the version of AIP that should replace the failed AIP. The
15454-SA-ANSI shelf (P/N: 800-19857) and 15454-SA-HD (P/N: 800-24848) currently use the 5A AIP,
(P/N: 73-7665-01). The 15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1 (P/N: 800-07149)
shelves and earlier use the 2A AIP (P/N: 73-5262-01).

Caution

Do not put a 2A AIP (P/N: 73-5262-01) into a 15454-SA-ANSI (P/N: 800-19857) or 15454-SA-HD
(P/N: 800-24848) shelf; doing so causes a blown fuse on the AIP.

Step 11

Attach the fan-tray assembly power cable to the new AIP.

Step 12

Place the new AIP on the backplane by plugging the panel into the backplane using the DIN connector.

Step 13

Replace the AIP cover over the AIP and secure the cover with the two screws.

Step 14

Replace the lower backplane cover and secure the cover with the five screws.

Step 15

In node view, click the Provisioning > Network tabs.

Caution

Cisco recommends TCC2/TCC2P card resets be performed in a maintenance window to avoid any
potential service disruptions.
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Step 16

Step 17

Reset the standby TCC2/TCC2P card:
a.

Right-click the standby TCC2/TCC2P card and choose Reset Card.

b.

Click Yes in the Resetting Card dialog box. As the card resets, a loading (Ldg) indication appears
on the card in CTC.The reset takes approximately five minutes. Do not perform any other steps until
the reset is complete.

Reset the active TCC2/TCC2P card:
a.

Right click the active TCC2/TCC2P card and choose Reset Card.

b.

Click Yes in the Resetting Card dialog box. As the card resets, a Ldg indication appears on the card
in CTC. The reset takes approximately five minutes and CTC loses its connection with the node.

Step 18

From the File drop-down list, choose Exit to exit the CTC session.

Step 19

Log back into the node. At the Login dialog box, choose (None) from the Additional Nodes drop-down
list.

Step 20

Record the new MAC address:
a.

In node view, click the Provisioning > Network > General tabs.

b.

Record the MAC address.

Step 21

In node view, click the Circuits tab. Note that all circuits listed are PARTIAL.

Step 22

In node view, choose Repair Circuits from the Tools drop-down list. The Circuit Repair dialog box
appears.

Step 23

Read the instructions in the Circuit Repair dialog box. If all the steps in the dialog box have been
completed, click Next. Ensure that you have the old and new MAC addresses.

Step 24

The Node MAC Addresses dialog box appears. Complete the following steps:

Step 25

a.

From the Node drop-down list, choose the name of the node where you replaced the AIP.

b.

In the Old MAC Address field, enter the old MAC address that was recorded in Step 2.

c.

Click Next.

The Repair Circuits dialog box appears. Read the information in the dialog box and click Finish.
The CTC session freezes until all circuits are repaired. Circuit repair can take up to five minutes or more
depending on the number of circuits provisioned on it.
When the circuit repair is complete, the Circuits Repaired dialog box appears.

Step 26

Click OK.

Step 27

In the node view of the new node, click the Circuits tab. Note that all circuits listed are DISCOVERED.
If all circuits listed do not have a DISCOVERED status, call the Cisco TAC (1-800-553-2447) to open a
Return Material Authorization (RMA).
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Transient Conditions
This chapter gives a description, entity, Simple Network Management Protocol (SNMP) number, and
trap for each commonly encountered Cisco ONS 15454 transient condition.

Note

Unless otherwise specified, ONS 15454 refers to both ANSI and ETSI shelf assemblies.

3.1 Transients Indexed By Alphabetical Entry
Table 3-1 alphabetically lists all ONS 15454 transient conditions and their entity, SNMP number, and
SNMP trap.

Note

The Cisco Transport Controller (CTC) default alarm profile might contain conditions that are not
currently implemented but are reserved for future use.
Table 3-1

ONS 15454 Transient Condition Alphabetical Index

Transient Condition

Entity

SNMP
Number

SNMP Trap

3.3.1 ADMIN-DISABLE, page 3-4

NE

5270

disableInactiveUser

3.3.2 ADMIN-DISABLE-CLR, page 3-4

NE

5280

disableInactiveClear

3.3.3 ADMIN-LOCKOUT, page 3-4

NE

5040

adminLockoutOfUser

3.3.4 ADMIN-LOCKOUT-CLR, page 3-4

NE

5050

adminLockoutClear

3.3.5 ADMIN-LOGOUT, page 3-4

NE

5020

adminLogoutOfUser

3.3.6 ADMIN-SUSPEND, page 3-4

NE

5340

suspendUser

3.3.7 ADMIN-SUSPEND-CLR, page 3-5

NE

5350

suspendUserClear

3.3.8 AUD-ARCHIVE-FAIL, page 3-5

EQPT

6350

archiveOfAuditLogFailed

3.3.9 AUTOWDMANS, page 3-5

NE

5690

automaticWdmAnsFinished

3.3.10 BLSR-RESYNC, page 3-5

OCN

2100

blsrMultiNodeTableUpdateCom
pleted

3.3.11 DBBACKUP-FAIL, page 3-5

EQPT

3724

databaseBackupFailed

3.3.12 DBRESTORE-FAIL, page 3-5

EQPT

3726

databaseRestoreFailed
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Table 3-1

ONS 15454 Transient Condition Alphabetical Index (continued)

Transient Condition

Entity

SNMP
Number

SNMP Trap

3.3.13 EXERCISING-RING, page 3-6

OCN

3400

exercisingRingSuccessfully

3.3.14 EXERCISING-SPAN, page 3-6

OCN

3410

exercisingSpanSuccessfully

3.3.15 FIREWALL-DIS, page 3-6

NE

5230

firewallHasBeenDisabled

3.3.16 FRCDWKSWBK-NO-TRFSW,
page 3-6

OCN

5560

forcedSwitchBackToWorkingRe
sultedInNoTrafficSwitch

3.3.17 FRCDWKSWPR-NO-TRFSW,
page 3-6

OCn

5550

forcedSwitchToProtectResultedI
nNoTrafficSwitch

3.3.18 INTRUSION, page 3-6

NE

5250

securityIntrusionDetUser

3.3.19 INTRUSION-PSWD, page 3-7

NE

5240

securityIntrusionDetPwd

3.3.20 IOSCFG-COPY-FAIL, page 3-7

—

3660

iosConfigCopyFailed

3.3.21 LOGIN-FAIL-LOCKOUT,
page 3-7

NE

5080

securityInvalidLoginLockedOut
SeeAuditLog

3.3.22 LOGIN-FAIL-ONALRDY,
page 3-7

NE

5090

securityInvalidLoginAlreadyLo
ggedOnSeeAuditLog

3.3.23 LOGIN-FAILURE-PSWD,
page 3-7

NE

5070

securityInvalidLoginPasswordS
eeAuditLog

3.3.24 LOGIN-FAILURE-USERID,
page 3-7

NE

3722

securityInvalidLoginUsernameS
eeAuditLog

3.3.25 LOGOUT-IDLE-USER, page 3-8

—

5110

automaticLogoutOfIdleUser

3.3.26 MANWKSWBK-NO-TRFSW,
page 3-8

OCN

5540

manualSwitchBackToWorkingR
esultedInNoTrafficSwitch

3.3.27 MANWKSWPR-NO-TRFSW,
page 3-8

OCN

5530

manualSwitchToProtectResulted
InNoTrafficSwitch

3.3.28 MSSP-RESYNC, page 3-8

STMN

4340

msspMultiNodeTableUpdateCo
mpleted

3.3.29 PM-TCA, page 3-8

—

2120

performanceMonitorThresholdC
rossingAlert

3.3.30 PS, page 3-8

EQPT

2130

protectionSwitch

3.3.31 RMON-ALARM, page 3-8

—

2720

rmonThresholdCrossingAlarm

3.3.32 RMON-RESET, page 3-9

—

2710

rmonHistoriesAndAlarmsReset
Reboot

3.3.33 SESSION-TIME-LIMIT, page 3-9

NE

6270

sessionTimeLimitExpired

3.3.34 SFTWDOWN-FAIL, page 3-9

EQPT

3480

softwareDownloadFailed

3.3.35 SPAN-NOT-MEASURED, page 3-9 OTS

6440

spanMeasurementCannotBePerf
ormed

3.3.36 SWFTDOWNFAIL, page 3-9

EQPT

3480

softwareDownloadFailed

3.3.37 USER-LOCKOUT, page 3-9

NE

5030

userLockedOut

3.3.38 USER-LOGIN, page 3-9

NE

5100

loginOfUser

3.3.39 USER-LOGOUT, page 3-10

NE

5120

logoutOfUser
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Table 3-1

ONS 15454 Transient Condition Alphabetical Index (continued)

SNMP
Number

SNMP Trap

2640

switchedBackToWorking

Transient Condition

Entity

3.3.40 WKSWBK, page 3-10

EQPT,
OCN

3.3.41 WKSWPR, page 3-10

2650
2R,
TRUNK,
EQPT,
ESCON,
FC, GE,
ISC, OCN,
STSMON,
VT-MON

switchedToProtection

3.3.42 WRMRESTART, page 3-10

NE

2660

warmRestart

3.3.43 WTR-SPAN, page 3-10

—

3420

spanIsInWaitToRestoreState

3.2 Trouble Notifications
The ONS 15454 system reports trouble by using standard condition characteristics that follow the rules
in Telcordia GR-253 and graphical user interface (GUI) state indicators.
The ONS 15454 uses standard Telcordia categories to characterize levels of trouble. The system reports
trouble notifications as alarms and reports status or descriptive notifications (if configured to do so) as
conditions in the CTC Alarms window. Alarms typically signify a problem that you need to remedy, such
as a loss of signal. Conditions do not necessarily require troubleshooting.

3.2.1 Condition Characteristics
Conditions include any problem detected on an ONS 15454 shelf. They can include standing or transient
notifications. You can retrieve a snapshot of all currently raised conditions on the network, node, or card
in the CTC Conditions window or by using the RTRV-COND commands in Transaction Language One
(TL1).

Note

Some cleared conditions are found on the History tab.
For a comprehensive list of conditions, refer to the Cisco ONS SONET TL1 Command Guide and the
Cisco ONS 15454 SDH and Cisco ONS 15600 SDH TL1 Command Guide.

3.2.2 Condition States
The History tab state (ST) column indicates the disposition of the condition, as follows:
•

A raised (R) event is active.

•

A cleared (C) event is no longer active.

•

A transient (T) event is automatically raised and cleared in CTC during system changes such as user
login, log out, and loss of connection to node view. Transient events do not require user action.
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3.3 Transient Conditions
This section lists in alphabetical order all the transient conditions encountered in Software Release 8.5.
The description, entity, SNMP number, and SNMP trap accompany each condition.

3.3.1 ADMIN-DISABLE
The Disable Inactive User (ADMIN-DISABLE) condition occurs when the administrator disables a user
or when a account is inactive for a specified period.
This transient condition does not result in a standing condition.

3.3.2 ADMIN-DISABLE-CLR
The Disable Inactive Clear (ADMIN-DISABLE-CLR) condition occurs when the administrator clears
the disable flag on a user account.
This transient condition does not result in a standing condition.

3.3.3 ADMIN-LOCKOUT
The Admin Lockout of User (ADMIN-LOCKOUT) condition occurs when the administrator locks a user
account.
This transient condition does not result in a standing condition.

3.3.4 ADMIN-LOCKOUT-CLR
The Admin Lockout Clear (ADMIN-LOCKOUT-CLR) condition occurs when the administrator unlocks
a user account or when the lockout time expires.
This transient condition does not result in a standing condition.

3.3.5 ADMIN-LOGOUT
The Admin Logout of User (ADMIN-LOGOUT) condition occurs when the administrator logs off a user
session.
This transient condition does not result in a standing condition.

3.3.6 ADMIN-SUSPEND
The Suspend User (ADMIN-SUSPEND) condition occurs when the password for a user account expires.
This transient condition does not result in a standing condition.
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3.3.7 ADMIN-SUSPEND-CLR
The Suspend User Clear (ADMIN-SUSPEND-CLR) condition occurs when the user or administrator
changes the password.
This transient condition does not result in a standing condition.

3.3.8 AUD-ARCHIVE-FAIL
The Archive of Audit Log Failed (AUD-ARCHIVE-FAIL) condition occurs when the software fails to
archive the audit log. The condition normally occurs when the user refers to an FTP server that does not
exist, or uses an invalid login while trying to archive. The user must log in again with correct user name,
password, and FTP server details.
This transient condition does not lead to a standing condition.

3.3.9 AUTOWDMANS
The Automatic WDM ANS Finish (AUTOWDMANS) condition indicates that an automatic node setup
(ANS) command has been initiated. It normally occurs when you replace dense wavelength division
multiplexing (DWDM) cards; the condition is an indication that the system has regulated the card.
This transient condition does not result in a standing condition.

3.3.10 BLSR-RESYNC
The BLSR Multinode Table Update Completed (BLSR-RESYNC) condition might occur when you
create or delete circuits on a bidirectional line switched ring (BLSR) or multiplex section-shared
protection ring (MS-SPRing), change a ring topology (for example, add or delete a BLSR/MS-SPRing
node), or change the BLSR/MS-SPRing circuit state and ring ID.
This transient condition does not result in a standing condition.

3.3.11 DBBACKUP-FAIL
The Database Backup Failed (DBBACKUP-FAIL) condition occurs when the system fails to back up the
database when the backup command is initiated.
This condition can occur when the server is not able to handle the backup operation due to network or
server issues. Repeat the same operation again and check to see if it is successful. If the backup fails, it
could be due to a network issue or software program failure. Contact the Cisco Technical Assistance
Center (TAC) for assistance; see the “Obtaining Documentation and Submitting a Service Request”
section on page xxxix as needed.

3.3.12 DBRESTORE-FAIL
The Database Restore Failed (DBRESTORE-FAIL) condition occurs when the system fails to restore the
backed up database when the restore command is initiated.
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This condition can be due to server issues, network issues, or human error (pointing to a file that does
not exist, wrong file name, etc.). Retrying the database restore with the correct file will usually succeed.
If the network issue persists, you must contact network lab support. If the condition is caused by a
network element (NE) failure, contact Cisco TAC for assistance. See the “Obtaining Documentation and
Submitting a Service Request” section on page xxxix as needed.

3.3.13 EXERCISING-RING
The Exercising Ring Successfully (EXERCISING-RING) condition occurs whenever you issue an
Exercise Ring command from CTC or TL1. This condition indicates that a command is being executed.

3.3.14 EXERCISING-SPAN
The Exercising Span Successfully (EXERCISING-SPAN) condition occurs whenever you issue an
Exercise Span command from CTC or TL1. This condition indicates that a command is being executed.

3.3.15 FIREWALL-DIS
The Firewall Has Been Disabled (FIREWALL-DIS) condition occurs when you provision the firewall to
Disabled.
This transient condition does not result in a standing condition.

3.3.16 FRCDWKSWBK-NO-TRFSW
The Forced Switch Back to Working Resulted in No Traffic Switch (FRCDWKSWBK-NO-TRFSW)
condition occurs when you perform a Force Switch to the working port or card and the working port or
card is already active.
This transient condition might result in a Force Switch (Ring or Span) standing condition for a BLSR or
MS-SPRing.

3.3.17 FRCDWKSWPR-NO-TRFSW
The Forced Switch to Protection Resulted in No Traffic Switch (FRCDWKSWPR-NO-TRFSW)
condition occurs when you perform a Force Switch to the protect port or card, and the protect port or
card is already active.
This transient condition does not result in a standing condition.

3.3.18 INTRUSION
The Invalid Login Username (INTRUSION) condition occurs when you attempt to log in with an invalid
user ID.
This transient condition does not result in a standing condition.
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3.3.19 INTRUSION-PSWD
The Security Intrusion Attempt Detected (INTRUSION -PSWD) condition occurs when you attempt to
log in with an invalid password.
This transient condition does not result in a standing condition.

3.3.20 IOSCFG-COPY-FAIL
The Cisco IOS Config Copy Failed (IOSCFG-COPY-FAIL) condition occurs on ML-Series Ethernet
cards when the software fails to upload or download the Cisco IOS startup configuration file to or from
an ML-Series card. This condition is similar to the “SFTWDOWN-FAIL” condition on page 3-9, but the
IOSCFG-COPY-FAIL condition applies to ML-Series Ethernet cards rather than the TCC2/TCC2P card.

3.3.21 LOGIN-FAIL-LOCKOUT
The Invalid Login–Locked Out (LOGIN-FAIL-LOCKOUT) condition occurs when you attempt to log
into a locked account.
This transient condition does not result in a standing condition.

3.3.22 LOGIN-FAIL-ONALRDY
The Security: Invalid Login–Already Logged On (LOGIN-FAIL-ONALRDY) condition occurs when a
user attempts to log into a node where the user already has an existing session and a
Single-User-Per-Node (SUPN) policy exists.
This transient condition does not result in a standing condition.

3.3.23 LOGIN-FAILURE-PSWD
The Invalid Login–Password (LOGIN-FAILURE-PSWD) condition occurs when you attempt to log in
with an invalid password.
This transient condition does not result in a standing condition.

3.3.24 LOGIN-FAILURE-USERID
The Invalid Login–Username (LOGIN-FAILURE-USERID) condition occurs when a user login (CTC,
Cisco Transport Manager [CTM], or TL1) fails because the login username is not present on the node
database. You must log in again with an existing user ID.
This transient condition is equivalent to a security warning. You must check the security log (audit log)
for other security-related actions that have occurred.
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3.3.25 LOGOUT-IDLE-USER
The Automatic Logout of Idle User (LOGOUT-IDLE-USER) condition occurs when a user session is
idle for too long (the idle timeout expires) and the session terminates as a result. You must log in again
to restart your session.

3.3.26 MANWKSWBK-NO-TRFSW
The Manual Switch Back To Working Resulted in No Traffic Switch (MANWKSWBK-NO-TRFSW)
condition occurs when you perform a Manual switch to the working port or card and the working port
or card is already active.
This transient condition does not result in a standing condition.

3.3.27 MANWKSWPR-NO-TRFSW
The Manual Switch to Protect Resulted in No Traffic Switch (MANWKSWPR-NO-TRFSW) condition
occurs when you perform a Manual switch to the protect port or card and the protect port or card is
already active.
This transient condition results in a BLSR or MSSP Manual Switch (Span or Ring) standing condition.

3.3.28 MSSP-RESYNC
The MS-SPRing Multi-Node Table Update Completed (MSSP-RESYNC) condition occurs when a node
receives all relevant information such as payload, path state, Routing Information Protocol (RIP),
cross-connect tables, and cross-connect VT tables from the other nodes in the ring. This condition is
raised on all nodes in the ring while a node is added or a circuit is provisioned. This transient condition
will not be cleared and is seen in the History tab of CTC.
You must check this condition on all the nodes and then remove the Forced Ring Switch commands.

3.3.29 PM-TCA
The Performance Monitoring Threshold Crossing Alert (PM-TCA) condition occurs when network
collisions cross the rising threshold for the first time.

3.3.30 PS
The Protection Switch (PS) condition occurs when traffic switches from a working/active card to a
protect/standby card.

3.3.31 RMON-ALARM
The Remote Monitoring Threshold Crossing Alarm (RMON-ALARM) condition occurs when the
remote monitoring (RMON) variable crosses the threshold.
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3.3.32 RMON-RESET
The RMON Histories and Alarms Reset Reboot (RMON-RESET) condition occurs when the
time-of-day settings on the TCC2/TCC2P card are increased or decreased by more than five seconds.
This invalidates all the history data, and RMON must restart. It can also occur when you reset a card.

3.3.33 SESSION-TIME-LIMIT
The Session Time Limit Expired (SESSION-TIME-LIMIT) condition occurs when a login session
exceeds the time limit and you are logged out of the session. You must log in again.

3.3.34 SFTWDOWN-FAIL
The Software Download Failed (SFTDOWN-FAIL) condition occurs when the system fails to download
the required software.
An incorrect input that points to the wrong place or file, network issues, or a bad (corrupt) package can
cause this failure. Retrying the operation with the correct name/location will usually succeed. If network
issues persist, you must contact the network lab support. If the package is corrupt, contact Cisco TAC.
See the “Obtaining Documentation and Submitting a Service Request” section on page xxxix for details.

3.3.35 SPAN-NOT-MEASURED
The SPAN-NOT-MEASURED condition is raised when a node cannot perform the span loss verification
as it cannot communicate with its peer at the other end of the span.

3.3.36 SWFTDOWNFAIL
The Software Download Failed (SFTDOWN-FAIL) condition occurs when the system fails to download
the required software.
An incorrect input that points to the wrong place or file, network issues, or a bad (corrupt) package can
cause this failure. Retrying the operation with the correct name/location will usually succeed. If network
issues persist, you must contact the network lab support. If the package is corrupt, contact Cisco TAC.
See the “Obtaining Documentation and Submitting a Service Request” section on page xxxix for details.

3.3.37 USER-LOCKOUT
The User Locked Out (USER-LOCKOUT) condition occurs when the system locks an account because
of a failed login attempt. To proceed, the administrator must unlock the account or the lockout time must
expire.

3.3.38 USER-LOGIN
The Login of User (USER-LOGIN) occurs when you begin a new session by verifying your user ID and
password.
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This transient condition does not result in a standing condition.

3.3.39 USER-LOGOUT
The Logout of User (USER-LOGOUT) condition occurs when you stop a login session by logging out
of your account.
This transient condition does not result in a standing condition.

3.3.40 WKSWBK
The Switched Back to Working (WKSWBK) condition occurs when traffic switches back to the working
port or card in a nonrevertive protection group.
This transient condition does not result in a standing condition.

3.3.41 WKSWPR
The Switched to Protection (WKSWPR) condition occurs when traffic switches to the protect port or
card in a nonrevertive protection group.
This transient condition does not result in a standing condition.

3.3.42 WRMRESTART
The Warm Restart (WRMRESTART) condition occurs when the node restarts while it is powered up. A
restart can be caused by provisioning, such as a database restore or IP changes, or by software defects.
A WRMRESTART is normally accompanied by MANRESET or AUTORESET to indicate whether the
reset was initiated manually (MAN) or automatically (AUTO).
This is the first condition that appears after a TCC2/TCC2P card is powered up. The condition changes
to COLD-START if the TCC2/TCC2P card is restarted from a physical reseat or a power loss.

3.3.43 WTR-SPAN
The Span is in Wait To Restore State (WTR-SPAN) condition occurs when a BLSR or MS-SPRing
switches to another span due to a Signal Failure-Span command or a fiber is pulled from a four-fiber
BLSR/MS-SPRing configuration. The condition is raised until the WaitToRestore (WTR) period expires.
This transient condition clears when the BLSR/MS-SPRing returns to a normal condition or the IDLE
state.
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Error Messages

Note

The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration.
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's
path protection feature, which may be used in any topological network configuration. Cisco does not
recommend using its path protection feature in any particular topological network configuration.
This chapter lists the error messages for the Cisco ONS 15454 Multi-Service Transport Platform
(MSTP). The error dialog box in Figure 4-1 consists of three parts: the error title, error ID, and error
message.
Figure 4-1

Error Dialog Box

124687

Error Title
Error Message
Error ID

Table 4-1 gives a list of all error or warning message numbers, the messages, and a brief description of
each message. The table lists two types of messages: error messages (EID-nnnn) and warning messages
(WID-nnnn). Error messages are alerts that an unexpected or undesirable operation has occurred that
either indicates the risk of loss of traffic or an inability to properly manage devices in the network.
Warnings are alerts that the requested operation could lead to an error. Warnings are sometimes used to
convey important information.
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Error Warning
ID
Error Warning Message

Description

EID-0

Invalid error ID.

The error ID is invalid.

EID-1

A null pointer encountered in {0}.

Cisco Transport Controller (CTC)
encountered a null pointer in the area
described by the specified item.

EID-1000

The host name of the network element cannot be resolved to an Refer to the error message text.
address.

EID-1001

Unable to launch CTC due to applet security restrictions.

Refer to the error message text.

Please review the installation instructions to make sure that the
CTC launcher is given the permissions it needs.
Note that you must exit and restart your browser in order for the
new permissions to take effect.
EID-1002

The host name (e.g., for the network element) was successfully The node is not reachable from CTC client
resolved to its address, but no route can be found through the station.
network to reach the address.

EID-1003

An error was encountered while attempting to launch CTC.
{0}

Unexpected exception or error while
launching CTC from the applet.

EID-1004

Problem Deleting CTC Cache: {0} {1}

Unable to delete the CTC cached JARs,
because another application may have the
JAR files running; for example, another
instance of CTC.

EID-1005

An error occurred while writing to the {0} file.

CTC encountered an error while writing to
log files, preference files, etc.

EID-1006

The URL used to download {0} is malformed.

The URL used to download the specified
JAR file is incorrect.

EID-1007

An I/O error occurred while trying to download {0}.

An input or output exception was
encountered when CTC tried to download
the specified JAR file.

EID-1018

Password shall not contain the associated user-ID.

The password is invalid.

EID-1019

Could not create {0}.
Please enter another filename.

CTC could not create the file due to an
invalid filename.

EID-1020

Fatal exception occurred, exiting CTC.
Unable to switch to the Network view.

CTC was unable to switch from the node or
card view to the network view and is now
shutting down.

EID-1021

Unable to navigate to {0}.

CTC was unable to display the requested
view (node or network).

EID-1022

An IOS session cannot be opened right now with this slot. Most Refer to the error message text.
likely someone else (using a different CTC) already has a
Ensure that the shell access in CTC
session opened with this slot. Please try again later.
(Provisioning>Security>Access) is set to
non-secure mode.
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Error Warning
ID
Error Warning Message

Description

EID-1023

Refer to the error message text.
This IOS session has been terminated.
Terminations are caused when the session has timed out, the
card resets, there is already a session with the slot, or password
configuration is required.

EID-1025

Unable to create Help Broker.

CTC was unable to create the help broker
for the online help.

EID-1026

Error found in the Help Set file.

CTC encountered an error in the online help
file.

EID-1027

Unable to locate help content for Help ID: "{0}".

CTC was unable to locate the content for
the help ID.

EID-1028

Error saving table. {0}

There was an error while saving the
specified table.

EID-1031

CTC cannot locate the online user manual files. The files may Refer to the error message text.
have been moved, deleted, or not installed. To install online
user manuals, run the CTC installation wizard on the software
or documentation CD.

EID-1032

CTC cannot locate Acrobat Reader. If Acrobat Reader is not
Refer to the error message text.
installed, you can install the Reader using the CTC installation
wizard provided on the software or documentation CD.

EID-1035

CTC experienced an I/O error while working with the log files. Refer to the error message text.
Usually this means that the computer has run out of disk space.
This problem may or may not cause CTC to stop responding.
Ending this CTC session is recommended, but not required.

WID-1036

WARNING: Deleting the CTC cache may cause any CTC
running on this system to behave in an unexpected manner.

Refer to the warning message text.

EID-1037

Could not open {0}. Please enter another filename.

Invalid file name. CTC is unable to open the
specified file. Ensure that the file exists and
the filename was typed correctly.

EID-1038

The file {0} does not exist.

The specified file does not exist.

EID-1039

The version of the browser applet does not match the version Refer to the error message text.
required by the network element. Please close and restart your
browser in order to launch the Cisco Transport Controller.

WID-1041

An error occurred while closing the {0} connection.

CTC encountered an error while closing the
specified connection.

WID-1042

You have selected Java version {0}.
This version is outside of the recommended range and may
cause an unpredictable behavior of the software.
Do you wish to continue?

Refer to the warning message text.

EID-1043

Error writing to file: {0}.
This might be caused by a directory permission, quota or disk
volume full issue.

Check for possible causes and try again.
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Error Warning
ID
Error Warning Message

Description

WID-1044

Warning: there is a discrepancy in the build timestamp between Refer to the warning message text.
the NE cached jar file ({0}) and the NE ({1}).
Your CTC jar cache should be emptied.

EID-1046

Selected CTC version ({0}) must be greater than or equal{to
the login NE version ({1}).

The CTC software version must be greater
than or equal to the software version on the
node being managed.

EID-2001

No rolls were selected. {0}

No rolls were selected for the bridge and
roll.

EID-2002

The roll must be completed or canceled before it can be deleted. You cannot delete the roll unless it has been
completed or cancelled.

EID-2003

An error occurred while deleting the roll.
{0}

There was an error when CTC tried to delete
the roll.

EID-2004

No Cisco IOS slot was selected.

You did not select a Cisco IOS slot.

EID-2005

CTC cannot find the online help files for {0}.
The files might have been moved, deleted, or not installed.
To install online help, run the setup program on the software
CD.

CTC cannot find the online help files for the
specified window. The files might have
been moved, deleted, or not installed. To
install online help, run the setup program on
the software CD.

EID-2006

An error occurred while editing the circuit(s).
{0}
{1}.

An error occurred when CTC tried to open
the circuit for editing.

EID-2007

The preferences could not be saved.

CTC cannot save the preferences.

EID-2008

The circuit preferences could not be saved:
{0}

CTC cannot find the file needed to save the
circuit preferences.

EID-2009

CTC was unable to download the package:
{0}

Refer to the error message text.

EID-2010

An error occurred while deleting the destination.

CTC could not delete the destination.

EID-2011

The circuit could not be destroyed.

CTC could not destroy the circuit.

EID-2012

The reverse circuit could not be destroyed.

CTC could not reverse the circuit destroy.

EID-2013

The circuit creation failed.
The circuit creation cannot proceed due to changes in the
network which affected the circuit(s) being created.
The dialog box will close. Please try again.

Refer to the error message text.

EID-2014

No circuit(s) were selected.
{0}

You must select a circuit to complete this
function.

EID-2015

The circuit {0} cannot be deleted because it has one or more
rolls.

You must delete the rolls in the circuit
before deleting the circuit itself.

EID-2016

The circuit deletion failed.

CTC could not delete the tunnel as there are
circuits that use the tunnel.

EID-2017

An error occurred while mapping the circuit.
{0}

There was an error mapping the circuit.
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Error Warning
ID
Error Warning Message

Description

EID-2018

The circuit roll failed.
The circuit must be in the DISCOVERED state in order to
perform a roll.

There was a failure in circuit roll. Change
the circuit state to DISCOVERED and
proceed.

EID-2019

The circuit roll failed.
Bridge and roll is not supported on DWDM circuits.

Refer to the error message text.

EID-2020

The circuit roll failed.
The two circuits must have the same direction.

Refer to the error message text.

EID-2021

The circuit roll failed.
The two circuits must have the same size.

Refer to the error message text.

EID-2022

The circuit roll failed.
Refer to the error message text.
A maximum of two circuits can be selected for a bridge and roll
operation.

EID-2023

CTC was unable to create a new user account.

Refer to the error message text.

EID-2024

An error occurred during node selection.

There was an error during node selection.

EID-2025

This feature cannot be used. Verify that each endpoint of this
circuit is running software that supports this feature.

Refer to the error or warning message text.
For example, this error is generated from
the node view Provisioning> WDM-ANS>
tabs to indicate that the selected ring type is
not supported by the endpoints of the
circuit. Another example is the
Provisioning> VLAN tabs in card view
(Ethernet card only), where it indicates that
the back-end spanning tree protocol (STP)
disabling is not supported.

EID-2026

The {0} request could not be applied.
{1}

Error occurred while attempting to switch a
path protection circuit away from a span.

EID-2027

An error occurred while deleting the circuit drop.

CTC could not delete the circuit drop.

EID-2028

An error occurred while removing the circuit node.

CTC could not remove the circuit node.

EID-2029

The requested operation is not supported.

The task you are trying to complete is not
supported by CTC.

EID-2030

An error occurred during provisioning.

There was an error during provisioning.

EID-2031

An error occurred while adding the node.

There was an error while adding a node.

EID-2032

The circuit could not be renamed.
{0}

CTC could not rename the circuit.

EID-2033

An error occurred during validation.
{0}

There was an internal error while validating
the user changes after the Apply button was
pressed. This error can occur in the Edit
Circuit dialog box or in the BLSR table in
the shelf view (rare condition).

EID-2034

Network circuits could not be added:
{0}

Refer to the error message text.

EID-2035

The source and destination nodes are not connected.

Refer to the error message text.
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ID
Error Warning Message

Description

EID-2036

The {0} cannot be deleted.
LAN Access has been disabled on this node and this {0} is
needed to access the node.

You cannot delete the DCC/GCC link as it
is needed to access the node.

EID-2037

The attribute for {0} cannot be found.

CTC cannot find an attribute for the
specified item.

EID-2038

The protection operation is invalid.

The protection operation you tried to
execute is invalid.

EID-2040

Please select a node first.

You must select a node before performing
the task.

EID-2041

No paths are available on this link. Please make another
selection.

You must select a link that has paths
available.

EID-2042

This span is not selectable. Only the green spans with an arrow Refer to the error message text.
may be selected.

EID-2043

This node is not selectable. Only the source node and nodes
attached to included spans (blue) are selectable. Selecting a
selectable node will enable its available outgoing spans.

Refer to the error message text.

EID-2044

This link may not be included in the required list. Constraints
only apply to the primary path. Each node may have a
maximum of one incoming signal and one outgoing link.

You must select only one link going in and
out of a node. Selecting more than one link
is contradictory to the path selection
algorithm.

EID-2045

This link may not be included in the required list. Only one
outgoing link may be included for each node.

Refer to the error message text.

EID-2047

Please enter a valid value for the slot number.

There was an error due to an invalid slot
number.

EID-2048

Please enter a valid value for the port number.

There was an error due to an invalid port
number.

EID-2050

The new circuit could not be destroyed.

CTC could not destroy the new circuit.

EID-2051

The circuit cannot be downgraded.
{0}

The specified circuit cannot be
downgraded.

EID-2052

An error occurred during circuit processing.

There was an error during the circuit
processing.

EID-2054

An error occurred while selecting an endpoint.

There was an error during the endpoint
selection.

EID-2055

No endpoints are available for this selection. Please make
another selection.

This error occurs in the circuit creation
dialog only during a race condition that has
incorrectly allowed entities without
endpoints to be displayed in the
combination boxes.

EID-2056

A communication error occurred: {0}

An internal error occurred in Network
Alarm tab while synchronizing alarms with
the nodes.
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ID
Error Warning Message

Description

EID-2059

An error occurred while deleting the node.
{0}

There was an error during the node deletion.

EID-2060

No PCA circuits were found.

CTC could not find any protection channel
access (PCA) circuits for this task.

EID-2061

An error occurred while provisioning the VLAN.

There was an error defining the VLAN.

EID-2062

An error occurred while deleting VLANs.
No VLAN(s) were selected.
Please select a VLAN.

Refer to the error message text.

EID-2063

The default VLAN cannot be deleted.

The selected VLAN is the default VLAN
and cannot be deleted.

EID-2064

An error occurred while deleting VLANs.
{0}

There was an error deleting the specified
VLAN.

EID-2065

Cannot import the profile because the
The profile cannot be imported.
The profile "{0}" exists in the editor and the maximum number profile has reached the maximum number of
copies in the editor.
of copies (ten) exists in the editor.
The import will be aborted. The profile has already been loaded
eleven times.

EID-2066

The profile could not be stored.
An error occurred while writing to {0}.

CTC encountered an error while trying to
store the profile.

EID-2067

An error occurred while writing to the file.
{0}

CTC encountered an error while writing the
specified file.

EID-2068

The alarm profile could not be loaded from the node.

CTC encountered an error trying to load the
alarm profile from the node.

EID-2069

The file could not be found or an I/O exception occurred.
{0}

Either the specified file was not found, or
there was an input/output exception.

EID-2070

The profile could not be deleted.
{0}

There was a failure in deleting the specified
profile.

EID-2071

Only one column may be highlighted.

You cannot select more than one column
during clone action.

EID-2072

Only one profile may be highlighted.

You cannot select more than one profile.

EID-2073

This column is permanent and cannot be removed.

You cannot delete a permanent column.

EID-2074

Select one or more profiles.

You have not selected any profile or
column. Reset operation is done by
right-clicking the selected column.

EID-2075

This column is permanent and cannot be reset.

A permanent column cannot be reset.

EID-2077

This column is permanent and cannot be renamed.

You cannot rename a permanent column.

EID-2078

At least two columns must be highlighted.

You cannot compare two profiles unless you
select two columns.
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Error Warning
ID
Error Warning Message

Description

EID-2079

Refer to the error message text.
The alarm types cannot be loaded into table.
There are no reachable nodes from which the list of alarm types
can be loaded.
Please wait until such a node is reachable and try again.

EID-2080

The node {0} has no profiles.

The specified node does not have any
profiles.

EID-2081

An error occurred while removing profile {0} from the node
{1}.

There was an error while removing the
specified profile from the specified node.

EID-2082

The profile {0} does not exist on the node {1}.

CTC cannot find the specified profile from
the specified node.

EID-2083

An error occurred while adding profile {0} to the node {1}.

There was an error adding the specified
profile to the specified node.

EID-2085

The profile selection is invalid.
No profiles were selected.

You tried to select an invalid profile. Select
another profile.

EID-2086

The node selection is invalid.
No nodes were selected.

You tried to select an invalid node. Select
another node.

EID-2087

No profiles were selected.
Please select at least one profile.

Refer to the error message text.

EID-2088

The profile name is invalid.

The profile name cannot be empty.

EID-2089

Too many copies of {0} exist. Please choose another name.

Select a unique name.

EID-2090

No nodes were selected.
Please select the node(s) on which to store the profile(s).

You must select one or more nodes on
which you can store the profile.

EID-2091

Unable to switch to the node {0}.

CTC is unable to switch to the specified
node.

EID-2092

A general exception error occurred.

CTC encountered a general exception error
while trying to complete the task.

EID-2093

The name is too short. It does not have enough characters.
{0}

The name must have a minimum of six
characters.

EID-2094

The password and confirmed password fields do not match.

You must make sure the two fields have the
same password.

EID-2095

The password is invalid.
{0}

The password you entered is not allowed.

EID-2096

The user must have a security level.

You must have an assigned security level to
perform this task.

EID-2097

No user name was specified.

You did not specify a user name.

EID-2099

An error occurred while ring switching.

There was an error during the ring switch.

EID-2100

Please select at least one profile to delete.

You have not selected the profile to delete.

EID-2101

An error occurred while protection switching.

There was an error during the protection
switching.
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Error Warning
ID
Error Warning Message

Description

EID-2102

The forced switch could not be removed for some circuits. You The forced switch could not be removed for
must switch these circuits manually.
some circuits. You must switch these
circuits manually.

EID-2103

An error occurred while upgrading the span.

EID-2104

The circuits cannot be switched back because one or both nodes This error occurs during the path protection
are not reachable.
span upgrade procedure.

EID-2106

The node name cannot be empty.

You must supply a name for the node.

EID-2107

An error occurred while adding {0}. The host is unknown.

There was an error adding the specified
item.

EID-2108

{0} is already in the network.

The specified item exists in the network.

EID-2109

The node is already in the current login group.

The node you are trying to add is already
present in the current login group.

EID-2110

Please enter a number between 0 and {0}.

You must enter a number in the range
between 0 and the specified value.

EID-2111

This node ID is already in use. Please choose another.

Select a node ID that is not in use.

EID-2113

The extension byte for the ring cannot be set.
{0}

CTC cannot set the BLSR/MS-SPRing
extension byte.

EID-2114

A card communication failure occurred during the operation.

This error can occur during an attempt to
apply a BLSR protection operation to a line.

EID-2115

An error occurred during the operation.
{0}

There was an error in applying the specified
operation.

EID-2116

The extension byte setting for the ring is invalid.
{0}

The extension byte set for the specified ring
is invalid.

EID-2118

The ring cannot be deleted.
Clear all the protection operations for the
A protection operation is set. All protection operations must be ring before deleting it.
clear for ring to be deleted.

EID-2119

{0} cannot be deleted because a protection switch is in effect. Clear all protection operations or switches
Please clear any protection operations, ensure that the reversion before deleting the ring.
time is not "never" and allow any protection switches to clear
before trying again.

EID-2120

The following nodes could not be unprovisioned
{0}
Therefore you will need to delete this {1} again later.

The specified nodes could not be
unprovisioned. Try deleting this BLSR or
MS-SPRing later.

EID-2121

The ring cannot be upgraded.
{0}

CTC cannot upgrade the specified ring.

EID-2122

The ring speed for is inadequate for the upgrade procedure.
Only {0} (or higher) {1} can be upgraded to four-fiber.

You have selected an incorrect ring speed
for upgrade. Only rings within the specified
parameters can be upgraded to 4-fiber
BLSR.

There was an error during the span upgrade.
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Error Warning
ID
Error Warning Message

Description
Nonupgradable nodes. Verify that the
specified nodes have at least two IS-NR
ports with the same speed as the 2-fiber
BLSR.
The specified ports cannot serve as a timing
reference, and they cannot have data
communications channel (DCC)
terminations or overhead circuits.

EID-2123

Verify that the following nodes have at least two in-service
ports with the same speed as the two-fiber {0}. The ports cannot
serve as timing references, and they cannot have DCC
terminations or overhead circuits.
{1}

EID-2124

You cannot add this span because it is connected to a node that Refer to the error message text.
already has the east and west ports defined.

EID-2125

You cannot add this span as it would cause a single card to host Refer to the error message text.
both the east span and the west span. A card cannot protect
itself.

EID-2126

An error occurred while provisioning the OSPF area.
{0}

There is an Open Shortest Path First (OSPF)
area error.

EID-2127

You cannot add this span. It would cause the following
circuit(s) to occupy different {0} regions on different spans:
{1}

A circuit cannot occupy different STS
regions on different spans. You may add a
different span or delete the specified circuit.

Either select a different span or delete the above circuit(s).
EID-2128

The state is invalid.

An internal error occurred while trying to
remove a span from a BLSR.
This alarm occurs in the network-level
BLSR creation dialog box.

EID-2129

You cannot use same slot for east and west protect ports.

Refer to the error message text.

EID-2130

The ring ID value, {0}, is not valid. Please enter a valid number Enter a ring ID value between 0 and 9999.
between 0 and 9999.

EID-2131

The reversion cannot be set to INCONSISTENT.

You must select another reversion type.

EID-2135

The overhead circuit preferences could not be stored:
{0}

Input/Output error. Unable to store
overhead circuit preferences.

EID-2137

An error occurred during the circuit merge.
{0}

There was an error while merging the
circuits.

EID-2138

Not all destinations could be deleted.
Please try again.

Refer to the error message text.

EID-2139

An error occurred while updating the destinations.

There was an error in updating the circuit
destinations.

EID-2143

No online help version was selected.
The online help book cannot be deleted.

Select the version of online help, and
proceed.

EID-2144

An error occurred while deleting the online help book(s).
{0}

You cannot delete the specified online help.

EID-2145

No nodes appear to have a Cisco IOS card.

Refer to error message.

EID-2146

This is a security violation.
You may only logout of your own account.

You cannot logout of an account other than
your own.

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5

4-10

78-18342-02

Chapter 4

Table 4-1

Error Messages
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Error Warning
ID
Error Warning Message

Description

EID-2147

This is a security violation.
You may only change your own account.

You cannot change an account other than
your own.

EID-2148

This is a security violation.
You cannot delete the account under which you are currently
logged in.

You cannot delete the account you are
currently logged in.

WID-2149

There is no exportable content in this view.

Refer to the error message text.

WID-2150

The node {0} is not initialized.
Please wait and try again.

Wait till the specified node is initialized and
try again.

WID-2152

Spanning tree protection is being disabled for this circuit.

Refer to the warning message text.

WID-2153

Adding this drop will make the circuit a PCA circuit.

Refer to the warning message text.

WID-2154

Monitor circuits cannot be created on a port grouping circuit.

Refer to the warning message text.

WID-2155

Switch counts might not be fully supported on some nodes.
{0}

The specified nodes do not support switch
counts completely.

WID-2156

The manual roll mode is recommended for dual rolls.
For auto dual rolls, please verify that roll to facilities are in
service and error-free.

Refer to the warning message text.

WID-2157

The roll(s) cannot be completed.
{0}

CTC could not complete the roll because
the roll is destroyed, in an incomplete state,
in a TL1_roll state, is cancelled, or is not
ready to complete.

EID-2158

The roll mode is invalid.
{0}

There are two roll modes: auto and manual.
For a one-way circuit source roll, the roll
mode must be auto and for a one- way
circuit destination roll, the roll mode must
be manual.

EID-2159

The roll is not ready for completion.
{0}

The roll is not ready for completion.

EID-2160

The roll is not connected.
{0}

Refer to error message text.

EID-2161

The sibling roll is not complete.
{0}

One of the rolls is not completed for the
dual roll. If it is auto roll, it will be
completed when a valid signal is detected.
If it is a manual roll, you must complete the
roll from CTC if Bridge and Roll is
operated from CTC, or from TL1 if Bridge
and Roll is operated from TL1.

EID-2162

An error occurred during roll acknowledgement.
{0}

Refer to the error message text.

EID-2163

The roll cannot be canceled.
{0}

CTC cannot cancel the roll.

EID-2164

An error occurred during the roll.
{0}

CTC encountered a roll error.

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5
78-18342-02

4-11

Chapter 4

Table 4-1

Error Messages

Error Messages (continued)

Error Warning
ID
Error Warning Message

Description

WID-2165

The MAC address of the node {0} has been changed. All
circuits originating from or dropping at this node will need to
be repaired.

Repair the circuits that originate from or
drop at the specified node, with the new
MAC address.

WID-2166

The node cannot be inserted into the domain because it is not
initialized.

Initialize the node and proceed.

WID-2167

You have insufficient security privileges to perform this action. You do not have the privilege to perform
this action.

WID-2168

The following warnings surfaced while loading {0}.
{1}

WID-2169

One or more of the profiles selected do not exist on one or more The profile selected does not exist on the
of the nodes selected.
node. Select another profile.

WID-2170

The profile list on node {0} is full. Please delete one or more
profiles if you wish to add the profile.
{1}

The number of profile that can exist on a
node has reached the limit. To add a profile,
delete any of the existing profiles.

WID-2171

You have been logged out. Click OK to exit CTC.

Refer to the warning message text.

WID-2172

The CTC CORBA (IIOP) listener port setting of {0} will be
applied on the next CTC restart.

The Internet Inter-ORB Protocol (IIOP)
listener port setting for the CTC Common
Object Request Broker Architecture
(CORBA) will be applied on the next CTC
restart.

EID-2173

Select an alternate port, as the current port
The port is unavailable.
The desired CTC CORBA ({0}) listener port, {1}, is already in is either in use or you do not have enough
use or you do not have permission to listen on it. Please select permission on it.
an alternate port.

EID-2174

An invalid number was entered. Please check it and try again.

You entered an invalid firewall port number.
Try again.

WID-2175

An extension byte mismatch occurred.
{0}

There is a mismatch with the extension
byte.

WID-2176

Refer to the warning message text.
Not all spans have the same OSPF area ID.
This will cause problems with protection switching. To
determine the OSPF area for a given span, click on the span and
the OSPF area will be displayed in the pane to the left of the
network map.

WID-2178

Only one edit pane can be opened at a time. The existing pane
will be displayed.

Refer to the warning message text.

WID-2179

No update is available because the circuit has been deleted.

Refer to the warning message text.

EID-2180

The CTC initialization failed during step {0}.

CTC initialization has failed in the specified
step.

EID-2181

This link cannot be included because it originates from the
destination.

You must not include this link as it
originates from destination of a circuit. It is
against the path selection algorithm.

EID-2182

The value of {0} is invalid.

The value of the specified item is invalid.

CTC encountered warnings while loading
the alarm profile import file.
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Error Warning
ID
Error Warning Message

Description

EID-2183

The circuit roll failed.
Bridge and roll is not supported on VCAT circuits.

Refer to the error message text.

EID-2184

Spanning Tree Protocol cannot be enabled on some ports
because the ports have been assigned an incompatible list of
VLANs.
You can view the VLAN/Spanning Tree table or reassign the
Ethernet port VLANs.

Refer to the error message text.

EID-2185

The VLANs on some ports cannot be assigned because they are Refer to the error message text.
incompatible with the Spanning Tree Protocol.
You can view the VLAN/Spanning Tree table or reassign the
VLANs.

EID-2186

The software download failed on node {0}.

The software could not be downloaded onto
the specified node.

EID-2187

The ring name cannot exceed {0} characters.
Please try again.

You must shorten the length of the ring
name.

EID-2188

The nodes in this ring do not support alphanumeric IDs. Please The ring ID should not contain
use a ring ID between {0} and {1}.
alphanumeric characters, and must be in the
specified range.

EID-2189

The TL1 keyword "all" cannot be used as the ring name.
Please provide another name.

EID-2190

Adding this span will cause the ring to contain more nodes than You have reached the maximum number of
allowed.
nodes allowed.

EID-2191

The ring name must not be empty.

You must supply a ring name.

EID-2192

A valid route cannot be found for the circuit creation request.

CTC could not complete the circuit creation
request either because there are no physical
links, or the bandwidth of the available
links are already reserved.

EID-2193

A valid route cannot be found for the circuit drop creation
request.

Refer to the error message text.

EID-2194

A valid route cannot be found for the roll creation request.

Refer to the error message text.

EID-2195

The circuit VLAN list cannot be mapped to one spanning tree. Refer to the error message text.
You can view the VLAN/Spanning Tree table or reassign
VLANs.

EID-2196

CTC cannot be relaunched.
{0}

There is an error relaunching CTC.

EID-2197

A CORBA failure occurred. CTC cannot proceed.

There was a CORBA failure, and the task
cannot proceed. Verify the Java version.

EID-2198

CTC is unable to switch to the {0} view.

CTC is unable to switch to the specified
view.

EID-2199

Login failed on {0} {1}

The login failed on the specified tasks.

Refer to the error message text.
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Error Warning
ID
Error Warning Message

Description

EID-2200

Refer to the error message text.
CTC has detected a jar file deletion. The jar file was used to
manage one or more nodes. This CTC session will not be able
to manage those nodes and they will appear gray on the network
map. It is recommended that you exit this CTC session and start
a new one.

EID-2202

An intra-node DRI circuit must have two sources.

Intranode circuit must have two sources to
be a dual ring interconnect (DRI).

EID-2203

No member was selected.

You must select a member.

EID-2204

The number of circuits must be a positive integer.

The number of circuits cannot be zero or
negative.

EID-2205

The circuit type must be selected.

You must select a circuit type.

EID-2206

The profile cannot be autoselected. Please select profile(s) to
store and try again.

Refer to the error message text.

EID-2207

You cannot add this span. Either the ring name is too long (that Reduce the length of the ring name, or
is, ring name length is greater than {0}) or the endpoints do not remove the alphanumeric characters from
the end points.
support alphanumeric IDs.

EID-2208

This is an invalid or unsupported JRE.

The version of Java Runtime Environment
(JRE) is either invalid or unsupported.

EID-2209

The user name must be at least {0} characters long.

The user name must be at least of the
specified character length.

EID-2210

No package name was selected.

You must select a package name.

EID-2211

No node was selected for upgrade.

You must select a node for the upgrade.

EID-2212

A protected line is not provisionable.

The protected line cannot be provisioned.
Choose another line.

WID-2213

The current type or state of some drops does not allow the new The circuit state, specified by {0} cannot be
circuit state of {0} to be applied to them indirectly.
applied to the selected drops.

EID-2214

The node is disconnected. Please wait until the node
reconnects.

Refer to the error message text.

EID-2215

An error occurred while leaving the {0} page.

There was an error while leaving the
specified page.

EID-2216

An error occurred while entering the {0} page.

There was an error while entering the
specified page.

EID-2217

Some conditions could not be retrieved from the network view Refer to the error message text.

EID-2218

The bandwidth must be between {0} and {1} percent.

The bandwidth must be within the specified
parameters.

EID-2219

The protection operation failed. An XC loopback was applied
on the cross-connection.

As the protection operation failed, a
cross-connect (XC) loopback will be
applied on cross-connection.

EID-2220

The tunnel status is PARTIAL. CTC is not able to change it.
Please try again later.

Refer to the error message text.
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Error Warning
ID
Error Warning Message

Description

EID-2221

A valid route cannot be found for the unprotected to {0}
upgrade request.

Refer to the error message text.

EID-2222

One or more of the following nodes are currently part of a
four-fiber {0}. Only a single four-fiber {0} is supported per
node.
{1}

The nodes, specified by {1}, are already
part of a 4-fiber BLSR/MS-SPRing type
(specified by {0}).

EID-2223

Only one circuit can be upgraded at a time.

Refer to the error message text.

EID-2224

This link may not be included because it terminates on the
source.

Refer to the error message text.

EID-2225

A valid signal could not be detected while trying to complete
the roll.
{0}

Roll can be completed only when a valid
signal is detected. If not, the roll completion
may result in an error.

EID-2226

The circuit roll failed.
{0}

Refer to the error message text.

EID-2320

This VCAT circuit does not support deletion of its member
circuits.

You can not delete a circuit that is a member
of VCAT circuit.

EID-2321

An error occurred while deleting member circuits.
{0}

Refer to the error message text.

WID-2322

Not all cross-connects from selected circuits could be merged
into the current circuit. They might appear as partial circuits.

Refer to the warning message text.

EID-2323

The circuit roll failed.
Bridge and roll is not supported on monitor circuits.

A monitor circuit does not support Bridge
and Roll.

EID-2324

An error occurred during the circuit upgrade.
{0}

Refer to the error message text.

EID-2325

You have failed {0} times to unlock this session. CTC will exit The maximum amount of attempts to
after you click OK or close this dialog box.
unlock this session has been reached.

WID-2326

Currently, CTC does not support bridge and roll on circuits that Refer to the warning message text.
are entirely created by TL1. To continue with bridge and roll in
CTC, the selected circuits must be upgraded.
Is it OK to upgrade the selected circuits and continue the bridge
and roll operation?

WID-2327

Currently, CTC does not support bridge and roll on circuits that Refer to the warning message text.
are partially created by TL1. To continue with bridge and roll
in CTC, the selected circuits must be upgraded.
Is it OK to upgrade the selected circuits and continue the bridge
and roll operation?

EID-2328

An error occurred during the circuit reconfiguration.
{0}

The attempt to reconfigure the specified
circuit has failed.

EID-2329

{0} of {1} circuits could not be successfully created.

A few circuits could not be created.

EID-2330

An error occurred during circuit verification. The selected {0} The selected item, specified by {0}, is
is invalid!
invalid as per the details, specified in {1}.
{1}
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Error Warning
ID
Error Warning Message

Description

EID-2331

Deleting {0} might be service affecting.

Deleting the item can affect the service of
CTC.

EID-2332

A validation error occurred in row {0}.
Refer to the error message text.
{1} hold-off timer for {2} must be between {3}-10,000 ms, in
steps of 100 ms.

EID-3001

An Ethernet RMON threshold with the same parameters
Change a few parameters in an Ethernet
already exists. Please change one or more of the parameters and remote monitoring (RMON) threshold and
try again.
try again.

EID-3002

An error occurred while retrieving defaults from the node: {0} There was an error while retrieving the
defaults from the specified node.

EID-3003

The file {0} cannot be loaded.

CTC cannot load the specified file.

EID-3004

Properties cannot be loaded from the node.

Refer to the error message text.

EID-3005

NE update properties cannot be saved to the file {0}.

CTC cannot save the network element (NE)
update values to the specified file.

EID-3006

NE update properties cannot be loaded from the node.

Refer to the error message text.

EID-3007

An error occurred while provisioning the {0}.

There was a provisioning error for the
specified item.

EID-3008

This is not a valid card.

You cannot perform DWDM automatic
node setup (ANS) from the Card view.
Please navigate to the Node view and try
again.

EID-3009

No {0} was selected.

Select the specified item, for example,
VLAN, port, slot, etc.

EID-3010

A bidirectional optical link could not be created.

Refer to the error message text.

EID-3016

The subnet address is invalid.

Refer to the error message text.

EID-3017

The subnet address already exists.

Refer to the error message text.

EID-3019

The internal subnet address is incomplete.

Enter the complete internal subnet address.

EID-3020

The subnet address cannot be the same for both TSC cards.
The requested action is not allowed.

A node’s internal subnet must be different
from one another as each TSC is on separate
ethernet buses, isolated by broadcast
domains.

EID-3021

An error occurred while retrieving the diagnostics:
{0}

Refer to the error message text.

EID-3022

The requested action is not allowed.

The requested action is not allowed.

EID-3023

The low order cross-connect mode could not be retrieved.

Refer to the error message text.

EID-3024

The {0} cross-connect mode could not be switched.
CTC cannot switch the cross-connect mode
Please verify that the type and/or number of circuits
for the specified item, as the type or the
provisioned does not exceed the criterion for switching modes. number of circuits does not match with the
criterion for switching modes.

EID-3025

An error occurred while retrieving thresholds.

There was an error retrieving the thresholds.
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Error Warning
ID
Error Warning Message

Description

EID-3026

The send DoNotUse attribute cannot be modified.

You cannot modify the Send DoNotUse
field.

EID-3027

The SyncMsg attribute cannot be modified.

You cannot modify the SyncMsg field.

EID-3028

The port type cannot be changed.

You cannot change the port type.

EID-3029

Unable to switch to the byte because an overhead change is
present on this byte of the port.

Refer to the error message text.

EID-3031

An error occurred while hard-resetting the card.

There was an error while resetting card
hardware.

EID-3032

An error occurred while resetting the card.

There was an error while resetting the card.

EID-3033

The lamp test is not supported on this shelf.

Refer to the error message text.

EID-3035

The cross-connect diagnostics cannot be performed

Refer to the error message text.

EID-3036

The cross-connect diagnostics test is not supported on this
shelf.

The cross-connect diagnostics test is not
supported on this shelf.

EID-3039

An error occurred while changing the card type.

There was an error while changing the card.

EID-3040

The card type is invalid.

The selected card type is invalid.

EID-3041

An error occurred while applying changes.

CTC is unable to create a protection group.
Check if the protect port supports circuits, a
timing reference, SONET SDCC,
orderwire, or a test access point.

EID-3042

The flow control low value must be less than the flow control
high value for all ports in the card.

Refer to the error message text.

EID-3046

The flow control watermark value must be between {0} and
{1}, inclusive.

The flow control watermark value must be
between the two specified values.

EID-3047

The file {0} could not be read.
Please verify the name and try again.

Refer to the error message text.

EID-3048

There is no Cisco IOS startup configuration file available to
download.

CTC could not find the configuration file
for IOS startup.

EID-3049

The download cannot be done at this time because an update in Refer to the error message text.
progress.

EID-3050

An error occurred while trying to save the file to your local file Check whether the file already exists and
system.
cannot be over written, or there is a space
constraint in the file system.

EID-3051

The configuration file has a maximum size of {0} bytes.

The size of the configuration file should not
exceed the specified number of bytes.

EID-3052

An error occurred while saving the configuration file to the
TCC2/TCC2P.

Refer to the error message text.

EID-3053

The value of {0} must be between {1} and {2}.

The value of the item must be between the
specified values.

EID-3054

The provisioned input/output ports cannot be removed or
another user is updating the card. Please try to remove these
ports later.

Another user may be updating the card. You
can try again later.
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Error Warning
ID
Error Warning Message

Description

EID-3055

The soak maintenance pane cannot be created.

Refer to the error message text.

EID-3056

Defaults cannot be saved to the file {0}.

CTC cannot save the defaults to the
specified file.

EID-3057

Default properties cannot be loaded from the node.

Refer to the error message text.

EID-3058

The file {0} does not exist.

Refer to the error message text.

EID-3059

An error occurred while refreshing.

There was an error while refreshing.

EID-3060

The ALS recovery pulse interval must be between {0} seconds The automatic laser shutdown (ALS)
and {1} seconds.
Recovery Interval must be between the
specified range of seconds.

EID-3061

The ALS recovery pulse duration must be between {0} seconds The automatic laser shutdown (ALS)
and {1} seconds.
Recovery Duration must be between the
specified range of seconds.

EID-3062

An error occurred while setting values in the table.

Refer to the error message text.

EID-3064

This is not a G1000 card.

This card is not a G1000-4 card.

EID-3065

An error occurred while attempting to create this RMON
threshold:
{0}

You must wait some time before you try
again.

EID-3066

The sample period must be between 10 and {0}.

Refer to the error message text.

EID-3067

The rising threshold must be between 1 and {0}.

This is an invalid rising threshold entry. The
valid range is from 1 to the specified value.

EID-3068

The falling threshold must be between 1 and {0}.

This is an invalid falling threshold entry.
The valid range is from 1 to the specified
value.

EID-3069

The rising threshold must be greater than or equal to the falling Refer to the error message text.
threshold.

EID-3070

Error in data for ports {0} Exactly one VLAN must be marked CTC encountered data error for the
untagged for each port. These changes will not be applied.
specified ports. Only one VLAN should be
marked untagged for each port.

EID-3071

An error occurred while retrieving the learned address list.

Unable to retrieve the learned MAC address
from the NE.

EID-3072

An error occurred while clearing the learned address.

Failure attempting to clear the learned MAC
address from a specific card or Ether group.

EID-3073

An error occurred while clearing the selected rows.

Failure attempting to clear the learned MAC
address from a specific card or Ether group.

EID-3074

An error occurred while clearing the learned address list by {0}. Error encountered trying to clear the
learned MAC address from either a VLAN
or a port.

EID-3075

At least one row in the parameter column must be selected.

Refer to the error message text.

EID-3076

CTC lost its connection with this node. The NE Setup Wizard
will exit.

Refer to the error message text.

EID-3077

No optical link was selected.

Refer to the error message text.
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Error Warning
ID
Error Warning Message

Description

EID-3078

An optical link could not be created.

Refer to the error message text.

EID-3079

Defaults cannot be applied to the node. {0}

CTC cannot apply the defaults to the
specified node.

EID-3080

CTC cannot navigate to the target tab.
{0}

CTC cannot go to the specified target tab.

EID-3081

The port type cannot be changed.

Refer to the error message text.

EID-3082

The {0} extension byte cannot be changed.

You cannot modify the specified extension
byte.

EID-3084

An error occurred while retrieving laser parameters for {0}.

There is no card, or there was an internal
communications error when attempting to
get the laser parameters for the card.

EID-3085

No OSC Terminations were selected

Select an OSC termination and proceed.

EID-3086

One or more Osc terminations could not be created.

Refer to the error message text.

EID-3087

The OSC termination could not be edited.

Refer to the error message text.

EID-3088

No {0} card is present to switch.

No card of the specified type is available to
switch.

EID-3089

The {0} state cannot be used or changed when the {1} has
failed or is missing.

You cannot use or change the specified state
when the card is failed or missing.

EID-3090

The operation cannot be performed because the {0} is
{1}LOCKED_ON/LOCKED_OUT.

You cannot perform operation.

EID-3091

The operation cannot be performed because the protect card is
active.

Refer to the error message text.

EID-3092

The requested action cannot be applied because the service
state is invalid.

Select another service state and proceed.

EID-3093

The operation cannot be performed because the duplex pair is
{0}locked.

Refer to the error message text.

EID-3094

The operation cannot be performed because no cross-connect
redundancy is available.

You cannot perform the requested operation
on the cross connect card without having a
backup cross connect card.

EID-3095

The deletion failed because the circuit is in use

Refer to the error message text.

WID-3096

An internal communication error was encountered while
retrieving laser parameters.
This can happen when equipment is not present or when
equipment is resetting.
Check the equipment state and try to refresh the values again.

Refer to the warning message text.

EID-3097

The ring termination is in use.

The ring termination you are trying to
access is in use. Try after sometime.

EID-3098

No ring terminations were selected.

Select one of the ring terminations.

EID-3099

The entered key does not match the existing authentication key. Check the authentication key and reenter.
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Error Warning
ID
Error Warning Message

Description

EID-3100

An error occurred during authentication.

There was an error in authentication. Verify
that the key does not exceed the character
limit.

EID-3101

The DCC metric must be between 1 and 65535.

The DCC metric should be in the range of 1
to 65535.

EID-3102

The DCC metric is invalid.

There was an invalid DCC metric.

EID-3103

The IP address {0} is invalid}.

The IP address is invalid.

EID-3104

The router priority must be between 0 and 255.

The router priority should be in the range of
0 to 255.

EID-3105

The router priority is invalid.

The router priority is invalid.

EID-3106

The hello interval must be between 1 and 65535.

The hello interval should be in the range of
1 to 65535.

EID-3107

The hello interval is invalid.

The hello interval is invalid.

EID-3109

The dead interval must be between 1 and 2147483647.

The dead interval value must be between 1
and 2147483647.

EID-3110

The dead interval must be larger than the hello interval.

Refer to the error message text.

EID-3111

The LAN transmit delay must be between 1 and 3600 seconds. The LAN transit delay should be in the
range of 1 to 3600 seconds.

EID-3112

The transmit delay is invalid.

The transmit delay is invalid.

EID-3113

The retransmit interval must be between 1 and 3600 seconds.

The retransmit interval should be in the
range of 1 to 3600 seconds.

EID-3114

The retransmit interval is invalid.

The retransmit interval is invalid.

EID-3115

The LAN metric must be between 1 and 65535.

The LAN metric should be in the range of 1
to 65535.

EID-3116

The LAN metric is invalid.

The LAN metric is invalid.

EID-3117

If OSPF is active on the LAN, no DCC area IDs may be 0.0.0.0. Refer to the error message text.
Please change all DCC area IDs to non-0.0.0.0 values before
enabling OSPF on the LAN.

EID-3118

If OSPF is active on the LAN, the LAN area ID cannot be the
same as the DCC area ID.

LAN must be part of a different OSPF area
other than the DCC network.

EID-3119

An error occurred during validation.

CTC was unable to validate the values
entered by the user. This error message is
common to several different provisioning
tabs within CTC (examples include the
SNMP provisioning tab, the General>
Network provisioning tab, the Security >
Configuration provisioning tab, etc.).

EID-3120

No object of type {0} was selected for deletion.

Choose an object of the specified type to
delete.

EID-3121

An error occurred while deleting {0}.

There is an error deleting the item.
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Error Warning
ID
Error Warning Message

Description

EID-3122

No object of type {0} was selected to edit.

Choose an object of the specified type to
edit.

EID-3123

An error occurred while editing {0}.

There was an error editing the item.

EID-3124

The {0} termination is in use.
Delete the associated OSPF range table entry and try again.

Refer to the error message text.

EID-3125

No {0} terminations were selected.

No specified terminations are selected.

EID-3126

The {0} termination could not be edited.

CTC could not edit the specified
termination.

EID-3127

Orderwire cannot be provisioned because the E2 byte is in use Refer to the error message text.
by {0}.

EID-3128

The authentication key cannot exceed {0} characters.

The authentication key cannot exceed the
specified number of characters.

EID-3129

The authentication keys do not match!

Refer to the error message text.

EID-3130

An error occurred while creating the OSPF area virtual link.

CTC encountered an error while creating
the area virtual link.

EID-3131

An error occurred while creating the OSPF virtual link.

CTC encountered an error creating the
virtual link.

EID-3132

An error occurred while setting the OSPF area range: {0}, {1}, CTC encountered an error while setting the
false.
area range for the specified values.

EID-3133

The maximum number of OSPF area ranges has been exceeded. OSPF area ranges exceeded the maximum
number.

EID-3134

The area ID is invalid. Use the DCC OSPF area ID, LAN port
area ID, or 0.0.0.0.

Refer to the error message text.

EID-3135

The mask is invalid.

Refer to the error message text.

EID-3136

The range address is invalid.

The range address is invalid. Try again.

EID-3137

Your request has been denied because the timing source
information was updated while your changes were still
pending. Please retry.

Refer to the error message text.

EID-3138

The clock source for switching is invalid.

You have selected an invalid clock source.
Choose another clock.

EID-3139

A switch cannot be made to a reference of inferior quality.

Refer to the error message text.

EID-3140

A higher priority switch is already active.

You cannot switch the timing source
manually when a higher priority switch is
already active.

EID-3141

An attempt was made to access a bad reference.

Refer to the error message text.

EID-3142

No switch is active.

None of the switches are active.

EID-3143

An error occurred while creating the static route entry.

CTC encountered an error while a creating
static route entry.

EID-3144

The maximum number of static routes has been exceeded.

The number of static routes has exceeded its
limit.
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Error Warning
ID
Error Warning Message

Description

EID-3145

The RIP metric must be between 1 and 15.

The Routing Information Protocol (RIP)
metric should be in the range of 1 to 15.

EID-3146

The RIP metric is invalid.

Refer to the error message text.

EID-3147

An error occurred while creating the summary address.

There was an error while creating the
summary address.

EID-3148

No Layer 2 domain has been provisioned.

You must provision any one of the layer 2
domain.

EID-3149

The MAC addresses could not be retrieved.

Refer to the error message text.

EID-3150

The target file {0} is not a normal file.

The specified target file is not a normal file.

EID-3151

The target file {0} is not writable.

The target file is not writeable. Specify
another file.

EID-3152

An error occurred while creating the protection group.

CTC encountered an error creating
Protection Group.

EID-3153

The card cannot be deleted because it is in use.

Refer to the error message text.

EID-3154

An error occurred while provisioning the card:
CTC cannot {0} the card.

CTC cannot perform the task on the card.

EID-3155

An error occurred while building the menu.

CTC encountered an error building the
menu.

EID-3156

An error occurred while building the menu.
Cards were not found for the {0} group.

CTC encountered an error while building
the menu, as cards could not be found for
the specified group).

EID-3157

The selected model could not be set because of an unexpected
model class: {0}.

CTC encountered an unexpected model
class while trying to complete the task.

EID-3158

Probable causes:
- Unable to switch, because a similar or higher priority
condition exists on a peer or far-end card.
- A loopback is present on the working port.

Refer to the error message text.

EID-31591

An error occurred while applying the operation.

CTC encountered an error while applying
this operation.

EID-3160

An error occurred while provisioning the {0}.

CTC encountered the specified error.

EID-3161

An error occurred while upgrading the ring.

An error was encountered while attempting
to upgrade the BLSR. Refer to the details
portion of the error dialog box for more
information.

EID-3162

This protection operation cannot be set because the protection
operation on the other side has been changed but not yet
applied.

Refer to the error message text.

EID-3163

The data in row {0} cannot be validated.

CTC cannot validate the data for the
specified row.

EID-3164

The new node ID ({0}) for ring ID {1} duplicates the ID of
node {2}.

The new specified node ID for the specified
ring ID is the same as another node ID.
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Error Warning
ID
Error Warning Message

Description

EID-3165

The ring ID provided is already in use. Ring IDs must be
unique.

Refer to the error message text.

EID-3166

An error occurred while refreshing the {0} table.

CTC encountered an error while refreshing
the specified table.

EID-3167

The slot is already in use.

Refer to the error message text.

EID-3168

An error occurred while provisioning.

An error was encountered while attempting
the specified provisioning operation. Refer
to the details portion of the error dialog box
for more information.

EID-3169

An error occurred while adding the card.

CTC encountered an error while adding the
card.

EID-3170

You cannot delete this card: {0}.

Refer to the error message text.

EID-3171

An error occurred while creating the trap destination.

CTC encountered an error creating the trap
destination.

EID-3172

No RMON thresholds were selected.

Select an RMON threshold.

EID-3173

The contact ''{0}'' cannot exceed {1} characters.

The specified contact exceeds the specified
character limit.

EID-3174

The description ''{0}'' cannot exceed {1} characters.

The specified location exceeds the specified
character limit.

EID-3175

The operator identifier ''{0}'' cannot exceed {1} characters.

The specified operator identifier exceeds
the specified character limit.

EID-3176

The operator specific information ''{0}'' cannot exceed {1}
characters.

The specified operator specific information
exceeds the specified character limit.

EID-3177

The node name cannot be empty.

The specified name is empty.

EID-3178

The node name ''{0}'' cannot exceed {1} characters.

The specified name exceeds the specified
character limit.

EID-3179

The protect card is in use.

Refer to the error message text.

EID-3180

The 1+1 protection group does not exist.

Create a 1+1 protection group.

EID-3181

The Y-cable protection group does not exist.

Refer to the error message text.

EID-3182

The topology element is in use and cannot be deleted as
requested.

You cannot delete the topology element
which is in use.

EID-3183

An error occurred while deleting the protection group.

CTC encountered an error while deleting
the protection group.

EID-3184

No {0} was selected.

You must select an item before completing
this task.

EID-3185

This ring has an active protection switch operation and cannot Refer to the error message text.
be deleted at this time.

EID-3186

The node is busy: {0} is {1} and cannot be deleted as requested. The request cannot be completed.

EID-3187

An error occurred while deleting the trap destination.

CTC encountered an error deleting the trap
destination.
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Error Warning
ID
Error Warning Message

Description

EID-3188

An error occurred during authentication. The password entered The password you entered is invalid. Enter
is invalid.
the password again.

EID-3189

The sum of the {0} must be between {1} and {2}.

Refer to the error message text.

EID-3214

The number of high order circuits for the line could not be
retrieved.

The number of High Orders (STS/STM) for
the line is not available.

EID-3215

An error occurred while refreshing.

Used frequently in pane classes to indicate
a general error condition when trying to
refresh from the model.

EID-3216

The proxy port is invalid.

Refer to the error message text.

EID-3217

The statistics could not be refreshed.

CTC could not refresh statistics values.

EID-3218

The automatic node setup could not be launched.

Refer to the error message text.

EID-3219

The automatic node setup information could not be refreshed.

Failure trying to retrieve automatic node
setup information.

EID-3220

An error occurred while refreshing row {0}.

Error refreshing the specified row.

EID-3222

The statistics could not be cleared.

Refer to the error message text.

EID-3225

An error occurred while refreshing the pane.

Used frequently in pane classes to indicate
a general error condition when trying to
refresh from the model.

EID-3226

The {0} termination(s) could not be deleted.
{1}

Refer to the error message text.

EID-3227

A baseline could not be recorded. Performance metrics will
remain unchanged.

CTC failed to set the baseline values while
provisioning NE. Previous values remain
unchanged.

EID-3228

The {0} termination(s) could not be created.
{1}

Refer to the error message text.

EID-3229

RIP is active on the LAN. Please disable RIP before enabling
OSPF.

Turn off the Routing Information Protocol
(RIP) on the LAN, before enabling OSPF.

EID-3230

OSPF is active on the LAN. Please disable OSPF before
enabling RIP.

Turn off the OSPF on the LAN before
enabling RIP.

EID-3231

An error occurred while setting the OPR.

An error was encountered while attempting
to provision the optical power received
(OPR).

WID-3232

The port state cannot be indirectly transitioned because the port Edit the port state while provisioning the
port.
is still providing services.
If the port state should be changed, edit it directly through port
provisioning.

EID-3233

The current loopback provisioning does not allow this state
transition.

Refer to the error message text.

EID-3234

The current synchronization provisioning does not allow this
state transition.

You cannot transition the port state to the
target date while in the current
synchronization state.
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ID
Error Warning Message

Description

EID-3235

The requested state transition cannot be performed on this
software version.

Refer to the error message text.

EID-3236

The database restore failed. {0}

CTC failed to restore the specified
database.

EID-3237

The database backup failed. {0}

CTC failed to backup the specified
database.

EID-3238

The send PDIP setting on {0} is inconsistent with the setting on The send payload defect indicator path
the control node {1}.
(PDI-P) setting on the specified item should
be consistent with that of the specified
control node.

EID-3239

The overhead termination is invalid

Refer to the error message text.

EID-3240

The maximum number of overhead terminations has been
exceeded.

Overhead terminations have exceeded the
limit.

EID-3241

The {0} termination port is in use.

The specified termination port is in use.
Select another port.

EID-3242

An {1} exists on the selected ports.
Therefore, you must create the {0}s one by one.

The specified DCC already exists on the
selected port. You can create a DCC of
another type.

WID-3243

The port you have chosen as an {0} endpoint already supports The same port can not be used by multiple
DCCs.
an {1}. The port cannot support both DCCs. After the {0} is
created, verify that no EOC alarms are present and then delete
the {1} to complete the downgrade.

EID-3244

An {0} exists on the selected ports.
Therefore, you must create the {1}s one by one.

WID-3245

The port you have chosen as an {1} endpoint already supports The port selected as a DCC endpoint
already supports another DCC. Refer to the
an {0}. The port cannot support both DCCs. After the {1} is
created, verify that no EOC alarms are present and then delete warning message text.
the {0} to complete the upgrade.

EID-3246

The wizard was not able to validate the data.
{0}

CTC encountered an error.

EID-3247

An ordering error occurred. The absolute value should be {0}.

The absolute value entered was wrong.

EID-3248

The value for the parameter {0} is invalid.

CTC changed the incorrect parameter.

EID-3249

The voltage increment value is invalid.

Refer to the error message text.

EID-3250

The power monitor range is invalid.

Refer to the error message text.

EID-3251

The requested action could not be completed.
{0}

CTC could not complete the specified
action.

EID-3252

No download has been initiated from this CTC session.

Refer to the error message text.

EID-3253

The reboot operation failed. {0}

Refer to the error message text.

The specified DCC already exists on the
selected port. You can create a DCC of
another type.
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ID
Error Warning Message

Description

EID-3254

An error occurred during validation. {0}

The Cisco Transport Controller (CTC) was
unable to validate the values entered by the
user, specified by {0}. This error message is
common to several different provisioning
tabs within the CTC.

EID-3255

You cannot change the timing configuration because a
Manual/Force operation is in effect.

Refer to the error message text.

WID-3256

The timing reference(s) could not be assigned because one or
more of the timing reference(s):
- is already used and/or
- has been selected twice and/or
- is attempting to use the same slot twice.
Please verify the settings.

Refer to the warning message text.

EID-3257

Duplicate DCC numbers are not permitted. {0}.

CTC detected more than one occurrence of
the a DCC number. Remove one of them.

EID-3258

A software error occurred while attempting to download the
file.
Please try again later.

Refer to the error message text.

EID-3259

An error occurred while creating the FC-MR threshold.

You must create a Fibre Channel Multirate
(FC_MR) card threshold.

EID-3260

An error occurred while provisioning the internal subnet:
{0}

The specified internal subnet could not be
provisoned.

EID-3261

The port rate provisioning cannot be changed while circuits
exist on this port.

Refer to the error message text.

EID-3262

The port provisioning cannot be changed when the port status
is {0}.

You must provision the ports only when the
port is Out of Service.

WID-3263

You are using Java version {0}. CTC should run with Java
version {1}. It can be obtained from the installation CD or
http://java.sun.com/j2se/

CTC is being launched with the wrong
version of the JRE {0}. This version of CTC
requires a particular version of the JRE {1}.
The CTC and browser must be closed and
restarted to allow the correct Java version to
be loaded.

EID-3265

An error occurred while modifying the protection group.

Protection Group could not be modified.

EID-3266

Conditions could not be retrieved from the shelf or card view.

Refer to the error message text.

WID-3267

The XTC protection group cannot be modified.

Refer to the warning message text.

WID-3268

The filter entry is invalid. {0}

The specified entry is invalid.

WID-3269

Refer to the error message text.
The {0} operation was successfully initiated for {1} but its
completion status could not be obtained from the node. When
the node is accessible, check its software version to verify if the
{0} succeeded.

WID-3270

The file {0} does not exist.

The specified file does not exist.
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Error Warning Message

Description

WID-3271

The value entered must be greater than {0}.

The value entered must be greater than the
specified value.

WID-3272

An entry is required.

An entry is required to complete this task.

WID-3273

{0} already exists in the list.

The specified item already exists in the list.

WID-3274

A software upgrade is in progress.
Network configuration changes that result in a node reboot
cannot take place during a software upgrade.
Please try again after the software upgrade is done.

Refer to the warning message text.

WID-3275

Ensure that the remote interface ID and the local interface ID
on the two sides match.
(The local interface ID on this node should equal the remote
interface ID on the neighbor node and vice-versa).

Refer to the warning message text.

WID-3276

Both {0} and {1} exist on the same selected port.
{2}

The specified port has both SDCC and
LDCC.

WID-3277

The description cannot exceed {0} characters. Your input will
be truncated.

The input exceeds the character limit. The
value will be truncated to the maximum
character limit.

WID-3279

This card has been deleted. CTC will return to the shelf view.

CTC returns to node view.

WID-3280

ALS will not engage until both the protected trunk ports detect Refer to the warning message text.
LOS.

WID-3282

Refer to the warning message text.
Performing a software upgrade while TSC 5 is active could
result in a service disruption. It is recommended that you make
TSC 10 the active TSC by performing a soft reset of TSC 5. The
following ONS 15600s are currently unsafe to upgrade...

WID-3283

Before activating a new version, ensure that you have a
database backup from the current version.

Refer to the warning message text.

WID-3284

Reverting to an older version.

CTC is being reverted to an older version of
application.

WID-3285

Applying FORCE or LOCKOUT operations might result in
traffic loss.

Refer to the warning message text.

WID-3286

The ring status is INCOMPLETE. CTC cannot determine if
there are existing protection operations or switches in other
parts of the ring. Applying a protection operation at this time
could cause a traffic outage. Please confirm that no other
protection operations or switches exist before continuing.

Refer to the warning message text.

WID-3287

There is a protection operation or protection switch present on Refer to the warning message text.
the ring. Applying this protection operation now will probably
cause a traffic outage.

WID-3288

The status of this ring is INCOMPLETE. CTC will not be able Change the ring status to apply the change
to apply this change to all of the nodes in the {0}.
to all nodes in the ring type.

EID-3290

The specified provisionable patchcord(s) could not be deleted. Refer to the error message text.
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EID-3291

The revertive behavior cannot be changed because a protection Protection switch should not be active to
switch is active.
change the revertive behavior.

EID-3292

An error occurred while resetting the shelf.

CTC encountered an error while resetting
the node.

EID-3293

No such provisionable patchcords exists.

You are attempting to delete a provisionable
patchcord that does not exist. This happens
when multiple instances of CTC are
running and attempting to delete the same
provisionable patchcord concurrently.

EID-3294

No RMON thresholds are available for the selected port.

Refer to the error message text.

EID-3295

This card does not support RMON thresholds.

Refer to the error message text.

EID-3296

Buffer-to-buffer credit is only supported for Fibre Channel (FC) Refer to the error message text.
and FICON.

EID-3298

This interfaces does not support ALS auto restart.

Refer to the error message text.

EID-3300

Duplicate OSPF area IDs are not permitted.

OSPF area IDs should be unique.

EID-3301

The LAN metric cannot be zero.

Refer to the error message text.

EID-3302

The standby {0} is not ready.

Standby controller card is not ready.

EID-3303

The DCC area ID and {0} conflict.
{1}

DCC Area ID and ring type, specified by
{0}, conflict each other due to the details
specified by {1}.

EID-3304

The DCC number is out of range.

Enter a DCC number that is within the range

EID-3305

OSPF cannot be active on the LAN interface when the
backbone area is set on a DCC interface.

You cannot have the default OSPF area on a
DCC while OSPF is enabled on the LAN.

EID-3306

Ethernet circuits must be bidirectional.

Refer to the error message text.

EID-3307

An error occurred while creating a connection object at {0}.

CTC encountered an error at the specified
connection while creating the connection.

EID-3308

DWDM links can be used only for optical channel circuits.

Refer to the error message text.

EID-3309

The link was excluded because it was in the wrong direction.

The optical channel (circuit) does not allow
the specified link to be included because it
is in the wrong optical direction.

EID-3310

The DWDM link does not have wavelengths available.

Refer to the error message text.

EID-3311

The laser is already on.

Refer to the error message text.

EID-3312

The power setpoint cannot be changed.
{0} {1}

CTC cannot change the power setpoint. The
new setpoint would either make the
thresholds inconsistent or set the fail
threshold outside the range.

EID-3313

The offset cannot be modified because the service state of the
port is IS.

Refer to the error message text.

EID-3314

The requested action is not allowed.
The state value is invalid.

Refer to the error message text.
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Error Warning
ID
Error Warning Message

Description

EID-3315

This operation cannot be performed.

CTC is unable to perform operation.

EID-3316

The node side is invalid.

This task was applied to the wrong node
side.

EID-3317

The ring name is too long.

Reduce the number of characters in the
name.

EID-3318

The ring name is invalid.

The name you entered is illegal.

EID-3319

The wrong line was selected.

Select another line

EID-3320

The optical link could not be deleted.

CTC cannot delete the optical link.

EID-3321

This feature is unsupported by this version of software.

Refer to the error message text.

EID-3322

The equipment is not plugged in.

Plug-in the equipment and proceed.

EID-3323

The APC system is busy.

Automatic Power Control (APC) system is
busy.

EID-3324

There is no path to regulate.

There is no circuit path to regulate.

EID-3325

The requested action is not allowed.

Generic DWDM provisioning failure
message.

EID-3326

The input was invalid.

The input value is incorrect.

EID-3327

An error occurred while retrieving thresholds.

There was an error retrieving the thresholds.
This message is displayed only for the
OSCM/OSC-CSM line thresholds.

EID-3328

An error occurred while applying changes to row {0}.
The value is out of range.

There was an error applying the changes to
the specified row. The value is out of range.

EID-3330

Unable to switch to the byte because an overhead channel is
present on this byte of the port.

Refer to the error message text.

EID-3331

An error occurred while applying changes to the row.

Refer to the error message text.

EID-3334

Timing parameters on the protect port cannot be changed.

You cannot change timing parameters on
protect port.

EID-3335

The port type cannot be changed because the SDH validation
check failed. Check if this port is part of a circuit, protection
group, SONET DCC, orderwire, or UNI-C interface.

Refer to the error message text.

EID-3336

An error occurred while reading a control mode value.

The Control Mode must be retrieved.

EID-3337

An error occurred while setting a set point gain value.

The Gain Set Point must be set.

EID-3338

An error occurred while reading a set-point gain value.

The Gain Set Point must be retrieved.

EID-3339

An error occurred while setting a tilt calibration value.

The tilt calibration must be set.

EID-3340

An error occurred while setting expected wavelength.

The expected wavelength must be set.

EID-3341

An error occurred while reading expected wavelength.

The expected wavelength must be retrieved.

EID-3342

An error occurred while reading actual wavelength.

The actual wavelength must be retrieved.

EID-3343

An error occurred while reading actual band.

The actual band must be retrieved.

EID-3344

An error occurred while reading expected band.

The expected band must be retrieved.
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Error Warning
ID
Error Warning Message

Description

EID-3345

An error occurred while setting expected band.

The expected band must be set.

EID-3346

An error occurred while retrieving defaults from the node: {0}. There was an error retrieving defaults from
the specified node.

EID-3347

The file {0} cannot be loaded.

CTC cannot load the specified file.

EID-3348

Properties cannot be loaded from the node.

Refer to the error message text.

EID-3349

NE update properties cannot be saved to a file.

Check your file system for space constraint
or any other problem.

EID-3350

NE update properties cannot be loaded from the node.

Refer to the error message text.

EID-3351

The file {0} does not exist.

The specified file does not exist.

EID-3352

An error occurred while setting a value at {0}.

There was an error while setting the value at
the specified location.

EID-3353

No such interface is available.

The interface specified is not present in
CTC.

EID-3354

The specified endpoint is in use.

Select another endpoint that is not in use.

EID-3355

The specified endpoint is incompatible.

Refer to the error message text.

EID-3357

The connections could not be calculated.

Refer to the error message text.

EID-3358

An optical link model does not exist for the specified interface. Create an optical linkmodel for the
interface, and proceed.

EID-3359

Optical parameters could not be set for the node.

Refer to the error message text.

EID-3360

ANS cannot be performed.
Please check {0} parameter value.

Refer to the error message text.

EID-3361

The ring termination is in use.
An error occurred while deleting the ring termination.

You cannot delete a ring in use.

EID-3362

An error occurred while deleting the ring termination.

There was an error while deleting ring
termination.

EID-3363

No ring terminations were selected.

You must select a ring termination.

EID-3364

An error occurred while creating the ring ID.

There was an error while creating the ring
ID.

EID-3365

The OSC termination is in use.

Select another optical service channel
(OSC) which is not in use.

EID-3366

The OSC termination could not be deleted.

There was an error deleting the OSC
termination.

EID-3370

No optical link was selected.

You must select an optical link.

EID-3371

An error occurred while calculating the automatic optical link
list.

Refer to the error message text.

EID-3372

CTC attempted to access an OCHNC connection that has been CTC destroyed an external attempt to
destroyed.
access an optical channel network
connection.

EID-3375

The expected span loss must be set.

Refer to the error message text.
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Error Warning
ID
Error Warning Message

Description

EID-3376

The measured span loss could not be retrieved.

Refer to the error message text.

EID-3377

The wrong interface was used.

The interface used for the card is wrong.

EID-3378

This is a duplicate origination patchcord identifier.

The provisionable patchcord identifier to
the patchcord you are attempting to
provision is already in use by another
patchcord on the origination node.

EID-3379

This is a duplicate termination patchcord identifier.

The provisionable patchcord identifier to
the patchcord you are attempting to
provision is already in use by another
patchcord on the remote node.

EID-3380

The host cannot be found.

Refer to the error message text.

EID-3381

The maximum frame size must be between {0} and {1} and
may be increased in increments of {2}.

The frame size must be in the specified
range. This can increment by the specified
value.

EID-3382

The number of credits must be between {0} and {1}.

The number of credits must be between the
specified values.

EID-3383

The GFP buffers available must be between {0} and {1} and
may be increased in increments of {2}.

The GFP buffers must be in the specified
range. This can increment by the specified
value.

WID-3384

You are about to force the use of Secure Mode for this chassis. Refer to the warning message text.
You will not be able to undo this operation.
Is it OK to continue?

EID-3385

{0}. Delete the circuits and try again.

Refer to the error message text.

EID-3386

The transponder mode could not be provisioned:
{0}

The specified transponder mode cannot be
provisioned.

EID-3387

You must change port(s) {0} to an out-of-service state before All the card ports should be changed to
changing card parameters. Click “Reset” to revert the changes. out-of-service before changing the
parameters.

EID-3388

The card mode cannot be changed because the card has circuits. Refer to the error message text.

EID-3389

An error occurred while changing the card mode.

Refer to the error message text.

EID-3390

The port is in use.

Refer to the error message text.

EID-3391

The port rate cannot be changed because the port has been
deleted.

You cannot change the port rate of a card
that has been deleted.

WID-3392

The timing reference(s) could not be assigned because with
external timing, only a single protected, or two unprotected
timing references per BITS Out can be selected.
Please use the "Reset" button and verify the settings.

Refer to the warning message text.

WID-3393

The timing reference(s) could not be assigned because with line Refer to the warning message text.
or mixed timing, only a single unprotected timing reference per
BITS Out can be selected.
Please use the "Reset" button and verify the settings.
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ID
Error Warning Message

Description

EID-3394

An error occurred while refreshing the power monitoring
values.

Refer to the error message text.

EID-3395

The configuration is invalid.
{0}

CTC encountered an error in IP address, net
mask length, or default router, or a
restricted IIOP port was selected.

EID-3396

The configuration is invalid. The standby controller card is not The standby controller card should be a
a TCC2P card.
TCC2P card.

EID-3397

The file {0} is the wrong version.

The specified file is of wrong version.

EID-3398

The PPM cannot be deleted.

Refer to the error message text.

EID-3399

The PPM cannot be deleted because it has port(s) in use.

Remove the ports connected to the
Pluggable Port Module before it can be
deleted.

EID-3400

Unable to switch. A force to the primary facility is not allowed. Refer to the error message text.

EID-3401

{0} cannot be provisioned for the port while {1} is enabled.

The relationship between parameters {0}
and {1} are such that enabling either one,
prevents the provisioning of the other.

EID-3402

The switch request could not be completed.
The {0} card is not present or is not responding.
Try again after ensuring that the {0} card is present and is not
resetting.

Refer to the error message text.

EID-3403

The administrative state transition has not been attempted on
the monitored port.

Refer to the error message text.

EID-3404

The far end IP address could not be set on the {0} termination. Refer to the error message text.
The IP address cannot be:
loopback (127.0.0.0/8)
class D (224.0.0.0/4)
class E (240.0.0.0/4)
broadcast (255.255.255.255/32)
internal {1}

EID-3405

You cannot change card parameters with port {0} in {1} state.
Click "Reset" to revert the changes.

Refer to the error message text.

EID-4000

The {0} ring name cannot be changed now because a {0}
switch is active.

You cannot change the ring name because a
switch of the same ring type is active.

EID-4001

The {0} node ID cannot be changed now because a {0} switch You cannot change the ring ID because a
is active.
switch of the same ring type is active.
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Error Warning
ID
Error Warning Message

Description

WID-4002

CAUTION: Reverting to an earlier software release may result Refer to the warning message text.
in TRAFFIC LOSS and loss of connectivity to the node. It may
require onsite provisioning to recover.
If the node was running {0} before, reverting will restore the
{0} provisioning, losing any later provisioning. If the node was
running some other version, reverting will LOSE ALL
PROVISIONING.
{1}
{2}

EID-4003

The Cisco IOS console is disabled for the card in Slot {0}.

The card may not be an IOS-based card or it
may be rebooting.

EID-4004

An error occurred while canceling the software upgrade.

CTC encountered an error while cancelling
the software upgrade.

EID-4005

{0} encountered while performing a database backup.

CTC encountered the specified error during
database backup.

EID-4006

The file {0} does not exist or cannot be read.

Refer to error message.

EID-4007

The size of the file {0} is zero.

The size of the file that is being backed up
or restored is zero.

WID-4008

A software upgrade is in progress.
{0} cannot proceed during a software upgrade.
Please try again after the software upgrade has completed.

The specified action cannot be performed
during a software upgrade. You must try
after the upgrade process is completed.

EID-4009

{0} encountered while restoring the database.

CTC encountered the specified error while
restoring the database.

EID-4010

The operation was terminated because:
{0}

Refer to the error message text.

EID-4011

An error occurred during provisioning:
{0}

Refer to the error message text.

EID-5000

A valid route cannot be found for the tunnel change request.

Refer to the error message text.

EID-5001

The tunnel could not be changed.

Refer to the error message text.

EID-5002

The tunnel could not be restored and must be recreated
manually.

Refer to the error message text.

EID-5003

The circuit roll failed.
{0}

Refer to the error message text.

EID-5004

There is already one four-fiber {0} provisioned on the set of
There is already one 4F BLSR provisioned
nodes involved in {1}. The maximum number of four-fiber {0} on the set of nodes involved in the ring. The
rings has been reached for that node.
maximum number of 4F BLSR rings has
been reached for that node.

WID-5005

A non-zero hold-off time can violate switching time standards, Refer to the warning message text.
and should only be used for a circuit with multiple path
selectors.
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Error Warning
ID
Error Warning Message

Description

WID-5006

Warning: A different secondary {0} node should only be used
for DRI or open-ended path protected circuits.

You should use different secondary end
point only for DRI or open-ended path
protected circuits.

WID-5007

If you change the scope of this view, the contents of this profile Refer to the warning message text.
editor will be lost.

WID-5008

Please ensure that all the protection groups are in proper states Refer to the warning message text.
after the cancellation.

WID-5009

The circuit {0} is not upgradable.
No {1} capable {2}s are available at the node {3}.

No VT capable STSs are available at the
node.

EID-5010

The domain name already exists.

Refer to the error message text.

EID-5011

The domain name cannot exceed {0} characters.

You may have reached the maximum
number of characters.

WID-5012

The software load on {0} does not support the addition of a
node to a 1+1 protection group.

Refer to the warning message text.

EID-5013

{0} does not support the bridge and roll feature. Please select a The specified port does not support Bridge
different port.
and Roll.

EID-5014

An automatic network layout is already in progress.
Please wait for it to complete before running it again.

You must for the automatic network layout
to complete before running it again.

WID-5015

{0} cannot be applied to {1}.

You cannot apply the admin state operation,
specified by {0}, to port count, specified by
{1}.

EID-5016

An error occurred while attempting to provision the {0}.
{1}

CTC encountered an error while
provisioning the card.

EID-5017

Provisioning could not be rolled back. The {0} might be left in You may have to remove the BLSR
an INCOMPLETE state and should be manually removed.
manually as it was left incomplete.

EID-5018

{0} is a(n) {1} node and cannot be added to a(n) {2} network.

You cannot add the node {0} of type {1} to
the host node of type {2}. This prevents you
from hosting both SONET and SDH nodes
in the same session.

EID-5019

The manual path trace mode for this equipment does not
support an expected string consisting of all null characters.
Please change the expected string or the path trace mode.

The path trace mode does not support
strings that consist of null characters. You
must either change the expected string or
the path trace mode.

EID-5020

Software activation is in progress. Provisioning is not allowed. Refer to the warning message text.

EID-5021

Software activation is in progress. {0} is not allowed.

Refer to the error message text.

WID-5022

Warning: Ethergroup circuits are stateless (that is, always in
service).
The current state selection of {0} will be ignored.

Refer to the warning message text.

EID-5023

CTC cannot communicate with the node.
The operation failed.

CTC encountered a network
communication error. Connectivity between
CTC and the NE was disrupted, either
transiently or permanently.
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ID
Error Warning Message

Description

EID-5024

The overhead circuit will not be upgraded.

Refer to the error message text.

WID-5025

The path targeted for this switch request is already active. The Refer to the warning message text.
switch request can be applied, but traffic will not switch at this
time.

EID-5026

An ONS 15600 cannot serve as the primary or secondary node Refer to the error message text.
in a four-fiber {0} circuit. Please change your ring and/or node
selections so that an ONS 15600 is not chosen as the primary or
secondary node in this four-fiber {1} circuit.

WID-5027

The {0} Edit dialog box for the ring {1} has been closed due to Re-open the BLSR/MS-SPRing edit
significant provisioning changes. These changes might only be window to view the updated state of the
transitory, so you can reopen the {0} Edit dialog box to view the ring.
updated state.

WID-5028

Warning: This operation should only be used to clean up rolls
that are stuck. It might also affect completeness of the circuit.
Is it OK to continue with the deletion?

Refer to the warning message text.

EID-5029

A software downgrade cannot be performed to the selected
version while an SSXC card is inserted in this shelf. Please
follow the steps to replace the SSXC with a CXC card before
continuing the software downgrade.

Refer to the error message text.

EID-5030

A software downgrade cannot be performed at the present time. Try the software downgrade later.

WID-5031

Canceling a software upgrade during a standby TSC clock
acquisition might result in a traffic outage.

Refer to the warning message text.

EID-5032

An error occurred while accepting the load.

Refer to the error message text.

EID-5033

The profile could not be loaded.
An error occurred while decoding the characters.

CTC detected an error while decoding
characters and could not load the profile.

EID-5034

The profile could not be loaded.
An error occurred while trying to recognize the file format.

CTC detected an error and could not load
the profile.

EID-5035

The profile could not be loaded.
An error occurred while reading the file.

CTC could not read the file and is therefore
unable to load the profile.

EID-5036

The GNE hostname {0} is invalid.

The specified host name is invalid. CTC
could not resolve the host name to any valid
IP address

EID-5037

Provisionable patchcords cannot be created between
You must create provisionable patchcords
transponder trunk ports and multiplexer/demultiplexer ports on between transponder trunk ports and
the same node.
mux/demux ports that are on different
nodes.

EID-5038

Provisionable patchcords created between transponder trunk
ports and multiplexer/demultiplexer ports must use the same
wavelength:
{0} is not equal to {1}.

Wavelengths used by provisionable
patchcords for transponder trunk ports and
mux/demux ports must be the same.
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Error Warning Message

Description
Transmitter and receiver port wavelengths
are not equal. Provision the receiver and
transmitter wavelengths on transmitter and
receiver ports respectively.

EID-5039

Provisionable patchcords created between transponder trunk
ports and multiplexer/demultiplexer ports must use the same
wavelength:
{0} is not equal to {1}.
Please provision the {2} wavelength on {3}.

EID-5040

Provisionable patchcords created between OC3/OC12 ports and Refer to the error message text.
multiplexer/demultiplexer ports are not supported.

EID-5041

Provisionable patchcords created between gray OC-N trunk
ports and multiplexer/demultiplexer ports are not supported.

Refer to the error message text.

EID-5042

Provisionable patchcords created between OC-N trunk ports
and multiplexer/demultiplexer ports must use the same
wavelength:
{0} is not equal to {1}.

Wavelengths used by provisionable
patchcords for OC-N trunk ports and
mux/demux ports must be the same.

WID-5043

Warning: Only the line card was provisioned.
The wavelength compatibility check was skipped.

Refer to the warning message text.

EID-5044

Virtual links can be used only for OCH-Trail circuits.

Refer to the error message text.

EID-5045

The virtual link does not have wavelengths available.

Set wavelengths for the virtual link and
proceed.

WID-5046

Warning: if you select "Use OCHNC Direction," your circuit
will be limited to nodes prior to release 07.00.

Refer to the warning message text.

EID-5047

Provisionable patchcords created between OC3/OC12 ports are Refer to the error message text.
not supported.

EID-5048

Provisionable patchcords created between gray OC-N trunk
ports are not supported.

Refer to the error message text.

EID-5049

Provisionable patchcords created between gray OC-N trunk
ports and multiplexer/demultiplexer ports are not supported.

Refer to the error message text.

EID-5050

The element model could not be found.
{0}

The specified Element Model cannot be
located.

WID-5051

The port state cannot be indirectly transitioned because the port Refer to the warning message text.
aggregates OCHCC circuits: if the port state needs to be
changed, edit it directly through port provisioning.

EID-5052

The operation is not valid for the connection type.

You may have selected the incorrect switch.

EID-5053

The operation cannot be performed because the connection is
under test access.

Refer to the error message text.

EID-5054

The TL1 tunnel could not be opened. {0}

Refer to the error message text.

EID-5055

Some patchcords were not deleted. Patchcords cannot be
Refer to the error message text.
deleted if they are incomplete or support any circuits, or if the
nodes supporting them are not connected.

EID-5056

This PPC cannot be deleted because one or more circuits are
provisioned over it.

Remove the circuits provisioned over the
provisionable patchcord before trying to
delete it.
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Error Warning Message
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EID-5057

The addition of the last node has not yet finished.
Please wait before trying to add a new node.

Refer to the error message text.

EID-5058

An OCHNC upgrade is applicable only to bidirectional circuits. Refer to the error message text.

EID-5059

The OCHNC upgrade failed.
One or more communication failures occurred during the
operation.

CTC encountered a complete failure while
upgrading optical channel network
connection.

EID-5060

The OCHNC upgrade partially failed.
One or more communication failures occurred during the
operation.
Create the OCHCC manually.

CTC encountered a partial failure while
upgrading an optical channel network
connection.

EID-5061

The overhead circuit source and destination must reside on the Refer to the error message text.
same shelf.

EID-5062

A four-fiber {0} cannot be created using three cards.

WID-5063

The profile "{0}" includes a change to the OPEN-SLOT alarm Refer to the warning message text.
severity.
This change is disallowed for the ONS 15600. "{1}" will
continue to use the OPEN-SLOT severity of MN that is
included in the default configuration.
Other changes from the "{2}" profile were successfully applied
to {3}".

EID-5064

{0}

A four-fiber BLSR needs four cards.

This indicates the status of path protection
switching.

{1}
WID-5065

Refer to the warning message text.
If you apply routing constraints to more than {0} nodes,
performance might be affected and the operation might require
more time than expected.
Select Yes if you intend to proceed in spite of this risk, or No if
you prefer to review your selection.

WID-5066

The routing constraints will be lost.
Are you sure you want to reset your changes?

Refer to the warning message text.

WID-5067

The routing constraints will be lost.
Are you sure you want to leave this panel?

Refer to the warning message text.

EID-5068

The routing constraints could not be applied.

Refer to the error message text.

EID-5069

A source node cannot be added to either of these lists.

Select a node other than the source node to
add to the route.

EID-5070

A destination node cannot be added to either of these lists.

Select a node other than the destination
node to add to the route.

EID-5071

This node already belongs to one of these lists.

The node is already selected either in
include or exclude list in the OCH circuit.

EID-5072

An OCH-Trail tunnel link was found but without any associated Create an OCH-Trail circuit associated with
circuit.
the link.

EID-5073

You are creating an unprotected link from a protected port.
Do you want to continue?

Refer to the error message.
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Error Warning Message
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EID-5074

Deleting OCH DCN circuits will cause a loss of connectivity to Refer to the error message.
nodes in the circuit path that do not have other DCN
connections.
Do you want to continue?

EID-5075

The VLAN ID must be a number between 1 and 4093.

Enter a number between 1 and 4093.

EID-5076

An error occurred while provisioning the VLAN ID.
The VLAN ID is already present in the current profile

Select a VLAN ID that is not present in the
current profile.

EID-5077

An error occurred while provisioning the VLAN database
profile.
{0}

CTC could not save the VLAN profile to the
file name mentioned.

EID-5078

The VLAN merge is not complete.
You forgot to fill {0} record(s).

Fill in the number of records specified and
then proceed.

EID-5079

An error occurred while validating the provisionable patchcord. Refer to the error message text.

EID-5080

No rolls are available.

You cannot delete a roll without selecting a
roll.

EID-5081

An error occurred while tracing the RPR ring:
{0}

The circuit reference is invalid.

EID-5082

{0} does not support:
- Low-order circuits that have both {1}-protected and
{2}-protected spans and that cross a node that does not have
low-order cross-connect capability.
- High-order circuits that carry low-order circuits with the
parameters described above.

Refer to the error message text.

EID-5083

This circuit is not the same size as the existing circuit {0}.
This circuit has size {1} and the existing circuit has size {2}.

During an RPR circuit creation ML card,
the new circuit size and the existing circuit
size must be the same.

EID-5084

The Trunk model could not be found.
{0}

The trunk specified is not found.

EID-5085

The maximum number of VLAN DB profiles is {0}.

Refer to the error message.

EID-5086

The circuit roll failed.
Refer to the error message.
You cannot bridge and roll the selected circuit because it has a
monitor circuit.

EID-5087

You cannot use same slot for east working and west protect
ports.

Refer to the error message text.

EID-5088

You cannot use same slot for east working and west protect
ports.

Refer to the error message text.

WID-5089

The maximum number of circuits that can be deleted at a time Refer to the error message text
is 200.
Do you want to delete the first 200 circuits selected?

EID-5090

This operation cannot be completed.
The selected circuits have different state models;
please select circuits of the same type.

Refer to the error message text
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Error Warning
ID
Error Warning Message

Description

EID-5091

Some PPC terminations were not repaired.

Refer to the error message text

WID-5092

The TL1 encoding mode for the tunnel is being changed.
Do you want to modify the encoding?

Confirm if you really want to modify TL1
tunnel encoding.

EID-6000

This platform does not support power monitoring thresholds.

Refer to the error message text.

EID-6001

One of the XC cards has failures or is missing.

Check whether all the cross-connect cards
are installed and working.

EID-6002

One of the XC cards is locked.

Unlock the cross-connect card.

EID-6003

The OSC termination could not be created.
This ring ID is already assigned.

Enter a new ID for the ring.

EID-6004

A system reset cannot be performed while a BLSR ring is
provisioned on the node.

Remove the BLSR from the node and
continue with the reset procedure.

EID-6005

The timing references could not be assigned.
- Only two DS1 or BITS interfaces can be specified.
- DS1 interfaces cannot be retimed and used as a reference.
- BITS-2 is not supported on this platform.

Refer to the error message text.

EID-6006

Refer to the error message text.
The timing references could not be assigned.
- An NE reference can only be used if the timing mode is LINE.
- A BITS reference can only be used if the timing mode is not
LINE.
- A Line reference can only be used if the timing mode is not
EXTERNAL.

EID-6008

SF BER and SD BER are not provisionable on the protect line
of a protection group.

Refer to the error message text.

WID-6009

If autoadjust GFP buffers is disabled, GFP buffers available
must be set to an appropriate value based on the distance
between the circuit endpoints.

Refer to the warning message text.

WID-6010

If auto detection of credits is disabled, credits available must be Refer to the warning message text.
set to a value less than or equal to the number of receive credits
on the connected FC endpoint.

WID-6011

Ingress idle filtering should be turned off only when required to Refer to the warning message text.
operate with non-Cisco Fibre Channel/FICON-over-SONET
equipment.

EID-6012

The retiming configuration could not be changed because there You cannot change the timing configuration
are circuits on this port.
on this port unless the circuits on this port
are deleted.

EID-6013

The NTP/SNTP server could not be changed.

Refer to the error message text.

{1}
EID-6014

The operation failed because the reference state is OOS.

Change the Out-of-service state to Active.

EID-6015

The distance extension cannot be disabled if the port media type Refer to the error message text.
is FICON 1Gbps ISL or FICON 2Gbps ISL.
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Error Warning Message
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EID-6016

The card mode cannot be changed to Fibre Channel Line Rate
if the port media type is FICON 1Gbps ISL or FICON 2Gbps
ISL.

Refer to the error message text.

EID-6017

The destination of a {0} route cannot be a node IP address.

A node IP address cannot be the destination
for a static route.

EID-6018

The destination of a {0} route cannot be the same as the subnet Refer to the error message text.
used by the node.

EID-6019

The destination of a static route cannot be 255.255.255.255

EID-6020

The destination of a static route cannot be the loopback network Refer to the error message text.
(127.0.0.0/8).

EID-6021

The subnet mask length for a non default route must be between Length of subnet mask must be within the
8 and 32.
specified range.

EID-6022

The subnet mask length for a default route must be 0.

Refer to the error message text.

EID-6023

The destination of a {0} route cannot be an internal
network{1}.

The destination of a static route must not be
an internal network.

EID-6024

The destination of a {0} route cannot be a class D (224.0.0.0/4) The destination of a static route must not be
or class E (240.0.0.0/4) address.
a class D or class E address.

EID-6025

The destination of a {0} route cannot be a class A broadcast
address (x.255.255.255/8).

The destination of a static route must not be
a class A broadcast address. It should be
(xxx.0.0.0).

EID-6026

The destination of a {0} route cannot be a class B broadcast
address (x.x.255.255/16).

The destination of a static route must not be
a class B broadcast address.

EID-6027

The destination of a {0} route cannot be a class C broadcast
address (x.x.x.255/24).

The destination of a static route must not be
a class C broadcast address.

EID-6028

The destination of a {0} route cannot be the subnet broadcast
address associated with a node IP address.

The destination of a static route must not be
a subnet broadcast address of a node IP.

EID-6029

The next hop of a static route cannot be the same as the
destination of the route or an internal network{0}.

Static route must have the default route as
the next hop, and not destination of the
route or internal network.

EID-6030

The next hop of a static default route must be the provisioned
default router.

The default route is selected for networks
that do not have a specific route.

EID-6031

No more static routes can be created.

You have reached the maximum number of
static routes.

EID-6032

This static route already exists.

Refer to the error message text.

EID-6033

A previous operation is still in progress.

Another operation is in progress. You must
try after sometime.

EID-6035

The parent entity does not exist.

Refer to the error message text.

EID-6036

The parent PPM entity does not exist.

Create a parent entity for the PPM.

EID-6037

This equipment type is not supported.

CTC does not support this equipment.

The network address such as
255.255.255.255 is not valid. Enter a valid
address.
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Error Warning
ID
Error Warning Message

Description

EID-6038

The PPM port is invalid.

Refer to the error message text.

EID-6039

The card is part of a regeneration group.

Select another card.

EID-6040

Out of memory.

Refer to the error message text.

EID-6041

The port is already present.

Refer to the error message text.

EID-6042

The port is used as timing source.

Choose another port because the selected
port is being used as a timing source.

EID-6043

A DCC or GCC is present.

Refer to the error message text.

EID-6044

The card or port is part of protection group.

Refer to the error message text.

EID-6045

The port has overhead circuit(s).

Refer to the error message text.

EID-6046

The ITU-T G.709 configuration is not compatible with the data Refer to the error message text.
rate.

EID-6047

The port cannot be deleted because its service state is
OOS-MA,LPBK&MT.

To delete the port, you must change the port
state to OOS-DSBLD.

EID-6048

{0} is {1}.

The trunk port is in the wrong state to carry
out the action.

EID-6049

The card operating mode of {0} is not supported.

CTC does not support the mode of
operation requested on the card.

EID-6050

Some {0} terminations were not {1}d.
{2}

Refer to the error message text.

WID-6051

All {0} terminations were {1}d successfully.
{2}

Refer to the warning message text.

EID-6052

The authentication key can not be blank.

Enter an authentication key.

EID-6053

No more SNMP trap destinations can be created.

You have reached the maximum number of
SNMP trap destinations.

EID-6054

{0} is not a valid IP address for an SNMP trap destination.

The IP address specified is not a valid
receiver of SNMP traps.

EID-6055

The IP address is already in use.

Refer to the error message text.

EID-6056

The SNMP trap destination is invalid. {0}

The specified SNMP trap destination is
invalid. Choose another destination.

WID-6057

Changing the card mode will result in an automatic reset.

Refer to the warning message text.

EID-6058

The maximum number of IP-over-CLNS tunnels has been
exceeded.

Refer to the error message text.

EID-6059

The specified IP-over-CLNS tunnel already exists!

Specify another IP Over CLNS tunnel.

EID-6060

An error occurred while trying to {0} an IP-over-CLNS tunnel Refer to the error message text.
entry:
{1}.

EID-6061

An error occurred while deleting the IP-over-CLNS tunnel
entry.

CTC encountered an error while deleting
the IP Over CLNS tunnel entry.

EID-6062

The selected IP-over-CLNS tunnel does not exist.

Create a IP Over CLNS tunnel.
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Error Warning Message
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EID-6063

The selected router does not exist.

Create a router.

EID-6064

The MAA address list is full.

Refer to the error message text.

EID-6065

The selected area address is duplicated.

Enter another area address.

EID-6066

The primary area address cannot be removed.

Refer to the error message text.

EID-6067

The selected area address does not exist.

Choose another area address.

EID-6068

The IP-over-CLNS NSEL cannot be modified while there are
IP-over-CLNS tunnel routes provisioned.

You cannot change the NSEL address if
tunnels are provisioned.

EID-6069

The node is currently in ES mode. Only Router 1 can be
provisioned.

An End System needs only one provisioned
router.

EID-6070

No router was selected.

Select a router.

EID-6071

The TARP data cache cannot be flushed.

You cannot flush the cache in the Tunnel
identifier Address Resolution Protocol
(TARP) state.

EID-6072

The TARP data cache entry cannot be added:
{0}

You cannot add the specified cache entry.

WID-6073

A TARP request has been initiated.
Try refreshing the TARP data cache later.

Refer to the warning message text.

EID-6074

End system mode only supports one subnet.

Refer to the error message text.

EID-6075

An error occurred while trying to remove a MAT entry. The
entry does not exist.

CTC is removing the MAT entry.

EID-6076

An error occurred while trying to {0} a TARP manual
adjacency entry:
{1}

CTC cannot add the specified adjacency
entry for reasons unknown.

EID-6077

The area address must be between 1 and 13 bytes long,
inclusive.

The area address should not be more than 13
characters.

EID-6078

A TDC entry with this TID {0} does not exist in the table.

The specified Tunnel Identifier does not
exist.

EID-6079

A TDC entry with this TID {0} could not be removed.
Please verify that TARP is enabled.

You must enable TARP to remove the TDC
entry.

WID-6080

Router {0} does not have an area address in common with
Router 1. Switching from IS L1/L2 to IS L1 in this case will
partition your network.

Refer to the warning message text.

EID-6081

The limit of 10 RADIUS server entries has been reached.

CTC does not allow more than 10 RADIUS
servers.

EID-6082

{0} cannot be empty.

The Shared Secrets field should not be
empty.

EID-6083

The entry you selected for editing has been altered by another
user. The changes cannot be committed.

Refer to the error message text.

EID-6084

The RADIUS server entry already exists.

Specify another RADIUS server entry.
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Error Warning Message

Description

WID-6085

Disabling shell access will prevent Cisco TAC from connecting Refer to the warning message text.
to the vxWorks shell to assist users.

EID-6086

The card cannot be changed because card resources are in use. The card you are trying to remove is being
used. Cannot change the card.

EID-6087

The card cannot be changed because the card type is invalid or Refer to the error message text.
incompatible.

EID-6088

This line cannot be put into loopback while it is in use as a
timing source.

Refer to the error message text.

EID-6089

The interface was not found. {0}

CTC cannot find the specified interface.

EID-6090

The interface type is not valid for this operation. {0}

Choose another interface.

EID-6091

The current state of the interface prohibits this operation. {0}

The port is in an invalid state to set a
loopback.

EID-6092

This operation is prohibited for this interface. {0}

CTC does not allow this operation for the
specified interface.

EID-6093

The maximum number of TARP data cache entries has been
exceeded.

You have exceeded the number of
characters permitted.

EID-6094

The maximum number of manual adjacency table entries has
been exceeded.

Refer to the error message text.

EID-6095

The AIS/Squelch mode is invalid.

Refer to the error message text.

EID-6096

A default IP-over-CLNS tunnel route is only allowed on a node Refer to the error message text.
without a default static route and a default router of 0.0.0.0.

EID-6097

The authorization key does not comply with Cisco IOS
password restrictions.
{0}

Specify another authorization key.

EID-6098

A default static route is not allowed when a default
IP-over-CLNS tunnel exists.

Refer to the error message text.

EID-6099

You cannot create a subnet on a disabled router.

Create the subnet on an active router.

WID-6100

Disabling a router that has a provisioned subnet is not
recommended.

Refer to the warning message text.

EID-6101

The MAT entry already exists.

Refer to the error message text.

WID-6102

The new card has less bandwidth than the current card. Circuits Refer to the warning message text.
of size VT15 and larger will be deleted.

EID-6103

The TDC entry already exists.

Specify another entry for TARP Data
Cache.

EID-6104

APC ABORTED.

Automatic Power Control is aborted.

EID-6105

The 'Change Card' command is valid for MRC cards only when Refer to the error message text.
Port 1 is the sole provisioned port.

EID-6106

To delete all RADIUS server entries, RADIUS authentication
must be disabled.

Disable Radius authentication and proceed.
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EID-6107

The node failed to restart the TELNET service on the selected Refer to the error message text.
port. Try using another unreserved port that is not being used
within the following ranges:
23, 1001-9999 (with the exception of 1080, 2001-2017, 2361,
3081-3083, 4001-4017, 4022, 4081, 4083, 5000, 5001, 7200,
9100, 9300, 9401).

EID-6108

That port is already in use.

EID-6109

A section trace is active on the trunk port. The action cannot be Actions such as putting the port in an
completed.
incomplete state are not permitted while a
section trace is active.

EID-6110

The maximum number of TARP requests has been reached.

You have exceeded the maximum number
of TARP requests.

EID-6111

The card in Slot {0} cannot be removed from the protection
group while its traffic is switched.

Refer to the error message text.

EID-6112

An error occurred while adding a shelf: {0}

The shelf ID specified is invalid or already
exists, the equipment does not support
multishelf, the specified shelf position is
out of range, or the specified shelf position
is already in use.

EID-6113

An error occurred while deleting a shelf: {0}

One or more of the equipment modules
(provisioned virtual links, provisioned
server trails, provisioned protection groups,
or provisioned DCCs) in the shelf is
currently in use. Delete cards from all the
slots and try again.

EID-6114

The maximum number of supported shelves has already been
provisioned.

Refer to the error message text.

EID-6115

There are bad or duplicate shelf positions.
Valid rack numbers are {0} to {1}.
Valid rack positions are {2} to {3}.

Refer to the error message text.

EID-6116

CTC attempted to access an OCH-Trail connection that has
been destroyed.

Software has prevented an attempt to access
an OCH trail.

EID-6117

CTC attempted to access an OCH-Trail audit that has been
destroyed.

The resource cannot be accessed because it
is released or fully utilized.

WID-6118

The following slots are provisioned but do not have cards
installed:
{0}
CTC will assume they are ITU-T interfaces.

Refer to the warning message text.

EID-6119

The shelves could not be rearranged.
{0}

One of the following conditions is present:
duplicate shelf positions, invalid shelf
positions, or concurrent movement (two
CTC sessions are attempting to rearrange
the shelves at the same time.)

EID-6120

This equipment does not support multishelf.

Refer to the error message text.

Restart a TELNET session.
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WID-6121

This internal patchcord cannot be provisioned because the
endpoints have no compatible wavelengths.

The end points of an internal patchcord
should have compatible wavelengths.

EID-6122

The wizard could not be started.
{0}

CTC was unable to initiate the wizard due
to the specified reason.

EID-6123

The OSI request can not be completed successfully.

A communication failure occurred.

EID-6124

The ALS recovery pulse interval is invalid.

Refer to the error message text.

EID-6125

The ALS recovery pulse duration is invalid.

Refer to the error message text.

EID-6126

The current setting does not support the specified ALS mode.

Refer to the error message text.

EID-6127

All enabled routers are required to have the same area.

Refer to the error message text.

EID-6128

A software download is in progress. Configuration changes that Refer to the error message text.
result in a card reboot cannot take place during a software
download.
Please try again after the software download is done.

EID-6129

The payload configuration and card mode are incompatible.

Refer to the error message text.

EID-6135

A DCC is present.

A data communication channel (DCC)
already exists.

EID-6136

An error occurred during provisioning: {0}

CTC was not able to provision the specified
port or card.

EID-6137

Multishelf cannot be disabled.
{0}

Multishelf is not supported on equipment, is
already disabled, or modules on the shelf
are currently in use.

EID-6138

The LAN configuration is invalid.

Verify the LAN configuration.

EID-6139

Invalid card(s) are present.
Please remove all non-MSTP cards and try again.

Non-DWDM cards cannot be added to an a
DWDM node. Remove the cards.

EID-6140

The shelf identifier for a subtended shelf cannot be provisioned Refer to the error message text.
through CTC. It must be changed using the LCD.

EID-6143

The DHCP server could not be changed.

Refer to the error message text.

EID-6144

The port provisioning cannot be changed when the port media
is Undefined.

If the port is not pre-provisioned with the
type of media that is going to be inserted,
you cannot access any of the existing values
for the port.

WID-6145

OSPF on LAN should only be enabled when the LAN routers Refer to the warning message text.
run OSPF. Otherwise, the node will not be reachable from
outside its subnet.
RIP implementation only advertise routes in one direction to
connected routers. It does not learn or distribute routes
advertised by other routers.
Also note that enabling OSPF on the LAN will temporarily
cause the current list of static routes to stop being advertised to
remote nodes and only be used locally.
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WID-6146

Deleting the protection group while in a switched state might Refer to the warning message text.
cause a loss of traffic. It is recommended that you verify switch
states before proceeding.

EID-6147

The protection switch could not be performed.

A protection switch cannot be performed
during protection operations like manual
switch, lockout, and so on.

EID-6148

A server trail is present.

Refer to the warning message text.

EID-6149

The LAPD MTU size must be greater than or equal to the {0}
LSP buffer size {1}. Alternatively, you can decrease the {0}
LSP buffer size to {2}.

Refer to the error message text.

EID-6150

The value is out of range.

Enter a value that is within the range.

EID-6151

The minimum span loss must be less than the maximum span
loss.

Refer to the error message text.

EID-6152

The "Use NTP/SNTP Server" field is checked. Enter the
NTP/SNTP server IP address or server name.

Enter the NTP/SNTP server name. To leave
this field empty, uncheck the “Use
NTP/SNTP Server" and proceed.

EID-6153

The maximum frame size is invalid.

Refer to the error message text.

EID-6154

To combine unidirectional two-port provisioning and
autonegotiation on the same port, autonegotiation must be set
first.

Refer to the error message text.

EID-6155

Transponder mode cannot be provisioned with circuits on the
card.

Refer to the error message text.

EID-6156

The transponder configuration is invalid.

The transponder is not configured properly.

EID-6157

The watermark values are either out of range or inconsistent.

Enter valid watermark values.

EID-6179

The 1+1 protection group is not optimized.

Refer to the error message text.

EID-6196

The equipment has failed or is missing.

Operation is requested on a failed or
missing equipment.

EID-6197

Attributes cannot be changed when the port administrative state You cannot change the attributes when the
is {0}.
port is in the specified administrative state.

WID-6204

This action will cause the node to reboot. When provisioning in Refer to the warning message text.
single-shelf mode, Shelf {0} of the node that you connect to
must be properly preprovisioned or you will lose traffic.
Use the LCD to return to single-shelf mode. CTC cannot be
used for this.
Changing from subtended shelf mode to single-shelf mode
could be traffic-affecting.

EID-6205

The interlink port is not provisioned.

EID-6206

The ADM peer group has already been created on the peer card. The user creates an ADM peer group
involving an ADM card inserted in a peer
group.

The user creates an ADM peer group
without interlink ports.
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EID-6207

This card is not in the ADM peer group.

The selected ADM card is not involved in
an ADM peer group.

EID-6208

The payload is not OTU2.

Refer to the error message text.

EID-6209

The side is already defined by the node.

During the creation of a side on node, a side
is already defined.

EID-6210

No side was selected.

The user requests an operation on a side, but
no side is selected.

EID-6211

The side was not deleted.

CTC could not delete the selected side
successfully.

EID-6212

One of the ports is connected to a patchcord or virtual link.

An operation on a port was not performed
because the port is connected to a patchcord
or a virtual link.

EID-6213

It is not possible to associate the side to the two ports.

During the creation of a side it is not
possible to associate the selected ports to
the new side.

EID-6214

The port is already assigned to a side.

The selected port is already assigned to a
side.

EID-6215

Error provisioning the CVLAN ID.
Enter a valid number or range between 0 and 4094.

The entered CVLAN ID was out of the
admitted range.

EID-6216

Changing card will reset the optical thresholds to the default
setting and may affect the optical connection.
The optical connection will work only if the optical
performance is compatible with {0} card.
Please check the network design.

Refer to the error message text.

EID-6217

You cannot delete the {0} {1}.

You cannot delete {0} {1} because it is part
of an ADM peer group or one or more
circuits are provisioned on it.

EID-6218

Invalid ethernet duplex value

the Ethernet duplex value is invalid. Enter
again.

EID-6219

Invalid committed info rate

The committed info rate value is invalid.
Enter again.

EID-6220

Invalid mode value

The mode value is invalid. Enter again.

EID-6221

Invalid mtu value

The MTU value is invalid. Enter again.

EID-6222

Invalid flow control value

The flow control value is invalid. Enter
again.

EID-6223

Invalid Network Interface Mode

The network interface mode value is
invalid. Enter again.

EID-6224

Invalid ingress COS value

The ingress COS value is invalid. Enter
again.

EID-6225

Invalid ethertype value

The Ethertype value is invalid. Enter again.
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Error Messages (continued)

Error Warning
ID
Error Warning Message

Description

EID-6226

Invalid buffer size value

The Buffer size value is invalid. Enter
again.

EID-6227

Invalid egress QOS value

The egress QOS value is invalid. Enter
again.

EID-6228

Invalid QinQ working Mode

The QinQ working mode is invalid. Enter
again.

EID-6229

Configured protection status Not Supported

The protection status is not supported

EID-6230

The number of provisioned entries exceeds the limit

Refer to the error message text.

EID-6231

This is not a valid VLAN ID.

Entered VLAN ID is not present in the
database file.

EID-6232

The VLAN remapping ID is not allowed.

Refer to the error message text.

EID-6233

The CVLAN is duplicated.

You cannot have identical CVLAN IDs.

EID-6234

The VLAN ID is out of range.

The VLAN ID entered is out of range.

EID-6235

This is not a valid VLAN name.

The entered VLAN name exceeds the
number of characters (32) allowed.

EID-6236

The protected VLAN number exceeds the maximum allowed.

The user enters more than 256 protected
VLAN in the VLAN database.

EID-6237

The port is not in OOS disabled admin state

Refer to the error message text.

EID-6238

The VLAN ID is in use.

The entered VLAN ID is in use by a node.

EID-6239

APC wrong node side.

Refer to the error message text.

EID-6240

You cannot change the Admin State for an interlink port when
it is part of an ADM peer group. This operation is not
supported.

Refer to the error message text.

EID-6242

The protection slot is invalid.

You must select a valid protection slot.

EID-6243

The {0} address of {1} is invalid.

Refer to the error message text.

EID-6244

The mask of {0} is invalid.

The mask of the specified value is not valid.

EID-6245

The cost must be between 1 and 32767.

Refer to the error message text.

EID-6246

The {0} address cannot be {1}.

Refer to the error message text.

EID-6247

The authentication type is invalid.

Enter a valid authentication type.

EID-6248

The cost must between 1 and 15.

Refer to the error message text.

EID-6249

The port has a cross-connect.

Refer to the error message text.

EID-6250

The reversion time is invalid.

The reversion time is invalid. Enter again.

EID-6251

Invalid Margin For Span Aging.
Value is not in the range 0 - 10.

Enter a value between 0 and 10.

EID-6252

The data cannot be retrieved because ANS parameters cannot
be calculated on the node in its current configuration.

Refer to the error message text.

EID-6253

Invalid Margin For Span Aging.

Refer to the error message text.
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Error Messages (continued)

Error Warning
ID
Error Warning Message

Description

EID-6254

SDH mode does not support timing references.

Timing reference is not supported by SDH
mode.

EID-6255

Only DS1 interfaces with ESF line types support timing
references.

Refer to the error message text.

EID-6256

sendDoNotUse and sendDoNotUseFF are mutually exclusive.

Refer to the error message text.

EID-6257

The termination is already in use.

Refer to the error message text.

EID-6258

The side is carrying services or traffic.

Refer to the error message text.

EID-6259

A pluggable module on Port 22 remains unmanaged.

Refer to the error message text.

EID-6260

Refer to the error message text.
You cannot delete this port.
There was a severe architectural error related to the index of the
pluggable trunk port object.
Please contact technical support for assistance.

EID-6261

This is not a valid VLAN ID. The VLAN database is empty.

The user adds a row without a valid VLAN
database loaded.

EID-6263

The equipment requires two slots.

The user provisions a double footprint card
in a single slot.

EID-6264

The patchcord is duplicated.

Refer to the error message text.

EID-6265

The wavelength is in use by an OCH trail, a virtual link, or an
internal patchcord.

Refer to the error message text.

EID-6266

The card cannot be changed because the port has not been
provisioned.

Refer to the error message text.

EID-6267

Each port can have a maximum of 8 MAC addresses.

Refer to the error message text.

EID-6268

This server trail does not have a valid start or end.

Refer to the error message text.

EID-6269

The maximum number of server trails is 3743.

Refer to the error message text.

EID-6270

A unique server trail ID could not be allocated.

Refer to the error message text.

EID-6271

The server trail already exists.

Refer to the error message text.

EID-6272

The server trail size must not exceed the port bandwidth.

Refer to the error message text.

EID-6273

An OCH Trail circuit is active on the trunk port.
Refer to the error message text.
To modify the ITU-T G.709 parameter, the circuit must be out
of service.

EID-6274

Unable to restore this database:
The user tries to restore a database on a
The software version cannot be obtained from the node. Please node, but its not possible to get the software
try again.
version from it.

EID-6275

You cannot change this parameter.
The port is part of an active circuit.

EID-6276

APC is disabled. APC Correction Skipped. Override cannot be Refer to the error message text.
performed.

Certain parameters like Port Rate and
Admin State cannot be changed when the
port is part is part of an active circuit.
Delete all the circuits on the port before
changing admin state of the port.
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Error Messages (continued)

Error Warning
ID
Error Warning Message

Description

EID-6277

There are no alarm conditions available to run APC Correction Refer to the error message text.
Skipped Override.

EID-6278

APC Correction Skipped Override is not supported for this
card.

Refer to the error message text.

EID-6279

Protection cannot be disabled when the FPAS alarm is active.

Refer to the error message text.

WID-6280

Any configuration change will be lost and the operation is
traffic affecting.

Refer to the error message text.

EID-6281

The port is involved in a protection group.
The protected port is not in the {0} administrative state

Change the port state to administrative.

WID-6282

Forcing FPGA update will be traffic-affecting.

Refer to the error message text.

WID-6283

Enabling ALS on a DWDM trunk port that is connected to a
channel filter
will result in a conflict with the ALS on the amplifier card or
with the
VOA startup process. Is it OK to continue?

Refer to the error message text.

WID-6284

Changing the timing standard will re-initialize the shelf timing Refer to the error message text.
and might affect traffic.
OK to continue?

WID-6285

Since you are changing the IP address of one node containing Refer to the error message text.
some PPC terminations,
you are also requested to run the PPC Repair tool in order to fix
the IP addresses stored
in the nodes connected by these PPCs

EID-6286

The port type cannot be changed because the port has been
deleted.

Refer to the error message text.

EID-6287

You cannot edit the {0} {1}.

Port rate of Optical and Electrical ports
cannot be changed while circuits are
provisioned on them.

EID-6288

The BERT configuration is invalid.

Refer to the eror message text.

EID-6289

The BERT mode is not yet configured

Refer to the error message text.

WID-6290

The BERT mode is configured in unframed format

Refer to the error message text.

WID-6291

Port has circuits; configuring the BERT mode will disrupt
normal traffic.

Refer to the error message text.

EID-6292

The alarm type name cannot exceed 20 characters

Refer to the error message text.

EID-6294

The alarm type name contains invalid characters.
Only the following characters are valid: 0-9, A-z, a-z and "-".

Refer to the error message text.

EID-6295

The alarm type is in use and cannot be deleted.

Refer to the error message text.

EID-6296

Maximum number of alarm types that can be added cannot
exceed 50.

Refer to the error message text.

EID-6297

Hard coded alarm types cannot be deleted.

Refer to the error message text.
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Error Messages (continued)

Error Warning
ID
Error Warning Message

Description

EID-6298

The alarm type already exists.

Refer to the error message text.

EID-6299

The alarm type does not exist.

Refer to the error message text.

EID-6300

Selective auto negotiation is allowed only when
selected speed and duplex modes are non-auto.
Click "Reset" to revert the changes.

Refer to the error message text.

WID-6301

Selective auto negotiation applies only to copper SFPs.

Refer to the error message text.

EID-6302

Users are not allowed to perform this operation.

When logged in as a maintainence user
provisioning operation is not allowed.

EID-6303

The ITU-T G.709 configuration cannot be disabled
when Fast Protection is enabled.

Refer to the error message text.

1. EID-3159 can appear if you attempt to perform another switching operation within a certain time interval. This interval is an algorithm of three seconds
per working card in the protection group. The maximum interval is 10 seconds.
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I N D EX

AIS-P

Numerics

2-27

AU-AIS
1+1 protection

2-37

AUTOSW-AIS

APS channel byte failure

2-32

APS invalid code condition

1+1 protection Force switch. See external switching
commands
2R logical object

2-14

AUTOSW-AIS-SNCP

2-33

optimized 1+1 APS primary facility condition

2-40

MS-AIS
2-34

2-161

ODUK-1-AIS-PM

2-165

ODUK-2-AIS-PM

2-166

ODUK-3-AIS-PM

2-166

ODUK-4-AIS-PM

2-167

ODUK-AIS-PM
OTUK-AIS

A

2-41

2-167

2-177

alarm logical objects
ADMIN-DISABLE

3-4

ADMIN-DISABLE-CLR
ADMIN-LOCKOUT

3-4

ADMIN-LOCKOUT-CLR
ADMIN-LOGOUT

index by alarm
3-4

2-14

alarm profiles, using to mask alarms
3-4

3-4

ADMIN-SUSPEND

list

2-16

alarms
alphabetical list

3-4

2-8

list of Critical alarms

2-2

ADMIN-SUSPEND-CLR

3-5

list of Major alarms

2-2

AICI-AEP logical object

2-14

list of Minor alarms

2-3

AICI-AIE logical object

2-14

masking with alarm profiles

AIP

states
logical object

2-14

MAC address location
MEA

2-155

replace

TL1
2-113

air filter

replacing

2-243
2-242

AIS

2-1

See also alarm troubleshooting
alarm troubleshooting
frequently used procedures

2-26

AIS-L

2-27

2-26 to 2-231
2-232 to 2-248

See also troubleshooting
ALS
ALS

AIS

2-24

alarm-specific procedures
2-243

inspecting

2-57

See also individual alarm names

2-246

cleaning

2-57

2-27

ALS-DISABLED

2-28

Auto Restart mode (illustration)

1-61
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disabling for the network

AUTOSW-PDI

1-68

system behavior in DISABLE mode
AMI coding

1-68

2-43

AUTOSW-PDI-SNCP
AUTOSW-SDBER

2-126

2-43

2-43

amplifier power control. See APC

AUTOSW-SDBER-SNCP

AMPLI-INIT

AUTOSW-SFBER

2-28

AOTS logical object
APC

2-45

AUTOSW-UNEQ (STSMON)

APC-CORR-SKIPPED
APC-DISABLED
APC-END

AUTOWDMANS

2-29

2-30

check mechanism

2-30

APSIMP

2-33

APS-INV-PRIM
2-34

AU-AIS

2-35

2-48

2-35

provisioning

1-26

BER
3-5

signal degrade condition

2-38

2-180

signal degrade PM condition

AUTOLSROFF

2-39

signal fail condition

automatic protection switching
byte failure

2-32

channel mismatch

2-32
2-34

path protection alarms

2-42, 2-44, 2-45

path protection switch (condition)
SNCP alarms

SNCP switch (condition)

2-43

2-43

2-40
2-40
2-40

AUTOSW-LOP-SNCP

2-170

verifying threshold level

2-240

2-41

1-54

BITS
daisy-chained
errors

AUTOSW-LOP (STSMON)

2-181

signal fail PM condition

bit errors

2-41

AUTOSW-AIS-SNCP

2-170

bit error rate. See BER

mode mismatch failure

AUTOSW-AIS

1-27

setting node defaults

2-37

AUTORESET

2-49

BBE thresholds

2-37

automatic reset

2-48

2-126

BAT-FAIL

2-35

AUD-ARCHIVE-FAIL
AU-LOP

2-47

B8ZS

APS-PRIM-SEC-MISM
AS-MT

AWG-FAIL

B

2-34

APS-PRIM-FAC
AS-CMD

2-47

AWG-WARM-UP

2-32

APSMM

AWG-DEG

2-46

3-5

AWG-OVERTEMP

1-74, 1-76

2-32

APSCM

2-45

AUTOSW-UNEQ-SNCP (VCMON-HP)

2-29

APC-OUT-OF-RANGE
APSB

2-44

AUTOSW-SFBER-SNCP

2-14

2-44

1-52

holdover timing

2-42

1-52

logical object

2-14

loss of frame

2-125

loss of signal

2-133

BKUPMEMP
2-42

1-53

2-49

blinking STAT LED

1-53

BLSR

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5

IN-2

78-18342-02

Index

BLSR-RESYNC transient condition
change node ID number
change ring name

deleting

2-232

BPLANE logical object

1-51

See also OCHNC circuits

2-14

CLDRESTART

2-50

browsers

2-57

cleaning the air filter

does not launch Java
reconfiguring
resetting

2-240

path-in-use error

2-233

2-243

clearing

1-38

1+1 Force or Manual switch

1-39

lock-on or lockout

1-42

stalls during download

1-44

supported in this release

1-36

unsupported in this release

2-236

MXP card loopbacks

2-241

MXP card signal loss

2-205

Netscape Navigator cache

1-37

2-234

1-45

STM-N card cross-connect loopback circuit

C
calculating IP subnets

TXP card loopbacks

2-241

TXP card signal loss

2-205

2-242

conditions

1-51

characteristics

cards
behavior during facility loopbacks
behavior during terminal loopbacks

1-3
1-5

2-23

list of Not Alarmed conditions

2-5

list of Not Reported conditions

2-8

See also individual condition names

removing

2-239

replacing

2-240

CONTBUS-DISABLED

reseating

2-239

CONTBUS-IO-A

2-58

resetting

2-237

CONTBUS-IO-B

2-60

See also DWDM cards

CRC

See also MXP cards

creating

2-58

2-49

RS-DCC terminations

2-242

See also TCC2P card

creating DCC terminations

2-241

See also TXP cards

Critical alarm list

See also TCC2 card

2-2

cross-connect loopback

CARLOSS
CARLOSS (EQPT)

2-51

clearing

2-242

CTC

CARLOSS (FC)

2-52

CARLOSS (GE)

2-53

applet not loaded

CARLOSS (ISC)

2-54

deleting cache files

CARLOSS (TRUNK)
CASETEMP-DEG

2-242

2-241

generic procedures

2-155

verify node visibility

circuits
clearing an STM-N cross-connect loopback

2-232

manual span condition

BPV

3-5

2-55

CHANLOSS, description

1-46 to 1-47

1-48

launching to correct the core version build

2-56

CAT-5 cable, crimping

grey node icon

1-38

1-55
2-56

launch problems
list of alarms

1-49, 1-50

1-45

2-1
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log-in errors

disabling

1-38, 1-44, 1-50

loss of TCP/IP connection

ALS for the network

2-51

minimum workstation requirements
release interoperability problems
resetting a card in

VirusScan

1-36

slow operation or login problems

audience

1-45

username and password mismatch
CTNEQPT-MISMATCH

2-63

documentation

2-237

verifying PC connection

1-44

DISCONNECTED

1-49

xxxi

conventions

1-50

objectives

1-40

xxxii
xxxi

related to this book

2-61

cyclic redundancy checking. See CRC

DSP-COMM-FAIL
DSP-FAIL

2-63

2-64

DUP-NODENAME
DUP-SHELF-ID

database

restoring default settings
verify version

DBOSYNC

troubleshooting circuits with ITU-T G.709
monitoring 1-24

2-62

E
3-5

EHIBATVG

DCC

1-3

electrical cards

1-51

creating or verifying DCC terminations
creating RS-DCC terminations
deleting a DCC termination

2-66

EIAs, facility loopback test

2-68, 2-71, 2-162, 2-194

connection loss

2-241

2-242

2-110

verifying RS-DCC terminations

2-242

failure to switch condition
initiating a protection switch
ELWBATVG

2-77
2-234

2-66

ENCAP-MISMATCH-P
ENVALRM logical object

1-34

2-67
2-14

EOC

DCU
loss

2-15

3-5

DBRESTORE-FAIL

DCN tool

2-15

OCHNC-CONN alarm object

2-61

channel loss

2-230

OCH alarm object

1-35

2-246

DBBACKUP-FAIL

2-65

LED activity

2-62

data communications network. See DCN tool
DATAFLT

2-65

DWDM cards

2-62

out of synchronization

xxxii

2-64

DUP-IPADDR

D

memory exceeded

1-68

EOC

2-63

EOC-L

deleting
circuits

2-68

GCC-EOC

2-241

CTC cache files
DCC termination
designing IP subnets
diagnostics, retrieving

2-70

1-46 to 1-47
2-110
1-51
1-33

MS-EOC

2-92
2-161

EQPT
EQPT alarm
EQPT-DIAG

2-72
2-73

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5

IN-4

78-18342-02

Index

EQPT-MISS alarm
logical object

FAILTOSW (TRUNK)

2-73

FAILTOSW-HO

2-15

equipment failure

2-77

FAILTOSW-PATH

hardware failure on reporting card
missing fan-tray assembly

2-77

FAN

2-72

alarm

2-73

software or hardware failure on reporting card

2-78

logical object

2-73

2-15

ERFI-P-CONN

2-74

ERFI-P-SRVR

2-74

MEA

error messages

4-1 to 4-51

missing unit alarm

ESCON logical object
EXCCOL

fan-tray assembly

2-15

2-74

excess collisions

2-76

2-75

2-157

removing

2-244

replacing

2-245

reseating

2-244

2-73

EXERCISING-RING

3-6

FAPS

EXERCISING-SPAN

3-6

FAPS-CONFIG-MISMATCH

EXT

2-78
2-79

FC_MR-4 card

2-75

external switching commands

GFP client signal fail detected alarm

clear a BLSR switching command

clearing a 1+1 Force or Manual switch
clearing a lock-on or lockout
disabled condition

FC logical object

2-236
2-234

2-79

2-80

FEC

2-111

initiate a BLSR lockout

2-15

FC-NO-CREDITS
FDI

2-236

description

2-236

initiating a 1+1 Manual switch
initiating a 1:1 protection switch

1-29

provisioning thresholds

2-233

initiating a 1+1 protection switch

FEC-MISM

2-233
2-234

1-30

2-83

FE-FRCDWKSWBK-SPAN

2-81

initiating a lock-on

2-235

FE-FRCDWKSWPR-SPAN

2-81

initiating a lockout

2-235

FE-MANWKSWBK-SPAN

2-82

FE-MANWKSWPR-SPAN

2-83

EXT-SREF logical object

2-94

2-15

FEPRLF

2-84

fiber and cabling errors

F

1-54

fiber cut
detecting

facility loopback
card behavior
definition

fixing

1-3

1-66

restarting system after

1-2

performing on destination-node ports
performing on intermediate-node ports
performing on source-node ports

1-59 to 1-66

1-18
1-13

1-8

FAILTOSW
FAILTOSW (2R, EQPT, ESCON, FC, GE, ISC,
OCN/STMN) 2-75

fiber-optic connections
FIBERTEMP-DEG

1-54

2-85

firewall, invalid port number
FIREWALL-DIS
flash manager
flow rate

1-68 to 1-78

4-12

3-6

2-49

2-75
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FORCED-REQ

HIBATVG

2-85

FORCED-REQ-SPAN

2-96

HI-CCVOLT

2-86

2-97

forward error correction. See FEC

HI-LASERBIAS

FP-LINK-LOSS

HI-LASERTEMP

2-86

FRCDSWTOINT

2-87

HI-RXPOWER

FRCDSWTOPRI

2-87

HITEMP

FRCDSWTOSEC

2-98
2-99

2-100

HI-TXPOWER

2-87

FRCDSWTOTHIRD

2-97

2-101

HLDOVRSYNC

2-87

1-52, 2-102

FRCDWKSWBK-NO-TRFSW

3-6

HP-ENCAP-MISMATCH

FRCDWKSWPR-NO-TRFSW

3-6

HP-EXC

free run synchronization
FRNGSYNC
FSTSYNC

alarm

2-88

HP-RFI

1-53, 2-88

2-104
2-105

HP-TIM

2-88

FTA-MISMATCH

2-105

HP-UNEQ

2-89

2-103

2-106

G

I

G.709 monitoring. See ITU-T G.709 monitoring

I-HITEMP

2-108

GAIN-HDEG

2-89

ILK-FAIL

2-108

GAIN-HFAIL

2-90

improper card removal

2-109

GAIN-LDEG

2-91

IMPROPRMVL

GAIN-LFAIL

2-91

INCOMPATIBLE-SEND-PDIP

2-109

GBICs. See SFPs and XFPs

INCOMPATIBLE-SW

GCC-EOC

INHSWPR

2-92

GE logical object

GE-OOSYNC (FC, GE, ISC)
GE-OOSYNC (TRUNK)

2-92

2-93

GFP
encapsulation mismatch

2-67

1-49, 2-112

2-111

INHSWWKG

2-15

2-112

2-111

inspecting the air filter

2-243

installing
SFPs

1-57

XFPs

1-57

GFP-CSF

2-94

Internet Explorer, resetting as default browser

GFP-LFD

2-94

internode problems

GFP-UP-MISMATCH

2-95

network level
node level
interoperability

H

INTRUSION

alarm
HELLO

1-59

1-83
1-49
3-6

INTRUSION-PSWD

HD-DEG
2-102
2-96

INVMACADR

1-42

2-112, 3-7

2-113

IOSCFG-COPY-FAIL

3-7

IP address, retrieving unknown

1-41
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IP connectivity

traffic card after reset

IP address unknown
verifying (ping)

traffic card during reset

1-41

traffic card insertion

1-40

IP subnets

line coding

calculating

ISC logical object
ISIS-ADJ-FAIL

1-3

LMP

2-15

LMP-FAIL

2-115

ITU-T G.709 monitoring
common trouble scenarios
description

2-231

2-125

line interface unit

1-51

2-231

2-125

line framing

1-51

designing

2-231

1-30

2-120

LMP-SD

2-121

LMP-SF

2-122

LMP-UNALLOC

1-24

provisioning thresholds

lock initiation

1-27

2-123

2-233

lock-on. See external switching commands
lockout. See external switching commands

J

LOCKOUT-REQ

LOCKOUT-REQ (2R, EQPT, ESCON, FC, GE,
ISC) 2-124

Java
browser does not launch

1-38

LOCKOUT-REQ (TRUNK)

Java Runtime Environment. See JRE
reconfiguring Java Plug-in control panel

1-38

incompatibility
launch failure

1-48

2-125

LOF (TRUNK)
OTUK-LOF

1-48

2-126

2-179

suppressed TCAs

1-38

supported in this release
unsupported in this release

1-36
1-37

2-125

LOF
LOF (BITS)

JRE
compatibility by software release

2-124

LOGBUFR90

1-25, 2-126, 2-136, 2-145

2-127

LOGBUFROVFL

2-127

logical objects
index by alarm

L

list

lamp test

LAN cable, crimping

1-55

2-117

LASERBIAS-DEG

2-117

LASERBIAS-FAIL

2-118

LASEREOL

2-119

LED
blinking STAT LED
1-32

browser login does not launch Java

1-53

1-38

browser stalls when downloading JAR file
no DCC connection

1-51

slow CTC operation

1-45

username/password mismatch

2-118

LASERTEMP-DEG

testing

2-14

log-in errors

1-32

LASER-APR

2-16

1-50

LOGIN-FAILURE-LOCKOUT

3-7

LOGIN-FAILURE-ONALRDY

3-7

LOGIN-FAILURE-PSWD
LOGIN-FAILURE-USERID
LOGOUT-IDLE-USER

1-44

3-7
3-7

3-8
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LO-LASERBIAS

2-128

LO-LASERTEMP
LOM

2-128

loopback

LPBKTERMINAL (ISC)

2-152

LWBATVG

2-152

M

See also terminal loopback
LOP

MAC address

AU-LOP

2-38

CTC location

AUTOSW-LOP

2-42

AUTOSW-LOP-SNCP

invalid
2-42

MAN-REQ
2-131

LOS (2R)

2-132

LOS (BITS)

2-133

LOS (ESCON)
LOS (ISC)

2-133

MANSWTOINT

2-153

MANSWTOPRI

2-154
2-154

MANSWTOTHIRD

2-154

MANUAL-REQ-SPAN (2R, ESCON, FC, GE, ISC,
OCN/STMN) 2-154

2-135

LOS (TRUNK)

2-153

MANSWTOSEC

2-135

LOS (OTS)

2-2

2-153

MANRESET

LOS

2-247

2-113

Major alarm list

2-130

LO-RXPOWER

MANUAL-REQ-SPAN (TRUNK)

2-136

LOS-O

2-137

MANWKSWBK-NO-TRFSW

3-8

LOS-P

1-90, 1-92, 1-100

MANWKSWPR-NO-TRFSW

3-8

LOS-P (AOPTS, OMS, OTS)
LOS-P (OCH)

2-138

AIP

2-141

2-155

2-144

MEA (EQPT)

suppressed TCAs

1-25, 2-126, 2-136, 2-145

MEA (FAN)

2-157

MEA (PPM)

2-158

loss of pointer. See LOP
loss of pointer see LOP

MEM-GONE

LO-TXPOWER

MEM-LOW

2-146

MFGMEM

2-147

LPBKFACILITY (ESCON)

2-147

2-155

2-159
2-159
2-160

Minor alarm list

LPBKFACILITY

2-3

ML-Series Ethernet cards

LPBKFACILITY (FC)

2-148

C2 byte mismatched path

LPBKFACILITY (GE)

2-148

GFP client signal fail detected

LPBKFACILITY (ISC)

2-149

LPBKFACILITY (TRUNK)

2-67, 2-103
2-94

MS-AIS

2-149

condition

2-161

MS-DCC. See DCC

LPBKTERMINAL
LPBKTERMINAL (ESCON)
LPBKTERMINAL (FC)

2-155

MEA

LOS-P (TRUNK)

LPBKCRS

2-152

2-149, 2-152

See also facility loopback

LOP-P

2-151

LPBKTERMINAL (TRUNK)

2-129

alarms

LPBKTERMINAL (GE)

2-150

2-150

MS-DEG

2-161

MS-EOC

2-161
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MS-EXC
MS-RFI

OCHNC circuits

2-162

conditions after rebuild

2-162

MSSP-RESYNC

deletion alarm

3-8

MS-SPRing
far-end protection line failure
MT-OCHNC

2-84

2-164

errors in creating

1-78 to 1-83

failure conditions

1-79

failure scenarios

2-163

1-81

muxponder cards. See MXP cards

in partial state

MXP cards

partial (illustration)

clearing loopbacks

related alarms

1-4

performing a facility loopback on

1-8, 1-13, 1-18

performing a terminal loopback on
signal loss

1-11, 1-16, 1-21

TCAs suppressed by LOS and LOP alarms

1-25, 2-126,

2-136, 2-145

terminal loopback behavior

1-6

troubleshooting circuits with loopbacks
2-229

N

OCHNC-CONN logical object
OCHNC-INC

1-7

2-15

NE-SREF logical object
Netscape Navigator
clearing cache

1-45

limiting colors

1-42

OCH-TERM logical object
ODUK-1-AIS-PM

2-165

ODUK-2-AIS-PM

2-166

ODUK-3-AIS-PM

2-166

ODUK-4-AIS-PM

2-167

ODUK-AIS-PM

2-167

ODUK-BDI-PM

2-168

2-169
2-169

ODUK-SF-PM

2-170

ODUK-TIM-PM

2-171

1-25

network-level internode problems

1-59

OMS logical object

network view, unable to change to

1-43

OPEN-SLOT

NIC card

1-39

node ID, identify

2-15

2-171

optical channel layer. See OCH layer
2-232

optical drop power

node-level internode problems

1-83

node view, unable to change from
NON-CISCO-PPM

2-15

2-168

ODUK-SD-PM

OMS layer

2-15

2-165

ODUK-OCI-PM
2-15

1-78

2-164

ODUK-LCK-PM
NE logical object

1-80

2-164

OCHTERM-INC

2-205

wavelength mismatch

1-70

prerequisites for successful creation

2-241

facility loopback behavior

1-74

1-43

2-163

NOT-AUTHENTICATED

lower than expected, corrective action
lower than expected, description

1-98

optical multiplex section layer. See OMS layer
1-50, 2-164

optical power level
lower than expected

1-90, 1-92

lower than minimum allowed

O

1-100

1-85

optical transmission section layer. See OTS layer
OCH layer

1-24

OCH logical object

optical transport networks
2-15

OPTNTWMIS

1-24

2-172
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OPWR-HDEG

2-172

provisioning thresholds using TL1

OPWR-HFAIL

2-174

ping

1-37, 1-40, 2-206
2-186

OPWR-LDEG

1-91, 1-96, 1-99, 1-102, 2-175

PMI

OPWR-LFAIL

2-176

PM-TCA

OSC-RING logical object

3-8

PORT-FAIL

2-15

OSPF

1-28

2-187

power

Disable OSPF check box
HELLO alarm
2-176

OTS layer

1-25

low battery voltage alarm

2-96

OSPF, DCN tool
OSRION

equipment power failure alarms

2-242

power supply problems
power up problems

OTS logical object

PPM logical object

2-15

PROTNA

OTUK-BDI

2-177

provisioning

OTUK-IAE

2-178

BBE or SES thresholds

OTUK-LOF

2-179

FEC thresholds

2-187

1-27

1-30

OTUK-SD

2-180

ITU-T G.709 thresholds

OTUK-SF

2-181

optical TCA thresholds

OUT-OF-SYNC

1-57

2-15

2-177

1-27
1-29

PM thresholds using TL1

2-182

1-28

TXP card BBE or SES thresholds

2-182

TXP card ITU-T G.709 thresholds
PROV-MISMATCH

P

PS

PARAM-MISM

password/username mismatch

1-50

path protection configurations
AIS alarm

2-41

failed switch path
LOP alarm
PDI alarm
SD alarm

2-77

2-42

1-27
1-27

2-188

3-8

PTIM

2-183

2-228

1-59

OTUK-AIS

OTUK-TIM

2-153

mismatch between control cards

1-34

2-190 to 2-192

2-189

PWR-FAIL-A

2-190

PWR-FAIL-B

2-191

PWR-FAIL-RET-A

2-192

PWR-FAIL-RET-B

2-192

PWR logical object

2-15

2-43
2-44

signal failure alarm

R

2-44

PDI

reconfiguring
AUTOSW-PDI

AUTOSW-PDI-SNCP
PDI-P

browsers

2-43

Java Plug-in control panel

2-43

1-38

removing

2-184

PEER-NORESPONSE

1-39

cards

2-185

performance monitoring
ITU-T G.709 optical transport network

2-239

fan-tray assembly
1-25

2-244

SFP or XFP connectors

1-57
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TCC2/TCC2P cards

AUTOSW-SDBER-SNCP

2-238

replacing

MS-DEG (STM1E)

air filter
cards

ODUK-SD-PM

2-242

OTUK-SD

2-240

fan-tray assembly

2-161

2-169

2-180

SD (TRUNK)

2-245

2-197

SFPs

1-56

SDBER-EXCEED-HO

XFPs

1-56

SD-L

2-198

SD-P

2-199

reseating
cards

SDBER-EXCEED-HO

2-239

fan-tray assembly

2-199

incorrect password condition

2-238

resetting

2-113

invalid login username condition

active TCC2/TCC2P card
browsers
cards

invalid password condition

2-237

1-42

2-237

Internet Explorer as the default browser
restoring the node database

1-42

service-affecting alarms

2-24

SESSION-TIME-LIMIT

3-9

provisioning

1-35

setting node defaults

1-33

unknown node IP address

1-41

1-26

1-26

SF
AUTOSW-SFBER

2-192

2-44

ERFI-P-CONN

2-74

AUTOSW-SFBER-SNCP

ERFI-P-SRVR

2-74

MS-EXC (STM1E)

HP-RFI

2-105

ODUK-SF-PM

MS-RFI

2-162

OTUK-SF

2-193

SF (TRUNK)

RFI-P

2-193

SF-L

2-201

SF-P

2-202

RMON-RESET

3-8

2-162

2-170

2-200

SFPs

3-9

RS-DCC. See DCC

installing

RS-TIM

removing connectors

2-197

replacing
SFTWDOWN

S

1-57

2-203
3-9

SHELF-COMM-FAIL

safety

1-57

1-56

SFTWDOWN-FAIL

2-203

summary

2-25

SHELF logical object

warnings

xxxiv to xxxviii

SH-IL-VAR-DEG-HIGH

2-203

SH-IL-VAR-DEG-LOW

2-204

SD
AUTOSW-SDBER

2-45

2-181

RFI-L

RMON-ALARM

3-7

1-27

setting node defaults

diagnostics

3-6

SES thresholds

retrieving

RFI

2-199

security

2-244

TCC2/TCC2P cards

2-44

2-43

SHUTTER-OPEN

2-15

2-204
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SIGLOSS

SYNC-FREQ

2-205

SNCP

synchronization status messaging. See SSM

PDI alarm
SNTP-HOST

SYNCLOSS

2-43

SYNCPRI

2-205

span is gray in CTC

SPAN-NOT-MEASURED
SQUELCHED

2-215
2-216

SYNCSEC

1-68

SPANLEN-OUT-OF-RANGE

2-216

SYNCTHIRD

2-206

SYSBOOT

2-207

2-217

2-218

2-207

SSM
failure

2-214

T

2-209

quality level degrade

2-209

TCAs

SSM-DUS

2-209

common trouble scenarios

SSM-FAIL

2-209

ITU-T G.709 optical transport network

SSM-LNC

2-210

provisioning optical TCA thresholds

SSM-OFF

2-210

resolving BBE

SSM-PRC

2-210

suppressed by LOS and LOP alarms

SSM-PRS

2-211

2-145

SSM-RES

2-211

SSM-SMC

1-30

1-25, 2-126, 2-136,

TCC2 cards
activating standby

2-211

2-237

2-211

flash memory exceeded

SSM-ST3

2-212

JAR file download problem

SSM-ST4

2-212

power mismatch between

SSM-STU

2-212

removing

2-238

SSM-TNC

2-213

reseating

2-238

resetting

2-237

synchronization traceability alarm

2-212

2-62
1-44
2-228

TCC2P cards

STM-N cards
STM-64 temperature alarm

2-39

activating standby

2-237

flash memory exceeded

STSMON
AUTOSW-LOP

2-42

AUTOSW-UNEQ

2-45

power mismatch between
removing

2-238

switching

reseating

2-238

resetting

2-237

see automatic protection switching
see external switching commands
SW-MISMATCH

2-213

SWTDOWNFAIL

3-9

2-213
2-214

SWTOTHIRD

2-214

2-62

JAR file download problem

Sun systems. See UNIX

SWTOSEC

1-29

1-31

SSM-ST2

SWTOPRI

1-25

TCP/IP

1-44
2-228

1-40, 2-51

Telcordia
signal degrade definition
signal failure definition

2-197
2-200

standards applicable to this book

xxxii

temperature

Cisco ONS 15454 DWDM Troubleshooting Guide, R8.5

IN-12

78-18342-02

Index

fan-tray assembly alarm

2-78

manual switch to third source (condition)

high-temperature alarm

2-100

switch error

industrial high-temperature alarm
STM-64 alarm
TEMP-MISM

TL1

2-108

terminal loopback

alphabetical list

card behavior

2-221

states

1-5

performing on intermediate-node ports
performing on source-node ports
testing card LED lamps

3-1 to 3-3

characteristics

1-5

performing on destination-node ports

3-3

3-3

See also individual transient condition names

1-21

transients. See transient conditions

1-16

transponder cards. See TXP cards

1-11

troubleshooting

1-32

threshold crossing alert. See TCA

alarm characteristics

thresholds, provisioning BBE or SES

conditions

1-27

TIM

2-23

2-23

frequently used procedures

HP-TIM

general procedures

2-105

ODUK-TIM-PM
OTUK-TIM
PTIM

service effect

2-182

severities

1-1 to 1-104

2-24
1-7

See also alarm troubleshooting

2-218

See also loopback

2-219

TIM-P

2-220

TRUNK logical object

TIM-S

2-221

TX-LOF

timing alarms

2-16

2-224

TXP cards

free running synchronization

clearing loopbacks

2-88

2-241

loss of primary reference

2-216

facility loopback behavior

loss of tertiary reference

2-217

performing a facility loopback on

synchronization

1-4
1-8, 1-13, 1-18

performing a terminal loopback on

2-102

timing reference failure

provisioning FEC thresholds

automatic switch to secondary source
(condition) 2-214

1-27

1-30

provisioning ITU-T G.709 thresholds
signal loss

automatic switch to third timing source
(condition) 2-214

1-27

2-205

TCAs suppressed by LOS and LOP alarms

1-25, 2-126,

2-136, 2-145

2-110

terminal loopback behavior

manual switch to internal source (condition)

2-154

manual switch to primary source (condition)

2-154

manual switch to second source (condition)

1-11, 1-16, 1-21

provisioning BBE or SES thresholds

2-88

timing reference

changing

1-7

2-24

TXP circuit paths with loopbacks

2-197

TIM-MON

2-232 to 2-248

MXP circuit paths with loopbacks

2-171

2-189

RS-TIM
TIM

1-28

transient conditions

2-218

definition

1-52

TRAIL-SIGNAL-FAIL

2-39

2-154

1-6

troubleshooting circuits with loopbacks
wavelength mismatch

1-7

2-229

2-154
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VOA-LFAIL

U

VOLT-MISM
UNC-WORD

2-228

2-222, 2-223

UNEQ
AUTOSW-UNEQ (STSMON)
AUTOSW-UNEQ-SNCP
HP-UNEQ

2-45

2-46

W
warnings

2-106

definition

UNIX

xxxiv

Windows, minimum workstation requirements

incorrect colors

1-42

minimum requirements for CTC
UNQUAL-PPM
USER-LOGIN

1-36

2-224

USER-LOCKOUT

3-10

WKSWPR

3-10

WKSWPR (TRUNK)

3-9

WRMRESTART

3-10
1-50

2-225

WTR (TRUNK)
WTR-SPAN

2-225

3-10

X

variable optical attenuation. See VOA

XFPs

verifying

installing

3-10
2-229

1-57

BER threshold level

2-240

removing connectors

CTC PC connection

1-40

replacing

DCC terminations
IP connectivity

2-229

2-229

WVL-MISMATCH

V

2-228

2-228

WTR (2R, EQPT, ESCON, FC, GE, ISC)

username/password mismatch
UT-COMM-FAIL

WKSWBK

1-36

WKSWPR (2R, EQPT, ESCON, FC, GE, ISC)

3-9

USER-LOGOUT

UT-FAIL

2-227

1-57

1-56

2-241

1-40

RS-DCC terminations

2-242

username and password
VirusScan, disabling

1-50

1-44

VOA
failure scenarios

1-85 to 1-104

high degrade alarm
high fail alarm

2-226

2-226

low degrade alarm

2-227

low fail alarm

2-227

startup phases

1-83 to 1-85

VOA-HDEG

2-226

VOA-HFAIL

2-226

VOA-LDEG

2-227
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